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Online Technical Support 
Center
AspenTech customers with a valid license and software 
maintenance agreement can register to access the Online 
Technical Support Center at:

http://support.aspentech.com

You use the Online Technical Support Center to: 

• Access current product documentation.
• Search for technical tips, solutions, and frequently asked 

questions (FAQs).
• Search for and download application examples.
• Search for and download service packs and product 

updates.
• Submit and track technical issues.
• Search for and review known limitations.
• Send suggestions. 

Registered users can also subscribe to our Technical Support e-
Bulletins. These e-Bulletins proactively alert you to important 
technical support information such as:

• Technical advisories
• Product updates
• Service Pack announcements
• Product release announcements
iv

http://support.aspentech.com
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Phone and E-mail
Customer support is also available by phone, fax, and e-mail for 
customers who have a current support contract for their 
product(s). Toll-free charges are listed where available; 
otherwise local and international rates apply. 

For the most up-to-date phone listings, please see the Online 
Technical Support Center at: 

http://support.aspentech.com

Support Centers Operating Hours

North America 8:00 - 20:00 Eastern time

South America 9:00 - 17:00 Local time

Europe 8:30 - 18:00 Central European time

Asia and Pacific Region 9:00 - 17:30 Local time
v

http://support.aspentech.com
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1-2 Introduction
1.1 Introduction
HYSYS offers a high degree of flexibility because there are 
multiple ways to accomplish specific tasks. This flexibility 
combined with a consistent and logical approach to how these 
capabilities are delivered makes HYSYS an extremely versatile 
process simulation tool.

The usability of HYSYS is attributed to the following four key 
aspects of its design:

• Event Driven operation
• Modular Operations
• Multi-flowsheet Architecture
• Object Oriented Design

1.1.1 Event Driven
This concept combines the power of interactive simulation with 
instantaneous access to information. Interactive simulation 
means the information is processed as it is supplied and 
calculations are performed automatically. Also, you are not 
restricted to the program location where the information is 
supplied.

1.1.2 Modular Operations
Modular Operations are combined with the Non-Sequential 
solution algorithm. Not only is information processed as it is 
supplied, but the results of any calculation are automatically 
produced throughout the flowsheet, both forwards and 
backwards. The modular structure of the operations means they 
can be calculated in either direction, using information in an 
outlet stream to calculate inlet conditions. Process 
understanding is gained at every step because the operations 
calculate automatically and results are seen immediately.
1-2
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1.1.3 Multi-flowsheet 
Architecture

Multi-flowsheet architecture can be used to create any number 
of flowsheets within a simulation and to easily associate a fluid 
package with a defined group of unit operations.

1.1.4 Object Oriented Design
The separation of interface elements (how the information 
appears) from the underlying engineering code means the same 
information appears simultaneously in a variety of locations. 
Each display is tied to the same process variable, so if the 
information changes, it automatically updates in every location. 

Also, if a variable is specified, then it is shown as a specification 
in every location. This means the specification can be changed 
wherever it appears and you are not restricted to a single 
location for making changes.
1-3
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1.2 Interface Basics
This section provides basic information about using the HYSYS 
interface.

1.2.1 Views Functionality
HYSYS has the same basic features as found in other Windows 
98 or NT 4.0 based programs:

• Minimize, Maximize/Restore and Close icons are 
located in the upper right corner of most property views.

• Object icon, located in the upper left corner of most 
property views, contains the normal Windows 3.x menu.

Most of the property views found in HYSYS are resizable to some 
degree. 

The following list provides a brief description on resizable 
property views:

• When the Minimize, Maximize/Restore and Close 
icons are available, the property view can be resized 
vertically and horizontally.

• When only the Minimize and Close icons are available, 
the property view can only be resized vertically.

• When only the Close icon or Close and Pin icons are 
available, the property view can not be resized.

Minimize icon

Maximize icon

Restore icon

Close icon

Pin icon
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1.2.2 Primary Interface 
Elements

Although you can input and access information in a variety of 
ways, there are five primary interface elements for interacting 
with HYSYS:

Each of these interface elements, plus the complimentary tools 
such as the Data Recorder, Strip Charts, Case Study Tool, and 
Plots, are all connected through the model itself. Changes made 
in any location are automatically reflected throughout HYSYS. 

In addition, there are no restrictions as to what can be displayed 
at any time. For example, you can have both the PFD and 
Workbook open, as well as property views for operations and 
streams. 

Interface Element Description

PFD A property view containing a graphical environment 
for building your flowsheet and examining process 
connectivity. Process information can be displayed for 
each individual stream or operation as needed.

Workbook A property view containing a collection of tabs that 
displays information in a tabular format. Each 
Workbook tab displays information about a specific 
object type. You can install multiple tabs for a given 
object type, displaying information in varying levels 
of detail.

Property View A single property view that contains multiple tabs. 
HYSYS extensively uses these single property views, 
which include all information about a specific object 
(in other words, an individual stream or operation).

Summary View Displays the currently installed streams and 
operations.

Simulation 
Navigation

A property view that provides a single location for 
viewing all stream and unit operation property views 
in the simulation case, regardless of the flowsheet 
they exist in.
1-5
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1.2.3 Multi-Flowsheet 
Architecture/Environments

HYSYS is developed around a Multi-flowsheet Architecture. After 
creating the fluid package(s) for the simulation, you enter the 
main flowsheet. This is where the bulk of the model is created 
(where you install the streams and operations that represent the 
process). 

Subflowsheets can also be created at any time within the main 
flowsheet. Subflowsheets appear as a single operation with 
multiple connections. The main simulation does not know what 
is inside the subflowsheet, meaning it could be a refrigeration 
loop or a decanter system. The subflowsheet is seen by HYSYS 
as any other operation and it calculates whenever conditions are 
changed within it.

The nature of the subflowsheet gives rise to the concept of 
environments. Although a subflowsheet (MASSBAL, template, or 
column) appears as a single operation in the main flowsheet, 
you can, at any time, enter the subflowsheet to examine 
conditions in greater detail or make changes. 

When you enter the subflowsheet’s Build environment, the 
following occurs:

• The main flowsheet is temporarily cached and hidden; it 
returns to the exact status when you exit the 
subflowsheet.

• Other flowsheet solvers still produce the effect of a 
change, but the results of that change are not produced 
beyond the flowsheet boundary until you leave the 
subflowsheet environment.
Example: A stream inside of a subflowsheet containing a 
flow specification can also be connected to a stream in 
the parent flowsheet. If changes are made to the flow 
rate in the subflowsheet environment, the flow in the 
parent flowsheet is forgotten, as are any other flows in 
any flowsheets that are calculated as a result of that flow 
specification. This is the “forget” pass in the HYSYS 
solver. 
1-6
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Considering the “forget” pass in the HYSYS solver, the definition 
of a flowsheet (or subflowsheet) in the context of the overall 
program is defined by what it possesses:

• Independent fluid package (optional)
• PFD
• Workbook
• Flowsheet Elements (streams and/or operations)
• Solver

This definition may seem to contradict previous statements 
regarding the access to information, however, capabilities were 
built into HYSYS to maximize the power of using subflowsheets 
without impeding any access to information. No matter where 
you are in the simulation, you can open any flowsheet’s PFD or 
Workbook.

Since the subflowsheets are, in essence, single operations within 
the main flowsheet, each has its own property view that allows 
you to access information inside the subflowsheet without ever 
entering the subflowsheet itself.

1.2.4 Navigators
All of the flowsheets within a simulation are tied together 
through the Navigators.

Navigators Description

Simulation Navigator Quick access to the property view of any stream or 
unit operation from any flowsheet within the case.

Object Navigator Immediate access to the property view for any 
stream or operation from any location.

You can access the Object Navigator property view 
by right-clicking on any blank area of the HYSYS 
Desktop and selecting Find Object command 
from the Object Inspect menu.

Variable Navigator Target process variables from any flowsheet. For 
example, you can select variables for inclusion on 
a Strip Chart or for attachment to logical 
operations such as Adjusts or Controllers.

Refer to Section 7.18 - 
Simulation Navigator for 
details on the Simulation 
Navigator.

Refer to Section 7.17 - 
Object Navigator for 
details on the Object 
Navigator.

Refer to Section 11.21 - 
Variable Navigator for 
details on the Variable 
Navigator.
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1.2.5 Objects
The term object is used extensively throughout the 
documentation to refer to an individual stream or operation. 
Within HYSYS, information associated with an object can appear 
in a variety of ways (for example, Workbook, PFD, Property 
View, and Plot). 

Through the object oriented design of HYSYS, the information 
displayed by each interface element is tied to the same 
underlying object. The result is that if a parameter changes in 
the flowsheet, it is automatically updated in every location. 

Objects, such as an icon in a PFD, are tied to appropriate 
commands for that object (for example, printing and direct 
access to the object’s property view). 

Object Inspect Menu
An object inspect menu has the same function as the menu in 
the menu bar. The differences between the object inspect menu 
and the menu bar are:

• The method to access the commands in the menu. 
In the menu bar, the commands are accessible by 
clicking on the menu item. 
In the object inspect menu, the commands are accessible 
by right-clicking on the appropriate object. 

• The commands in the menu. 
In the menu bar, the commands are associated to one or 
more objects in the simulation case. 
In the object inspect menu, the commands are only 
associated to the object.
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1.2.6 Structure Terminology
All HYSYS cases include certain structural elements. The 
following table defines some common HYSYS terminology.

Special Flowsheet Elements
Column operations and flowsheet templates are special 
Flowsheet Elements because they are also flowsheets. A 
flowsheet template can be a column subflowsheet or a more 
complex system.

The special capabilities of the column and flowsheet template 
are as follows:

• Contain their own flowsheet, meaning they possess their 
own PFD and Workbook.

• Can be comprised of multiple flowsheet elements.
• Can be retrieved as a complete entity into any other 

simulation case.

Object Definition

Flowsheet Element 
(or Object) 

A stream or unit operation in the simulation case.

Flowsheet A collection of Flowsheet Elements that utilize a 
common fluid package. A flowsheet possesses its 
own Workbook and PFD.

Fluid Package Includes the property package, Components 
(library, pseudo or hypothetical), Reaction Package 
and User Properties used for flowsheet 
calculations. Fluid packages can be Imported and 
Exported.

Simulation Case A collection of fluid package(s), flowsheets, and 
flowsheet elements that form the model. The 
simulation case can be saved to disk for future 
reference. The extension used for saved cases is 
*.hsc.

Simulation cases can also be saved as template 
files (*.tpl), HFL files (*.hfl) and XML files (*.xml).

Session Encompasses every simulation case that is open 
while HYSYS is running.

Refer to Section 4.3 - 
HFL Files for more 
information regarding the 
HFL files.
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1.2.7 Desktop
The figure below shows the basic components of the HYSYS 
Desktop.

The main features of the Desktop are defined in the following 
table.

 Figure 1.1

Menu Bar

Toolbar

Title Bar Environment/Mode Label

Object Status Window Trace Window

Scroll 
Bar

Status 
Bar

Object Definition

Title Bar Indicates the HYSYS file currently loaded.

Menu Bar Provides access to common flowsheet commands 
through a drop-down menu system.

Toolbar Contains various icons that invoke a specific command 
when clicked.

Environment/
Mode Label 

Indicates the environment and mode that you are 
currently working in.

Status Bar Displays the calculation status of the object. When the 
mouse pointer is placed over an icon in the toolbar, the 
Object Palette, or a property view, a brief description 
of its function appears in the Status Bar.
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Some additional information about the HYSYS Desktop:

• When the mouse pointer is placed over a button/icon, its 
descriptive name pops up below the pointer and a Fly by 
function appears in the status bar.

• When necessary, the Desktop has both a vertical and 
horizontal scroll bar that are automatically created.

1.2.8 Interface Terminology 
The terminology shown in the following figures is used to 
describe the various HYSYS interface elements. 

Calculation/
Responsiveness 
icon

The Calculation/Responsiveness icon enables the user 
to control how much time is spent updating the 
screens vs. calculations.

Scroll Bars Allows you to scroll horizontally and vertically.

Object Status 
Window/Trace 
Window

The Object Status Window (left pane) shows current 
status messages for flowsheet objects, while the Trace 
Window (right pane) displays Solver information. The 
windows can be resized vertically or horizontally by 
clicking and dragging the windows frames located 
between or above them.

For more information about the Object Status Window 
or Trace Window, refer to Section 1.3 - Object 
Status & Trace Windows.

Object Definition

Calculation/
Responsiveness icon

 Figure 1.2

Drop-
down 
Field

Pin

Input 
Field

Status 
BarTabs

Button

Drop-
down List
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 Figure 1.3

Minimize, Maximize, and Close IconsActive Selected Location

Selected Tab

Radio 
Button

Group
Pages

Object Icon

Checkbox (clear)

Object Definition

Active Selected 
Location

The current active location is always indicated by a 
dark frame or border.

Button Invokes a command when clicked.

Checkbox Items or settings that are On or Off. Selecting the 
checkbox turns the function On. Clearing it turns it Off.

Drop-Down List A list of available options for a given input cell.

Group Organizational border within a page that groups 
related functions together. Each group has its own 
active location.

Icon Invokes a command when clicked, or opens a property 
view when double-clicked.

Input Cell/Field Location in a property view for supplying or viewing 
information (for example, stream names and 
temperatures). In many cases it has a drop-down list 
associated with it.

Matrix A group of cells where you can manoeuvre with the 
mouse or the keyboard arrow keys.

Minimize/
Maximize icon

Either shrink the current property view (minimize), or 
expand the property view to its full size.

Object icon Either closes the property view (double-clicking), or 
produces a drop-down menu of common Windows 
commands.
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Active Property View/Active Location
Although several property views can be displayed on the 
Desktop at any time, only one property view is Active or has 
focus. This is indicated by the property view’s Title Bar being 
selected. Within that property view, there is again only one 
location that is Active. How this appears varies depending on the 
location (for example, an active cell vs. an active button).

1.3 Object Status & Trace 
Windows 

At the bottom of the HYSYS Desktop there is a window that 
appears by default. The window is split vertically into two panes 
and displays status messages and detailed solver information. 
The left pane is referred to as the Object Status Window and the 
right pane is the Trace Window.

Object Status Each property view shows the status of the associated 
object with a coloured background (red for a missing 
parameter, yellow for a warning message, and green 
for OK).

Pages Provides access to detailed information for the selected 
object.

Pin Converts a Modal property view to a Non-Modal 
property view.

Radio Button Always found in groups of at least two; only one can be 
active at a time. 

Tabs Provides a logical grouping of information. Often 
contain pages where the information is sorted further.

View Any graphical representation found on the Desktop, for 
example, a property view for an operation. 

The Object Status Window and Trace Window cannot be 
opened separately.

Object Definition
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1.3.1 Opening & Sizing the 
Windows

To open the Object Status and Trace Windows, position the 
mouse pointer on any part of the thick border directly above the 
Status Bar. When the cursor changes to a sizing arrowhead 
(double-headed arrow), click and drag the border vertically.

If the cursor is placed over the vertical double line that 
separates the two panes, a horizontal sizing arrowhead appears. 
The size of the two panes can be adjusted by clicking and 
horizontally dragging the cursor.

1.3.2 Message Windows
The message windows within HYSYS include the Object Status 
and Trace windows. Refer to the following table for the 
functionality of the windows: 

Window Functionality

Object 
Status 
Window

• Shows current status messages for objects in the 
flowsheet, coloured accordingly. The colour of the 
status message for an object usually matches the 
colour of the status message on the object’s property 
view.

• Allows you to access to the property view of an object 
described in the status message by double-clicking on 
the message.

Trace 
Window

• Displays iterative calculations for certain operations 
(such as the Adjust, Recycle, and Reactor). These 
appear in black text.

• Displays scripting commands in blue text.
• Displays error messages (that still solve), such as 

operation errors or warnings, in red text.

Status messages displayed in yellow in a property view 
appear in black in the Object Status Window for clarity.
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An example of the contents shown in the Object Status and 
Trace Windows appears below. Each window has a vertical scroll 
bar for viewing the contents of the window.

1.3.3 Object Inspect Menus
The commands available through the Object Inspect menu of 
the Object Status Window and Trace Window are specific to each 
pane.

Object Status Window
The following commands are available by right-clicking the 
Object Status Window:   

 Figure 1.4

Command Description

View Status 
List Properties

Opens the Status List Properties property view. This 
property view contains an input field for the Status List 
File Name (by default Status.Log), that enables the 
contents of the left pane to be written to a file. Also on 
this property view is a drop-down list for the Minimum 
Severity.

From top to bottom, the options in the drop-down list 
represent increasing status message severity. For 
example, selecting Warning from the list displays all 
messages that are warnings or more severe in the left 
pane. To display only error messages that are the most 
severe, select the **Error** option.

Dump Current 
Status List to 
File 

Automatically dumps the contents of the left pane to the 
Status List File Name.

The OK status messages do not appear in the Object Status 
Window.
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Trace Window
The commands in Object Inspect menu for the Trace Window are 
described in the following table:  

 Figure 1.5

Command Description

View Trace 
Properties 

Opens the Trace Properties property view, which contains the following:
• Trace File Name field. Shows the file name to which the contents of 

the Trace Window can be written (by default Trace.Log).
• History Length field. Represents the number of lines that the Trace 

Window keeps in its history.
• Trace to File Continuously checkbox. When selected, the Trace 

Window contents are written to the Trace File.
• Verbose checkbox. When selected, the Trace Window shows solver 

information for all operations in the case.
• Trace Inactive checkbox. When selected, the Trace Window shows 

information for all inactive operations in the case.
• Word Wrap Trace Lines checkbox. When selected, the messages in 

the Trace Window are word wrapped to fit the Trace Window.

Dump Current 
Trace to File

Automatically dumps the contents of the Trace Window to the Trace File. 

Clear Trace 
Window 

Clears all the information from the Trace Window.

 Figure 1.6
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1.4 Toolbar
The icons on the toolbar provide immediate access to the most 
commonly used commands. 

The following icons are found on the various toolbars in HYSYS.

The toolbar varies depending on the current environment 
and Mode.

The option icons in the toolbar are also available in the menu 
bar.

Name Icons Description

New Case Creates a new case.

Open Case Locates and opens an existing case/
template/column.

Save Case Saves the active case.

PFD Opens the PFD for the current flowsheet.

Workbook Opens the Workbook for the current 
flowsheet.

Navigator Opens the Object Navigator.

Simulation 
Navigator

Opens the Simulation Navigator.

Steady State/
Dynamics 

Toggles between Steady State and 
Dynamic modes. Currently toggled to 
Steady State mode.

Dynamics 
Assistant

Opens the Dynamics Assistant property 
view.

Column Opens the Column Runner property view.

Active/Holding

Run/Stop

(Steady State) 

Main environment: Toggles between 
Active and Holding modes. Green (left) is 
Active.

Column environment: Toggles between 
Run and Stop Column Solver. Green (left) 
is Run.

Integrator

(Dynamics) 

Integrator toggle. Toggles between Active 
and Holding. Red (right) is Holding.
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Some additional things about the HYSYS Desktop:

• When the cursor is placed over a button/icon, its 
descriptive name pops up below the pointer and a Fly by 
function appears in the status bar.

• The Desktop has both a vertical and horizontal scroll bar. 
These are automatically created when necessary.

Basis Enter the Basis environment.

Parent 
Flowsheet 

Return to the parent flowsheet from a 
subflowsheet (in other words, the main 
environment from the column 
subflowsheet environment).

Oil Environment Enter the Oil environment from the Basis 
environment.

Leave 
Environment

From the Oil environment, return to the 
Basis environment; from the Basis 
environment, return to the Main 
environment.

Name Icons Description
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1.5 Hot Keys
File

Create New Case CTRL N

Open Case CTRL O

Save Current Case CTRL S

Save As... CTRL SHIFT S

Close Current Case CTRL Z

Exit HYSYS ALT F4 

Simulation

Enter Simulation Basis Manager CTRL B 

Main Properties CTRL M

Access Optimizer F5

Access Event Scheduler CTRL E

Leave Current environment (Return to 
Previous)

CTRL L 

Toggle Steady-State/Dynamic Modes F7 

Toggle Hold/Go Calculations F8

Access Integrator CTRL I

Start/Stop Integrator F9

Stop Calculations CTRL BREAK

Flowsheet

Add Material Stream F11

Add Operation F12

Access Object Navigator F3 

Access Notes Manager CTRL G

Show/Hide Object Palette F4

Access Composition Property View (from 
Workbook)

CTRL K

Displays Stream Temperatures SHIFT T

Displays Stream Pressures SHIFT P

Displays Stream Molar Flow Rates SHIFT F

Displays Stream Names (Default) SHIFT N

Tools

Access Workbooks CTRL W

Access PFDs CTRL P

Toggle Move/Attach (PFD) CTRL

Access Utilities CTRL U

Access Reports CTRL R

Access Databook CTRL D
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Access Controller FacePlates CTRL F

Access Dynamics Assistant CTRL Y

Access Help F1

Column

Go to Column Runner (subflowsheet) CTRL T

Stop Column Solver CTRL BREAK

View

Close Active Property View CTRL F4

Tile Property Views SHIFT F4

Go to Next Property View CTRL F6 or CTRL TAB

Go to Previous Property View CTRL SHIFT F6 or CTRL SHIFT 
TAB

Go to Next item within the Property View TAB

Go to Previous item within the Property 
View

SHIFT TAB

Editing/General

Access editing cell function F2

Access Pull-Down Menus F10 or ALT

Go to Next Page Tab CTRL SHIFT N

Go to Previous Page Tab CTRL SHIFT P

Cut CTRL X

Copy CTRL C

Paste CTRL V
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2-2 Introduction
2.1 Introduction
HYSYS is based on these fundamental principles: 

• single model concept 
• rigorous first principle’s models 
• reuse of simulation data 
• best in class usability
• an open customizable environment

The HYSYS series of products, which include HYSYS 3.01 and 
3.1, is true to these principles as new developments have 
expanded and built upon this foundation.

2.1.1 One Model, Many Uses
The single model concept allows the user to build one model of 
the process and migrate it through the various stages of the 
Lifecycle. During the design stage, a model can be used for 
conceptual design, real process design, detailed engineering 
design, and finally, for operability design. Once the asset has 
been built, this same model can be used for operations 
improvement, operator training, safety studies, and asset 
optimization. In addition to delivering simulation capabilities 
that support the Lifecycle, HYSYS also serves as the platform for 
modeling across the entire range of the chemical and 
hydrocarbon processing industries.

HYSYS serves as the engineering platform for modeling 
processes from Upstream, through Gas Processing and 
Cryogenic facilities, to Refining and Chemicals processes. A 
range of powerful new engineering capabilities have been 
delivered within HYSYS through the development activities of 
Aspentech and its alliance partners, including the following:

• COMThermo. Completely flexible thermodynamics, 
COMThermo, is the first truly componentized 
thermodynamics server now on the market in the 
process industries. COMThermo is a thermodynamic 
calculation framework that makes it possible to develop 
independent, extensible, and encapsulated calculation 
modules for reuse within the engineering Lifecycle. The 
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immediate benefits are more flexible thermodynamic 
choices and the easy integration of in-house and 3rd 
party methods.

• HYSYS OLI Interface. Integration of OLI Systems Inc. 
technology and component databanks with the industry’s 
first fit for purpose set of electrolyte unit operations.

• Claus Plant Modeling. Integration of SULSIM from 
Sulphur Experts.

• Well and Pipeline Modeling. Integration of PIPESIM 
from Baker Jardine.

• Multi-phase Pipeline Hydraulics. Integration of 
PIPESYS from Neotechnology.

• Transient Multi-phase Flow. Integration with 
Aspentech ProFES tools.

• Advanced Amine Systems. Integration of AMSIM from 
DB Robinson.

• Economic Evaluation. HYSYS cases can be 
automatically exported to Aspen’s Icarus Process 
Evaluator (IPE) for cost evaluation.

Beyond the development and integration of these technologies 
into the HYSYS engineering platform, there have been many 
new capabilities developed that enhance Process Asset Lifecycle 
Management. These include the following:

• Hyprotech SQP. A new optimization algorithm, 
Hyprotech SQP, for design and asset optimizations. 

• LP Utility. A utility that uses the rigorous HYSYS process 
model to generate vector data for planning and 
scheduling tools.

• Dynamic Depressuring. Uses the powerful, proven 
dynamic modelling capabilities of HYSYS for conducting 
depressuring studies in our steady state simulator to 
perform Relief Valve sizing against safe depressuring 
times.

• LNG Rating. Integration of the rigorous MUSE engine 
from HTFS.

• Air Cooler Rating. Integration of the ACOL functionality 
from HTFS.

• Heat Exchanger Rating. Tight integration of the TASC 
engine from HTFS so that process engineers can perform 
detailed rating calculations within the HYSYS 
environment.

• SPS. Integration of solid component characterization 
technology from SPS.

• MASSBAL. A simultaneous solver for flowsheets 
delivered by integrating MASSBAL technology into 
HYSYS.
2-3



2-4 Introduction
2.1.2 Leader in Usability
Aspentech has always believed that ease of use is a 
fundamental component of simulation technology. HYSYS has 
consistently delivered on this, allowing engineers to easily 
construct and analyze models of their process to obtain the 
understanding necessary to make informed engineering, 
operating, and business decisions. 

As with previous releases of HYSYS, there are a range of new 
features that simplify the engineer’s task of building and 
analyzing models. Some of the highlights include: 

• A Simulation Navigator that allows instant access to all 
unit operations and streams within the simulation case.

• Case Collaboration that allows the building of compound 
cases that span the user’s network. Boundary streams 
are connected through an external data server which 
supports revisions and change notifications. 

• A Notes Manager that allows one spot access to all user 
notes from any location in the simulation case.

• Auto Connection feature for rapidly building flowsheets in 
the PFD environment.

• Correlation Sets, which allow the user to define the 
properties to be calculated and displayed for any stream 
in the case.

• Case security levels that allow the protection of 
Intellectual Property contained within any built HYSYS 
model.

2.1.3 Maximizing the 
Engineer’s Efficiency

There are several key aspects of HYSYS which have been 
designed specifically to maximize the engineer’s efficiency in 
using simulation technology. Usability and reliability are two 
obvious attributes, which HYSYS has and continues to excel at. 
The single model concept is key not only to the individual 
engineer’s efficiency, but to the efficiency of an organization. 

Of equal importance is the commitment to developing the 
capabilities within the simulator that support re-use of the 
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engineer’s work, as well as capabilities that allow for the flexible 
application of the available technology. The HYSYS 3 series 
contains a number of new developments which are designed 
specifically to promote re-use and deliver increased flexibility to 
the engineer. Underlying this aspect of HYSYS has been a steady 
migration to delivering finer granularity of the “components” 
which make up a simulation case, such that these components 
can be defined once and used many times. 

The most significant development within the HYSYS 3 series in 
this regard is the delivery of XML (eXtensible Mark up Language) 
technology. The range of possibilities that this opens up are 
significant, but some of the immediate benefits are:

• The ability to store all (or part) of the user’s inputs and 
specifications in XML to allow re-building of the case.

• The ability to store parts of an existing simulation case in 
XML and have it read into another case, either 
augmenting or overwriting the definitions within that 
case.

• The ability to store simulation case results in an XML 
format to allow post processing of simulator data, taking 
advantage of the wide range of XML technology being 
developed within the software industry.

• The ability to browse the simulation case data in a 
familiar internet browser-like environment.

In addition, HYSYS has increased ability to define and store 
simulation components, including:

• Workbook Sheet definitions. Individual pages of the 
Workbook can be stored out and read back into any other 
simulation case.

• Correlation Sets. User defined sets of properties can be 
configured and read into any other case.

• Independent and Dependant Property Sets for LP 
utilities.

• HFL files. Unit operation collections from an existing 
case can be stored out and modified as *.hfl files, 
allowing them to be re-imported via the copy/paste 
capabilities into any other case.
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2.1.4 Difference in the Aspen 
HYSYS Series

For existing HYSYS users there are some significant differences 
in the Aspen HYSYS 2004 series that the user will want to take 
advantage of. There have been significant advancements in the 
underlying fluid structure within HYSYS that has delivered a 
range of exciting possibilities.

• A component (library or pseudo) has been defined. The 
component within HYSYS has become both flexible and 
extensible. Properties of components can change through 
the flowsheet, either through user intervention or via the 
action of a unit operation.

• Component lists can be shared amongst fluid packages, 
which, in combination with the flexible component 
technology, significantly reduces the number of 
components required to model a given process, 
particularly in refining.

• User properties have been integrated into the 
components and have been tied into flexible stream 
reporting capabilities.

• Multiple fluid packages are supported within a single 
flowsheet. The user is not restricted to having one fluid 
package per flowsheet. Fluid packages can be applied to 
individual streams and operations within a flowsheet, 
with Fluid Package Transitions automatically inserted (or 
removed) where necessary.

New Technology Built on Historical 
Success
The Aspen HYSYS 2004 series represents a significant 
advancement in simulation technology, built upon the proven 
capabilities of previous versions. As with every Aspentech 
product, it reflects our commitment to delivering the Process 
Asses Lifecycle within a platform that is the world leader in ease 
of use and flexibility, and sets the standard for an open 
engineering environment. 
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2.2 Simulation Case
The simulation case is comprised of the main elements 
described in the following table:

Main Elements Description

Fluid Definition The definition of the material that is being operated on 
by the unit operations, including component lists, 
component properties, property package, and reactors. 
Refer to Chapter 5 - Basis Environment for more 
information.

Flowsheet A collection of unit operations (physical and logical) 
and the streams that connect fluid information 
between them. This is termed Topology and 
connectivity. See Chapter 3 - Flowsheet for more 
information.

Analytical 
Calculations

The property calculations (stream based) and utilities 
that perform additional calculations using data 
(typically stream information) owned by other objects. 
Refer to Appendix A - Property Methods & 
Calculations in the HYSYS Simulation Basis guide 
for more information.

Data Sources Variables which are owned by the unit operations can 
either be used by other unit operations (logical 
operations) in their calculations, or attached to Data 
Collectors for visualization. Refer to Section 11.21 - 
Variable Navigator for more information.

Data Collectors Elements within the program that access data owned 
by other objects for the purpose of visualization or 
analysis. Refer to Section 11.7 - Databook for more 
information.

Simulation 
Control Tools

These are the tools that sit on top of the simulation 
case, causing it to solve in a specific manner to deliver 
specific behaviour. 

Refer to the following objects Optimizer, Dervutil, Data 
Recon utility, PM utility, and Case Studies in the 
HYSYS Operations Guide, and Section 7.7 - 
Integrator.
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2.2.1 Building a Simulation 
Case

If you use the basic steps of building a simulation case, the 
ability to re-use these simulation elements can be more easily 
illustrated:

1. Create the fluid definition. Fluid packages can be stored as 
self-contained pieces (as well as some of the pieces within 
the fluid package) and read in to begin a simulation case.

2. Construct the flowsheet topology. Flowsheet templates, *.hfl 
files, and *.xml files can all be stored as self-contained 
pieces and be read in to any future simulation case. With 
HYSYS 3.0, changes made in the external files (*.hfl and 
*.xml) can be easily incorporated into an existing case.

Then optionally:

3. Define the Property Calculations wanted for the various fluid 
types. The correlation sets or Workbooks (the entire 
Workbook definition or individual tabs/pages) can be stored 
outside of the simulation case and subsequently applied to 
existing or new cases.

4. Create any Analytical Calculators required.

5. Identify any data sources that are required for Data 
Collectors.

6. Define any Data Collectors (Strip charts, Workbooks, PFD 
tables).

7. Construct any Simulation Control Tools required (Optimizer, 
Integrator, or Case Study).
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2.3 Multi-Flowsheet 
Architecture/
Environments

With the continued evolution of computer hardware and 
software architecture, the ability to rigorously model entire 
plants has become feasible. HYSYS, which has always been 
based on a multi-flowsheet architecture, is ideally suited for 
dealing with the size of the simulation cases that result from 
building plant-wide models.

Once the fluid package(s) for your simulation have been 
created, you enter the main flowsheet. In this location, the bulk 
of the model is created, installing the streams and operations to 
represent your process.

Subflowsheets within the main flowsheet can be created at any 
time, as well as subflowsheets within subflowsheets. There are 
three fundamental purposes of the subflowsheet:

• Representation of complex plant models in terms of 
“units” which provides an easy mechanism for the 
organization of large models.

• Easy support for templating of units or processes to 
facilitate their re-use.

• Provide the mechanism for solver transitions (in other 
words, from the default non-sequential modular solver to 
the simultaneous solver used by the Column or the 
MASSBAL subflowsheet). 

In addition, it is also possible to use the subflowsheet as a fluid 
package transition (in other words, switching from a fluid 
package tailored for VLE calculations to one tailored for LLE 
calculations), although with HYSYS 3.0 and up this is not the 
only mechanism for applying these transitions.

Within a given flowsheet, all subflowsheets are treated as a 
single unit operation with multiple connections. The parent 
flowsheet (main or sub) in which that subflowsheet resides has 
no knowledge of what is inside the subflowsheet (in other 
words, it could be a refrigeration loop or a decanter system). 
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From the parent flowsheet, the subflowsheet behaves as any 
other operation and calculates whenever “feed” conditions 
change. 

The nature of the subflowsheet gives rise to the concept of 
environments. Although a subflowsheet (template or column) 
appears as a single operation in its owner flowsheet, you can, at 
any time, enter the subflowsheet to examine conditions in 
greater detail or make changes. You can make topology changes 
in the main PFD or in the subflowsheet environment. If you 
enter the subflowsheet’s build environment, the following HYSYS 
behaviour occurs:

• The parent flowsheet (and all those which are above the 
current flowsheet in the simulation case hierarchy) are 
temporarily cached. 

• The parent flowsheet’s solver(s) (and all those which are 
above the current flowsheet in the simulation case 
hierarchy) only process the forget pass, and calculations 
are temporarily suspended. Within the subflowsheet 
calculations are still performed, but the results are not 
propagated to the rest of the simulation until you come 
out of the subflowsheet environment. This lets you focus 
on a specific aspect of the simulation without having the 
entire simulation calculate every time conditions change.

While there are certain programmatic behaviours built into 
HYSYS to facilitate the proper behaviour of the flowsheets, this 
does not limit its ability to access information from any location 
in the program. No matter where you are in the simulation case, 
you can open any flowsheet’s PFD, Workbook or property view 
for a stream or operation within that flowsheet. Since the 
subflowsheets are, in essence, single operations within the main 
flowsheet, each has its own property view. You can access 
resident information inside the subflowsheet through this 
property view without ever having to enter the subflowsheet 
itself.

With other unit operations in HYSYS, information can flow 
across the subflowsheet boundary bi-directionally (in other 
words, product stream information can flow into the 
subflowsheet).
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The accessing of data within the simulation case is the function 
of the Navigators. 

• The Object Navigator gives immediate access to the 
property view for any stream or operation from any 
location. 

• The Variable Navigator lets you target variables from any 
Flowsheet for use—either by a logical unit operation—or 
as part of one of the Data Collectors. 

• The Simulation Navigator provides a single location 
where you can view or interact with the property views 
for all streams and unit operations in the simulation case, 
regardless of which flowsheet they reside in.

Refer to Section 7.17 - 
Object Navigator for 
details on the Object 
Navigator.

Refer to Section 11.21 - 
Variable Navigator for 
details on the Variable 
Navigator.

Refer to Section 7.18 - 
Simulation Navigator 
for details on the 
Simulation Navigator.
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3-2 Introduction
3.1 Introduction
The following sections describe the functionalities of the various 
flowsheets within HYSYS.

Keep the following in mind:

• Fluid packages can be assigned to individual unit 
operations or groups of unit operations in a flowsheet, 
independent of the default fluid package for that 
flowsheet. Fluid package transitions are automatically 
introduced for the user.

• The Cut/Copy/Paste function allows the creation of an 
*.hfl file, which can be stored on disk. This HFL file can 
be created from any collection of unit operations and 
streams within the simulation case. The fluid packages 
associated with those objects are also saved with the HFL 
file. You can open this file and edit it, using the fluid 
packages contained for the calculations. When an HFL file 
is imported into a simulation case, the fluid packages are 
removed; only the objects, topology, and specifications 
are imported into the target case.

• Unit operations and streams can be added to and 
removed from flowsheets using the Cut/Copy/Paste 
functionality.

• Case Collaboration allows you to construct smaller 
flowsheets of a larger process and examine the 
relationships/impacts between flowsheets.

• XML data representation provides a complimentary 
representation of the traditional binary form of the case 
storage. It allows you to read impartial information into 
one or more existing simulation cases, resulting in those 
cases being updated with the new information.

In addition to these features, HYSYS can define elements of the 
simulation case and store them independently of the case for 
subsequent re-use. This includes not only fluid package 
elements and flowsheet topologies, but analytical tools such as 
property calculations and Workbooks as well.
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3.2 Flowsheets in HYSYS
HYSYS uses a multi-level flowsheet architecture tightly 
integrated within a framework of simulation environments. 
Separate Desktops for each environment help you focus on the 
current design task, and multi-level flowsheets allow you to 
contain complex processes within subflowsheets.

As a result, you can interact with an installed subflowsheet 
operation as if it were a simple black box, or you can use the 
subflowsheet’s simulation environment when more detailed 
interaction is required. Potentially complex flowsheets installed 
as subflowsheet operations function in a familiar and consistent 
manner, much like the other “normal” unit operations in HYSYS.

HYSYS also supports the concept of a Process Template. A 
template is a complete flowsheet that is stored on disk with 
additional information on how to set up the flowsheet as a 
subflowsheet operation. 

Typically, templates represent a plant process module or a 
portion of a process module. The stored template can be read 
from disk and installed as a complete subflowsheet operation 
numerous times and in any number of different simulation 
cases.

The subflowsheet can also be assigned a separate fluid package 
different from main flowsheet. This feature lets you model plant 
utilities more rigorously using, for example, cooling water and 
steam circuits as separate flowsheets with dedicated Steam 
Table property packages.

Column Subflowsheets – A Special Case

Column subflowsheets are a distinct class of subflowsheets 
because they provide a simultaneous flowsheet solution. Even 

The flowsheet and subflowsheet are not restricted to a single 
fluid package.
3-3



3-4 HYSYS Environments
though they are different, they are created and accessed much 
like normal subflowsheets, and can be created and later 
imported into other simulations.

The column subflowsheet’s property view and the Column’s 
simulation environment are very different, however, as they are 
suited specifically for designing columns rather than general 
processes. 

Although a lot of the general subflowsheet information 
presented in this chapter also applies to the column 
subflowsheet, the column subflowsheet operation is discussed 
specifically and in-depth in Chapter 2 - Column Operations in 
the HYSYS Operations Guide.

MASSBAL Flowsheets – A Special Case

HYSYS can also solve selected flowsheet configurations in a 
simultaneous mode. By integrating the MASSBAL solver into 
HYSYS, a flowsheet can be configured and initialized using the 
non-sequential modular solver, and then transitioned to be 
solved simultaneously. From the overall flowsheet execution, 
this flowsheet behaves as a black box solution, solving 
whenever its connections change. 

3.3 HYSYS Environments
The environment design concept is one of the cornerstones on 
which HYSYS is built. These environments let you access and 
input information in a certain area (environment) of the 
simulation, while other areas of the simulation are put on hold. 
The other areas will not proceed with steady state calculations 
until you are finished working in the active area. Since the 
HYSYS integrator is time-step based, the environments have no 
impact on dynamic calculations.

The environments help you maintain peak efficiency while 
working with your simulation by avoiding the execution of 
redundant calculations.

Refer to Section 13.2 - 
MASSBAL 
Subflowsheet in the 
HYSYS Operations 
Guide for more 
information.
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Separate Desktops are available within each environment. 
These Desktops include an appropriate menu bar, toolbar, and 
Home View(s) specifically designed for interaction with that 
particular environment. The Desktops also remember the 
property views that are open, even when their associated 
environment is not currently active. 

When moving from one environment to another, Desktops 
provide a mechanism to quickly and automatically put away 
what ever property views are open in one environment, and 
bring up the property views that were open in the other 
environment. This feature is useful when working with large 
flowsheets.

The environments in HYSYS can be loosely grouped into two 
categories: 

• Basis environments
• Simulation environments

These environments are described in more detail in the following 
sections.

3.3.1 Basis Environments
There are two types Basis environments:

•  Simulation Basis 
•  Oil Characterization

Simulation Basis Environment 
When beginning a HYSYS simulation, you automatically start in 
the Simulation Basis environment. Here you create, define, and 
modify fluid packages to be used by the simulation’s flowsheets. 
In general, a fluid package contains—at minimum—a property 
package and library and/or hypothetical components. Fluid 
packages can also contain information such as reactions and 
interaction parameters.

The Desktop for the Simulation Basis environment contains a 
toolbar with the appropriate icons for Basis tasks and designates 
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the Simulation Basis Manager property view as the Home View.

Oil Characterization Environment
The Oil Characterization environment lets you characterizes 
petroleum fluids by creating and defining assays and blends. 
The Oil Characterization procedure generates petroleum 
hypocomponents for use in your fluid package(s). The Oil 
environment is accessible only within the Simulation Basis 
environment.

The Desktop for the Oil Characterization environment is very 
similar to the Desktop in the Simulation Basis environment. 
Icons specific to Generating Oils appear and the Oil 
Characterization Manager is the Home View.

3.3.2 Simulation Environments
The following are examples of Simulation environments: 

• Main flowsheet environment/subflowsheet environment
• Column subflowsheet environment
• MASSBAL subflowsheet environment

HYSYS allows you to “nest” flowsheets. The main flowsheet is 
the parent flowsheet for the subflowsheets it contains. A 
subflowsheet can also be a parent flowsheet if it contains other 
subflowsheets.

You can create subflowsheets within all the flowsheets in 
your simulation.
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Main Flowsheet/SubFlowsheet 
Environment
The simulation case main flowsheet environment is where you 
do the majority of your work in HYSYS. Here you install and 
define the following:

• Streams
• Unit operations
• Columns

You can also create subflowsheets in the main environment.

This flowsheet serves as the base level or “main” flowsheet for 
the whole simulation case. Any number of subflowsheets can be 
generated in this main flowsheet. While there is only one main 
flowsheet environment, each individual subflowsheet that is 
installed can have its own corresponding subflowsheet 
environment.

The Desktop for the main flowsheet environment contains an 
extensive menu bar and toolbar designed for building and 
running simulations. There are two Home Views for the 
flowsheet: the Workbook and the PFD.

A subflowsheet environment is almost identical to the main 
flowsheet environment because you can install streams, 
operations, and other subflowsheets. One difference is that each 
installed flowsheet in the simulation case has its own 
corresponding environment, while there is only one main 
flowsheet environment. The other difference is that while you 
are in a subflowsheet environment, steady state calculations in 
other areas of the simulation are put on hold until you return to 
the main flowsheet environment.

The Desktop for a subflowsheet environment is virtually 
identical to the Desktop for the main flowsheet except for one 
difference: the Parent Simulation Environment icon appears 
in the toolbar.

Parent Simulation 
Environment icon
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Column Subflowsheet Environment
The Column environment is where you install and define the 
streams and operations contained in a column subflowsheet, 
and it is similar to the subflowsheet environment described in 
the previous section. Examples of unit operations you can install 
in a column subflowsheet include the following:

• Tray sections
• Condensers
• Reboilers
• Side strippers
• Heat exchangers
• Pumps

HYSYS contains a number of pre-built column subflowsheet 
templates that allow you to quickly install a column of a typical 
type and then, if necessary, customize it as required within its 
Column environment.

The menu bar, toolbar, and Home Views for the Column 
environment are designed expressly for designing, modifying, 
and converging column subflowsheets. It includes an additional 
Home View (the Column Runner), and a corresponding menu 
item and a Column Runner icon on the toolbar provide access 
to the Column Runner property view. Even with these changes, 
a Column environment Desktop still closely resembles the 
conventional flowsheet environment Desktop.

There are eleven pre-build columns available in HYSYS.

Due to the nature of its solution method, the column 
subflowsheet does not support other subflowsheets.

Column Runner icon
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3.3.3 Environment 
Relationships

The figure below shows the relationship among the various 
environments. The arrows indicate how you usually move 
between environments as you build a HYSYS simulation. 

 Figure 3.1
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Building a Simulation
1. Create a new simulation case. HYSYS automatically starts 

you in the Simulation Basis environment.
2. Inside the Simulation Basis environment, do the following:

• Select a property method and pure components from the 
HYSYS pure component library.

• Create and define any hypothetical components, if 
required.

• Define reactions, if required.
At this point, you have two options. If you have a petroleum 
fluid to characterize, proceed to step #3. If not, proceed to 
step #5.

3. Enter the Oil Characterization environment, where you can 
do the following:

• Define one or more Assays and Blends.
• Generate petroleum hypocomponents representing the 

oil.

4. Return to the Simulation Basis environment.

5. Enter the main flowsheet environment, where you can do 
the following:

• Install and define streams and unit operations.
• Install columns operations, process templates, and 

subflowsheet operations as required.
6. Enter a Column or subflowsheet environment when you need 

to make topological changes, or if you want to take 
advantage of a subflowsheet environment’s separate 
Desktop.

You can move between the flowsheet environments at any 
time during the simulation. The arrows in the previous 
diagram show that the column and subflowsheet 
environments are accessible only from the main flowsheet, 
however, this is only the typical way of moving between the 
environments. 

To access the Oil environment you must be inside the 
Simulation Basis environment.
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The Navigator lets you move directly from one flowsheet to any 
another. The only restriction is that the Oil environment can be 
accessed only within the Simulation Basis environment.

3.3.4 Advantages of Using 
Environments 

To illustrate the advantages of the environments approach, 
consider the creation of a new HYSYS simulation case. When 
you start HYSYS, you start in the Simulation Basis environment, 
where you define a fluid package by selecting a property method 
and components. When finished, you enter the main flowsheet 
environment and begin installing streams and unit operations.

If you are missing some components in the fluid package, you 
can return to the Simulation Basis environment and all 
flowsheets are placed in Holding mode until you return to the 
main flowsheet. This prevents calculations from occurring until 
you have made all required changes to the fluid package.

The flowsheet calculations do not resume until you return to the 
main flowsheet environment.

For subflowsheets, the concept of Holding steady state 
calculations works according to the hierarchy of the flowsheets 
in the simulation. When working inside a particular flowsheet, 
only that flowsheet and any others below it in the hierarchy 
automatically calculate as you make changes. 

Using environments helps make the most of your simulation 
time by eliminating the execution of time-consuming, 
extraneous calculations.

With each time-step, Dynamic calculations proceed from the 
front to back of the flowsheet in an orderly propagation. This 
is not affected by the flowsheet environments. Dynamics 
calculate in a “flat” flowsheet space.

Navigator icon

Click the Active icon to 
resume calculations.
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All other flowsheets hold until you move to their flowsheet’s 
Simulation environment, or one directly above them on the 
hierarchical tree.

If changing the number of trays for a column in subflowsheet F, 
enter the environment for this subflowsheet and make the 
changes. HYSYS re-calculates the column. There are no 
flowsheets below F, so all other flowsheets are on hold while you 
modify the column. 

Continue making changes until you reach a satisfactory solution 
for F, then return to the main flowsheet environment to 
automatically re-calculate all the flowsheets based on the new 
subflowsheet solution.

 Figure 3.2

You can change specifications from anywhere in the 
simulation case. You can make topology changes on any 
open PFD, or you can make the changes in the environment 
of that flowsheet.
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If you modify subflowsheet D, all flowsheets are on hold except 
D and E, which will solved based on your modifications. After 
reaching a new solution for D, enter subflowsheet C, which then 
resumes calculations. When you return to the main flowsheet, 
all other flowsheets (Main, A, B and F) resume calculations. 

If you move directly from subflowsheet D to subflowsheet A, 
however, HYSYS automatically visits the main flowsheet and 
updates all calculations, so flowsheet A has the most up-to-date 
information when you transfer to it. Any movement to a 
flowsheet not on your branch of the tree forces a full 
recalculation by HYSYS. 

3.4 Subflowsheet 
Environment

The Simulation environment described in the previous section is 
one of the cornerstone design concepts upon which HYSYS is 
built. When combined with subflowsheet capabilities, it defines 
the basic foundation for building a HYSYS simulation. The 
subflowsheet and Column operations use the multi-level 
flowsheet architecture and provide a flexible, intuitive method 
for building the simulation.

Suppose you are simulating a large processing facility with a 
number of individual process units. Instead of installing all 
process streams and unit operations into a single flowsheet, you 
can simulate each process unit inside its own subflowsheet.

Modeling a large process using several flowsheets helps 
better organize your work and manipulate the simulation.

Refer to Section 13.3.1 - 
Adding a Subflowsheet 
in the HYSYS Operations 
Guide for more 
information.
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3.4.1 Subflowsheet Entities
Both the main flowsheet and subflowsheets contain the 
following components:

3.4.2 Subflowsheet 
Advantages 

The multi-flowsheet architecture of HYSYS provides a number of 
technical and functional advantages. The following table 
explains the benefits of using subflowsheets in a simulation:

Flowsheet Component Description

Fluid Package An independent fluid package, consisting of a 
property package and components. 

It is not necessary that every flowsheet in the 
simulation have its own separate fluid 
package. More than one flowsheet can share 
the same fluid package.

Flowsheet Objects The inter-connected topology of the 
flowsheet, including unit operations, material 
and energy streams, and utilities.

A Dedicated PFD A graphics property view of the flowsheet 
showing the inter-connections between 
flowsheet objects.

A Dedicated Workbook A tabular property view describing the various 
types of flowsheet objects. 

A Dedicated Desktop The PFD and Workbook are Home Views for 
this Desktop, but also included are a menu 
bar and a toolbar specific to the specific 
flowsheet type.

Capability Benefit

Multiple Fluid 
Packages

Each installed subflowsheet can have its own fluid 
package within a single simulation case. 

Flowsheet 
Association

Flowsheet association is a design that forces the 
change of property methods to occur at defined 
flowsheet boundaries. This ensures that consistent 
transitions between the thermodynamic basis of the 
different property methods are maintained and easily 
controlled.
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The use of subflowsheets is the ideal solution if your simulation 
requires the use of multiple property packages or involves 
modeling large and complex processes.

3.4.3 Multi-Level Flowsheet 
Architecture

The subflowsheets contained in the main flowsheet of the 
simulation case are discrete unit operations with feed and 
product streams. If you are interested only in the feeds to and 
the products from a subflowsheet, you can work from the main 
flowsheet. 

If you need to view information about the individual operations 
in the subflowsheet, go “inside” the subflowsheet to get a more 
detailed perspective. This is also referred to as “Entering the 
subflowsheet environment”.

Simulation Case 
Organization

Create subflowsheets to break large simulations into 
smaller, more easily managed components. This helps 
you to keep your simulation organized and concise. 

There is no limit (except available memory) to the 
number of flowsheets contained in a HYSYS simulation.

Template 
Creation

Save time and money by creating individual template 
style flowsheets of commonly used process units, 
which you can install within other simulations. 
Templates are fully defined flowsheets with a property 
package and components, unit operations, streams, 
and flowsheet specifications.

Once a template is installed, it is functionally 
equivalent to a subflowsheet that was created in that 
simulation case. It doesn’t work the other way, 
however; you can’t save a subflowsheet to disk and 
use it in another simulation.

Nested 
Flowsheets

You can create nested flowsheets, subflowsheets inside 
other subflowsheets. The only restriction on nesting is 
you cannot create subflowsheet operations inside a 
Column subflowsheet.

A Show/Hide command also exists for displaying 
subflowsheet objects on the main flowsheet PFD.

Capability Benefit

For further details, see 
Section 7.24.4 - Access 
Column or 
Subflowsheet PFDs.
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This concept also applies to column operations. For example, 
consider the PFD of the main flowsheet for the Sour Water 
Stripper simulation shown below.

From the simulation environment of the main flowsheet, the 
distillation column SW Stripper appears as any other unit 
operation with feed and product streams, however, the column 
is also a subflowsheet with streams and operations of its own. 

For a more detailed look at the column, go inside the column 
subflowsheet and examine the streams and operations in the 
SW Stripper’s simulation environment. Inside the column 
subflowsheet (see Figure 3.4), the tray section, reboiler, and 
condenser exist as individual unit operations. Similarly, the 
streams attaching these operations are also distinct.

Within the main flowsheet, the only subflowsheet streams of 
interest are those that directly attach to the column. In the case 
of the Sour Water Stripper, the material streams Feed, Off Gas, 
Bottoms, and the utility streams Cooling Water and Steam are 
the streams of interest. These streams are called Boundary 
Streams because they cross out of the main flowsheet’s 
environment into that of the subflowsheet, carrying information 
between parent and subflowsheets. 

Within the subflowsheet environment, a dedicated Workbook 
and PFD allow you to access to the information that pertains 
only to this subflowsheet. Although information is never hidden 

 Figure 3.3
In the main flowsheet, the 
column appears as any 
other unit operation 
(Figure 3.3), however, 
the column has its own 
subflowsheet (Figure 
3.4) that provides a 
detailed look at the 
column’s internal streams 
and operations.

MAIN FLOWSHEET
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or inaccessible among the various levels of flowsheets in a 
simulation case, the use of the environments organizes and 
focuses the simulation efforts in a clear and logical manner. 

Multi-Flowsheet Navigation
The multi-flowsheet architecture can be compared to a directory 
structure. The main flowsheet and its subflowsheets are 
directories and sub-directories, with the streams and operations 
as the files in that directory. The process information associated 
with the streams and operations becomes the contents of the 
files.

HYSYS has special tools called Navigators that are designed to 
take advantage of this directory-like structure. Within a single 
property view, you can easily access a stream, operation, or 
process variable in one flowsheet from any other flowsheet in 
your simulation. 

 Figure 3.4

The Simulation environment design basis of HYSYS allows 
topological changes to a subflowsheet only within the 
Simulation environment for that specific flowsheet.

Each subflowsheet has its own PFD and Workbook, which 
display only the information related to that flowsheet.

COLUMN SUB-FLOWSHEET

Refer to Section 7.18 - 
Simulation Navigator 
for details on the 
Simulation Navigator.

Refer to Section 7.17 - 
Object Navigator for 
details on the Object 
Navigator.
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3.4.4 Flowsheet Information 
Transfer 

When you install or create a subflowsheet in the Simulation 
environment, it appears and behaves as a single operation with 
one or more feed and product streams. Whenever the values of 
the streams attached to the subflowsheet change, the 
subflowsheet recalculates just like any other regular unit 
operation.

Each of the parent flowsheet’s streams attached to the 
subflowsheet as either a feed or product are associated on a 1:1 
basis with a Boundary Stream inside the subflowsheet. 
Information flows between the parent flowsheet and the 
subflowsheet through these associated streams. 

When a connection is established across the boundary, the 
subflowsheet is automatically renamed with the name of the 
stream in the parent flowsheet. You can override the name 
reassignment afterwards since the streams on each side of the 
flowsheet boundary do not require the same name. For 
example, you can have a stream named To Decanter in the 
main flowsheet connected with the Decanter Feed stream in a 
subflowsheet.

The subflowsheet architecture allows the consistent use of 
different property methods. On each subflowsheet’s property 
view, HYSYS allows you to control how stream information is 
exchanged as it crosses the flowsheet boundary. 

For example, you can specify the Vapour Fraction and 
Temperature (specified or calculated values) of a stream in the 
Main simulation to be passed to the subflowsheet. Once this 

By default, the Calculation Level for a subflowsheet is set to 
2500, which ensures that all possible flowsheet calculations 
in the Parent flowsheet are performed before the 
subflowsheet is calculated. This tends to force the 
subflowsheet to be the last calculation in the chain. In most 
situations this is the desired behaviour, but can be changed 
by modifying the subflowsheet's calculation Level.
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information is passed to the subflowsheet, the property package 
for the subflowsheet then calculates the remaining properties 
using the transferred composition.

3.5 Templates
A template flowsheet is a normal HYSYS flowsheet with some 
additional information contained in its main properties. It uses a 
different file extension when it is stored to disk (*.tpl or *.hfl 
instead of the regular *.hsc). The different file extension is used 
mainly for organizational purposes.

3.5.1 Template Information
The template information for the flowsheet is accessed through 
the Simulation Case property view. 

No flash calculations are required for Energy streams. The 
heat flow is simply passed between flowsheets.

Component maps are available to allow you to define how to 
handle different component lists between fluid packages.

 Figure 3.5

The seven tabs of 
this property view 
are the same as for 
any simulation case. 
3-19



3-20 Templates
There are two additional tabs that are exclusive to templates, 
which are available when the standard simulation case is 
converted to a template. To convert a simulation case to a 
template, click the Convert to Template button at the bottom 
of the Simulation Case property view. Once you click the button, 
the extra tabs appear and the button is no longer visible.

These extra tabs contain all of the same information available on 
the property view of an installed subflowsheet operation as well 
as some additional information. These extra parameters allow 
the flowsheet to be treated as a “black box” that you can install 
as a subflowsheet operation with the same ease and in the same 
manner as you would install a regular unit operation.

Exported Connections Tab
On the Exported Connections tab, enter the Template Tag and 
select the Installed Simulation Basis. All Feed and Product 
connections also appear.

To open the Simulation Case property view, select Main 
Properties from the Simulation menu, or press CTRL M.

 Figure 3.6
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Template Tag

Flowsheet Tags are short names used by HYSYS to identify the 
flowsheet associated with a stream or operation when that 
flowsheet object is being viewed outside of its native flowsheet’s 
scope. The default Tag name for subflowsheet operations is TPL 
(for template). When more than one subflowsheet operation is 
installed, HYSYS ensures unique tag names by adding an 
incremental numerical suffix similar to the HYSYS auto-naming 
unit operations; they are numbered sequentially in the order 
they were installed. For example, if the first subflowsheet added 
to a simulation contained a stream called Comp Duty, it would 
appear as Comp Duty@TPL1 when viewed from the main 
flowsheet of the simulation.

Installed Simulation Basis

When a template is imported into a simulation case, its 
associated fluid package is added to the list of fluid packages in 
the Simulation Basis Manager property view. The Installed 
Simulation Basis gives the template builder the choice of using 
its own internal fluid package or the same fluid package of the 
parent flowsheet where it is installed. This only affects what 
happens at the time the template is first installed.

Feed and Product Stream Info

All streams in the flowsheet template that are not completely 
connected (for example, a feed to a unit operation or a product 
from a unit operation) are designated as Boundary Streams, and 
appear in the appropriate group. Boundary Streams cannot be 
selected to appear on this tab; they are automatically 
determined by HYSYS. These are the streams that you are 
connecting to when the template is installed in a flowsheet.

Once a template is installed the resulting fluid package 
association can be over-ridden in the Simulation Basis 
Manager property view at any time.
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For each stream appearing in either the Feed Stream or Product 
Stream matrices, you can specify the Boundary Label and 
Transfer Basis.

A Boundary Label describes the name of the feed and product 
connections. This is not the name of the streams, but rather the 
function of the streams (in other words, if using a numerical 
standard for stream numbering, the feed stream inside the 
template could be 1, but its feed label could be HP Feed).

This option allows you to provide descriptive feed and product 
stream labels, much like the built-in unit operation property 
views used on their Connection tabs. By default, it assumes the 
name of its corresponding boundary stream in the template.

The Transfer Basis is used for feed and product streams as they 
cross the flowsheet boundary. The Transfer Basis becomes 
significant only when the subflowsheet and parent flowsheet 
property packages are different. When there are differing fluid 
packages in the two flowsheets (parent and subflowsheet) you 
can specify what stream properties are used to calculate the 
stream on the other side of the boundary. 

The Transfer Basis provides a consistent means of switching 
between the differing basis of the various property methods:

A stream that appears on the Exported Connections tab does 
not necessarily have to be connected.

Flash Type Description

T-P Flash The Pressure and Temperature of the Material stream are 
passed between flowsheets. A new Vapour Fraction is 
calculated.

VF-T Flash The Vapour Fraction and Temperature of the Material 
stream are passed between flowsheets. A new Pressure is 
calculated.

VF-P Flash The Vapour Fraction and Pressure of the Material stream 
are passed between flowsheets. A new Temperature is 
calculated.

None 
Required

No calculation is required for an Energy stream. The heat 
flow is simply passed between flowsheets.
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Exported Variables Tab
Use this tab to create and maintain the list of Exported 
Variables.

Although any information can be accessed inside the 
subflowsheet using the Variable Navigator, this feature can 
target key process variables inside the subflowsheet and display 
their values on the property view. Then, when the template is 
installed, you can conveniently view this information directly on 
the subflowsheet’s property view in the parent flowsheet.

This is useful when treating the subflowsheet as a black box as 
all the important specifications for the operation of the 
subflowsheet can be collected and documented in one location. 
You will not have to enter the subflowsheet environment to 
adjust the template to your needs.

To add variables to this tab, click the Add button. The Add 
Variable to Case property view appears. Select the flowsheet 
object and variable. On the Add Variable to Case property view, 
you can override the default variable description and provide 
another one.

When installing a template into another case, these variables 
appear on the Parameters tab of the subflowsheet property 
view.

 Figure 3.7

Refer to Section 13.3 - 
Subflowsheet Property 
View in the HYSYS 
Operations Guide for 
information about the 
Parameters tab.
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3.5.2 Creating a Template 
Style Flowsheet

Any main flowsheet can be used as the base for a template. By 
pressing a button, you toggle the flowsheet so that it becomes a 
template style flowsheet. Then you supply the extra information 
needed for installing in any simulation case. You can also save it 
to disk.

Once you convert a case into a template and import it into 
another case, most of the monitoring and customizing tools 
within the template will be transferred over to the new 
simulation environment. Information such as the strip charts, 
utilities, and macro language entries are transferred along with 
the template. However, the event schedules, optimizer settings, 
dynamics initialization settings, snapshot manager settings, and 
Databook items (for example, case studies, process data table, 
and data recorder settings) are not transferable.

You can convert an existing case to a template or create a new 
template for a flowsheet.

There is no difference between a template flowsheet and a 
normal flowsheet, except the additional information 
mentioned above, and the use of different file extensions. A 
template flowsheet can be read in as the main flowsheet in a 
simulation case if necessary—you just get a warning 
message and the extra information is ignored.

You cannot create a template from just parts of a main 
flowsheet. Delete any unwanted streams and operations 
from the main flowsheet before saving it to disk. To preserve 
your original simulation case, save it with another name 
before creating the template.

HFL files, which are created using the Cut/Copy and Paste 
functionality (accessible from the PFD), have near 
equivalent behaviour to template files and can be created by 
selecting groups of operations from within a simulation case.
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Converting an Existing Case to a Template

You can convert an existing case to a template if you have 
already created a simulation case (not a new template), or if 
you have an existing case on disk that you want to use as a 
template.

1. From the Simulation menu, select the Main Properties. 
The Simulation Case property view appears.

2. Click the Convert to Template button.

3. Click on the Exported Connections tab.

4. Set the Template Tag, Installed Simulation Basis and other 
optional template information if required. 

5. When you save the simulation, it is saved as a template.

Creating a New Template

You can create a new template for a new simulation case.

1. From the File menu, select the New command, and then 
Template. 

2. Build the simulation.

3. From the Simulation menu, select Main Properties. The 
Simulation Case property view appears.

4. Click on the Exported Connections tab.

5. Set the Template Tag, Installed Simulation Basis and other 
optional template information if required.

6. When you save the simulation, it is saved as a template.

You cannot create a template from an existing subflowsheet 
that is part of a larger simulation.

Since you can have multiple simulation cases in memory, you 
can create a new template as part of your current session 
and then install it in your original Simulation case.

Refer to Section 3.5.1 - 
Template Information 
for more information.

Refer to Section 3.5.1 - 
Template Information 
for more information.
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HYSYS automatically saves the template in the Templates 
directory as a template file (*.tpl). The default path for the 
Templates directory is set according to the HYSYS preferences. 
As shipped, the default directory is HYSYS\Template.

3.5.3 Installing a Template
To install a template, follow the same procedure as for installing 
a subflowsheet. 

1. Do one of the following:
• Select the Flowsheet-Add Operation command (or 

press F12), to open the UnitOps property view. Select 
Standard Sub-Flowsheet from the Available Unit 
Operations list.

• Open the HYSYS Object Palette (press F4) and click the 
Subflowsheet icon on the Object Palette.

After you initiate the installation of a subflowsheet, a Sub-
Flowsheet Option property view appears.

2. Click the Read an Existing Template button to install a 
template from disk.

If you do not want to read an existing template, click the 
Start with a Blank Flowsheet button.

A combination of flowsheets can be in your template (for 
example, a main flowsheet and one or more subflowsheets). 
Likewise, multiple fluid packages can be included in the 
template if they are associated with a flowsheet at the time 
the template is saved to disk.

 Figure 3.8

Subflowsheet icon
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The process of creating a subflowsheet with a blank initial 
flowsheet operation is covered in detail in Section 13.3.1 - 
Adding a Subflowsheet of the HYSYS Operations Guide.

Reading an Existing Template
To install a template style flowsheet, click the Read an Existing 
Template button. HYSYS looks in the default Templates directory 
[Root:\HYSYS\Template] for available template files 
(*.TPL).

HYSYS automatically installs any fluid packages associated with 
the template into the Simulation Basis Manager. The main 
flowsheet contained in the template is then installed as a new 
subflowsheet unit operation in the current flowsheet.

After the flowsheet(s) have been inserted in the simulation case, 
a fluid package is selected for the subflowsheet based on the 
Installed Fluid Package setting used in the template.

Once HYSYS finishes installing the template, you are placed on 
the Connections tab of the subflowsheet property view where 
you can define the connections for the template.

The Start with a Blank Flowsheet is a good option if you are 
just creating a small subflowsheet. This subflowsheet is not 
available for use in any other simulation case you create in 
the future. 

If you think you might re-use the subflowsheet at a later 
date, consider creating a full template flowsheet instead.

HYSYS includes a sample process template for trial 
purposes. It is called REFRIG.TPL.

If there are subflowsheets in the template, they are installed 
as subflowsheets underneath the new subflowsheet 
operation. In other words, everything in the template is 
shifted-down at least one level.
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3.6 Property View 
Flowsheet Analysis 

In HYSYS, stream and operation property views contain 
analytical information based on the current flowsheet 
conditions. For example, the stream property view has a page 
that contains information concerning all phases present in the 
stream. Also, certain operations have pages that display 
performance profiles, results, and other analytical information.

3.6.1 Stream Analysis
The stream property view has two tabs that contain information 
pertinent to stream analysis: the Worksheet and Attachments 
tabs. 

The Properties page in the Worksheet tab contains detailed 
property correlation information about the stream. The 
Conditions page is a subset of the information provided in the 
Properties page. 

 Figure 3.9

Refer to Section 12.2 - 
Material Stream 
Property View in the 
HYSYS Operations 
Guide for details on the 
various tabs and pages.

See Section 7.26 - 
Utilities for information 
on attaching a utility to a 
stream.
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The Utilities page in the Attachments tab is used to attach 
utilities to the stream, while the Unit Ops page indicates which 
unit operations are attached to the stream.

To view the stream properties, do the following:

1. Open the Stream property view, click the Worksheet tab, 
then select the Properties page. 

2. Click the View Correlation Set List icon. The Correlation 
Set Picker property view appears.

3. Select Standard Set from the property view and click the 
Apply button. 

The Correlation Set Picker property view closes and the 
stream properties appear in the table on the Properties 
page. In addition to containing the basic stream conditions, 
more detailed physical property information for the stream is 
shown in the table.

With the stream property view at its default size, the page has 
horizontal scroll bars. By using the horizontal scroll bar, you can 
scroll left and right to view the Vapour, Liquid, and/or Aqueous 
phases for the stream.

Instead of scrolling through the property view, you can also 
resize it so that all phases, and all of the properties for each 
phase can be seen, as shown in the figure below. 

 Figure 3.10

View Correlation Set List 
icon
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The Liquid Phase is referred to as the Aqueous Phase because 
Water is present in the stream. The other phases you may 
encounter are Light and/or Heavy Liquid.

3.6.2 Unit Operation Analysis 
Many unit operations in HYSYS have pages that contain 
analytical information. 

For example, the Heat Exchanger displays its analytical 
information on the Worksheet and Performance tabs.

The Details page in the Performance tab of a Heat Exchanger 
displays the information in two groups:

• Overall Performance
• Detailed Performance

The type of analytical information found in operation 
property views depends on the operation type. Regardless of 
what the operation is, the displayed information is 
automatically updated as conditions change.

A Worksheet tab is available on each unit operation property 
view. It provides access to the streams attached to the unit.
3-30



Flowsheet 3-31
The Plots page lets you to generate curves for the shell and/or 
tube sides of the heat exchanger. From the Plot Type drop-
down list, you can select the X and Y axis variables for the plot. 

 Figure 3.11

 Figure 3.12
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The Tables page displays the same information provided in the 
Plots page but in tabular form.
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4-2 Menu Bar
4.1 Menu Bar
Most of the tasks performed in HYSYS are accessed through the 
menu bar. The list of command or function groups, displayed at 
the top of the HYSYS Desktop, is a drop-down menu system. By 
selecting an option from the menu bar, a menu of commands 
appears.

The menu bar also provides access to functions that can only be 
accessed through the menu bar, such as Session Preferences 
property view and switching to another simulation currently in 
memory.

You can access the menu bar options in three ways: 

• Click the required menu to open the associated drop-
down menu. 

• Use the ALT key in combination with the underlined 
letter in the menu bar title. For example, ALT F opens 
the File menu.

• Use the ALT key by itself to move the active location to 
the File option in the menu bar. Once the menu bar 
becomes the active location in HYSYS, you can 
manoeuvre through the menu using the keyboard. The 
UP and DOWN arrow keys move through the menu 
associated with a specific item, while the LEFT and 
RIGHT arrow keys move you to the next menu, opening 
the associated drop-down menu.

The menus available in the menu bar changes depending on 
the simulation environment. For example, the Column 
environment has a menu item called Column in the menu 
bar.

If you want to switch focus from the menu bar without 
making a selection, press the ESC key or the ALT key.
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4.2 File
There are two variations of the File menu. A condensed menu 
appears in HYSYS before a simulation is created or opened. The 
commands common to both versions of the menu, as well as the 
functions specific to the detailed menu, are explained in this 
section.

The menu commands are grouped into five main categories:

• Starting a Simulation
• Saving a Simulation
• Closing a Simulation
• Printing
• Exiting HYSYS

4.2.1 Starting a Simulation 
Case

The New and Open commands under File in the menu bar enable 
you to create a new flowsheet or open an existing flowsheet. If 
you select New or Open, an expandible menu appears 
containing the available flowsheet commands:

A command item with an arrow head pointing to the side 
contains additional commands in a submenu.

Option Description

Case Creates a new simulation case or opens an existing one. 
This command enables you to access HYSYS simulation 
cases (*.hsc), HYSIM simulation cases (*.sim) or Backup 
simulation cases (*.bk0).

Template Creates a new template or opens an existing one. These 
are subflowsheet templates.

Column Creates a new column flowsheet or opens an existing one.

Cut/Copy/
Paste

Creates a new blank case and then imports the selected 
HFL file into that case.

File Menu

See Chapter 3 - 
Flowsheet for more 
information on 
subflowsheets and 
templates.

 Refer to Section 4.3 - 
HFL Files for more 
information regarding the 
HFL files.
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When opening a case from an older version of HYSYS, you 
receive the following message.

It is not necessary to go into the Simulation Basis environment. 
The warning lets you know that some objects will be 
recalculated when the case is loaded.

Reading a HYSIM Case
HYSYS presents the functionality to open HYSIM simulations and 
to transfer all compatible data into the appropriate HYSYS 
environments. 

 Figure 4.1

 Figure 4.2

Displays files according to the File Path and File Filter selections. 
Your selection in this list appears in the File Name cell.

Use the File Filter to display only HYSIM 
cases (*.sim) in the property view.
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If the Hyprotech file picker radio button is selected in the 
Session Preferences property view, then the Open and Close 
property view displays the description for any HYSIM case with a 
Revision number. 

To open a HYSIM case:

1. From the File menu in the menu bar, click Open, then click 
Case from the submenu, or click the Open Case icon.

2. On the Open Simulation Case property view, select Hysim 
Simulation Cases (*.sim) from the File Filter drop-down 
list.

3. Select a directory that contains a HYSIM case in the File Path 
group.

4. Select a HYSIM case in the list of cases or type the name of a 
case in the File Name input cell.

5. Click the OK button.

6. As HYSYS reads a HYSIM case, the simulation is rebuilt in a 
piece-by-piece fashion. If an incompatibility is encountered, 
a message is recorded in both the Trace Window and the 
Case Description. 

At the end of the case recall procedure, HYSYS displays a 
summary on the HYSIM Case Reader Summary property 
view. 

The messages are separated into two groups:

• Ops with warnings
• Unsupported Ops

If the value shown in the revision number is less than 10014, 
the HYSIM case is not valid for transfer into HYSYS.

 Figure 4.3

Open Case icon
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7. You can view a summary list of messages by doing either of 
the following:

• Scroll through the messages in the Trace Window.
• Click the Main Properties command in the Simulation 

menu. The Main Properties property view appears. Click 
the Status Messages tab.

HYSIM Functionality Not Supported 
in HYSYS
HYSYS does not currently support HYSIM functionality, so it is 
not possible to transfer all HYSIM information into HYSYS. The 
following table lists some of the issues:

Object Details Not Supported

Calculator All Programs

Column Condenser or Reboiler with Side Stripper Draw

Column Condenser or Reboiler with Pump Around Draw

Column Reboiler Liquid Draw (other than Bottoms product)

Column Condenser Side Vapour Draw

Column Reboiler Water Draw

Column In AMSIM, tray efficiencies require the input of tray 
dimensions on a per tray basis. HYSYS supports only 
one diameter, one weir length and one weir height per 
Tray Section. In this case, dimensions of the 2nd stage 
from the bottom of the HYSIM column are used for the 
HYSYS Tray Section.

Liquid Extractor Pump Arounds

Cyclone Liquid Streams

Hydrocyclone Vapour Streams

Rotary Vacuum 
Filter

Only Connections are transferred. Other operation 
parameters must be specified in HYSYS.

Baghouse Filter Liquid Streams

Crystallizer Solid 
Operation

All

Tee Energy Stream Attachments

LNG If the LNG Duty Stream is attached to another 
operation in HYSIM, the flowsheet is not complete in 
HYSYS.

Plug Flow 
Reactor (PFR)

Space Time Option

CSTR Space Time Option

CSTR Dead Space Option

Refer to Section 1.3 - 
Object Status & Trace 
Windows for details on 
the Trace Window.
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4.2.2 Saving a Simulation 
Case

HYSYS has three different save commands:  

CSTR Initialization from Stream

Data Recorder Records variables while a flowsheet is being converged 
when adjusts or recycles are present.

Electrolyte HYSIM functionality is not supported at all for 
simulation cases with Electrolytes OLI property 
package.

Command Description

Save Saves the case using the current file name and location.

Save As With this save command, enter a name and location to save the file. 
The Save Simulation Case As property view appears when you select 
the Save As command. You are able to select the File Path and a File 
Name for the case. HYSYS automatically attaches the default file 
extension, *.hsc.

You can also save the entire case as an XML file or an HFL file.

Save All Use this command to save all currently opened HYSYS cases. You 
are asked to select which cases should be saved. You can select 
more than one case at a time by holding down the CTRL key then 
clicking each case you want to select. Click Save to save the case(s) 
as shown in the property view, or Save As to save with a new name 
and/or location.

 Figure 4.4

Object Details Not Supported
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4.2.3 File Extensions
The following table contains the file extensions that are available 
in HYSYS:

 Figure 4.5

File Extension Description

*.* All Files

*.dll Application Extensions (DLLs)

*.inp ASPEN to HYSYS

PRO II to HYSYS

*.bk? Backup Simulation Cases

*.col Column Templates

*.cml Component Lists

*.EDF Extension Definition Files (EDFs)

*.fpk Fluid Packages

*csv Historical Data CSV History Files

*.DMP Historical Data DMP History Files

*.xml HYCON XML to HYSYS

HYCON TRUNK XML to HYSYS

*.hyp Hypothetical Groups

*.sim HYSM Simulation Cases

*.hfl HYSYS HFL Files

*.hsp HYSYS HSP Cases

*.hsc HYSYS Simulation Cases

*.XML HYSYS XML Cases

*.oil Oil Assay Files

*.PRF Preference Files

*.rst Reaction Sets

*.sch Schedule Files

*.scp Script Files

*.tpl Template Cases
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4.2.4 Closing a Simulation 
Case

Two of the commands under the File menu involve closing your 
simulation. To close the simulation use the commands below: 

4.2.5 Printing
HYSYS has the following print commands:

*.hvv User Variables

*.WWB WinWrap Basic

*.wrk Workbook Files

Command Description

Close Case Closes the active case. Before closing the case, you are 
asked if you want to save the case.

Close All Allows you to close more than one case at a time. The 
name of each opened file appears in the Close Simulation 
Cases property view. You select which case(s) you want to 
close.

 Figure 4.6

Command Description

Print Allows you to print Datasheets for streams and operations.

Print 
Snapshot

Prints a bitmap snapshot of what currently appears in the 
active HYSYS property view.

Printer Setup Allows you to select the default printer, print orientation, 
and paper size. It is similar to the Printer Setup commands 
in other Windows applications.

File Extension Description

See Section 9.2 - 
Printing in HYSYS for 
more information.
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4.2.6 Exiting HYSYS
You can close HYSYS by opening the File menu and clicking the 
Exit command.

If you have not saved your case before you select the Exit 
command, a warning message appears prompting you to save 
the case before exiting the program. 

• If you want to save the case and exit HYSYS, click the 
Yes button.

• If you do not want to save the case and still exit HYSYS, 
click the No button. 

• If you do not want to exit the HYSYS program, click the 
Cancel button to stop the exit command.

4.3 HFL Files
The Object Inspect menu from the PFD contains a Cut/Paste 
Objects command. The sub-commands under the Cut/Paste 
Objects command allows you to copy, clone, cut, paste, export 
(copy to file), and import (copy from file) objects. When these 
commands are used, information about the objects is stored in 
an HFL file.

• When the Copy, Cut or Clone command is used, a 
temporary HFL file is created in the default temporary 
directory. This file gets overwritten each time one of 
these commands is used by any copy of HYSYS that is 
running. When the paste command is used, this HFL file 
is used to import the objects back into HYSYS.

 Figure 4.7

Information can be pasted into a different case or copy of 
HYSYS.
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• When the “Copy Object to File” or “Paste Object from 
File” command is used, the user can explicitly provide a 
name for the HFL file that is used. By default the file is 
saved in the HYSYS template directory. You can access 
this file from a different case, or send this file to other 
HYSYS users.

HFL files contain information about the objects that have been 
copied, so when importing or exporting HFL files, you get all the 
information required to restore the objects in a case (including 
fluid package information), but not the entire flowsheet or 
subflowsheet the object resides in.

You can use the Save As command from the File menu to save 
an entire case as an HFL file. This options saves you the time 
and trouble of selecting every object within the main PFD and 
exporting them to an HFL file. For convenience, HYSYS also 
allows you to open an HFL file directly rather than importing it 
into an existing open case. But in this situation, a blank new 
case is created and the HFL file is actually imported into the new 
case.

HFL files are a bit more flexible than templates (*.tpl files). 
When you create a new template, you have to convert an entire 
case into a template and when that template file is read into a 
HYSYS case, it always becomes a new subflowsheet. Each time 
you convert the case to a template, you gain one level of 
flowsheets and there is no way to move objects to different 
flowsheets. 

The cut/copy/paste commands are easier to use because you 
can quickly operate on a selected group of objects only and 
paste objects back into any existing flowsheet without always 
creating a new subflowsheet.

The HFL files are not full simulation case files, and do not 
contain case information on the Databook, strip charts, 
utilities, Optimizer, DCS driver, or event scheduler.

HFL files generally contain a piece of a case that has been 
copied, and are typically imported into an existing open case.
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The entire subflowsheet can also be readily copied.
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5-2 Introduction
5.1 Introduction
The Basis environment contains the following environments:

• Simulation Basis environment
• Oil Characterization environment 

Simulation Basis Environment 

When beginning a new simulation case, HYSYS automatically 
starts you in the Simulation Basis environment where you can 
create, define and modify fluid packages for use by the 
simulation flowsheets. In general, a fluid package contains a 
minimum of one property package and library and/or 
hypothetical components. Fluid packages can also contain 
information for reactions and interaction parameters.

You can re-enter the Simulation Basis environment from any 
flowsheet by selecting the Enter Basis Environment command 
in the Simulation menu, or clicking the Basis icon found in the 
toolbar of both the Main and Column environments. For more 
information about the Basis environment, refer to the HYSYS 
Simulation Basis guide.

Basis Menu
The Basis menu appears in the menu bar when you enter the 
Basis environment. The options available in this menu appear in 
the following figure. 

 Figure 5.1

Refer to Chapter 6 - Oil 
Characterization 
Environment for more 
information.

Basis icon
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5.2 Simulation Basis 
Manager

The Simulation Basis Manager property view allows you to 
create and manipulate every fluid package in the simulation. 
Each flowsheet in HYSYS can have its own fluid package.

The template and column subflowsheets reside inside the Main 
Simulation, so these subflowsheets can inherit the fluid package 
of the main flowsheet, or you can create an entirely new fluid 
package for each subflowsheet. 

For each fluid package, you can define the following:

• Property package
• Components
• Reactions
• User properties

 Figure 5.2
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There are common buttons at the bottom of the Simulation 
Basis Manager property view.

5.2.1 Components Tab
The Components tab is where you define the sets of chemical 
components used in the simulation. These component sets are 
stored in Component Lists and can include library pure 
components and/or hypothetical components.

The Components tab contains a Master Component List that 
cannot be deleted. This master list contains every component 
available from “all” component lists. 

If you add components to any other component list, they are 
automatically added to the Master Component List. Also, if you 
delete a component from the master list, it is deleted from all 
other component lists using that component.

Button Description

Extend 
Simulation Basis 
Manager

Enables you to access the Petroleum Assay Manager 
property view. This button is only available if you have 
installed RefSYS.

Enter Simulation 
Environment

Enables you to enter the simulation environment of the 
HYSYS case. 

Refer to Chapter 7 - Simulation Environment for 
more information.

 Figure 5.3

For more information, 
refer to Section 2.2 - 
Petroleum Assay 
Manager Property View 
in the RefSYS Option 
Guide.

See Chapter 1 - 
Components in the 
HYSYS Simulation Basis 
guide for more 
information.
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From this property view, you can do the following to the 
component lists:

• View
• Add
• Delete
• Copy
• Import
• Export

Viewing a Component List
When you view a component list, you can add, remove, and sort 
the components in a list:

1. From the list of available component lists, select the 
component list you want to view/edit.

2. Click the View button. The selected Component List 
property view appears.

Adding a Component List
To add a component list, click the Add button. The Component 
List property view appears. This property view allows you to add 
pure, electrolyte and hypothetical components to the new 
component list.

This property view has two tabs: Selected and Component by 
Type. 
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Selected Tab

This tab allows you to add, remove, sort, and view components 
in a component list. This tab also provides a quick method for 
creating hypothetical groups and hypothetical components.

Adding a Traditional or Electrolyte Component

1. Click the Selected tab in the Component List property view.
2. Double-click the Components branch in the Add Component 

tree browser to expand the branch. Two branches appear: 
Traditional and Electrolyte.

3. Click the Traditional or the Electrolyte sub-branch. The 
available components appear in the Component Library 
group.

4. In the Match field, type the name of the component you 
want to add to your list. HYSYS filters the list of available 
components as you type.

5. In the component list, select the component you want to 
add.

 Figure 5.4
5-6



Basis Environment 5-7
6. Click the Add Pure button. The component is moved from 
the list of available components to the list of selected 
components.

Adding a Hypothetical Component Group

1. Click the Selected tab in the Component List property view.
2. In the Add Component tree browser, click the Hypothetical 

branch. This displays the Hypothetical Components Available 
group. You have the option of adding either a group of 
hypothetical components or individual hypothetical 
components to your case.

3. To add a group of hypothetical components, select the Hypo 
Group you want to add from the list of available hypo 
groups.

4. Click the Add Group button.

Adding an Individual Hypothetical Component

5. From the Available Hypo Groups list, select the Hypo Group 
that contains the hypothetical component you want to add.

6. From the list of Available Hypo Components, select the 
hypothetical component you want to add.

7. Click the Add Hypo button.

• The Quick Create a Hypo Component button opens 
the Hypothetical Component property view, which allows 
you to quickly create a new hypothetical component. 

• The Quick Create a Solid Component button opens 
the Hypothetical Solid Component property view, which 
allows you to quickly create a new hypothetical solid 
component.

Adding Other Components

1. Click the Selected tab of the Component List property view.
2. In the Add Component tree browser, select the Other 

branch. This displays the Existing Component Lists group.

You can also double-click the component name to add it to 
the list of selected components.

Refer to the Section 5.4 - 
Component Property 
View for more information 
about defining 
hypothetical components.
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3. From the list of available component lists, select the 
component list that contains the component you want to 
add.

4. From the list of available components, select the component 
you want to add to your case.

5. Click the Add button.

Removing Components

To remove a component from the component list:

1. Click the Selected tab of the Component List property view.
2. Select the component you want to delete from the list of 

selected components.

3. Click the Remove button.

Component by Type Tab

This tab allows you to filter and view the components in your 
component list by type.

Deleting a Component List
1. From the list of available component lists, select the 

component list you want to delete.

2. Click the Delete button.

The Master Component list cannot be deleted.

HYSYS does not prompt you to confirm the deletion of your 
component list. After the list is deleted, the information 
cannot be retrieved.
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Copying a Component List
This procedure assumes you are in the main Simulation Basis 
Manager property view.

1. From the Component List, select the name component list 
you want to copy.

2. Click the Copy button.

Copying a component list creates a new component list with the 
exact same properties as the original.

Importing a Component List
1. On the Simulation Basis Manager property view, click the 

Import button. The Open File property view appears.
2. Browse to the location of your component list file (*.cml).

3. Select the file you want to import, then click Open.

Exporting a Component List
1. On the Simulation Basis Manager property view, click the 

Export button. The Save File property view appears.
2. Specify the name of your component list file and its location.

3. Click Save.

5.2.2 Fluid Packages Tab
The fluid package contains all the necessary information for pure 
component flash and physical property calculations. This allows 
you to define all the required information inside a single entity. 
There are four key advantages to using fluid packages:

• All associated information is defined in a single location 
for easy creation and modification.

• Fluid packages can be exported and imported as 
completely defined packages for use in any simulation.

• Fluid packages can be cloned, reducing the time involved 
in creating and/or modifying complex fluid packages.

• Multiple fluid packages can be used in the same 
simulation.

See Chapter 2 - Fluid 
Package in the HYSYS 
Simulation Basis guide 
for more information.
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The Fluid Pkgs tab of the Simulation Basis Manager allows you 
to create and manipulate multiple fluid packages.

Each fluid package available to your simulation appears in the 
Current Fluid Packages group with the following information 
displayed: 

• Name
• Number of components attached to the fluid package
• Property package attached to the fluid package

 Figure 5.5
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Adding a Fluid Package
1. In the Simulation Basis Manager property view, click the 

Add button. The Fluid Package Manager appears as shown 
below.

2. Click the Set Up tab.

3. From the Component List Selection drop-down list, select the 
component list you want to use for your fluid package.

4. From the list of available property packages, click the 
property package you want to use. If the property package is 
one of the following, then additional property package 
options appear in the top right corner of the property view:

• Equation of State (EOS)
• Activity Model
• Amines package
• Electrolyte property package

The rest of the tabs in the Fluid Package Manager property view 
are used to modify the fluid package according to your 
requirements.

 Figure 5.6
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Editing a Fluid Package
1. From the Current Fluid Packages list, select the fluid package 

that you want to edit.
2. Click the View button to display the Fluid Package Manager 

property view.

3. Modify any of the parameters that comprise the fluid 
package. 

Deleting a Fluid Package
1. From the Current Fluid Packages list, select the fluid package 

that you want to delete.
2. Click the Delete button.

Copying a Fluid Package
1. From the Current Fluid Packages list, select the fluid package 

you want to copy.
2. Click the Copy button.

Copying a fluid package creates a new fluid package with the 
exact same properties as the original.

Importing a Fluid Package
1. In the Current Fluid Packages group, click the Import 

button. The Open File property view appears.
2. Browse to the location of your fluid package file (*.fpk).

3. Select the file you want to import and click Open.

HYSYS does not prompt you to confirm the deletion of your 
fluid package. After the fluid package is deleted, the 
information cannot be retrieved.
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Exporting a Fluid Package
1. In the Current Fluid Packages group, click the Export 

button. The Save File property view appears.
2. Specify the name and location of the fluid package file.

3. Click Save.

Associating a Fluid Package with a 
Flowsheet
1. In the Flowsheet-Fluid Pkg Associations group, select the 

required flowsheet.
2. Click the corresponding Fluid Pkg To Use cell to open a 

drop-down list. 

3. From the list, click the fluid package you want to associate 
with that flowsheet.

There must be at least one fluid package within a case before 
you can assign it to a flowsheet. The Default Fluid Pkg drop-
down list specifies which fluid package to use as the default. The 
default fluid package is automatically assigned to any new 
flowsheets that are created within the case.

5.2.3 Hypotheticals Tab
This tab enables you to create non-library or hypothetical 
components. Hypothetical components can be any of the 
following:

• Pure components
• Defined mixtures
• Undefined mixtures
• Solids 

You can also clone library components into hypothetical 
components, which allows you to modify the library values.

See Chapter 3 - 
Hypotheticals in the 
HYSYS Simulation Basis 
guide for more 
information.
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When you click the Hypotheticals tab, the following property 
view appears.

A broad selection of estimation methods are provided for the 
various Hypo groups, ensuring the best representation of the 
behaviour of the hypothetical components in the simulation. In 
addition, methods are provided for estimating the interaction 
binaries between hypotheticals and library components. You can 
also use hypotheticals with the Tabular Package and in 
reactions.

Hypothetical components are independent of the fluid package, 
and when created, they are placed in a Hypo Group. Since 
hypothetical components are not exclusive to a particular fluid 
package, multiple fluid packages can share hypotheticals. You 
can create a hypothetical component or group once and use it in 
any fluid package within the case.

Adding a Hypothetical Group
1. Click the Add button. The Hypo Group property view 

appears.
2. From the Component Class drop-down list, select the class 

for grouping your hypotheticals.

 Figure 5.7
5-14



Basis Environment 5-15
3. Click either the Add Hypo or Add Solid button. Keep 
clicking the button until all of the hypothetical components 
are added to the group.

4. Enter the information from the following table for each 
component so HYSYS can estimate the properties of the 
components.

5. Each component also requires a UNIFAC structure. Click the 
UNIFAC button to display the UNIFAC Component Builder 
property view.

Deleting a Hypothetical Component
1. From the list of available hypothetical components, select 

the component you want to delete.
2. Click the Delete button.

Cloning Library Components

Use this procedure to clone a library component into a 
hypothetical component.

1. In the Hypo Group property view, click the Clone Library 
Comps button. The Convert Library Comps to Hypothetical 
Comps property view appears.

2. The Source Components group has two lists. From the list of 
available component lists, select the component list that 
contains the component you want to clone. 

Normal Boiling Point Minimum Required Information

< 700°F (370°C) Normal Boiling Point

> 700°F (370°C) Normal Boiling Point and Liquid Density

Unknown Molecular Weight and Liquid Density

HYSYS does not prompt you to confirm the deletion of your 
hypothetical component. After the component is deleted, the 
information cannot be retrieved.

Select more than one component by holding down the CTRL 
key and clicking each component you want to select.
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3. From the lists of available library components, select the 
component you want to clone.

4. In the Hypo Groups group, select the target hypo group for 
your new hypothetical component.

5. Click the Convert to Hypo(s) button. This clones the 
selected component(s).

Editing a Hypothetical Group
1. From the list of available hypothetical groups, select the 

hypothetical group you want to edit.
2. Click the View button to display the Hypo Group property 

view.

3. From here you can add and remove hypothetical 
components, change the component class, clone library 
components and change estimation methods.

You can also access the Hypo Group property view by selecting a 
hypothetical component from the Hypothetical Quick Reference 
table and clicking the View Hypo button. The information that 
appears corresponds to the hypo group the hypothetical 
component is associated with.

Deleting a Hypothetical Group
1. From the list of available hypothetical groups, select the 

hypothetical group you want to delete.
2. Click the Delete button.

Importing a Hypothetical Group
1. Click the Import button. The Open File property view 

appears.
2. Browse to the location of your hypothetical group file 

(*.hyp).

HYSYS does not prompt you to confirm the deletion. After 
the hypothetical group is deleted, the information cannot be 
retrieved.
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3. Select the file you want to import, then click the Open 
button.

Exporting a Hypothetical Group
1. Click the Export button. The Save File property view 

appears.
2. Specify a name for your hypothetical group file and the 

location of your file.

3. Click Save.

5.2.4 Oil Manager Tab
The Oil Characterization environment is where the 
characteristics of a petroleum fluid can be represented by using 
discrete hypothetical components. Physical, critical, 
thermodynamic and transport properties are determined for 
each hypothetical component using correlations that you select. 
The fully defined hypocomponent can then be installed in a 
stream and used in any flowsheet.

To use the Oil Characterization environment, at least one fluid 
package must exist in the case. Any hypothetical components 
must be compatible with the property method used by the fluid 
package.

HYSYS defines the hypocomponent by using assay data you 
provide. The following are features exclusive to the oil 
environment:

• Providing laboratory assay data
• Cutting a single assay
• Blending multiple assays
• Assigning a user property to hypocomponents
• Selecting correlation sets to determine properties
• Installing hypocomponents into a stream
• Viewing tables and plots for your input and for the 

characterized fluid

See Chapter 4 - HYSYS 
Oil Manager in the 
HYSYS Simulation Basis 
guide for more 
information.
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5.2.5 Reactions Tab
The Reactions Tab in the Simulation Basis Manager allows you to 
define reactions within HYSYS. You can define an unlimited 
number of reactions and group these reactions in reaction sets. 
The reaction sets are then attached to unit operations in the 
flowsheet.

 Figure 5.8

Any ReactionSet and Reaction in the Reaction Manager bank 
cannot be attached to any unit operation in an electrolyte 
flowsheet (reactor unit operations are disabled).

The electrolytes thermo calculation conducts a reactive and 
phase flash at the same time. Therefore, adding any external 
reactions to a unit operation is not yet allowed in HYSYS for 
electrolyte simulation.

See Chapter 5 - 
Reactions in the HYSYS 
Simulation Basis guide 
for more information.

For more information, 
refer to the HYSYS OLI 
Interface Reference 
Guide.
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The Reaction tab appears as shown in the following figure.

Use the Reaction Manager to do the following:

• Create a new list of components for the reactions or use 
the components associated with a fluid package.

• Add, Edit, Copy or Delete reactions and reaction sets.
• Attach reactions to various reaction sets, or attach 

reaction sets to multiple fluid packages.
• Import and Export reaction sets.

Adding a Reaction
1. Click the Add Rxn button. The Reactions property view 

appears.
2. Select the type of reaction that you want to use.

3. Click the Add Reaction button. The Reaction Property 
property view appears; in this property view, you can define 
the following:

• Stoichiometry
• Conversion basis
• Equilibrium constant
• Other properties

4. Click the Stoichiometry tab.

5. Click the field that displays **Add Comp**. Select the 
component you want to use for the reaction from the drop-
down list.

 Figure 5.9
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6. Repeat the previous step until all of the required components 
are added to the table.

7. In the Stoich Coeff column, enter a stoichiometric coefficient 
for each component. This value must be negative for a 
reactant and positive for a product. 

8. Specify the coefficient for an inert component as 0 (which for 
the Conversion reaction is the same as not including the 
component in the table). Fractional coefficients are 
acceptable.

Editing a Reaction
1. From the list of available reactions, select the reaction you 

want to edit.
2. Click the View Rxn button. The Reaction Property property 

view appears. In this property view, you can modify the 
following:

• Stoichiometry
• Conversion basis
• Equilibrium constant
• Other properties

Deleting a Reaction
1. From the list of available reactions, select the reaction you 

want to delete.
2. Click the Delete Rxn button. HYSYS prompts you to confirm 

the deletion.

Copying a Reaction
1. From the list of available reactions, select the reaction you 

want to copy.
2. Click the Copy Rxn button. The Copy Reactions property 

view appears.

3. Select the reaction you want to copy from the list of 
reactions.

4. Use the radio buttons in the New Reaction Type group to 
select the reaction type for the reaction copy. 

5. Click the Copy Reaction button.
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Adding a Reaction Set
1. Click the Add Set button. The Reaction Set property view 

appears.
2. In the Active List column, click the <empty> cell and use 

the drop-down list to select the reaction you want to add to 
the set.

3. In the Inactive List column, click the <empty> cell and 
use the drop-down list to select the reaction you want to add 
to the set. This reaction remains inactive, but it is included in 
the set.

4. From the Solver Method drop-down list, select the reaction 
solver method you want to use.

5. Add any of the available reactions to the set (as long as they 
are the same type). A single reaction can be added to as 
many sets as necessary.

Editing a Reaction Set
1. From the list of available reaction sets, select the reaction 

set you want to edit.
2. Click the View Set button. The Reaction Set property view 

appears. In this property view, you can do the following:

• Add and remove reactions in the reaction set.
• Modify the solver method.
• Activate and inactivate reactions already in the set.

Deleting a Reaction Set
1. From the list of available reaction sets, select the reaction 

set you want to delete.
2. Click the Delete button. HYSYS prompts you to confirm the 

deletion of the reaction set.

Available reaction solver methods:

• Newton's Method
• Rate Iterated
• Rate Integrated
• Auto Select
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Copying a Reaction Set
1. From the list of available reaction sets, select the reaction 

set you want to copy.
2. Click the Copy button.

Copying a reaction set creates a new reaction set with the exact 
same properties as the original.

Importing a Reaction Set
1. Click the Import Set button. The Open File property view 

appears.
2. Browse to the location of your reaction sets file (*.rst).

3. Select the file you want to import, then click Open.

Exporting a Reaction Set
1. Click the Export Set button. The Save File property view 

appears.
2. Specify the name and location of your reaction set file.

3. Click Save.

Adding a Reaction Set to a Fluid 
Package
After creating reactions and reaction sets, you can associate the 
set(s) with a fluid package.

1. Click the Add to FP button. The Add Reaction Set property 
view appears.

2. From the list of available fluid packages, select the fluid 
package to which you want to add a reaction set.

3. Click the Add Set to Fluid Package button. 
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3
5-2

5.2.6 Component Maps Tab
The Component Maps tab allows you to map fluid component 
composition across fluid package boundaries. Composition 
values for individual components from one fluid package can be 
mapped to a different component in an alternate fluid package. 
This is useful when dealing with hypothetical oil components.

Two previously defined fluid packages are required to perform a 
component mapping. One fluid package becomes the target 
component set and the other becomes the source component 
set. Mapping is performed using a matrix of source and target 
components. The transfer basis can be performed on a mole, 
mass or liquid volume basis.

Adding a Collection
1. In the Component Mapping group, select the fluid packages 

you want to map.
2. After two distinct fluid packages are selected, click the 

Create Collection button to add a new collection to the 
Collections table.

The table lists the following information:

• The fluid package where the components came from
• The fluid package where the components are going
• The collection name (can be edited at any time)

 Figure 5.10

See Chapter 6 - 
Component Maps in the 
HYSYS Simulation 
Basis guide for additional 
information.
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Adding a Component Map
1. From the Collection drop-down list in the Maps for Collection 

group, select the collection for which you want to map 
components. 

2. Click the Add button. The Component Map property view 
appears.

3. In the component matrix, map all specifiable components 
(values in red text). All source components appear in 
columns and all target components appear in rows.

4. In the Transfer Basis group, select the basis of the 
component transfer by selecting the Mole, Mass, or 
Volume radio button.

Editing a Component Map
1. From the Collection drop-down list in the Maps for Collection 

group, select the required collection.
2. From the list of available component maps, select the 

component map you want to edit.

3. Click the Edit button. The Component Map property view 
appears. In this property view, you can modify the 
parameters for the map.

Deleting a Component Map
1. From the Collection drop-down list in the Maps for Collection 

group, select the collection for which you want to delete 
components.

2. From the list of available component maps, select the 
component map you want to delete.

3. Click the Delete button.

You are not prompted to confirm the deletion, so ensure you 
have selected the correct component map before deleting.
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5.2.7 User Property Tab
Use the User Property tab to create an unlimited number of user 
properties for use in the Simulation environment.  

User properties are any property that can be defined and 
calculated on the basis of composition. You supply a user 
property value for each component in a fluid package, then 
select the mixing basis and mixing equation to calculate the 
total user property.

When a user property is defined, HYSYS calculates the value of 
the property for any stream through the user property utility. 
User properties can also be set as Column specifications.

 Figure 5.11

You can also create user properties in the Oil 
Characterization environment. See Section 6.2.4 - User 
Property Tab for more information.

See Chapter 7 - User 
Properties in the HYSYS 
Simulation Basis guide 
for more information.
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Adding a User Property
1. Click the Add button. The User Property property view 

appears.
2. Click the Data tab.

3. In the Mixing Basis field, use the drop-down list i to select 
the basis for mixing.

4. In the Mixing Rule field, use the drop-down list to specify 
the mixing rule to use with for your user property.

5. Specify values for the mixing rule parameters F1 and F2 to 
accurately reflect your property formula. By default these 
parameters have a value of 1.00.

6. Select a unit from the Unit Type drop-down list for the user 
property value. If the unit type is Temperature, the internal 
unit used is degrees Kelvin. This is important when 
calculating the mixed value for a stream.

7. Specify a lower and upper limit for your user property in the 
Lower Limit Value and Upper Limit Value cells.

 Figure 5.12

Refer to the HYSYS 
Simulation Basis guide 
for more information 
regarding the mixing 
rules.
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The property parameters determine how the user property is 
calculated in all streams. Whenever the value of a user property 
is requested by the User Property utility or by the Column, 
HYSYS uses the composition in the specified basis and calculates 
the user property value using the mixing rules and parameters 
that you set.

Editing a User Property
1. From the list of available user properties, select the user 

property that you want to edit.
2. Click the View button. The User Property property view 

appears.

In this property view, you can edit all of the parameters that 
define the user property. 

Deleting a User Property
1. From the list of available user properties, select the user 

property that you want to delete.
2. Click the Delete button. 

You are not prompted to confirm the deletion of your user 
property, so ensure you are deleting the correct one. After a 
user property is deleted, it cannot be retrieved.
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5.3 Reaction Package
From the Basis menu, select Reaction Package to open the 
Reaction Package property view. Use this property view to 
create, copy and edit both reactions and reaction sets. You can 
attach reactions to a reaction set and make a Reaction Set 
available to unit operations within the current case.

The Reaction Package property view eliminates the need to 
return to the Reaction tab of the Simulation Basis Manager when 
defining reactions and reaction sets. The only task when 
defining reactions that must be done in the Simulation Basis 
Manager is the selection of components.

 Figure 5.13

Refer to Section 5.2.5 - 
Reactions Tab and 
Chapter 5 - Reactions 
in the HYSYS 
Simulation Basis guide 
for more information 
about reactions and 
reaction sets.

The reactions in the Current 
Reaction Sets group are 
available to all the unit 
operations in the current case.

Clicking this 
button creates a 
new reaction 
set.

Double-click on 
the selected 
reaction to open 
its property view.

Click this button 
to add a new 
reaction.

Click this button to 
make a copy of the 
selected reaction.

Attached reactions for 
the selected reaction 
set.
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5.4 Component Property 
View

The Component property view enables you to view and edit the 
properties of a component. The two types of property views are 
the traditional component property view and solid component 
property view.

You can access both types of property views from the 
Component List property view. You can also access the property 
view for hypothetical and solid hypothetical components from 
the Hypo Group property view.

Refer to the following figure to see how both the Traditional and 
Solid pure component property views appear.

Both of these property views contain five tabs and the 
information is colour coded according to the type of information 
being displayed. The following table explains the color coding.

 Figure 5.14

Colour Information description

Red Values estimated by HYSYS.

Refer to Chapter 1 - 
Components in the 
HYSYS Simulation Basis 
guide for more 
information.
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You can supply values for any of the component properties, or 
overwrite values estimated by HYSYS. If you change a specified 
value, all properties previously estimated using that 
specification are removed.

5.4.1 Viewing a Pure 
Component

Use this procedure to view the properties of a pure component 
found in a component list.

1. Select the pure component you want to view from the list of 
available components.

2. Click the View Component button. The Component 
property view appears for the selected component.

Accessing a Hypothetical 
Component Property View
You can access the Hypothetical Component property view using 
the following methods:

• In the Component List property view, select the 
component from the list of selected components and click 
the View Component button.

• On the Hypotheticals tab of the Simulation Basis 
Manager, select the component from the Hypothetical 
Quick Reference table and click the View Hypo button.

• In the Hypo Group property view, select the component 
from the list of available components and click the View 
button.

Blue User defined values.

Black Calculated values or information that you cannot 
modify.

Colour Information description
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5.4.2 Defining a Traditional 
Hypothetical Component

1. Open the component property view, or create a new 
hypothetical component.

2. Click the ID tab.

3. Click the Structure Builder button. The UNIFAC Component 
Builder property view appears.

4. From the list of available UNIFAC groups, select the sub-
group you want to add to your structure.

5. Click the Add Groups button.

6. Repeat steps 4 and 5 until you have the structure you want 
and there are no free bonds. 

7. Close the UNIFAC Component Builder property view.

8. Click the Critical tab. 

9. Enter the information from the following table so HYSYS can 
estimate the properties of your component.

10.After entering the values, click the Estimate Unknown 
Props button to calculate the other properties.

5.4.3 Defining a Solid 
Hypothetical Component

1. Open the component property view, or create a new 
hypothetical component.

2. Click the Critical tab.

3. Enter both the molecular weight and density (at minimum).

4. Click the Estimate Unknown Props button to calculate the 
other properties.

Normal Boiling Point Minimum Required Information

< 700°F (370°C) Normal Boiling Point

> 700°F (370°C) Normal Boiling Point and Liquid Density

Unknown Molecular Weight and Liquid Density

Refer to the sections 
Adding a Hypothetical 
Component Group and 
Adding a Hypothetical 
Group for more 
information.

Refer to the sections 
Adding a Hypothetical 
Component Group and 
Adding a Hypothetical 
Group for more 
information.
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6-2 Introduction
6.1 Introduction
The Oil Characterization environment enables you to 
characterize petroleum fluids by creating and defining Assays 
and Blends. The oil characterization procedure generates 
petroleum hypocomponents for use in your fluid package(s). 
The Oil Characterization environment is accessible only through 
the Simulation Basis environment.

The Desktop for the Oil Characterization environment is similar 
to the Desktop in the Simulation Basis environment. Icons 
specific to generating oils appear and the Oil Characterization 
Manager is the Home View.

Accessing the Oil Characterization 
Environment
To enter the Oil Characterization environment, click the Oil 
Environment icon or the Enter Oil Environment button found in 
the Oil Manager tab of the Simulation Basis Manager.

To enter the Oil Characterization environment, at least one 
fluid package must exist in the case and any hypothetical 
components must be compatible with the property method 
used by the fluid package.

Refer to Chapter 4 - 
HYSYS Oil Manager in 
the HYSYS Simulation 
Basis guide for additional 
information.

Oil Environment icon
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6.2 Oil Characterization 
Manager

The Oil Characterization Manager contains five tabs and four 
buttons. The buttons are as follows:

• Clear All. Click to clear all the information entered or 
imported in the Oil environment.

• Calculate All. Click to calculate all unknown variables. 
This button is only effective if you supply enough 
information about the hypocomponents.

• Oil Output Settings. Click to open the Oil Output 
Settings property view.

• Return to Basis Environment. Click to return to 
Simulation Basis environment.

6.2.1 Oil Output Settings 
Property View

To access this property view, click the Oil Output Settings button 
on the Oil Characterization property view.

During the characterization of an oil or the calculation of boiling 
ranges for a fluid in the BP Curves utility, the initial boiling point 
(IBP) and final boiling point (FBP) cut point values can have a 
significant effect on the outer limits of the boiling range. During 
the laboratory analysis of a petroleum fluid’s boiling point 
regions, the most difficult to measure are the end regions.

HYSYS uses the defaults of 1% and 98% for the IBP and FBP. 
With a 1% IBP value, HYSYS uses the boiling points of all 
components in the first volume percent of the given fluid and 
calculates a weighted average boiling point that is used as the 
IBP for any further analysis. 

The final boiling point is determined similarly, using the 
weighted average of the boiling points for the components found 
in the final two liquid volume percents of the fluid.

Refer to Chapter 14 - 
Utilities in the HYSYS 
Operations Guide for 
more information about 
the BP Curves utility.
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These IBP and FBP values can be modified in this property view. 
In the IBP cut point and FBP cut point fields, enter the values 
you want to use for calculating your BP curve. 

Refer to the following table for a description of the values. 

You can also specify the Interconversion method used for the 
ASTM D86 interconversion and ASTM D2887 interconversion. 
Select the method you want to use.

For the ASTM D86 Interconversion Method, the following options 
are available:

• API 1974
• API 1987
• API 1994
• Edmister-Okamoto 1959

For the ASTM D2887 Interconversion Method, the following 
options are available:

• API 1987
• API 1994 Indirect
• API 1994 Direct

 Figure 6.1

Field Description

IBP cut point Specify a value from 0% to 5%.

FBP cut point Specify a value from 90% to 100%.

Basis for IBP & 
FBP

Using the drop-down list, select the basis for your 
boiling points. You have three choices: Liquid 
Volume%, Mass% and Mole%.
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6.2.2 Assay Tab
The Assay tab allows you to manage the oil assays in your case. 
Use this tab to add new assays and modify existing ones. You 
can also import assays from other cases or export them for use 
with another case. The Description field lets you add notes for 
individual assays. 

The minimum amount of information required to characterize a 
petroleum fluid is either a laboratory distillation curve or two of 
the following three bulk properties: 

• Molecular Weight
• Density
• Watson UOP K factor 

The more information you supply, the better the results will be 
for your oil characterization. 

All physical and critical properties are generated from an 
internally generated TBP curve at atmospheric conditions. 
Regardless of the assay data provided, HYSYS converts it to an 
internal TBP curve for the characterization procedure. This 
internal TBP curve is not stored with the assay.

Click the Oil Input Preferences button to change the default oil 
preferences. 

 Figure 6.2

See Section 4.5 - 
Characterizing Assays 
in the HYSYS 
Simulation Basis guide 
for additional 
information.

Refer to Section 12.8 - 
Oil Input Tab for more 
information.
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Adding an Assay
1. In the Oil Characterization property view, click the Add 

button. The Assay property view appears.
2. Click the Input Data tab.

3. In the Assay Definition group, use the Bulk Properties drop-
down list to specify if you are supplying bulk properties. 
Select either Not Used or Used.

4. From the Assay Data type drop-down list, select an assay 
data type option.

5. Depending on the assay data type selected, supply 
information for the following:

• Light Ends curve
• Molecular Weight curve
• Density curve
• Viscosity curves
• Distillation conditions

6. Each definition requires you to provide data in the Input 
Data group. Click the required radio button and either enter 
the data directly into the table or click the Edit Assay radio 
button.

7. Click the Light Ends Handling & Bulk Fitting Options 
button to specify if a given curve contains light-ends 
contributions. Also, specify whether the specified bulk 
properties contains light-ends and partition a property curve, 
so that some sections can be adjusted more than others.

Editing an Assay
1. From the list of available assays, select the assay you want 

to edit.
2. Click the View button. The Assay property view appears.

3. Click the Input Data tab, then modify the assay data.

4. Click the Calculation Defaults tab, then modify how the 
hypocomponents are calculated. 

Assay Data Type 
options
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Deleting an Assay
1. From the list of available assays, click the assay you want to 

delete.
2. Click the Delete button.

Cloning an Assay
1. From the list of available assays, select the assay you want 

to clone.
2. Click the Clone button. Cloning creates a new assay with the 

exact same properties as the original.

Importing an Assay
1. Click the Import button. The Open File property view 

appears.
2. Browse to the location of your assay file (*.oil).

3. Select the file you want to import and click Open. The new 
assay appears in the list of available assays.

Exporting an Assay
1. Click the Export button. The Save File property view 

appears.
2. Specify a name and location for your assay file.

3. Click Save.

You will not be prompted to confirm the deletion of an assay, 
however, assays being used by a blend will not be deleted.
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6.2.3 Cut/Blend Tab
The Cut/Blend tab allows you to manage the hypocomponents in 
a case. 

The Cut/Blend tab allows you to do the following:

• Add new blends
• Modify existing blends
• Clone existing blends 
• Provide descriptions for individual blends so others can 

easily access the information. 

The Cut/Blend characterization splits internal working curves for 
one or more assays into hypocomponents.

Adding a Blend
1. Click the Add button. The Blend property view appears.
2. Click the Data tab.

 Figure 6.3

To modify the graph labels in a Blend plot, click the Clone 
button. HYSYS generates a copy of the existing selected plot. 
The cloned plot is independent, and its labels can be 
modified and are not overwritten.

See Section 4.6 - 
Hypocomponent 
Generation in the HYSYS 
Simulation Basis guide 
for additional information.

For more information, refer 
to Chapter 4 - HYSYS Oil 
Manager in the HYSYS 
Simulation Basis guide.
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3. From the list of available assays, select the assay you want 
use for the blend.

4. Click the Add button. The assay is moved from the list of 
available assays to the Oil Flow Information table.

5. In the Oil Flow table, specify the flow units for the oil as 
either Liquid Volume, Molar, or Mass. 

6. Specify the flow rate of the oil.

7. From the Cut Option Selection drop-down list, select one of 
the following cut options: 

• Auto Cut
• User Ranges
• User Points

There is no limit for the number of assays that can be included 
in a single blend or the number of blends that can contain a 
given assay. Each blend is treated as a single oil and does not 
share hypocomponents with other blends or oils.

The Bulk Data button is available when more than one assay is 
present in the Oil Flow Information table. Clicking this button 
opens the Bulk Values property view, where you can provide the 
following bulk data for a blend: 

• Molecular Weight
• Mass Density
• Watson (UOP) K
• Viscosities at two temperatures. 

The Bulk Data feature is useful for supplying the bulk viscosities 
of the blend if they are known.

Editing a Blend
1. From the list of available blends, select the blend you want 

to edit.
2. Click the View button. The Blend property view appears.

3. Click the Data tab, then modify the data for the blend.
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Deleting a Blend
1. From the list of available blends, click the blend you want to 

delete.
2. Click the Delete button.

Cloning a Blend
1. From the list of available blends, select the blend you want 

to clone.
2. Click the Clone button. Cloning a blend creates a new blend 

with the exact same properties as the original.

6.2.4 User Property Tab
The User Property tab allows you to create an unlimited number 
of user properties for use in the Simulation environment. You 
can only create user properties in the Basis environment. 

HYSYS will not prompt you to confirm the deletion of a blend, 
so ensure you have selected the correct blend before 
deleting.

 Figure 6.4

Refer to Section 4.7 - 
User Property in the 
HYSYS Simulation Basis 
guide for additional 
information.
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During the characterization process, all hypocomponents are 
assigned an appropriate property value. The value of the 
property for any flowsheet stream is then calculated. This 
enables user properties to be used as Column specifications. 

Adding a User Property
1. Click the Add button. The User Property property view 

appears.
2. Click the Data tab.

3. Use the drop-down list in the Mixing Basis field to select 
the basis for mixing.

4. Use the drop-down list in the Mixing Rule field to specify 
the mixing rule to use with your user property.

5. Specify values for the mixing rule parameters F1 and F2. By 
default these parameters have a value of 1.00.

6. Select a unit from the Unit Type drop-down list for the user 
property value. If the unit type is Temperature, the internal 
unit used is degrees Kelvin. This is important when 
calculating the mixed value for a stream.

7. Specify a lower and upper limit for your user property in the 
Lower Limit Value and Upper Limit Value cells.

The choice of Mixing Basis applies only to the basis that is used 
for calculating the property in a stream. You supply the property 
curve information on the same basis as the Boiling Point Curve 
for your assay.

The values you provide for the light end components are used 
when calculating the property value for each hypocomponent 
(removing that portion of the property curve attributable to the 
light ends components). 

This is not the property curve information. These values 
determine how the user property is calculated in all flowsheet 
streams. When the value of a user property is requested for a 

A user property is any property that can be defined and 
calculated on the basis of composition. Examples for oils 
include RON and Sulfur content.
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stream, the composition in the specified basis is used and the 
property value is calculated using your mixing rule and 
parameters.

Editing a User Property
1. From the list of available user properties, click the user 

property you want to edit.
2. Click the View button. The User Property property view 

appears.

3. Click the Data tab and modify the data for the user property. 

Deleting a User Property
1. From the list of available user properties, click the user 

property you want to delete.
2. Click the Delete button.

Cloning a User Property
1. From the list of available user properties, select the user 

property you want to copy.
2. Click the Clone button. Cloning a user property creates a 

new user property with the exact same properties as the 
original.

You will not be prompted to confirm the deletion of a user 
property, so ensure you have selected the correct one before 
deleting.
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6.2.5 Correlation Tab
This tab allows you to manage the correlations in a case. Use 
this tab to add new correlation sets and modify existing sets. 

You cannot change the correlations or ranges for the Default 
correlation set. If you want to specify different correlations or 
temperature ranges, create a new correlation set.

Adding a Correlation Set
1. Click the Add button. The Correlation Set property view 

appears.
2. Click the Options tab and use the drop-down list in the MW 

column to specify the correlation you want to use. 

3. Repeat step 2 for each of the columns in the table: SG, Tc, 
Pc, Acc. Factor and Ideal H.

Property correlations can be changed for the entire range or 
they can be made valid for only certain boiling point ranges.

4. To divide correlations over several boiling ranges, click the 
Add New Range button. The Add Temperature Range 
property view appears.

5. In the New Temp field, enter the temperature at which you 
want to split the range. 

 Figure 6.5

See Section 4.8.1 - 
Correlation Tab in the 
HYSYS Simulation 
Basis guide for more 
information.
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6. Click the Split Range button and specify correlations in 
these two ranges. You can add as many temperature splits 
as required.

7. In the Assay and Blend Association group, select the New 
Assays/Blends checkbox to add all new assays and blends 
that were created using this correlation set.

8. Select the Available Assays radio button. 

9. In the Assay/Blend table, select the Use this Set checkbox 
to use all the assays in this correlation set.

10.Select the Available Blends radio button. 

11. In the Assay/Blend table, select the Use this Set checkbox 
to use all the blends in this correlation set.

Changes to the Molecular Weight or Specific Gravity correlations 
are applied to the assay curve, while the critical temperature, 
critical pressure, acentric factor and heat capacity correlations 
are applied to the blend’s hypocomponent properties. 

Changes to the assay correlations have no effect when you 
supply a property curve (for example, Molecular Weight). The 
changes only apply when properties are being estimated.

Removing a Split
1. Click the Remove Range button. The Remove property view 

appears.
2. From the list of available splits, select the split you want to 

remove.

3. Click the Merge Temp Range button. When you merge a 
range, you delete the correlations for the range with a Low 
End Temperature that is equal to the range temperature you 
are merging.

Changes to the correlations for an input assay results in the 
recalculation of that assay followed by the recalculation of any 
blend that uses it. Existing oil is automatically recalculated/re-
cut using the new correlations and components installed in the 
flowsheet.
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Editing a Correlation Set
1. From the list of available correlation sets, click the 

correlation set you want to edit.
2. Click the View button. The Correlation Set property view 

appears.

3. Click the Options tab and modify the data that makes up 
the correlation set. 

Deleting a Correlation Set
1. From the list of available correlation sets, click the 

correlation set you want to delete.
2. Click the Delete button.

Cloning a Correlation Set
1. From the list of available correlation sets, select the 

correlation set you want to copy.
2. Click the Clone button. Cloning a correlation set creates a 

new correlation set with the exact same properties as the 
original.

You will not be prompted to confirm the deletion of a 
correlation set, so ensure the correct correlation set is 
selected before deleting.
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6.2.6 Install Oil Tab
Use this table to install an oil blend into a flowsheet.

1. Select the Install checkbox.
2. In the Stream Name column, type a stream name for that 

blend. You can use an existing stream name or provide a 
new one. If you do not provide a name, the hypocomponents 
are not attached to the fluid package.

3. Use the drop-down list in the Flow Sheet column to specify 
for which flowsheet you want to install the stream containing 
the hypocomponents.

 Figure 6.6

See Section 4.8.3 - 
Install Oil Tab in the 
HYSYS Simulation Basis 
guide for more 
information.
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7-4 Introduction
7.1 Introduction
The Simulation environment contains the main flowsheet where 
you do the majority of your work (installing and defining 
streams, unit operations, columns and subflowsheets).

This flowsheet serves as the base level or “main” flowsheet for 
the whole simulation case. Any number of subflowsheets can be 
generated from the main flowsheet, but there is only one main 
flowsheet environment. Each individual subflowsheet that is 
installed has its own corresponding subflowsheet environment.

To enter the Simulation environment, click either the Enter 
Simulation Environment button or Return to Simulation 
Environment button in the Basis environment.

Before entering the Simulation environment, you must have 
a fluid package with selected components in the component 
list and a property package. 

If you do not have the above requirements, you cannot enter 
the Simulation environment.
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7.2 Main Properties
To access the Simulation Case property view, do one of the 
following:

• Select Main Properties command from the Simulation 
menu.

• Press CTRL M hot key combination.

The Simulation Case property view appears as shown below: 

 Figure 7.1

For the Simulation Case property view of a subflowsheet 
environment, an extra button called Main Environment 
appears at the bottom right corner of the property view. This 
button enables you to return to the main environment.
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7.2.1 Status Message Tab
The Status Message tab allows you to view any errors or 
warnings in your case, name the flowsheet, and provide a tag 
for it.

• To name the flowsheet, click the Name field and type a 
name for the flowsheet. The default name is Case.

• To add a tag to the flowsheet, click the Tag field and type 
a tag for your flowsheet. The default tag for the main 
flowsheet is Main.

The Object Status group displays the current status messages 
for all objects in the flowsheet according to the minimum 
severity. In the Minimum Severity drop-down list, click one of 
the following options:

• OK. Sets the minimum severity at OK.
• Optional Info. Sets the minimum severity at Optional 

Info.
• Warning. Sets the minimum severity at Warning.
• Required Info. Sets the minimum severity at Required 

Info.
• **Error**. Sets the minimum severity at **Error**.

 Figure 7.2
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7.2.2 Calculation Levels Tab
The Calc Levels tab controls the order in which streams, 
operations, and flowsheets are calculated.

Use this procedure to change the calculation order/sequence of 
a separator in the PFD.

1. Open the HYSYS case that contains the PFD you want to 
modify.

2. Enter the Simulation Environment.

3. From the Simulation menu, select the Main Properties 
command. The Simulation Case property view will appear.

4. Click the Calc Levels tab in the Simulation Case property 
view.

5. Locate the name of the separator in the table on the Calc 
Levels tab.

6. Enter a lower calculation level value in the appropriate cell 
under the Calculation Level column.

7.2.3 Notes Tab
Use the Notes tab to add comments or descriptions about your 
simulation. For example, this is a good location for documenting 
changes made to the settings.

 Figure 7.3

You can ignore a certain 
stream or operation in a 
case by clearing its 
checkbox. 

Clicking the Reset button 
returns all Calculation 
Levels to their default 
values.

To see all notes entered in 
the case, refer to Section 
7.19 - Notes Manager.
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7.2.4 WebModels Tab
The WebModels tab enables you to export a HYSYS simulation 
case into a webmodel file.

7.2.5 PV Balance Tab
The PV Balance tab enables you to modify the property vector 
balance calculation.

There are two balance option available for you to select: Default 
Property Balance and Petroleum Assay Balance.

For the Petroleum Assay Balance, you can click the View button 
to modify the balance calculation method for the assay 
properties.

 Figure 7.4

 Figure 7.5

For more information on 
converting HYSYS case to 
WebModels, refer to 
Section 7.4 - HYSYS 
Support for Aspen 
WebModels.
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7.2.6 Lock Tab
The Lock tab enables you to lock the Main flowsheet by entering 
a password in the field and press ENTER.

7.2.7 Converting a Case to a 
Template

Click the Convert to Template button in the Simulation Case 
property view. You are prompted to confirm your selection and 
save your case. 

Converting your case to a template treats the flowsheet like a 
“black box” and allows you to install it as a subflowsheet 
operation in other cases.

After you convert the case to a template, the Exported 
Connections and Exported Variables tabs become available and 
the Convert to Template button disappears from the Simulation 
Case property view.

 Figure 7.6

Refer to Section 11.15 - 
Case Security for more 
information on locking 
flowsheet.

Refer to Section 3.5 - 
Templates for additional 
information about 
templates and extra tabs.
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7.3 HYSYS XML
HYSYS now contains the ability to represent a simulation case in 
XML form. XML (Extended Markup Language) is used 
extensively in the computer software industry to facilitate data 
exchange between applications.

 Figure 7.7
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The HYSYS XML property view lists all the current specifications 
used to build the simulation case. To access the HYSYS XML 
property view:

1. From the Simulation menu, select HYSYS XML.
2. The HYSYS XML property view appears.    

 Figure 7.8

Options Description

Allows you to return to the main Web page as shown in 
Figure 7.8. 

Allows you to return to the previous page.

Allows you to go to the next page.

Import/Export/
Display Options

Use the checkboxes to select the information you want 
to appear in the Datasheet.

Use WebBrowser If you want to view the data in a web page, select the 
Use WebBrowser checkbox. If the checkbox is clear, 
XML code is displayed.
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There are a number of options associated with the HYSYS XML 
output. These control the amount of information saved to the 
XML file.

Benefits of the HYSYS XML tool:

• A structured output of simulation case data that can be 
queried using XML tools.

• An alternate form of case storage that allows the user to 
rebuild the case from the XML file.

• The ability to read partial information (additional pieces 
of equipment/streams or changed parameters for 
existing streams or operations) over top of an existing 
case.

Print the information in the Datasheet to an XML file:

1. Click the Export Case as XML button. The Save File 
property view appears.

2. Specify a name and location for the Datasheet file, then click 
Save.

Import a Datasheet from an XML file:

1. Click the Import XML button. The Open File property view 
appears.

2. Browse to the location of the required Datasheet file (*.xml).

3. Select the file you want to import, then click Open.

Auto Refresh To automatically update the web page, select the Auto 
Refresh checkbox.

Input Summary 
Format

If you want to view all the user specifications in the 
HYSYS v2.4 case, select the Input Summary Format 
checkbox. The functionality is similar to the Print-
Specsheet-Flowsheet capability in HYSYS 2.4.1, but 
reports more specifications to produce a more accurate 
representation of the case.

Scroll up and down for a list of 
all flowsheet specification 
details. Click the buttons in the 
list to jump to the list displayed 
in groups.

Export Case as 
XML

Allows you to save the flowsheet specification details to 
an *.xml file.

Import XML Allows you to open the flowsheet specification details 
from an *.xml file.

Refresh Updates the list of current specifications in the 
flowsheet.

Restore Restores the default import/export options.

Options Description
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7.4 HYSYS Support for 
Aspen WebModels

Aspen WebModels is a mechanism that enables a user to allow 
remote users access to certain variables in a specific HYSYS 
simulation case. A central server holds an XML file for each 
simulation case. The XML file contains information about the 
variables that are exposed, as well as an encoded version of the 
simulator file(s). The remote user can only view an HTML page 
that is created by the central server. The HTML page displays the 
variable values and a PFD which is a graphical representation of 
the flowsheet connectivity. The HTML page allows the user to 
edit the values of certain variables. When the user changes 
variable values, the central server starts the appropriate 
simulator, loads the simulation case, solves the case with the 
new variable values, and reports the results back to the remote 
user via the HTML page.

7.4.1 Creating a HYSYS 
WebModel File

You can create a WebModel file from an existing HYSYS 
simulation case or from a new HYSYS simulation case that you 
have created. The WebModel file you create will include a range 
of simulation variables and a Process Flowsheet Diagram (PFD).

The Figure 7.9 shows the PFD for the Steady State example 
named gstrt-ss.hsc. This example is available in the HYSYS 
sample cases folder, and it will be used to create a HYSYS 
WebModel file.

Refer to Section 4.2 - 
File for information on 
creating and saving a new 
HYSYS simulation case.
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Specifying Variables for the 
WebModel File
You have to specify the variables that you want the remote user 
to view.

1. From the Tools menu, select Databook. 
The Databook property view appears. 

 Figure 7.9

You can also access the Databook by pressing the CTRL D hot 
key.
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You will notice that variables have already been defined for 
the gstrt-ss.hsc simulation case. However, you can add other 
variables that you want the remote user to view.   

2. Click the Insert button to add a variable. The Variable 
Navigator property view appears. 

3. From the available object list select an object, and then 
select a variable from the available variable list. 

4. Click the OK button to insert the variable in the Databook.

 Figure 7.10

 Figure 7.11
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Adding Process Data Tables for the 
WebModel File
You will have to add the process data tables of variables to 
export the WebModel as an XML file.

1. Click on the Process Data Tables tab of the Databook 
property view. The objects and variables that you defined on 
the Variables tab are shown in the Individual Data Selection 
group.

2. Click the Add button in the Available Process Data Tables 
group to add a process data table. The default name for 
process data table appears in the Process Data Table field 
of the Individual Data Selection group.

 Figure 7.12
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3. You can change the name of the process data table. When 
the Show checkbox is selected the variable is added to the 
process data table. 

4. If you want to view the process data table, select the 
process table that you want to view from the Available 
Process Data Tables group. Then click the View button. A 
property view as shown in the figure below appears.

Figure 7.14 shows the details for the variables in the table. You 
can add a descriptive tag for each variable, and you can also 
change the access mode.

 Figure 7.13

 Figure 7.14

WebModels require that all the variables that are specified in 
the table are either read/write or read-only.
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7.4.2 Exporting the 
WebModels as an XML File

You can now export an XML file that will contain information 
about the variables in the process data tables.

1. From the Simulation menu, select Main Properties.
2. Click on the WebModels tab. A list of all the Process Data 

Tables in the case is shown on this tab.

3. You can change the WebModel name and description in the 
appropriate fields.

4. If you want to link the WebModel to an Aspen OnLine server 
and project, type the server and project names in the 
Online Server and Online Project fields.

5. If you want to include the variables in the WebModels file, 
select the Include checkbox.

6. You can specify if the tables contain are writable variables by 
selecting the Writable checkbox.

 Figure 7.15
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7. Click the Export WebModel button to create the.xml file. 
The Save WebModels File property view appears. 

8. Change the name for XML file in the File name field. 
WebModels.xml is the default file name.

9. Click the Save button to save the WebModel XML file.

7.4.3 Publishing a WebModel
Publishing a WebModel makes it available to other users over a 
corporate Intranet. A WebModel cannot be directly published to 
a WebModels library from Aspen WebModels Author. To publish a 
model, you must log in to the WebModels service in Aspen 
Enterprise Engineering (AEE). Please see the online 
documentation for AEE on how to perform the publish task.

7.5 Optimizer
The Optimizer performs steady state optimization by finding 
values of process variables that minimize or maximize a user-
defined objective function. It has its own spreadsheet with 
attached variables that define the objective function and 
mathematical expression relating to the variables.

 Figure 7.16

Refer to Chapter 6 - 
Optimizer Operation in 
the HYSYS Operations 
Guide for more 
information about the 
Optimizer.
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In addition, you must set upper and lower bounds and 
constraints that the process variables must satisfy. The 
optimization must begin in a feasible region (in other words, all 
constraints must be satisfied at the initial starting conditions).

7.6 Event Scheduler
Use the Event Scheduler to perform tasks at specified times 
during the dynamic simulation of a process. Task times can be 
predetermined, or they can depend on the simulation. 

For example, you can set a task to begin 20 minutes into the 
simulation or after a reboiler product stream temperature 
stabilizes.

To access the Event Scheduler property view:

1. From the Simulation menu, select Event Scheduler.
You can also access the Event Scheduler using the CTRL E 
hot key combination.

2. The Event Scheduler property view appears. 

 Figure 7.17

Refer to Chapter 2 - 
Dynamic Tools in the 
HYSYS Dynamic 
Modeling guide for 
additional information.
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7.6.1 Adding a Schedule
To add a new schedule:

1. From the Event Scheduler property view, click the Add 
button in the Schedule Options group. 

2. The Schedule Sequences group appears. 

The Event Scheduler can be used only in Dynamics mode.

 Figure 7.18

Tree browser
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7.6.2 Adding a Sequence
To add a new sequence:

1. From the Event Scheduler property view, click the Add 
button in the Schedule Options group. The Schedule 
Sequences group appears.

2. From the Schedule Sequences group, click the Add button. 
The sequence appears in the Schedule Sequences table.  

7.6.3 Adding an Event
To add a new event to the sequence:

1. From the Event Scheduler property view, click the Add 
button in the Schedule Options group. The Schedule 
Sequences group appears.

2. From the Schedule Sequences group, click the Add button. 
The sequence appears in the Schedule Sequences table.

You can add as many sequences as needed in a schedule.

 Figure 7.19

You can add multiple events to a sequence.
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3. Click the View button in the Schedule Sequences group. The 
Sequence property view appears. 

4. Click the Add button. The event appears in the table.

 Figure 7.20

 Figure 7.21
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Defining an Event
1. From the Sequence property view, click the View button. 

The Event property view appears, which allows you to define 
events.    

2. Click on the Condition tab. 

3. In the Wait For group, select the condition you are waiting 
for before running the event. Select from the following 
options:

• The Logic to Evaluate True
• An Elapsed Amount of Time
• A Specific Simulation Time
• A Variable to Stabilize

4. Click the Action List tab.

5. Close the Event and Sequence property views to return to 
the Event Scheduler property view.

6. Click the Start button to start the integrator.

 Figure 7.22

The parameters on the property view change depending on 
the radio button you select.

Refer to Section 2.5.4 - 
Event Property View in 
the HYSYS Dynamic 
Modeling guide for more 
information.

Refer to Action List Tab 
section from Section 
2.5.4 - Event Property 
View in the HYSYS 
Dynamic Modeling 
guide for more 
information.
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7.6.4 Editing a Sequence
1. From the Schedule Sequences group of the Event Scheduler 

property view, select the sequence you want to edit. 

2. You can modify the sequence name and run mode. If you 
want to modify the information for the defined event and the 
sequence universal settings, click the View button. The 
Sequence property view appears.

 Figure 7.23

 Figure 7.24
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7.6.5 Editing an Event
1. From the Schedule Sequences group of the Event Scheduler 

property view, select the sequence you want to edit the 
defined events. 

2. Click the View button in the Schedule Sequences group.   
The Sequence property view appears.

3. From the Sequence property view, select the event you want 
to edit.

4. Click the View button. The Event property view appears.

5. Modify the event as required.

7.6.6 Deleting a Schedule
1. From the Event Scheduler property view, select the schedule 

you want to delete from the tree browser.
 

 Figure 7.25

 Figure 7.26

 Figure 7.27

The Delete button is only active when a schedule exists in 
the case.
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2. Click the Delete button in the Schedule Options group.

7.6.7 Deleting a Sequence
1. From the Schedule Sequences group of the Event Scheduler 

property view, select the sequence you want to delete.

2. Click the Delete button in the Schedule Sequences group.

7.6.8 Deleting an Event
1. From the Schedule Sequences group of the Event Scheduler 

property view, select the sequence you want to delete the 
defined events.

2. Click the View button. 

You will not be prompted to confirm the deletion of the 
schedule, even if you have sequences and events defined. 
Ensure the correct schedule is selected before deleting.

 Figure 7.28

The Delete button is only active when a sequence exists in 
the schedule.

You will not be prompted to confirm the deletion of the 
sequence, even if you have events defined. Ensure you 
selected the correct sequence before deleting.

 Figure 7.29
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The Sequence property view appears.

3. From the Sequence property view, select the event you want 
to delete, and click the Delete button.

7.6.9 Copying a Schedule
1. From the Event Scheduler property view, select the schedule 

you want to copy from the tree browser.

2. Click the Copy button in the Schedule Options group to 
make a copy of the selected schedule. The copied schedule is 
added to the tree browser.

 Figure 7.30

The Delete button is only active when an event exists in the 
sequence.

You will not be prompted to confirm the deletion of the 
event, so ensure you selected the correct event before 
deleting.

 Figure 7.31

The Copy button is only active when a schedule exists in the 
case.
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7.6.10 Copying a Sequence
1. From the Schedule Sequences group of the Event Scheduler 

property view, select the sequence you want to copy.

2. Click the Copy button in the Schedule Sequences group to 
make a copy of the selected sequence. 

7.6.11 Copying an Event
1. From the Schedule Sequences group of the Event Scheduler 

property view, select the sequence you want to copy the 
defined events.

2. Click the View button. The Sequence property view appears.

3. From the Sequence property view, select the event you want 
to copy, and click the Copy button.

 Figure 7.32

The Copy button is active when a sequence exists in the 
schedule.

 Figure 7.33

 Figure 7.34
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7.6.12 Importing a Schedule
1. From the Schedule Options group of the Event Scheduler 

property view, click the Import button. The File Selection 
for Importing Schedule property view appears.

2. Browse to the location of the saved schedule file (*.sch). 

3. Select the file you want to import, then click the Open 
button.

The Copy button is only active when an event exists in the 
sequence.

 Figure 7.35
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7.6.13 Importing a Sequence
1. From the Schedule Sequences group of the Event Scheduler 

property view, click the Import button. 
The File Selection for Importing Sequence property view 
appears.

2. Browse to the location of the saved sequence file (*.seq).

3. Select the file you want to import and click the Open button.

7.6.14 Exporting a Schedule
1. From the Event Scheduler property view, select the schedule 

you want to export from the tree browser.
2. Click the Export button. 

The File Selection for Exporting Schedule property view 

 Figure 7.36

The Export button is only active when a schedule exists in 
the case.
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appears. 

3. In the File name field, specify the name for the schedule file

4. From the Save in drop-down list, select the location to save 
the schedule file and then click the Save button.

7.6.15 Exporting a Sequence
1. From the Schedule Sequences group of the Event Scheduler 

property view, select the sequence you want to export.
2. Click the Export button. 

The File Selection for Exporting Sequence property view 

 Figure 7.37

The Export button is only active when a sequence exists in 
the schedule.
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appears.

3. In the File name field, specify the name for the schedule file

4. From the Save in drop-down list, select the location to save 
the sequence file and then click the Save button.

7.6.16 Sorting a Schedule
1. From the Schedule Options group of the Event Scheduler 

property view, click the Sort button. The Reorder Schedules 
property view appears. 

2. From the Move Object list, select the schedule you want to 
move.

 Figure 7.38

 Figure 7.39

The Sort button is only active when at least two schedules 
exist in the case.
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3. From the Before list, select the schedule you want to insert 
the schedule you are moving before.

4. Click the Move button to complete the move.

5. Close the Reorder Schedules property view when you have 
completed sorting the schedules.

7.6.17 Sorting a Sequence
1. From the Schedule Sequences group of the Event Scheduler 

property view, click the Sort button. The Reorder Sequences 
property view appears.

The Sort button is only active when at least two sequences 
exist in the schedule.

2. From the Move Object list, select the sequence you want to 
move.

3. From the Before list, select the sequence you want to insert 
the sequence you are moving before.

4. Click the Move button to complete the move.

5. Close the Reorder Sequences property view when you have 
completed sorting the sequences.

To move a schedule to the end of the list, select the blank 
space under the last schedule in the Before list.

 Figure 7.40

To move a sequence to the end of the list, select the blank 
space under the last sequence in the Before list.
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7.6.18 Sorting an Event
1. From the Schedule Sequences group of the Event Scheduler 

property view, select the sequence you want to sort the 
defined events.

2. Click the View button. The Sequence property view appears.

3. Click the Sort button. The Reorder Events property view 
appears.

The Sort button is only active when at least two events exist 
in the sequence.

4. From the Move Object list, select the event you want to 
move.

5. From the Before list, select the event you want to insert the 
event you are moving before.

6. Click the Move button to complete the move.

 Figure 7.41

 Figure 7.42

 Figure 7.43

To move an event to the end of the list, select the blank 
space under the last event in the Before list.
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7. Close the Reorder Events property view when you have 
completed sorting the events.

7.7 Integrator
You can use the Integrator when running a case in Dynamic 
mode. There are two ways you can access the Integrator:

• From the Simulation menu, select Integrator.
• Press CTRL I.

 Figure 7.44

Refer to Section 2.4 - 
Integrator in the 
HYSYS Dynamic 
Modeling guide for 
additional information.

The Start button allows you 
to start to run the Integrator. 
When the Integrator is 
running, the button is 
replaced by Stop. When the 
Integrator has run once, the 
Start button turns into a 
Continue button. You can 
also access the Start/
Continue and Stop 
functionality by using the 
icons on the toolbar.

Automatically forces 
the flowsheet 
variables to update 
regardless of what is 
set for the display 
interval.

The Reset button forces all the unit operations to 
re-initialize. This can cause significant 
disturbances in the case and is generally not 
recommended for large cases. Instead, consider 
using the Dynamic Initialization option. Refer to 
Section 2.7 - Dynamic Initialization in the 
HYSYS Dynamic Modeling guide for more 
information.
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7.7.1 Integration Time Group
The Integration Time group contains the following parameters:

Parameter Description

Units Time units for the Current Time, End Time, and Display 
Interval fields.

Current Time Displays the time that the Integrator is running. When 
the Integrator is Reset, this value returns to zero.

When the Integrator is not running, you can specify the 
value for the current time.

Acceleration If running in Real Time, changing this field can speed 
up (>1) or slow down (<1) the HYSYS model by taking 
larger or smaller steps. The specified factor value is 
applied to the step size.

End Time Allows you to specify the time at which the Integrator 
stops.

Real Time Activates the Desired Real Time Factor field.

Display Interval Visible only in Automatic Integration Control, this field 
contains the time interval at which HYSYS updates the 
property views. The frequency of updating has a 
significant impact on the speed at which your 
simulation runs. The Display Interval has no effect on 
the calculation frequency.

Real time factor Visible only in Automatic Integration Control, this field 
is calculated by dividing a time interval for a case by 
the actual time required by HYSYS to simulate that 
time interval. The Real time factor depends on the 
computer’s processing speed and the complexity of the 
simulation case.

Desired Real 
Time Factor

Appears only when you select the Real time checkbox. 
Allows you to set the speed at which the integrator 
operates. The default setting of 1 indicates that the 
integrator is running at actual time, which appears on 
the status bar of the HYSYS Desktop. You have the 
option to increase (>1) or decrease (<1) the speed of 
the integration. The Desired Real Time Factor has no 
effect on the calculation and results.

Number of time 
steps to execute:

Number of time steps at which HYSYS executes. This 
field appears only when you click the Manual radio 
button in the Integration Control group.
7-37



7-38 Simultaneous Adjust Manager
7.7.2 Integration Step Size 
Group

The Integration Step Size group contains the following 
parameters:

7.8 Simultaneous Adjust 
Manager

The Simultaneous Adjust Manager (SAM) allows you to monitor 
and modify all adjusts that are defined as simultaneous. This 
gives you access to a more efficient calculation method with 
more control over the calculations. 

Access the Simultaneous Adjust Manager by selecting the 
Simultaneous Adjust Manager command from the Simulation 
menu.

Parameter Description

Units Allows you to select the units for the integration step size.

Step Size Allows you to specify the integration step size, which by 
default is 0.5 seconds. While the integrator is running, this 
value cannot be changed.

Minimum Allows you to specify the minimum number of steps that 
can be taken.

A fixed integration step size is used and currently the 
minimum and maximum values are not relevant.

Maximum Allows you to specify the maximum number of steps that 
can be taken.

The SAM requires two or more active (in other words, not 
ignored) adjusts to solve. If you are using only one adjust, 
you cannot use the SAM.

Refer to the 
Simultaneous Adjust 
Manager section from 
Section 5.1.3 - 
Parameters Tab in the 
HYSYS Operations 
Guide for more 
information.
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7.9 Dynamic/Steady State 
Modes

The Dynamic/Steady State command is located in the 
Simulation menu and is used to alternate between the two 
modes.

To switch from Steady State to Dynamic mode, open the 
Simulation menu and select the Dynamics command. The 
Dynamics Assistant identifies items that require attention:

• Click Yes to open the Dynamics Assistant and view the 
items. 

• Click No to ignore them and continue to Dynamics mode. 

To switch from Dynamic to Steady State mode:

1. Open the Simulation menu and select the Steady State 
command. 

2. Click Yes to proceed to steady state.

 Figure 7.45

Press the F7 hot key to alternate between the two modes.

See Chapter 2 - 
Dynamic Tools in the 
HYSYS Dynamic 
Modeling guide for 
additional information 
about the Dynamics 
Assistant.
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Switching back to Steady State mode results in the loss of 
results. Your steady state simulation remains unsolved and 
may require some adjusting before it fully solves.

7.10 Solver Active/Holding
When in Steady State mode, you can activate or hold the solver. 
This is useful for building your simulation without interruption; 
you can add operations and streams without HYSYS trying to 
solve them immediately. By default the HYSYS solver is active.

Use one of the following methods to place the solver on hold:

• Open the Simulation menu and click the Solver Holding 
command.

• Press the F8 hot key.
• Click the Solver Holding icon in the toolbar.

Use one of the following methods to make the solver active:

• Open the Simulation menu and click the Solver Active 
command.

• Press the F8 hot key.
• Click the Solver Active icon in the toolbar.

You can halt the switch and remain in dynamics mode by 
clicking No.

When inheriting a case from someone else, double-check 
that the solver is active when your case is not solving.

Solver Holding icon

Solver Active icon
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7.11 Integrator Active/
Holding

When in Dynamics mode, you can activate and hold the 
integrator. This is useful for examining the results of your 
simulation. By default the integrator is on hold (inactive).

Use one of the following methods to activate the integrator:

• Open the Simulation menu and click the Integrator 
Active command.

• Press the F9 hot key.
• Click the Integrator Active icon in the toolbar.

Use one of the following methods to put the integrator on hold:

• Open the Simulation menu and click the Integrator 
Holding command.

• Press the F9 hot key.
• Click the Integrator Holding icon in the toolbar.

7.12 Equation Summary
The Equation Summary property view is used when running a 
case in Dynamics mode and it automatically opens when there 
are dynamic specification errors in your case.

To open the property view manually, select the Equation 
Summary View command from the Simulation menu.

The Equation Summary provides a list of the equations and 
pressure flow specifications that are currently used in the 
dynamic simulation. It also enables you to analyse the 
simulation to determine if any equations/specifications are 
required or redundant.

The Equation Summary option is available only in Dynamics 
mode.

Integrator Active icon

Integrator Holding icon

Refer to Section 2.3 - 
Equation Summary 
Property View in the 
HYSYS Dynamic 
Modeling guide for 
additional information.
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7.13 Enter Basis 
Environment

To enter the Basis environment from any flowsheet, use one of 
the following methods:

• Click the Enter Basis Environment command in the 
Simulation menu.

• Click the Enter Basis Environment icon in the toolbar.
• Use the hot key CTRL B to enter the Basis environment 

from any environment.

The Basis environment allows you to create and manipulate the 
fluid package in your simulation. Each object and flowsheet can 
have its own fluid package, and flowsheets can contain multiple 
fluid packages. For each fluid package, you can supply the 
following:

• Property package
• Components
• Reactions
• User properties

7.14 User Variables
User Variables increase the internal functionality of objects, such 
as streams and unit operations, by dynamically attaching 
variables and code to those objects from within the application. 

User Variables cannot be distinguished from variables built into 
HYSYS objects so they can be added to spreadsheets, targeted 
by logic controllers, and have their values specified by user 
input. 

For example, you can attach a User Variable to a stream to 
ensure the flow rate is specified lower than a certain value, or 
display a property view when a vessel temperature exceeds a 
certain value. 

User Variables let you attach code (written in a Visual Basic 
compatible macro language) to simulation objects and specify 

Enter Basis Environment 
icon

Refer to Chapter 5 - 
Basis Environment of 
this guide and the HYSYS 
Simulation Basis guide 
for additional information 
about the Basis 
environment.

Refer to Chapter 5 - User 
Variables in the HYSYS 
Customization Guide for 
additional information.
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when the code is to execute. This can add extra functionality to 
any simulation.

Simulation Case User Variables

Select the Simulation Case User Variable command from the 
Simulation menu to access the User Variables of Case property 
view. 

The User Variables listed in this property view apply to the 
current simulation case.

Flowsheet User Variables

Select the Flowsheet User Variables command from the 
Flowsheet menu to access the Flowsheet User Variables property 
view.

The User Variables listed in this property view apply only to the 

 Figure 7.46

 Figure 7.47
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flowsheet.
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7.14.1 Adding a User Variable
You can add a User Variable in either the User Variables of Case 
property view or the Flowsheet User Variables property view.

1. Click the Create a New User Variable icon to add a new 
User Variable to your simulation. The Create New User 
Variable property view appears.

2. On the Create New User Variable property view, you can 
enter code to define your User Variable. You can also specify 
the following:

7.14.2 Editing a User Variable
You can edit a User Variable from either the User Variables of 
Case property view or Flowsheet User Variables property view.

1. Select the User Variable you want to edit from the list of 
available User Variables.

2. Click the Edit the Selected User Variable icon. The Edit 
Existing Code of Case User Variables property view appears. 
This property view allows you to modify the code, tag, type 
and dimensions of the user variable.

7.14.3 Deleting a User 
Variable

You can delete a user variable from either the User Variables of 
Case or Flowsheet User Variables property view.

1. Select the User Variable you want to delete from the list of 
available User Variables.

2. Click the Delete the Selected User Variable icon. You are 
prompted to verify the deletion of the User Variable.

• Type
• Dimensions
• Units
• Macros

• Attributes
• Filters
• Security
• Variable defaults

Create a New User 
Variable icon

Edit the Selected User 
Variable icon

Delete the Selected User 
Variable icon
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7.15 Importing & 
Exporting User 
Variables

From the Simulation menu, select the Import and Export User 
Variables. The Import and Export User Variables property view 
appears.

7.15.1 Importing User 
Variables

1. Click the Select File button. The Open File property view 
appears.

2. Browse to the location of the User Variable file you want to 
import (*.hvv).

3. Select the file you want to import and click Open.

4. From the list of available User Variables in the export file, 
select the User Variable(s) you want to import.

5. Click the Import button.

 Figure 7.48

Select multiple User Variables at one time by holding down 
the CTRL key, and clicking each variable you want to select.
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7.15.2 Exporting User 
Variables

1. Click the User Var Manager Object in the User Variables In 
Case group. A list of available User Variables appears.

2. From the list of available User Variables, select the User 
Variable(s) you want to export.

3. Click the Export button. The Save File property view 
appears.

4. Specify a name and location for the User Variable file and 
click Save.

7.16 Oil Output Settings
Select the Oil Output Settings command in the Simulation menu 
to open the Oil Output Settings property view.

7.17 Object Navigator
The Object Navigator is one of the two navigational aids that 
brings the multi-flowsheet architecture into a flat space. A 
simulation containing a main flowsheet and subflowsheets 
(columns and/or template subflowsheets) is considered as 
having a directory/file structure. Flowsheets are directories 
(with the main flowsheet being the root directory) with 
flowsheet elements (streams, operations or utilities) being the 
files.

One difference, however, is that subflowsheets are both 
flowsheet elements (within the main simulation) as well as 
flowsheets themselves. How you use the navigational tools is 
illustrated in the following subsections.

Select multiple User Variables at one time by holding down 
the CTRL key and clicking each variable you want to select.

For more information, see 
Section 6.2.1 - Oil 
Output Settings 
Property View.
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The Object Navigator enables you to locate and view any 
flowsheet element within any flowsheet, or enter the build 
environment for a flowsheet.

There are several ways to access the Object Navigator:

• Right-click in any blank area of the HYSYS Desktop and 
select the Find Object command from the Object 
Inspect menu.

• Click the Find Object command in the Flowsheet 
menu.

• Press the F3 hot key.
• Click the Object Navigator icon in the toolbar.

The Object Navigator property view appears.

Object Filter Tools

Filter Radio Buttons

These radio buttons allow you to filter the Object list by certain 
types. For example, click the Streams radio button to view only 
streams.

 Figure 7.49

Object Inspect menu

Object Navigator icon

The Flowsheets group 
contains flowsheets, 
subflowsheets and 
templates.

Contains objects 
present in the selected 
flowsheet according to 
the filter.

Radio buttons 
designate which 
object types appear 
in the Flowsheet 
Objects group.

Enter the 
environment of the 
selected flowsheet by 
clicking this button.

Locates and opens the 
property view of a 
named object.

Opens the 
property view of 
the selected 
object.

Create your own 
filter topic for the 
Flowsheet Objects 
group.
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Setup Custom Button

The Setup Custom button lets you to define your own filter 
criteria.

1. Click the Custom radio button or the Setup Custom 
button. The Select Type property view appears.

2. Select the stream type or unit operation type.

3. Click OK.

Entering the Build Environment
Enter the Build environment for any flowsheet directly from the 
Object Navigator.

1. From the list of available flowsheets, select the flowsheet 
you want to enter.

2. Click the Build button.

7.17.1 Locating an Object
The Object Navigator works in a left to right sequence. When 
you select a flowsheet, all flowsheet objects (based on the 
current filter) appear in the Flowsheet Objects group.

Use this procedure to locate an object and open that object’s 
property view.

1. From the list of available flowsheets, select the required 
flowsheet.

2. In the Flowsheet Objects list, select the object you want to 
view.

3. Click the View button. The Object Navigator is closed and 
the property view for the selected object appears.

Click the Plus icon  to expand the tree browser and view 
more options.
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Use this procedure to locate an object by name.

1. Click the Find button. The Find Object property view 
appears.

2. Type the name of the object in the Object Name field.

3. Click OK. The Object Navigator is closed and the property 
view for the selected object appears.

Use any one of the following methods to access a property view 
for a specific flowsheet object. For these methods you need to 
first select the appropriate flowsheet from the Flowsheets group.

• Select the required object in the Flowsheet Objects 
group, then click the View button.

• Double-click the object in the Flowsheet Objects 
group.

• Click the Find button, then type the name of the object 
you want to locate.

When the required object is located, the Object Navigator closes 
and the property view for that stream or operation is opened.

7.18 Simulation Navigator
The Simulation Navigator lets you quickly access the property 
view of any stream or unit operation within the case. Within the 
Simulation Navigator property view, you can modify object 
parameters the same way you would in the regular object 
property view.

To access the Simulation Navigator, do one of the following:

• Click the Simulation Navigator icon in the toolbar.
• Select the Simulation Navigator command from the 

Flowsheet menu.

You can start or end the search string with an asterisk (*), 
which acts as a wildcard character. This lets you find 
multiple objects with one search. For example, searching for 
VLV* will open the property view for all objects with VLV at 
the beginning of their name.

Simulation Navigator icon
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In the Filter Types group, use the radio buttons to filter the 
flowsheet objects:

• Object Filter. Organizes the attachment tree browser by 
object type. This allows you to access all objects of a 
given type (for example, heat exchangers or vessels) 
regardless of the flowsheet they exist in.

• Status Filter. View all of the objects by status type: OK, 
Not Solved, Warning, Under Specified and Error.

• Flowsheet Filter. All the objects within a column or 
subflowsheet appear under their respective column/
subflowsheet title. The objects in the main flowsheet are 
listed in alphabetical order.

For certain objects you may need to enlarge the property view 
horizontally to see more of the property view. To resize the 
property view, place the mouse pointer at the property view 
edge, then click and drag the mouse button to resize the 
property view.

 Figure 7.50

Locates the 
selected 
object on the 
PFD.
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7.18.1 Viewing an Object
To view an object using the Simulation Navigator, do the 
following.

1. In the Filter Types group, select the required filter radio 
button.

2. From the list of available objects, select the object you want 
to view. Click the Plus icon  symbol to expand the tree 
browser and reveal more selections.

7.19 Notes Manager
The Notes Manager lets you search for and manage notes for a 
case.

You can use the Object Inspect menu (right-click) to access 
commands associated with the current property view.

 Figure 7.51
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To access the Notes Manager, select the Notes Manager 
command from the Flowsheet menu, or press the CTRL G hot 
key.

View/Add/Edit Notes

To view, add, or edit notes for an object, select the object in the 
List of Objects group. Existing object notes appear in the Note 
group.

• To add a note, type the text in the Note group. A time 
and date stamp appears automatically.

• To format note text, use the text tools in the Note group 
toolbar. You can also insert graphics and other objects.

• Click the Clear button to delete the entire note for the 
selected object. Click the View button to open the 
property view for the selected object.

Search Notes

The Notes Manager allows you to search notes in three ways:

• Select the View Objects with Notes Only checkbox (in 
the List of Objects group) to filter the list to show only 
objects that have notes.

• Select the Search notes containing the string 
checkbox, then type a search string. Only objects with 
notes containing that string appear in the object list.
You can change the search option to be case sensitive by 
selecting the Search is Case Sensitive checkbox.

• Select the Search notes modified since checkbox, 
then type a date.Only objects with notes modified after 
this date will appear in the object list.

Click the Plus icon  to expand the tree browser.

The case sensitive search option is only available if you are 
searching by string.
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7.20 Optimization Objects
The Optimization Objects property view lets you select a generic 
set of objects that identify the underlying flowsheet variable(s) 
and provide the necessary configuration information for use by 
Optim or Estim.

To access the Select Optimization Object property view, select 
the Optimization Objects command from the Flowsheet menu.

7.20.1 Adding an Optimization 
Object

1. In the Types group, select one of the optimization type radio 
buttons to determine the type of optimization object you are 
creating.

2. Click the Add button.

 Figure 7.52

You cannot add an optimization object when the All radio 
button is selected.

Refer to Chapter 2 - 
Using HYSYS.RTO in 
the HYSYS RTO 
Reference Guide for 
additional information.
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The Select object and variable property view appears.

3. Select the object and variable you want to optimize.

4. Click OK. The Optimization Object property view appears.

5. Specify the parameters defining your optimization object.

7.20.2 Editing an Optimization 
Object

1. In the Select Optimization Object property view, select the 
object you want to edit from the Objects list.

2. Click the Edit button. The Optimization Object property view 
appears.

3. Modify the parameters that define your optimization object.

 Figure 7.53

You must select an object before the variable list is 
populated.
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7.20.3 Deleting an 
Optimization Object

1. Select the object you want to delete from the list of available 
objects.

2. Click the Delete button. HYSYS prompts you to confirm the 
deletion.

7.21 Reaction Package
To access the Reaction Package property view, select the 
Reaction Package command from the Flowsheet menu. 

This property view allows you to do the following:

• Create, Copy, or Edit a Reaction
• Create, Copy, or Edit a Reaction Set
• Attach Reactions to a Reaction Set
• Make a Reaction Set available to unit operations in the 

current case

The Reaction Package property view eliminates the need to 
return to the Reaction tab of the Simulation Basis Manager to 
define reactions and reaction sets. The only aspect of defining 
reactions that must be done in the Simulation Basis Manager is 
the selection of components.

 Figure 7.54

Refer to Chapter 5 - 
Basis Environment 
in this guide and 
Chapter 5 - 
Reactions in the 
HYSYS Simulation 
Basis guide for more 
information about 
reactions and reaction 
sets.
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7.22 Fluid Package/
Dynamics Model

To access the Fluid Packages property view, select Fluid 
Package/Dynamics Model from the Flowsheet menu.

The Fluid Packages property view provides you with a summary 
of all the fluid packages in the simulation and lets you view the 
property package and components contained in each flowsheet. 
Since each flowsheet can have a different fluid and property 
package, each can also have a different flash option.  

 Figure 7.55

If flowsheets use the same fluid package, they must also use 
the same flash options.

For information 
regarding the Dynamic 
Flash options, refer to 
Section 2.4.4 - 
Stability Test Tab of 
the HYSYS Simulation 
Basis guide.

Displays all the 
flowsheets in the case.

Displays the fluid and 
property packages for the 
selected flowsheet.

Displays the 
components in 
the selected 
flowsheet.

Displays the flash 
options for the 
current fluid 
package.
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7.23 Workbook
The most concise way to display process information is in a 
tabular format. The Workbook is designed for this purpose and 
extends the concept to the entire simulation. In addition to 
displaying stream and general unit operation information, the 
Workbook is also configured to display information about any 
object type (for example, streams, pipes, controllers, and 
separators).

The Workbook becomes a collection of tabs. For example, if you 
add a tab for Separators, then every separator in the flowsheets 
appear on the tab with their current value of process variables 
displayed. To provide the greatest degree of flexibility, modify 
the variable set to show the variables of interest, or install 
multiple tabs for the same object type with varying levels of 
detail.

Not only is the Workbook useful for process analysis, but it was 
also developed as an integral element in the building and 
manipulation of your simulation. In addition to displaying the 
process information, you can make changes to specifications 
directly from the Workbook and calculations are performed 
automatically. Mechanisms were also built into the Workbook to 
provide immediate access to the property view for an individual 
stream or operation.

Key Workbook features:

• Workbook tabs can be added/deleted as required.
• Multiple tabs for a given object type are supported, 

allowing each tab to display different variables for that 
object type.

• Objects on a given Workbook tab can be sorted, hidden, 
or revealed as required.

Most of the object properties in HYSYS are calculated based 
on information entered by the user, so if there are large 
quantities of data in your workbook, then the performance of 
your simulation may be affected.

For example, extensive calculations such as Heat of Comb 
will take longer to calculate than simpler calculations.
7-58



Simulation Environment 7-59
• User defined configurations of variables for given object 
types can be stored independently of the case they were 
configured in, and read back in to any other simulation 
case.

Each flowsheet in your simulation (main flowsheet and column/
template subflowsheets) has its own Workbook. You can access 
the Workbook for any flowsheet from any location in your 
simulation.

7.23.1 Opening a Workbook
There are three ways to open a Workbook:

• Click the Workbook icon in the toolbar.
• Select the Workbooks command in the Tools menu. 
• Press the CTRL W hot key to open the Workbook for the 

current flowsheet.

The Select Workbook property view displays all flowsheets in the 
simulation. To open a specific Workbook, select the flowsheet 
containing the Workbook and click the View button.

The first time you access the Workbook, it opens to the Material 
Streams tab, displaying the basic stream information for all 
streams currently installed in the main flowsheet. The default 
Workbook also contains tabs for Compositions, Energy Streams, 
and Unit Ops.

The Workbook can be exported entirely or as individual tabs. 
When importing, the user defined configurations can either 
replace or be appended to the Workbook.

Workbook icon

Select Workbook property 
view
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When the Workbook is active, the Workbook menu appears in 
the menu bar. The commands associated with this menu are 
described below:

 Figure 7.56

Command Description

Setup Opens the Setup property view allowing you to manage the 
tabs in your Workbook. Refer to Section 7.23.5 - 
Managing Workbook Tabs for more information.

Export Accesses a submenu containing the Workbook and Pages 
commands. These commands let you save a Workbook or 
page setup. Refer to Section 7.23.7 - Exporting/
Importing Workbook Tabs for more information.

Import Accesses a submenu containing the Workbook and Pages 
commands. These commands replace the current 
Workbook or page setup with a saved setup. Refer to 
Section 7.23.7 - Exporting/Importing Workbook Tabs 
for more information.

Indicates where 
you can type in 
a name to 
create a new 
Stream.

The Workbook is a resizable property view. Place the 
mouse pointer over the border and drag to resize.

In the case of a stream, this field indicates which unit 
operations the active stream is attached to 
(FeederBlock and ProductBlock indicates that no unit 
operation is connected to that side of the stream). In 
the case of a unit operation, this field indicates which 
streams are attached to the active unit operation.
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7.23.2 Installing Streams or 
Operations

Material Streams
Use this procedure to install a new stream using the Workbook.

1. Click the Material Streams tab.
2. Click the **New** cell and type the stream name. 

3. Press ENTER or click any other cell to complete your input.

4. Specify values for three of the properties in the table with at 
least one of the specifications being temperature or 
pressure.

5. Specify the composition of the stream.

Operations
Use this procedure to install a new unit operation through the 
Workbook:

1. Click the Unit Ops tab. 
2. Click the Add UnitOp button. The UnitOps property view 

appears.

If the unit operation category is known, selecting the 
corresponding radio button in the UnitOps property view 
filters the list of available unit operations. For example, click 
the Heat Transfer Equipment radio button to display only 
unit operations associated with heat transfer.

Page Scope Accesses a submenu containing the Show/Hide Sub-
Flowsheet Objects commands. This toggle function either 
shows or hides subflowsheet objects on the active 
Workbook tab. Refer to the Viewing Subflowsheet 
Objects section for more information.

Order/Hide/
Reveal 
Objects

Opens the Order/Hide/Reveal Objects property view 
allowing you to sort the Workbook objects either 
alphabetically or manually, hide Workbook objects and 
reveal Workbook objects. Refer to Section 7.23.6 - 
Sorting Information for more information.

Command Description
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3. From the list of available unit operations, click the operation 
you want to install.

4. Click Add. The operation is added to the Workbook and the 
operation’s property view automatically opens.

7.23.3 Deleting Streams or 
Operations

Streams
To delete a stream from the Workbook:

• Right-click any cell associated with the stream you want 
to delete. From the Object Inspect menu, select the 
Delete command.

• Click the Name cell associated with the stream you want 
to delete and press the DELETE key on the keyboard.

A confirmation message appears to ensure the deletion is 
intended.

Operations
To delete a unit operation from the Workbook:

• Click any cell associated with the unit operation you want 
to delete and click the Delete UnitOp button.

• Click the name cell associated with the unit operation you 
want to delete and press the DELETE key on the 
keyboard.

HYSYS prompts you to confirm the deletion.

To delete objects without confirmation, clear the Confirm 
Delete checkbox on the Simulation page of the Session 
Preferences property view. Access the Session Preferences 
property view by selecting the Preferences command from 
the Tools menu.

Object Inspect menu
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7.23.4 Accessing Streams or 
Operations

You can access both streams and unit operations from any of the 
default Workbook tabs.

You can access the property view for a material stream directly 
from the Material Streams and Compositions tab. From this 
location, you can also access the Input Composition property 
view, as well as open the property view for any operation 
attached to a stream.  

 Figure 7.57

 Figure 7.58

Double-click any stream cell 
(except the material flow cells) to 
open the property view for that 
stream.

Double-clicking the material flow 
cells opens the Input Composition 
property view with units defaulted 
to the selected flow type.

Double-click DEHYDRATOR to open 
its property view.

Double-click the 
name cell to 
access the 
stream property 
view.

Double-click or 
start typing in a 
composition cell to 
open the Input 
Composition 
property view for 
the stream.

Double-click the 
unit operation 
name to access its 
property view.

Right-click any 
cell and select 
the View 
command to 
display the 
stream property 
view.
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Access the energy stream property views from the Energy 
Streams tab. The property views for unit operations that the 
energy streams are attached to can also be accessed through 
this tab.

The same capabilities are found on the Unit Ops tab. You can 
access each operation’s property view by double-clicking in the 
appropriate row. The property view of any stream that is 
attached to a unit operation can also be opened from this tab.

 Figure 7.59

Double-click a cell to open 
the energy stream property 
view.

Right-click a cell and select 
the View command to 
access a property view.

Double-click on the unit 
operation name to access 
its property view.

 Figure 7.60

Double-click the Name 
cell, Object Type cell or 
Calc. Level cell to access 
the Unit Operation 
property view.

Open the property view of the first stream listed by double-clicking 
the Inlet or Outlet cell.

Double-click a name to 
access the stream 
property view.
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Viewing Subflowsheet Objects
From the Workbook in the main environment, you can view 
information for subflowsheet items. You can display 
subflowsheet information by clicking the Include Sub-
Flowsheets button, located in the lower right corner of the 
Workbook. This includes all of the information from the 
subflowsheet with the information from the main flowsheet.

The functionality of the Include Sub-Flowsheets button is not 
global to the entire Workbook. With each tab, you can include 
the subflowsheet objects.

To hide the subflowsheet objects from a Workbook tab, click the 
Include Sub-Flowsheets button again.

You can also view or hide subflowsheet items on a Workbook tab 
by using the commands in the Workbook menu, select 
Workbook | Page Scope | Show/Hide Sub-Flowsheet 
command as shown below. 

The command to display subflowsheet objects must be 
repeated on each individual Workbook tab.

 Figure 7.61

When the Include Sub-Flowsheets option is selected, the 
Composition tab only displays results if a common fluid 
package is shared by the subflowsheets and the main 
environment in the case. Since different fluid packages can 
contain both different types and numbers of components, it 
is not possible to display the compositions in the same form.
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Show Name Only
To simplify the search for a particular stream or unit operation, 
click the Show Name Only button, located in the lower right 
corner of the Workbook. 

This button hides all object data except the object name. Place 
the cursor on the name of the chosen object and click the Show 
Name Only button again. All object data re-appears and the 
cursor remains on the selected object.

The functionality of the Show Name Only button is not global to 
the entire Workbook. With each Workbook tab, you can show 
either just the object name or all object data.

7.23.5 Managing Workbook 
Tabs

The Workbook Setup property view lets you add, delete, and 
customize the tabs in the Workbook. To access this property 
view, do the following:

• Select the Setup command from the Workbook menu.
• Right-click any of the tabs available in the Workbook. 

From the Object Inspect menu click the Setup 
command.

The Show Name Only button is not available on the Unit Ops 
tab.
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Adding a New Tab to the Workbook
1. From the list of available Workbook tabs, click the tab you 

want to insert the new tab before.
2. Click the Add button in the Workbook Tabs group to 

display the New Object Type property view.

3. Click the object that is the subject of the tab. Click the 
Expand icon  to view the additional sub-items.

4. Click Expand icon  next to the Stream object type. The 
list appears as shown in the figure below (on the right). 

 Figure 7.62

 Figure 7.63

This is the 
newly typed 
name.

The name of 
the Object Type 
appears.

The default variable set for streams is filled.

Format cells 
indicate the 
precision of the 
variable.
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The Material and Energy Stream options appear in the list.

5. Click the Material Stream object type and then click the OK 
button. You return to the Setup property view and the new 
tab appears in the list of available tabs.

6. The tab is named Material Streams 2, since there is 
already a Material Streams tab. To change the tab name, 
click the Name field and type a new name for the tab.

7. Click the Close icon  to return to the Workbook. The newly 
added tab is active.

Editing a Workbook Tab
Use the Setup property view to edit the tabs in your Workbook 
by adding, deleting, and sorting variables on the Workbook tab. 
Tabs can contain default variable sets or user-defined variable 
sets. 

You can define the format of each variable and modify the 
name, type, and order of tab objects.

1. From the list of available Workbook tabs, select the tab you 
want to edit.

2. Click the New Type button to change the object type of the 
tab. The New Object Type property view appears. 

3. From the list of available objects, select the new object type, 
then click OK.

4. Click the Use Set button to display the Use Set property 
view. This property view lets you select a pre-defined 
variable set.

Changes cannot be made to the default Unit Ops Workbook 
tab.

 Figure 7.64

Refer to Section 7.23.6 - 
Sorting Information for 
details on sorting objects 
and variables.
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5. From the list of available variable sets, select the variable set 
being used, then click OK. The Use Set property view closes 
and the variables appear in the Variables table.

6. To add a variable to the variable set, click the Add button in 
the Variables group. The Select Variables property view 
appears. 

7. Select the variable and any variable specifics you want to 
add to the variable set, then click OK.

8. To change the format of the variables value, click the 
Format button The Real Format Editor appears. Specify the 
number of significant digits, a fixed number of decimal 
places or have the variable display in exponential form. 

9. Make any necessary changes and click OK, or click the Use 
Default button for application defaults.

 Figure 7.65

 Figure 7.66

From this list select the variable to add to the Workbook tab.

The Single radio button lets 
you add one variable to the 
variable set.

You can change the variable label by typing the new name in the 
Description field. This is useful for changing long default names.

The All radio button lets you add 
all available variables to the 
variable set.

Refer to Section 10.5 - 
Format Editor for details 
on the Real Format Editor.
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Deleting Variables
1. From the list of available variables, click the variable you 

want to delete. Select more than one variable at a time by 
holding down the CTRL key, and clicking each variable. 

2. Click the Delete button.

Deleting a Tab from the Workbook
1. From the list of available Workbook tabs, select the 

Workbook tab you want to delete.
2. Click the Delete button in the Workbook Tabs group.

7.23.6 Sorting Information
Workbook tabs can be sorted independently. You can sort the 
objects on a tab or you can set the order of the variables on a 
tab.

Sorting Objects

To sort the objects of a tab:

1. Open the Order/Hide/Reveal Objects property view using 
one of the following methods:
• Select the Order/Hide/Reveal Objects command 

From the Workbook Menu.
• Use the Order/Hide/Reveal command in the Object 

Inspect menu that appears when you right-click any 
Workbook tabs or cells.

• Click the Order button in the Object group of the Setup 
property view.

There is no confirmation message when you delete a 
Workbook tab and deleted tabs cannot be recovered.

If the Workbook tab is sorted alphabetically, objects 
continue to be sorted automatically following any ensuing 
name changes.
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2. Use the radio buttons in the Sorting group to specify the 
sorting method being used.

• Manual. From the list of revealed objects, select an 
object (or multiple objects) using the Up Arrow and 
Down Arrow icons to manually move the selected 
object(s) through the list.

• Alphabetical Ascending. Sorts the names of the 
objects in alphabetically ascending order. Objects with 
numerical names are listed first.

• Alphabetical Descending. Sorts the names of the 
objects in alphabetically descending order. Objects with 
numerical names are listed last.

Hiding & Revealing Objects
To hide an object:

1. From the list of revealed objects, select the object(s) you 
want to hide. Select more than one at a time by holding 
down the CTRL key and clicking each object being selected.

2. Click the Hide button. The selected object(s) appear(s) in 
the Hidden list.

To reveal a hidden object:

1. From the list of hidden objects, select the object(s) you want 
to reveal. Select more than one at a time by holding down 
the CTRL key and clicking each object being selected.

2. Click the Reveal button. The selected object(s) appears in 
the Revealed list.

 Figure 7.67

Up Arrow and Down 
Arrow icons
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Sorting Variables
1. Select Setup from the Workbook menu. The Setup 

property view appears.
2. From the list of available Workbook tabs, select the 

Workbook tab with the variables you want to sort.

3. Click the Order button in the Variables group. The Move 
Variables property view appears as shown below.

4. From the list of available variables, select the variable(s) you 
want to move. Select more than one at a time by holding 
down the CTRL key and clicking each variable being 
selected.

5. Click the Up Arrow or Down Arrow icon.

7.23.7 Exporting/Importing 
Workbook Tabs

HYSYS allows you to import and export Workbook information. 
This same Workbook setup can then be used in other simulation 
cases.

If variables were added to the Workbook tab as a group (in 
other words, component molar flows), then you cannot move 
these individually, but only as a group.

 Figure 7.68

Up Arrow and 
Down Arrow icons
7-72



Simulation Environment 7-73
Exporting a Workbook
1. From the Workbook-Export sub-menu, select the 

Workbook command. The Save File property view appears.
2. Specify a name and location for your Workbook file.

3. Click Save.

Exporting a Workbook Tab
1. From the Workbook-Export sub-menu, select the Pages 

command. The Export Pages property view appears.

2. Click the Export checkbox by the name of the tab you want 
to export.

• Click the Select All button to select all of the 
checkboxes. 

• Click the Deselect All button to clear all of the 
checkboxes.

3. Click the Export button. The Save File property view 
appears.

4. Specify a name and location for your Workbook file and click 
Save.

The format for the *.wrk files does not change for an 
exported Workbook or individual exported pages. This 
means existing *.wrk files are completely backwards and 
forwards compatible, as well as interchangeable for 
Workbook or Workbook page importing.

 Figure 7.69
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Importing a Workbook
1. From the Workbook-Import sub-menu, select the 

Workbook command. The Open File property view appears.
2. Browse to the location of your Workbook file (*.wrk).

3. Select the file you want to import and click Open.

Importing a Workbook Tab
1. From the Workbook-Import sub-menu, select the Pages 

command. The Open File property view appears.

2. Browse to the location of your Workbook file (*.wrk).

3. Select the file you want to import and click Open. 

7.24 PFD
The Process Flow Diagram (PFD) is the default property view 
when you first enter the Simulation environment. The PFD 
provides the best representation of the flowsheet as a whole. 
Using the PFD gives you immediate reference to the progress of 
the simulation currently being built, such as what streams and 
operations are installed, flowsheet connectivity, and the status 
of objects.

Any PFD in the simulation can be accessed from any location in 
the Simulation environment by clicking the PFD icon or using 
the CTRL P hot key.

The imported Workbook replaces the existing one.

A unique-naming function is available to distinguish 
imported pages from pre-existing pages with the same 
name.

The imported Workbook tabs are added to the existing 
Workbook.

PFD icon
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In addition to graphical representation, you can build your 
flowsheet within the PFD using the mouse to install and connect 
objects. A full set of manipulation tools is available so you can 
reposition streams and operations, resize icons, or reroute 
streams. All of these tools are designed to simplify the 
development of a clear and concise graphical process 
representation.

The PFD also possesses analytical capabilities. You can access 
property views for streams or operations directly from the PFD, 
or install custom Material Balance Tables for any or all objects. 
Complete Workbook pages can also be displayed on the PFD and 
information is automatically updated when changes are made to 
the process. 

There are several ways you can track a specific variable 
throughout the PFD, including replacing stream name labels or 
designating a colour to represent a variable range.

Every flowsheet (or subflowsheet) has its own PFD, so you can 
access any flowsheet’s PFD from any location. You can also use 
the multi-flowsheeting architecture to provide clear and concise 
representations of complex simulations. Instant access to the 
subflowsheet PFD is available through Object Inspect menu of 
the main flowsheet’s PFD.

7.24.1 Custom PFD Notebook
You can customize the PFD into a Notebook by adding new tabs. 
Using multiple tabs allows for flexibility when dealing with large 
and complex flow diagrams. For example, one PFD can be used 
as the main tab for the entire process, while subsequent tabs 
deal with more specific areas.

The PFD is the default property view that appears when you 
enter the Simulation environment. You can change the 
Simulation environment default property view in your 
Session Preferences. 

Refer to Section 12.2.3 - 
Desktop Page for 
additional information.

For information 
regarding manipulating 
PFDs, see Section 10.3 
- Editing the PFD.
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Notebooks are also useful when you want each PFD to have a 
distinct colour scheme for an identical object’s setup.

Installing a New PFD
To add a new PFD to the Notebook:

1. From the PFD menu, select Add a PFD. The Add a PFD 
property view appears.

2. In the New PFD Name field, type the name of your PFD.

3. Click the OK button.

• If you want your new PFD to be a clone of an existing 
PFD, select the Clone from Existing PFD checkbox. 
From the list of available PFDs, select the PFD you want 
to clone and click OK.

• If you just want to create a new blank PFD, ensure the 
Clone from Existing PFD checkbox is clear.

A new tab appears with the specified name and the new PFD 
becomes the active property view.

Each PFD is an independent element in that objects can be 
moved or hidden without changing the appearance of the 
other tabs. However, when multiple PFDs exist, an object 
added to one PFD appears on all PFDs.

 Figure 7.70

Cloning a PFD produces an exact duplicate of the selected 
PFD.
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Deleting a PFD
Unlike the deletion of a single object, deleting a PFD removes it 
from the Notebook, but does not remove the associated objects 
from the simulation case.

1. Click the PFD tab that you want to delete.

2. Do one of the following:

• Select Delete this PFD from the PFD menu.
• Right-click the PFD tab, and select Delete this PFD.

Renaming a PFD
If the name of the PFD is not changed when it is added, or if the 
name of the original PFD is not suitable, it can be changed.

1. Make the PFD active by selecting its tab.
2. Select Rename this PFD from the PFD menu. The PFD 

Name property view appears.

3. In the Current PFD Name field, type the new name of the 
PFD.

4. Click the Close icon  to return to the PFD.

You cannot recover a deleted PFD.

The delete option is not available if there is only one PFD in 
the Notebook.

 Figure 7.71
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7.24.2 Locating Objects in PFD
The Select Objects command in the PFD Object Inspect menu 
enables you to find objects in the PFD.

To access the locating option in the PFD:

1. Open the PFD of the simulation case.
2. Right-click in any empty area of the PFD to access the Object 

Inspect menu.

3. Click the Select Objects command.

The Select Objects property view appears.

4. Select the object you want from the list and click the OK 
button.

The object you are looking for will be selected on the PFD 
and will have a blinking white frame around it.

7.24.3 Flowsheet Analysis 
Using the PFD

After installing your streams and operations in the PFD, you 
need to supply specifications. Specifications are entered using 
the Workbook or an object’s property view. Property views are 
accessed through the PFD, so you can keep the PFD open while 
supplying the necessary object information. Tables containing 
specified variables for streams and operations can also be 
installed in the PFD.

 Figure 7.72

You can select the 
appropriate radio 
button to filter the 
objects in the 
Objects To Select 
list.
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Accessing Stream & Operation 
Property Views
Open the property views directly from the PFD by double-
clicking the object icon. Also, you can right-click on an object’s 
icon and select View Properties from the Object Inspect menu 
that appears, as shown in the following figure. 

View the property view for a stream by double-clicking the 
stream icon or by right-clicking any portion of the line that 
represents the stream and selecting the View Properties 
command from the Object Inspect menu.

You can also use the Object Status Window to open property 
views. Move the cursor to the thick border (directly above the 
status bar at the bottom of the Desktop) and it changes to a 
vertical line with two arrowheads. Click and hold the mouse 
button while dragging the cursor upward to expand the Object 
Status and Trace Windows. 

 Figure 7.73

You can also press the V or E key to open the property view 
of a single selected object in the PFD property view.

Stream Object 
Inspect menu

Unit Operation Object 
Inspect menu

Refer to Section 1.3 - 
Object Status & Trace 
Windows for details 
about these windows.
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The left pane is the Object Status Window and contains status 
messages for the various streams and operations. By double-
clicking a message, the property view for the associated object 
appears.

Deleting Streams & Operations
You can delete streams and operations from the case in the PFD 
by doing either of the following: 

• Select the object being deleted and press the DELETE 
key on the keyboard.

• Right-click the object and select Delete from the Object 
Inspect menu, as shown on the left.

Using either method, you are prompted to confirm the deletion 
of the object. If multiple objects are being deleted at once, you 
must confirm each deletion. 

Fly-by Information
You can view Information related to an object by placing the 
cursor over its associated icon. A small box listing the object 
name and the current values of key variables appears. This box 
is called a Fly-by. 

The Object Status Window option is not available after the 
case solves. At this point, all object status messages are OK 
and are no longer displayed in the window.

Deleting an object is a global function, so if an object is 
deleted from a PFD, it is removed not only from all PFDs, but 
from the simulation case.

The controls for the Fly-by are found in the Session 
Preferences.

Refer to Section 12.2.5 - 
Tool Tips Page for more 
information.
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The Fly-by of a heat exchanger is shown below.

7.24.4 Access Column or 
Subflowsheet PFDs

Right-clicking a column (or subflowsheet template) in the main 
PFD displays an Object Inspect menu similar to the one for 
streams and operations, but with the addition of two options: 

• Open PFD command opens the separate column or 
subflowsheet PFD into the case (main) environment.

• Show sub-FlowSheet Objects command displays all 
subflowsheet objects (for example, streams, unit 
operations, tables, and text) in the main flowsheet. This 
allows all subflowsheet streams and operations to be 
viewed and accessed from the main PFD without entering 
the subflowsheet environment.

To hide subflowsheet objects displayed in the main PFD, right-
click the tip of any subflowsheet stream connected to the main 
flowsheet. The tip of the stream has a small square visible. 
When you right-click, the Hide sub-FlowSheet Objects 

 Figure 7.74

 Figure 7.75

A reasonable arrangement of icons on the PFD 
should be preserved using the Show sub-
FlowSheets option, however, for complex 
subflowsheets the icon layout can become 
crowded and may need to be re-arranged 
manually.
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command appears. Clicking this command hides all associated 
subflowsheet objects.

Column Subflowsheet
The external property view of the Column resides in the main 
PFD. Only the external streams of the Column appear (in other 
words, Inlet, Outlet, and Energy streams), however, the Column 
has a unique PFD that displays the complete representation of 
the column flowsheet internal property view, including reboilers 
and condensers.

The Column PFD displays the Columns internal streams, such as 
Boilup and Reflux. Also, in the Column PFD, the Column stages 
appear.

7.24.5 Opening Controller Face 
Plates

Controllers can also be right-clicked like streams, operations, 
and columns. The commands available are the same as those 
associated with the other operations, except for the addition of 
the Face Plate command. Selecting this command opens the 
face plate of the selected controller.

 Figure 7.76

When the column PFD is accessed from the main flowsheet, 
you are not able to modify internal subflowsheet 
connections. You must enter the column subflowsheet to 
perform such tasks as adding or deleting objects and 
breaking stream connections.

Appearance of subflowsheet stream 
tip within main flowsheet PFD. 
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7.24.6 PFD Colour Schemes
By viewing the colour schemes on the PFD, you can retrieve 
specific information about your case. The type of information 
that is available depends on the selected colour scheme. 

For example, in default mode, a unit operation can be red, 
indicating a serious status message associated with the object. 
The red status can indicate that the object requires the 
attachment of a material or energy stream. The benefit of the 
colour scheme in the PFD is greatly enhanced if the Object 
Status Window is also open. The object colour combined with 
the information provided in the Object Status Window is helpful.

There are three colour scheme options supplied with HYSYS:  

Each PFD can have its own distinct colour scheme.

Scheme Description

Default 
Colour 
Scheme

The colour of unit operations and streams is changed to 
reflect the status of the object. Unit Ops are red if a serious 
message is in the Object Status Window, outlined in yellow 
if a warning message exists, and completely grey if the 
object has solved. A Stream icon appears light blue if 
unsolved and dark blue if solved.

PFD default colours can be changed on the Colours page of 
the Session Preferences property view. 

Colour Scheme icon

Refer to Section 12.6.1 - 
Colours Page for more 
information.
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HYSIM 
Colour 
Scheme

Streams and unit operation icons are shown as wire frames 
and the colours can be changed. Right-click an object and 
click the Change Colour command. The colour palette 
appears and a new colour can be selected. Select an 
existing colour or click the Define Custom Colours button to 
customize a colour. After a colour is selected, click the OK 
button. The new colour for the wire frame appears.

Simultaneously change the colour of multiple wire frames 
by selecting all of the required objects.

Query Colour 
Scheme 

The value of a specified variable can be monitored for all 
material streams. You can select five colours and an 
associated variable range for each. 

For the example given in the figure above, the top colour 
(Colour 1) appears for material streams that have a 
temperature greater or equal to 300°C. Colour 2 represents 
streams ranging from 200 to 300°C. The last colour (Colour 
5) is shown for streams that have temperatures below 0°C.

The Temperature colour scheme (shown in the Colour 
Scheme drop-down list when the PFD is accessed), is a 
Query scheme.

Scheme Description
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Selecting/Changing a Colour 
Scheme
The Default Colour Scheme is active when the PFD is first 
accessed. There are two ways of switching to another scheme:

• Click the Colour Scheme icon in the toolbar. The PFD 
Colour Schemes property view appears. From the 
Current Scheme drop-down list, select a colour scheme. 
Click the Close icon  to return to the PFD.

• Click the colour scheme drop-down list located in the PFD 
toolbar. Select a colour scheme from the list.

When the simulation case is saved, the active colour scheme for 
each PFD is also stored.

Adding a Query Colour Scheme
You can add a colour scheme that tracks a key material stream 
variable throughout the PFD.

1. Click the Colour Scheme icon in the toolbar. The PFD Colour 
Schemes property view appears.

2. Click the Add a Scheme button. The Select Query Variable 
property view appears.

3. From the list of available variables, select the variable you 
want to monitor. Some variables require a qualifier such as 
the Comp Mole Frac variable, which requires a component 
from the list of variable specifics.

 Figure 7.77

The Delete this Scheme and Edit this Scheme buttons appear 
for query colour schemes only.

Colour Scheme icon
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4. Click the OK button. The Edit PFD Colour Scheme property 
view appears.

5. Input the appropriate values in the variable range fields.

6. To change the colour of the variable range, double-click a 
colour to access the colour palette. Changes can also be 
made to the scheme name and to the variable.

7. Click the Close icon  to return to the PFD Colour Schemes 
property view. The new colour scheme is active.

8. Click the Close icon  to return to the PFD.

Deleting a Query Colour Scheme
1. Click the Colour Scheme icon in the toolbar. The PFD Colour 

Schemes property view appears.
2. Select a colour scheme from the Current Scheme drop-down 

list.

3. Click the Delete this Scheme button. 

Editing a Query Colour Scheme
1. Click the Colour Scheme icon in the toolbar. The PFD Colour 

Schemes property view appears.
2. Select a colour scheme from the Current Scheme drop-down 

list.

 Figure 7.78

Delete button appears only when a Query Colour Scheme is 
selected.

Ensure the correct scheme is selected before deleting. You 
cannot recover deleted schemes.

Variable 
range fields

Colours that 
represent the 
variable 
ranges.

For details about available 
colour scheme changes, 
refer to the Editing a 
Query Colour Scheme 
section.

Colour Scheme icon
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3. Click the Edit this Scheme button. The Edit PFD Colour 
Scheme property view appears as shown previously in 
Figure 7.78.

4. In this property view, edit the scheme name, query variable, 
variable ranges, and variable range colours. 

5. After all changes are made to the query colour scheme, click 
the Close icon  to return to the PFD Colour Schemes 
property view.

6. Click the Close icon  on the PFD Colour Schemes property 
view to return to the PFD.

7.24.7 Column Tray Section 
Display

In the column subflowsheet, you can right-click the individual 
components of the Column (for example, Tray Section, 
Condenser, and Reboiler). The Object Inspect menu of the Tray 
Section provides two additional commands: Show Trays and 
Compress/Expand as shown below.

Edit button appears only when a Query Colour Scheme is 
selected.

Only one colour can be changed at a time.

 Figure 7.79

Refer to Adding a Query 
Colour Scheme in the 
previous section for more 
information.
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Click the Show Trays command to open the Stage Visibility 
property view.

Click the Expand option to expand the column to the full size, 
showing all trays. Click the Compress option to compress the 
column to the settings in the Stage Visibility property view. Only 
the selected trays will appear.

7.24.8 PFD Tables

Workbook Table
You can display any full Workbook tab as a table on the PFD 
except for the Unit Ops tab. All information on the Workbook tab 
is shown in the table and is automatically updated when 
changes occur in the flowsheet.

 Figure 7.80

When this radio button is 
selected, the Column 
appears showing each 
tray. For instance, a 10-
tray column shows trays 1 
through 9 on the PFD.

When this radio button is 
selected, you can 
compress the column tray 
section displayed on the 
PFD.

Instead of individually 
selecting all the 
checkboxes, use these 
buttons to select or clear 
all the stages in the 
Column.

Select the checkbox for 
each tray you want to 
display on the PFD.

This group can only be 
accessed when the 
Selected Expansion radio 
button is selected.

HYSYS always draws the 
column showing the first 
and last stages, as well as 
feed and draw stages.

If the tray section shown is compressed, the command at the 
bottom of the menu is Expand. If the section is fully 
expanded, the command is Compress.
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Add a Workbook Table to the PFD
1. Right-click to open the PFD Object Inspect menu and select 

Add Workbook Table. The Select Workbook Page property 
view appears.

2. Click the name of the tab being added, then click the Select 
button as shown below. After the Workbook table is added, 
click and drag it to the necessary location.

When you right-click a Workbook table, the Object Inspect 
menu shows the following options:

• Hide. Hides the Workbook table.
• Change font. Changes the font of the text in the table.
• Change colour. Opens the colour palette so you can 

change the text and table border colours.

Object Variable Table
Install a table for any object in the PFD by right-clicking the 
stream or operation and clicking the Show Table command as 
shown on the left. Each object type has a default variable list 
associated with it. 

 Figure 7.81

The Select Workbook 
Page property view 
appears.
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The table shown below is for a Separator.

You can modify the list of displayed variables as well as the table 
appearance by right-clicking to access the table’s Object Inspect 
menu. The menu contains the following options.

Table Properties

To open the PFD Table property view by double-clicking on the 
table. A default variable set is provided for each stream and 
operation type. 

 Figure 7.82

Table Menu Item Description

View Properties Access the various properties available for the tables. 
Refer to the Table Properties section for more 
information.

Hide Table Temporarily hides the table on the PFD. When the table 
is revealed, it is shown as it was before it was hidden.

Change Font Change the font for the text in the table.

Change Colour Open the colour palette, and change the colour of the 
Table text, and the Table outline.

If you are having trouble selecting a table, ensure you are 
not in Attach mode.

Table Object Inspect 
menu
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To modify this list, right-click the table and select the View 
Properties command.

Use the buttons available in the property view to modify the 
variable set for the table. Refer to the following table for the 
description of each button:

 Figure 7.83

Toggle the 
checkboxes on 
and off to 
control these 
table properties.

Adds a new 
variable to the 
table.

Removes the selected variable 
from the table.

Button Button Usage Views/Remarks

Add 
Variable

To add a variable to the table:

1. Click the Add Variable button. The Variable 
Navigator property view appears.

2. From the list of available variables, select the 
variable you want to add to the table.

3. Make any required changes to the variable 
description in the Description field.

4. Click the OK button to return to the PFD Table 
property view.

The Add Variable option lets you add only one 
variable at a time to the table.

Remove 
Var

Removes variables from the table. Select the 
variable(s) to remove from the table, and click the 
Remove Var button.

(Select more than one variable at a time by 
holding down the CTRL key, and then clicking 
each variable you want to select.)

You are not prompted to confirm the 
deletion of variables from the table.
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Column Tables
Column tables can be added in the main PFD and in the column 
PFD. The tables that can be added are different in each 
environment. For example, in the main PFD, the column table 
consists of variables relating to the column tray section.

Inside the column PFD, you can add tables for the Condenser, 
Tray Section, and Reboiler. Each of these can contain variables 
specific to that unit operation.

Use Set Default variable sets are provided and accessed by 
clicking the Use Set button. The list of variable 
Sets differs, depending on the object type 
(stream, unit operation, column, or controller). To 
change to a default variable set, select variable set 
from the list and click the OK button.

The sets shown above applies to a 
Separator.

Sort Use to reorganize variables in the table. Select the 
item(s) being moved in the Move Variable field. In 
the Before field, select the variables that are in 
front of the variables being moved and click the 
Move button.

(Select more than one variable at a time by 
holding down the CTRL key, and then clicking 
each variable you want to select.)

Format Change the numeric format of a value. Select the 
variables being changed from the table. Click the 
Format button. The Real Format Editor appears. 
In the Format Specification group, select one of 
the following radio buttons: Exponential, Fixed 
Decimal Point, or Significant Figures. Each 
selection requires you to specify information to 
fully define the selection. Click the OK button.

Button Button Usage Views/Remarks
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7.24.9 Multi-Pane PFDs
The PFD interface lets you separate the PFD property view into a 
maximum of four panes. Each pane contains all the information 
concerning the PFD (for example, operations and connections), 
but operates independently in regards to the area of focus or 
zooming.

New panes are created using the manipulation areas located on 
the border edge of the PFD property view. The PFD appears with 
two borders. The manipulation areas are located along the inner 
border. You can split the PFD once vertically and once 
horizontally, for a maximum of four panes. Each new pane 
created has its own zoom and scroll buttons. This enables the 
various property views to be at different zoom levels or locations 
in the overall PFD.

When the cursor is over the inside border of the PFD, the pointer 
changes into the multi-pane sizing tool. The symbol is rotated 
90 degrees for a horizontal split. 

The Status Bar in the bottom of the screen indicates the way the 
split occurs.

Since each pane is simply a different representation of the 
same flowsheet, you can interact across property views. In 
other words, you can connect an operation in one pane to an 
operation in another pane.

Multi-Pane Sizing Tool
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There is no requirement for how you initially split the PFD. For 
description purposes, a pane that is created by dragging 
vertically is termed a horizontally split pane, and one created by 
dragging horizontally is termed a vertically split pane.

Working Across Panes
The splitting of PFD panes becomes useful when the PFD is 
complex and you cannot view it entirely without making it very 
small. When working in split panes, remember that all the panes 
interact with each other. This enables you to connect an 
operation or stream in one pane to an operation or stream in 
another. Changes made in one pane are made in the overall 
PFD.

 Figure 7.84

By creating split panes within your PFD, you can focus on 
different sections of the PFD in each pane.

Each Pane has its own zoom 
and scrolling buttons.

2. By placing the cursor over the inside border and then dragging 
horizontally, a second pane of the PFD is created.

1. The third and fourth Panes 
can be created by dragging 
from the inside border of the 
PFD property view.
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Resizing or Closing Split Panes
After panes are created, they can be resized or closed. To resize 
or close a vertically split pane, place the cursor on the right side 
of the vertical scroll bar (in the split pane). The Multi-Pane 
Sizing Tool cursor appears. Drag it left or right to change the 
existing property view. Dragging to the extreme right closes the 
right split pane. 

The procedure is the same for a horizontally split pane, except 
you place the cursor on the bottom of the horizontal scroll bar 
and drag up or down. Dragging to the bottom of the original PFD 
property view closes the bottom split pane.

7.24.10 Exchanging XML Files
When you right-click any object on the PFD, the Object Inspect 
menu appears. When you select the XML Data Exchange 
command, the XML File Exchange property view appears. 

Select the information you want to export or import to the XML 
file by clicking the corresponding checkboxes. You can change 
the file name and location by entering the new name and file 
path in the File field.

Click the Export button to export the file, the Import button to 
import the file, or the Cancel button to close the property view 
without completing the action.

 Figure 7.85

Multi-Pane Sizing Tool 
cursor
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7.25 Column
This menu item only appears inside the Column environment. 
The options under Column are as follows:

7.26 Utilities
The utilities available in HYSYS are a set of useful tools that 
interact with your process, providing additional information or 
analysis of streams or operations. A utility becomes a 
permanent part of the flowsheet, automatically recalculating 
when conditions change in the stream or operation that it is 
attached to. You can access utilities using any of the following 
methods:

• Select the Utilities command from the Tools menu.
• Press the CTRL U hot key.
• Click the Create button on the Utilities page of the 

Attachments tab of a Stream property view.

7.26.1 Adding Utilities
There are two ways to add utilities: add the utility in the Stream 
property view or in the Available Utilities property view.

Command Description

Column Runner View the Column Runner.

Run Start the Column Solver.

Reset Reset the Column Solver.

Refer to Chapter 2 - 
Column Operations in 
the HYSYS Operations 
Guide for more 
information.

Refer to Chapter 14 - 
Utilities in the HYSYS 
Operations Guide for 
detailed information about 
the individual utilities.
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Using the Stream Property View
1. Open the property view for the stream, and go to the 

Utilities page of the Attachments tab.

2. Click the Create button. The Available Utilities property view 
appears as shown on the left.

3. From the list of available utilities, select the utility you want 
to add.

4. Click the Add Utility button. The property view for the 
selected utility appears.

5. Define the utility as required.

Not all utilities can be accessed through the Stream property 
view.

 Figure 7.86

Available Utilities property 
view for stream
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Using the Flowsheet
1. Select the Utilities command from the Tools menu. The 

Available Utilities property view appears.

2. From the list of available utilities, select the utility you want 
to add.

3. Click the Add Utility button. The property view for the 
selected utility appears.

4. Define the utility as required.

7.26.2 Viewing Utilities
There are two ways to view utilities: from the Stream property 
view or the Available Utilities property view.

Using the Stream Property View
1. Open the property view for the stream.
2. Click the Attachments tab and select the Utilities page.

3. From the list of attached utilities, select the utility you want 
to edit.

 Figure 7.87

The property view for a Utility can remain open 
independently of the stream to which it is attached. 

List of utilities 
that are 
added to the 
case.

List of 
available 
utilities.
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4. Click the Edit button. The property view for the selected 
utility appears.

Using the Flowsheet
1. Select the Utilities command from the Tools menu. The 

Available Utilities property view appears.
2. From the list of attached utilities, select the utility you want 

to edit.

3. Click the View Utility button. The property view for the 
selected utility appears.

7.26.3 Deleting Utilities
There are two ways to delete the utilities: delete the utility in 
the Stream property view or in the Available Utilities property 
view.

Using the Stream Property View
1. Open the property view for the stream.
2. Click the Attachments tab, then select the Utilities page.

3. From the list of attached utilities, select the utility you want 
to delete.

4. Click the Delete button. You are not prompted to confirm 
the deletion of a utility.

Using the Flowsheet
1. Select the Utilities command from the Tools menu. The 

Available Utilities property view appears.
2. From the list of attached utilities, select the utility you want 

to delete.

3. Click the Delete Utility button. You are not prompted to 
confirm the deletion of a utility.
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8.1 Installing Objects
Objects are used to build your simulation within the Simulation 
environment. The objects in HYSYS are streams, unit 
operations, and logical operations. 

Use one of the following methods to install an object in your 
simulation:

• Object Palette
• Workbook
• Flowsheet-Add Stream/Add Operations command

8.1.1 Install Objects Using the 
Object Palette

To access the Object Palette (shown on the left), select the 
Object Palette command from the Flowsheet menu or press F4.

In the main flowsheet or template subflowsheet, all available 
operations are accessible through the palette except those 
specifically used with Columns (tray sections, reboilers, etc.). A 
modified palette appears when you are inside the column 
subflowsheet.

The Object Palette is organized into the following categories 
from top to bottom:

• Streams
• Vessels (separators and tank)
• Heat Transfer Equipment
• Rotating Equipment (compressor, expander, pump)
• Piping Equipment
• Solids Handling
• Reactors
• Prebuilt Columns

To enter the Simulation environment click the Enter 
Simulation Environment button or Return to Simulation 
Environment button in the Basis environment.

Refer to Section 7.23.2 - 
Installing Streams or 
Operations for more 
information about the 
Workbook.
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• Shortcut Columns
• Subflowsheets
• Logicals

General Buttons

Icons on the object palette with an arrow pointing to the right 
are general icons (for example, the Solid Ops and General 
Reactors icons) that contain sub-palettes. These sub-palettes 
display icons for more specific unit operations. 

As shown on the left, you can install a Gibbs Reactor, an 
Equilibrium Reactor, or a Conversion Reactor from the Reactors 
sub-palette.

You can install a single stream, unit operation, or logical 
operation from the palette by double-clicking the icon for the 
object you want to install. The object appears in the PFD and the 
object’s property view is opened.

You can also use the Add icon at the top of the palette to install 
objects. 

1. Click the icon for the object you want to install.
2. Click the Add icon to insert the object in the PFD and open 

the object’s property view.

You can install same objects multiple times by using the Lock 
feature.

1. Click the Lock icon at the top of the palette. 
2. Click the icon of the object you want to install.

3. Click the Add icon to install the object. With the lock feature 
active, you can add as many of the selected object as 
required without having to click the object icon.

4. To switch objects when in locked mode, click the Cancel icon 
or click a different icon.

5. To stop the Lock function, click the Lock icon again.

Each operation has an icon and when you place the cursor 
over it, a fly-by description of the operation appears below 
the cursor and in the Status Bar.

The General Reactors icon 
opens the Reactors sub-
palette.

Add icon

Lock icon

Cancel icon
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You can also use the drag-and-drop method of installing objects.

1. Click the icon of the object you want to install.
2. Move the cursor into the PFD. Your cursor changes to an 

arrow with a + and a white outline of the object.

3. In the PFD, click where you want to install the object. The 
object appears in the PFD (but the object’s property view 
does not automatically open).

8.1.2 Install Objects Using the 
Flowsheet Menu

Installing Material Streams

Select the Add Stream command from the Flowsheet menu to 
install a stream in the PFD. When the stream is added to the 
PFD, the stream property view opens.

You can also press the F11 hot key to quickly add a stream to 
the simulation.

Installing Operations
1. Select the Add Operation command from the Flowsheet 

menu. The UnitOps property view appears.
You can press the F12 hot key to quickly open the UnitOps 
property view.

The Add Stream command and F11 hot key can only add 
material streams. 

The Object Palette can add both material and energy 
streams.

Use the radio button in the Categories group to filter the list 
of available unit operations making it easier to find the 
operation you want to add.
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2. From the list of available unit operations, click the operation 
you want to install.

3. Click the Add button. The operation is added to the PFD. The 
operation property view automatically opens.

8.2 Defining Objects
8.2.1 Defining a Material 

Stream
1. Add a material stream to your simulation.
2. Click the Worksheet tab, then select the Conditions page.

3. Specify values for three of the properties in the table. 

One of the specifications must be temperature or pressure.

4. Select the Composition page.

5. Click the Edit button. The Input Composition for Stream 
property view appears.

6. Click the radio button in the Composition Basis group that 
indicates the basis of your composition.

7. In the table, specify the composition of your stream.

8. Click the Normalize button to ensure that your composition 
adds up to 1.0 in the case of fractions.

9. Click Ok. 

The status bar at the bottom of the property view turns green 
and displays the message Ok.

The following sections show steps for providing the 
minimum amount of information required to define each 
object. 

If you specify a vapour fraction of 0 or 1, the stream is 
assumed to be at the bubble point or dew point. You can also 
specify vapour fractions between 0 and 1.

For more information, 
refer to the HYSYS 
Operations Guide.
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8.2.2 Defining an Energy 
Stream

1. Add an energy stream to your simulation.
2. Click the Stream tab.

3. In the Heat Flow field, specify a value for heat flow. 

The status bar at the bottom of the property view turns green 
and displays the message Ok.

8.2.3 Defining a Separator
1. Add a separator to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlets list, click the <<stream>> field and a drop-
down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the name of the 
stream. 

5. Repeat step 4 if you have multiple feed streams.

6. In the Vapour Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
name of the stream.

7. In the Liquid Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
name of the stream.

When all of the attached streams are properly defined the 
status bar at the bottom of the property view turns green 
and displays the message Ok. If the separator cannot solve, 
the status bar is yellow and displays the requirements 
needed to solve.

8. (Optional) Click the Parameters page and enter a pressure 
difference in the Delta P field. 

A default value of zero is entered for new separators, so it 
solves without entering a value, but you may not get the 
results you want.
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8.2.4 Defining a 3-Phase 
Separator

1. Add a 3-phase separator to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlets list, click the <<stream>> field and a drop-
down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

5. Repeat step 4 if you have multiple feed streams.

6. In the Vapour drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

7. In the Light Liquid drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

8. In the Heavy Liquid drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green 
and displays the message Ok. If the 3-phase separator 
cannot solve, the status bar is yellow and displays the 
requirements needed to solve.

9. (Optional) Click the Parameters page and enter a pressure 
difference in the Delta P field. A default value of zero is 
entered for new separators so it solves without entering a 
value, but you may not get the results you want.

8.2.5 Defining a Tank
1. Add a tank to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlets list, click the <<stream>> field to display a 
drop-down list.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 
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5. Repeat step 4 if you have multiple feed streams.

6. In the Vapour Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

7. In the Liquid Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green 
and displays the message Ok. If the tank cannot solve, the 
status bar is yellow and displays the requirements needed to 
solve.

8. (Optional) Click the Parameters page and enter a pressure 
difference in the Delta P field. A default value of zero is 
entered for new separators so it solves without entering a 
value, but you may not get the results you want.

8.2.6 Defining a Cooler/Heater
1. Add a cooler or heater to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Outlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

5. In the Energy drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

For your cooler/heater to solve, you must have enough 
specifications to calculate the pressure drop across the 
cooler/heater and the duty of the cooler/heater.

6. Click the Parameters page and enter a pressure difference 
for the cooler/heater in the Delta P field. The value is 
automatically calculated if the pressure is specified for both 
inlet and outlet streams.
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7. In the Duty field, specify a duty for the cooler/heater. The 
value is automatically calculated if the temperature is 
specified for both the inlet and outlet streams.

When the cooler/heater is solved, the status bar at the bottom 
of the property view turns green and displays the message Ok. 
If the cooler/heater cannot solve, the status bar is yellow and 
displays the requirements needed to solve.

8.2.7 Defining an LNG 
Exchanger

1. Add an LNG exchanger to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet Streams column, click the <<stream>> field and 
a drop-down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name.

5. Repeat step 4 for the remaining inlet streams.

6. In the Outlet Streams column, click the <<stream>> field 
and a drop-down list appears.

7. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

8. Repeat step 7 for the remaining outlet streams.

9. In the Pressure drop column, specify a pressure drop for 
both the hot side and cold side.

10.Click the Parameters (SS) page.

11.Specify the rating method being used; heat leak/loss, pass 
intervals, step type or pressure profile.

For the LNG exchanger to solve, the number of independent 
unknowns must be equal to the number of constraints 
(Degrees of Freedom = 0). The LNG considers constraints to 
be parameters such as UA, Minimum Temperature Approach, 
or a temperature difference between two streams.

12.Click the Specs (SS) page.

13.Click the Add button to display the Spec property view. In 
this property view you can add a specification to define your 
LNG exchanger. 
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14.Repeat step 13 until the degrees of freedom equal zero.

When the degrees of freedom equal zero and all attached 
streams are properly defined, the status bar at the bottom of 
the property view turns green and displays the message Ok. If 
the LNG exchanger cannot solve, the status bar is yellow and 
displays the requirements needed to solve.

8.2.8 Defining a Heat 
Exchanger

1. Add a heat exchanger to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Tube Side Inlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

4. In the Tube Side Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

5. In the Shell Side Inlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

6. In the Shell Side Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

7. Click the Parameters page.

8. Where applicable, specify the rating method being used; 
heat leak/loss, heat curve details, tube and shell side 
pressure differences and UA.

For the heat exchanger to solve, the number of independent 
unknowns must equal the number of constraints (Degrees of 
Freedom = 0). The heat exchanger considers constraints to 
be parameters such as UA, Minimum Temperature Approach, 
or a temperature difference between two streams.

9. Click the Specs page.

10.Click the Add button to display the Spec property view. In 
this property view, add a specification to define your heat 
exchanger. 
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11.Repeat step 10 until degrees of freedom equal zero.

When the degrees of freedom equal zero and all attached 
streams are properly defined, the status bar at the bottom of 
the property view turns green and displays the message Ok. If 
the heat exchanger cannot solve, the status bar is yellow and 
displays the requirements needed to solve.

8.2.9 Defining an Air Cooler
1. Add an air cooler to your simulation.
2. Click the Connections page of the Design tab.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Outlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

For your air cooler to solve, you must have enough 
specifications to calculate the pressure drop across the air 
cooler and the duty of the air cooler.

5. Click the Parameters page.

6. In the Delta P field, specify a pressure difference for the air 
cooler. This value automatically calculates if the pressure is 
specified for both the inlet and outlet streams.

7. Specify either the overall UA or the temperature of the 
outlet air. This value automatically calculates if the 
temperature is specified for both the inlet and outlet 
streams.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the air cooler cannot solve, the 
status bar is yellow and displays the requirements needed to 
solve.

For information about the 
HTFS-ACOL tab in the Air 
Cooler property view, 
refer to Section 4.1 - 
Air Cooler in the HYSYS 
Operations Guide.
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8.2.10 Defining a Pump
1. Add a pump to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Outlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

5. In the Energy drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

For your pump to solve, you must have enough 
specifications to calculate the pressure drop across the 
pump and the duty of the pump.

6. Click the Parameters page. Do one of the following:

• In the Delta P field, specify a pressure difference for the 
pump. This value is calculated if the pressure is specified 
for both the inlet and outlet streams.

• In the Duty field, specify the duty for the pump. These 
values are calculated if the pressure is specified for both 
the inlet and outlet streams.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the pump cannot solve, the status 
bar is yellow and displays the requirements needed to solve.

8.2.11 Defining a Compressor/
Expander

1. Add a compressor/expander to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.
8-13



8-14 Defining Objects
4. In the Outlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

5. In the Energy drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

For your compressor/expander to solve, you must have 
enough specifications to calculate the duty of the 
compressor/expander.

6. Select the Parameters page.

7. In the Duty field, specify a duty for the compressor/
expander. This value is calculated if the pressure is specified 
for both the inlet and outlet streams.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the compressor/expander cannot 
solve, the status bar is yellow and displays the requirements 
needed to solve.

8.2.12 Defining a 
Compressible Gas Pipe

1. Add a compressible gas pipe to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Outlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

5. Click the Parameters page.

6. In the Delta P field, specify a pressure difference for the 
compressible gas pipe. By default a value of 25 kPa is 
specified.

7. Click the Rating tab, then select the Sizing page.

Click the Add Section button to add multiple pipe sections.
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8. Specify the following parameters:

• Length
• Elevation Change
• Cells
• Roughness
• External Diameter
• Internal Diameter

9. Select the Heat Transfer page, then specify the ambient 
temperature and overall heat transfer coefficient in the 
corresponding fields.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the compressible gas pipe cannot 
solve, the status bar is yellow and displays the requirements 
needed to solve.

8.2.13 Defining a Pipe 
Segment

1. Add a pipe segment to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Outlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

5. In the Energy drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

6. Select the Parameters page.

7. From the list of available pipe flow correlations, select the 
correlation you want to use.

8. In the Delta P field, specify a pressure difference for the 
pipe segment. This value is calculated if the pressure is 
specified for both the inlet and outlet streams.

9. Click the Ratings tab, then select the Sizing page.
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10.Click the Append Segment button to display a pipe 
segment in the table. Specify the Fitting/Pipe, Length, and 
Increments.

11.Click the View Segment button to display the Pipe Info 
property view. Specify the pipe schedule and diameters.

12.Click the Heat Transfer page.

13. In the Specify By group, click the radio button that describes 
how the heat transfer occurs in the pipe segment. Then 
specify the corresponding parameters.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the pipe segment cannot solve, the 
status bar is yellow and displays the requirements needed to 
solve.

8.2.14 Defining a Valve
1. Add a valve to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Outlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

5. Select the Parameters page.

6. Specify a pressure difference for the pipe segment in the 
Delta P field. This value is calculated if the pressure is 
specified for both the inlet and outlet streams.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the valve cannot solve, the status 
bar is yellow and displays the requirements needed to solve.
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8.2.15 Defining a Relief Valve
1. Add a relief valve to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Outlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

5. Select the Parameters page.

6. In the Set Pressure field, specify the pressure for when the 
relief valve begins to open.

7. In the Full Open Pressure field, specify the pressure for 
when the relief valve is fully open.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view is either red or 
yellow. When the status bar is yellow, the message ‘Valve is 
Open’ displays. When the status bar is red, the message 
‘material flows into a closed relief valve’ displays. This indicates 
the valve is shut and no material is passing through.

8.2.16 Defining a Mixer
1. Add a mixer to your simulation.
2. Click the Connections page of the Design tab.

3. In the Inlets list, click the <<stream>> field and a drop-
down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

5. Repeat step 4 for the multiple feed streams.

Both the inlet and outlet stream pressures must be specified 
for the relief valve.
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6. In the Outlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the mixer cannot solve, the status 
bar is yellow and displays the requirements needed to solve.

8.2.17 Defining a Tee
1. Add a tee to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Outlets list, click the <<stream>> field and a drop-
down list appears.

5. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

6. Repeat step 5 for the multiple outlet streams.

7. Select the Parameters page and specify flow ratios for 
outlet streams.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the tee cannot solve, the status bar 
is yellow and displays the requirements needed to solve.

8.2.18 Defining a Simple Solid 
Separator

1. Add a simple solid separator to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.
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4. In the Vapour Product drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

5. In the Liquid Product drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

6. In the Solids Product drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

7. Select the Parameters page.

8. In the Delta P field, specify a pressure difference for the 
solids separator. By default a value of 0.0 kPa is specified.

9. Select the Splits page, then define your stream split 
according to the separation.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the solid separator cannot solve, 
the status bar is yellow and displays the requirements needed to 
solve.

8.2.19 Defining a Cyclone
1. Add a cyclone to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Vapour Product drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

5. In the Solid Product drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

6. Select the Parameters page.

7. In the Particle Efficiency field, specify a value for the 
particle efficiency of the cyclone.

8. Select the Solids page.
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9. Click the Solid Name field to open the drop-down list. 
Select the solid component being separated from the 
stream.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the cyclone cannot solve, the status 
bar is yellow and displays the requirements needed to solve.

8.2.20 Defining a 
Hydrocyclone

1. Add a hydrocyclone to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Liquid Product drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

5. In the Solid Product drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

6. Select the Parameters page.

7. In the Particle Efficiency field, specify a value for the 
particle efficiency of the cyclone.

8. Select the Solids page.

9. Click the Solid Name field to open the drop-down list. 
Select the solid component being separated from the 
stream.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the hydrocyclone cannot solve, the 
status bar is yellow and displays the requirements needed to 
solve.
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8.2.21 Defining a Rotary 
Vacuum Filter

1. Add a rotary vacuum filter to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Liquid Product drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

5. In the Solid Product drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

6. Click the Rating tab, then select the Sizing page.

7. In the Filter Size group, specify either the filter radius or 
filter width in the corresponding field.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the rotary vacuum filter cannot 
solve, the status bar is yellow and displays the requirements 
needed to solve.

8.2.22 Defining a Baghouse 
Filter

1. Add a baghouse filter to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

4. In the Vapour Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

5. In the Solid Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.
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When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the baghouse filter cannot solve, 
the status bar is yellow and displays the requirements needed to 
solve.

8.2.23 Defining a CSTR
1. Add a CSTR to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlets list, click the <<stream>> field and a drop-
down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

5. Repeat step 4 if you have multiple feed streams.

6. In the Vapour Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

7. In the Liquid Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

8. In the Energy drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

9. Select the Parameters page.

10. In the Volume field, specify the volume of the reactor.

11.Click the Reactions tab, then select the Details page.

12. From the Reaction Set drop-down list, select the reaction set 
being used.

13. From the Reaction drop-down list, select the reaction being 
used.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the CSTR cannot solve, the status 
bar is yellow and displays the requirements needed to solve.
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8.2.24 Defining a PFR
1. Add a PFR to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlets list, click the <<stream>> field and a drop-
down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

5. Repeat step 4 if you have multiple feed streams.

6. In the Outlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

7. Select the Parameters page.

8. In the Delta P field, specify the pressure drop across the 
reactor.

9. Click the Reactions tab, then select the Overall page.

10. From the Reaction Set drop-down list, select the reaction set 
being used.

11.Select the Details page.

12. From the Reaction drop-down list, select the reaction being 
used.

13.Click the Rating tab, then select the Sizing page.

14. In the Tube Dimensions group, specify two of the three 
following parameters: 

• Total Volume
• Length
• Diameter

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the PFR cannot solve, the status bar 
is yellow and displays the requirements needed to solve.
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8.2.25 Defining a Gibbs 
Reactor

1. Add a Gibbs reactor to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlets list, click the <<stream>> field and a drop-
down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

5. Repeat step 4 if you have multiple feed streams.

6. In the Vapour Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

7. In the Liquid Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green 
and displays the message Ok. If the Gibbs reactor cannot 
solve, the status bar is yellow and displays the requirements 
needed to solve.

8. (Optional) Select the Parameters page and enter a 
pressure difference in the Delta P field. A default value of 
zero is entered for new Gibbs reactors, so your Gibbs reactor 
solves without entering the value, but you do not get the 
desired results.

9. (Optional) Click the Reactions tab, then select the Overall 
page. In the Reactor type group, click the corresponding 
radio button for the type of reactor you want to model.

8.2.26 Defining an Equilibrium 
Reactor

1. Add an equilibrium reactor to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlets list, click the <<stream>> field and a drop-
down list appears.
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4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

5. Repeat step 4 if you have multiple feed streams.

6. In the Vapour Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

7. In the Liquid Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

8. Click the Reactions tab, then select the Details page.

9. From the Reaction Set drop-down list, select the reaction set 
containing the reaction being used.

10. From the Reaction drop-down list, select the reaction being 
used.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green 
and displays the message Ok. If the equilibrium reactor 
cannot solve, the status bar is yellow and displays the 
requirements needed to solve.

11. (Optional) Click the Design tab, then select the 
Parameters page. In the Delta P field, enter a pressure 
difference. A default value of zero is entered for new 
equilibrium reactors, so your equilibrium reactor solves 
without entering a value, but you may not get the desired 
results.

8.2.27 Defining a Conversion 
Reactor

1. Add a conversion reactor to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlets list, click the <<stream>> field and a drop-
down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

5. Repeat step 4 if you have multiple feed streams.
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6. In the Vapour Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

7. In the Liquid Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

8. Click the Reactions tab, then select the Details page.

9. From the Reaction Set drop-down list, select the reaction set 
containing the reaction being used.

10. From the Reaction drop-down list, select the reaction being 
used.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green 
and displays the message Ok. If the conversion reactor 
cannot solve, the status bar is yellow and displays the 
requirements needed to solve.

11. (Optional) Click the Design tab, then select the 
Parameters page. In the Delta P field, enter a pressure 
difference. A default value of zero is entered for new 
conversion reactors, so your conversion reactor solves 
without entering a value, but you do not get the desired 
results.

8.2.28 Defining a Neutralizer

1. Add a neutralizer to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlets list, click the <<stream>> field and a drop-
down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

5. Repeat step 4 if you have multiple feed streams.

6. In the Reagent Stream drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

This operation can only be used with a fluid package that 
uses the electrolyte property package.
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7. In the Vapour Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

8. In the Liquid Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green 
and displays the message Ok. If the neutralizer cannot 
solve, the status bar is yellow and displays the requirements 
needed to solve.

9. (Optional) Select the Parameters page. In the Delta P 
field, enter a pressure difference. A default value of zero is 
entered for new neutralizers, so your neutralizer solves 
without entering a value, but you may not get the desired 
results.

8.2.29 Defining a Crystallizer

1. Add a crystallizer to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlets list, click the <<stream>> field and a drop-
down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

5. Repeat step 4 if you have multiple feed streams.

6. In the Vapour Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

7. In the Liquid Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green 
and displays the message Ok. If the crystallizer cannot 

This operation can only be used with a fluid package that 
uses the electrolyte property package.
8-27



8-28 Defining Objects
solve, the status bar is yellow and displays the requirements 
needed to solve.

8. (Optional) Select the Parameters page. In the Delta P 
field, enter a pressure difference. A default value of zero is 
entered for new crystallizers, so your crystallizer solves 
without having to enter a value, but you may not get the 
desired results.

8.2.30 Defining a Precipitator

1. Add a precipitator to your simulation.
2. Click the Design tab, then select the Connections page.

3. In the Inlets list, click the <<stream>> field and a drop-
down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

5. Repeat step 4 if you have multiple feed streams.

6. In the Reagent Stream drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

7. In the Vapour Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

8. In the Liquid Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green 
and displays the message Ok. If the precipitator cannot 
solve, the status bar is yellow and displays the requirements 
needed to solve.

This operation can only be used with a fluid package that 
uses the electrolyte property package.
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9. (Optional) Select the Parameters page. In the Delta P 
field, enter a pressure difference. A default value of zero is 
entered for new precipitators, so your precipitator solves 
without entering a value, but you may not get the desired 
results.

8.2.31 Defining a Distillation 
Column

Use this procedure to define a distillation column using the input 
expert:

1. Add a distillation column to your simulation.
2. In the # Stages field, specify the number of trays in the 

column.

3. In the Inlet Streams list, click the <<stream>> field and a 
drop-down list appears.

4. From the drop-down list, select a pre-defined stream or click 
the space at the top of the list and type the stream name. 

5. Repeat step 4 if you have multiple feed streams.

6. In the Inlet Stage column, use the drop-down list to select 
what stage the stream is entering the column.

7. In the Condenser Energy Stream drop-down list, select a 
pre-defined stream or click the space at the top of the list 
and type the stream name.

8. In the Condenser group, click the condenser type radio 
button that you want to use for the column. Depending on 
the selection, select a pre-defined stream or click the space 
at the top of the list and type the stream name for the 
following:

• Total. Specify in the Ovhd Liquid Outlet drop-down list. 
• Partial. Specify in the Ovhd Outlets drop-down list.
• Full Rflx. Specify in the Ovhd Vapour Outlet drop-down 

list.
9. In the Reboiler Energy stream drop-down list, select a pre-

defined stream or click the space at the top of the list and 
type the stream name.

10. In the Bottoms Liquid Outlet drop-down list, select a pre-
defined stream or click the space at the top of the list and 
type the stream name.
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11.Click the Next button.

12. In the Condenser Pressure field, enter the pressure in the 
condenser.

13. In the Condenser Pressure Drop field, enter the pressure 
drop across the condenser. 

14. In the Reboiler Pressure field, enter the pressure in the 
reboiler.

15.Click the Next button.

16. (Optional) Enter temperature values for the condenser, top 
stage, and reboiler.

17.Click the Next button.

18. (Optional) Enter a product flow rate and a reflux ratio.

19.Click Done to display the Column property view.

For the distillation column to solve, the number of 
independent unknowns must be equal to the number of 
constraints (Degrees of Freedom = 0). The distillation 
column considers constraints to be parameters such as 
product draw rates, tray temperatures, or reflux ratio.

20.Click the Design tab, then select the Specs page.

21.Click the Add button to display the Spec property view. In 
this property view, add a specification to define your 
distillation column. Repeat this step until the degrees of 
freedom equal zero.

When the degrees of freedom equal zero and all attached 
streams are properly defined, the status bar at the bottom of 
the property view turns green and displays the message Ok. If 
the distillation column cannot solve, the status bar is red and 
displays Unconverged.

Select the Monitor page of the Design tab to see the degrees 
of freedom the column has and manage the specifications in 
the column.
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8.2.32 Defining a Refluxed 
Absorber Column

Use this procedure to define a refluxed absorber column using 
the input expert:

1. Add a refluxed absorber column to your simulation.
2. In the # Stages field, type the number of trays for the 

column.

3. In the Bottom Stage Inlet drop-down list, select a pre-
defined stream or click the space at the top of the list and 
type the stream name.

4. In the Condenser Energy Stream drop-down list, select a 
pre-defined stream or click the space at the top of the list 
and type the stream name.

5. In the Condenser group, click the condenser type radio 
button being used for the column. Depending on the 
selection, in the Ovhd Liquid Outlet drop-down list, select a 
pre-defined stream or click the space at the top of the list 
and type the stream names for the following:

• Total
• Partial
• Full Rflx

6. In the Bottoms Liquid Outlet drop-down list, select a pre-
defined stream or click the space at the top of the list and 
type the stream name. 

7. Click the Next button.

8. In the Condenser Pressure field, enter the pressure in the 
condenser. 

9. In the Condenser Pressure Drop field, enter the pressure 
drop across the condenser. 

10. In the Reboiler Pressure field, enter the pressure in the 
reboiler. 

11.Click the Next button.

12. (Optional) Enter temperature values for the condenser, top 
stage, and reboiler. 

13.Click the Next button.

14. (Optional) Enter the product flow rate and a reflux ratio.
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15.Click Done to display the Column property view.

For the refluxed absorber column to solve, the number of 
independent unknowns must equal the number of 
constraints (Degrees of Freedom = 0). The refluxed 
absorber column property views constraints as parameters 
such as product draw rates, tray temperatures, or reflux 
ratio.

16.Click the Design tab, then select the Specs page.

17.Click the Add button to display the Spec property view and 
add a specification to define your refluxed absorber column.

18.Repeat step 17 until the degrees of freedom equal zero.

When the degrees of freedom equal zero and all attached 
streams are properly defined, the status bar at the bottom of 
the property view turns green and displays the message Ok. If 
the refluxed absorber column cannot solve, the status bar is red 
and displays Unconverged.

8.2.33 Defining an Absorber 
Column

Use this procedure to define an absorber column using the input 
expert:

1. Add an absorber column to your simulation.
2. In the # Stages field, type the number of trays in the 

column.

3. In the Top Stg Reflux group, click the radio button being 
used for the column. Depending on the selection, select a 
pre-defined stream or click the space at the top of the list 
and type the stream names for the following:

• Liquid Inlet. Specify in the Top Stage Inlet drop-down 
list.

Select the Monitor page of the Design tab to see how many 
degrees of freedom the column has and manage the 
specifications in the column.
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• Pump-around. Specify in the Draw Stage drop-down 
list.

4. In the Bottom Stage Inlet column, use the drop-down list to 
specify at what stage the stream enters the column.

5. In the Ovhd Vapour Outlet drop-down list, select a pre-
defined stream or click the space at the top of the list and 
type the stream name.

6. In the Bottoms Liquid Outlet drop-down list, select a pre-
defined stream or click the space at the top of the list and 
type the stream name.

7. Click the Next button.

8. In the Top Stage Pressure field, type the pressure in the 
condenser. 

9. In the Bottom Stage Pressure field, enter the pressure in 
the reboiler.

10.Click the Next button.

11. (Optional) Enter temperature values for the top stage and 
bottom stage.

12.Click Done to display the Column property view.

When all attached streams are properly defined, the status bar 
at the bottom of the property view turns green and displays the 
message Ok. If the absorber column cannot solve, the status 
bar is red and displays Unconverged.

8.2.34 Defining a Reboiled 
Absorber Column

Use this procedure to define a reboiled absorber column using 
the input expert:

1. Add a reboiled absorber column to your simulation.
2. In the # Stages field, specify the number of trays in the 

column.

3. In the Top Stg Reflux group, click the radio button being 
used for the column. Depending on the selection, select a 
pre-defined stream or click the space at the top of the list 
and type the stream name for the following:
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• Liquid Inlet. Specify in the Top Stage Inlet drop-down 
list.

• Pump-around. Specify in the Draw Stage drop-down 
list.

4. In the Ovhd Vapour Outlet drop-down list, select a pre-
defined stream or click the space at the top of the list and 
type the stream name.

5. In the Reboiler Energy Stream drop-down list, select a pre-
defined stream or click the space at the top of the list and 
type the stream name.

6. In the Bottoms Liquid Outlet drop-down list, select a pre-
defined stream or click the space at the top of the list and 
type the stream name.

7. Click the Next button.

8. In the Top Stage Pressure field, type the pressure in the 
condenser. 

9. In the Reboiler Pressure field, type the pressure in the 
reboiler.

10.Click the Next button.

11. (Optional) Enter temperature values for the top stage and 
reboiler.

12.Click the Next button.

13. (Optional) Enter a boilup ratio.

14.Click Done to display the Column property view.

For the reboiled absorber column to solve, the number of 
independent unknowns must equal the number of 
constraints (Degrees of Freedom = 0). The reboiled absorber 
column property views constraints as parameters such as 
product draw rates, tray temperatures, or reflux ratio.

15.Click the Design tab, then select the Specs page.

16.Click the Add button to display the Spec property view. 
From this property view, add a specification to define your 
refluxed absorber column. 

17.Repeat step 16 until degrees of freedom equals zero.

Click the Monitor page of the Design tab to see how many 
degrees of freedom the column has and manage the 
specifications in the column.
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When the degrees of freedom equal zero and attached streams 
are properly defined, the status bar at the bottom of the 
property view turns green and displays the message Ok. If the 
reboiled absorber column cannot solve, the status bar is red and 
displays Unconverged.

8.2.35 Defining a Liquid-Liquid 
Extractor

Use this procedure to define a liquid-liquid extractor using the 
input expert:

1. Add a liquid-liquid extractor to your simulation.
2. In the # Stages field, specify the number of trays in the 

column.

3. In the Top Stage Inlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

4. In the Bottom Stage Inlet drop-down list, select a pre-
defined stream or click the space at the top of the list and 
type the stream name.

5. In the Ovhd Light Liquid drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

6. In the Bottoms Heavy Liquid drop-down list, select a pre-
defined stream or click the space at the top of the list and 
type the stream name.

7. Click the Next button.

8. In the Top Stage Pressure field, enter the pressure in the 
condenser. 

9. In the Bottom Stage Pressure field, enter the pressure in 
the reboiler.

10.Click the Next button.

11. (Optional) Enter temperature values for the top stage and 
bottom stage.

12.Click Done to display the Column property view.

When all attached streams are properly defined, the status bar 
at the bottom of the property view turns green and displays the 
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message Ok. If the liquid-liquid extractor cannot solve, the 
status bar is red and displays Unconverged.

8.2.36 Defining a Three Phase 
Distillation Column

Use this procedure to define a three phase distillation column 
using the input expert:

1. Add a three phase distillation column to your simulation.
2. Click one of the following radio buttons for the column you 

want to model: 

• Distillation
• Refluxed Absorber
• Reboiled Absorber
• Absorber

3. Click the Next button.

4. In the Two Liquid Phase Check group, select the stages you 
want to check for two liquid phases.

5. Click the Next button.

6. In the Condenser Energy Stream drop-down list, select a 
pre-defined stream or click the space at the top of the list 
and type the stream name.

7. Use the radio buttons in the Condenser type, Outlet 
Streams, and Reflux Streams groups to specify the 
condenser configuration of the column.

8. In the remaining drop-down lists, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

9. Click the Next button.

10. (Optional) Specify the flow rates for entering and leaving the 
condenser.

11.Click the Next button to display the Input Expert property 
view for the selected column. 

12. Follow the sections outlined for each of the columns above to 
complete the three phase distillation column.
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8.2.37 Defining a Component 
Splitter

1. Add a component splitter to your simulation.
2. In the Inlet Streams list, select a pre-defined stream from 

the drop-down list, or click the space at the top of the list 
and type the stream name. 

3. Repeat step 2 if you have multiple feed streams.

4. In the Energy Streams list, select a pre-defined stream from 
the drop-down list, or click the space at the top of the list 
and type the stream name.

5. Repeat step 4 if you have multiple energy streams.

6. In the Overhead Outlet list, click the <<stream>> field to 
display the drop-down list. From the drop-down list, select a 
pre-defined stream or click the space at the top of the list 
and type the stream name. 

7. Repeat step 6 if you have multiple outlet streams.

8. In the Bottoms Outlet drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

9. Select the Splits page.

10.Specify the split fraction for each of the overhead streams.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the component splitter cannot 
solve, the status bar is yellow and displays the requirements 
needed to solve.

8.2.38 Defining a Short Cut 
Distillation Column

1. Add a short cut distillation column to your simulation.
2. In the Inlet drop-down list, select a pre-defined stream or 

click the space at the top of the list and type the stream 
name.
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3. From the Top Product Phase group, select whether you want 
the overhead product to be vapour or liquid.

4. Then specify the following by selecting a pre-defined stream 
or clicking the space at the top of the list and typing the 
stream name:

• Liquid. Specify in the Distillate drop-down list.
• Vapour. Specify in the Overhead Vapour drop-down list.

5. In the Condenser Duty drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

6. In the Reboiler Duty drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

7. In the Bottoms drop-down list, select a pre-defined stream 
or click the space at the top of the list and type the stream 
name.

8. Select the Parameters page.

9. Click the down arrow icon  in the Light Key in Bottoms 
cell under the Component column. From the drop-down list 
of available components, select the component to use for the 
light key.

10. In the Light Key in Bottoms cell under the Mole Fraction 
column, specify the mole fraction of the key component.

11.Click the down arrow icon  in the Heavy Key in Distillate 
cell under the Component column. From the list of available 
components, select the component to use for the heavy key.

12. In the Heavy Key in Distillate cell under the Mole Fraction 
column, specify the mole fraction of the key component.

13. In the Condenser Pressure field, specify the pressure at 
the condenser.

14. In the Reboiler Pressure field, specify the pressure at the 
reboiler.

15. In the External Reflux Ratio field, specify the external 
reflux ratio.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the short cut distillation column 
cannot solve, the status bar is yellow and displays the 
requirements needed to solve.
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8.2.39 Defining an Adjust
1. Add an adjust to your simulation.
2. In the Adjusted Variable group, click the Select Var button 

to display the Select Variable property view.

3. Select the object and the variable you want to use and click 
OK.

4. In the Target Variable group, click the Select Var button to 
display the Select Variable property view.

5. Select the object and the variable you want to use and click 
OK.

6. In the Target Value group, enter either a user specified value 
or a value from another object.

7. Click the Start button to start the solver.

8.2.40 Defining a Set
1. Add a set to your simulation.
2. In the Target Variable group, click the Select Var button to 

display the Select Variable property view.

3. Select the object and the variable you want to use and click 
OK.

4. In the Source Object drop-down list, select a pre-defined 
stream or click the space at the top of the list and type the 
stream name.

5. Click the Parameters tab.

6. Specify either the multiplier or offset in the appropriate field. 
The parameter that is not specified is automatically 
calculated.

8.2.41 Defining a Recycle
1. Add a recycle to your simulation.
2. In the Inlet drop-down list, select a pre-defined stream or 

click the space at the top of the list and type the stream 
name.
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3. In the Outlet drop-down list, select a pre-defined stream or 
click the space at the top of the list and type the stream 
name.

8.2.42 Defining a PID 
Controller

1. Add a PID controller to your simulation.
2. In the Process Variable Source group, click the Select Var 

button to display the Select Variable property view.

3. Select the object and the variable you want to use and click 
OK.

4. In the Output Target Object group, click the Select OP 
button to display the Select OP Object property view.

5. Select the object you want to use and click OK.

6. Click the Parameters tab, then select the Configuration 
page.

7. Click either the Reverse or Direct action radio button.

8. In the Kc field, specify a value for the controller gain.

9. In the Ti field, specify a value for the integral time, if 
required.

10. In the Td field, specify a value for the derivative time, if 
required.

11. In the PV Minimum field, specify the minimum process 
variable value.

12. In the PV Maximum field, specify the maximum process 
variable value.

13. From the mode drop-down list, select one of the following 
options for the mode of the controller: 

• Man
• Auto Indicator
• Off

14. In the SP field, specify the set point for the controller.
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8.2.43 Defining a Selector 
Block

1. Add a selector block to your simulation.
2. Click the Add PV button to display the Select Input PV 

property view.

3. Select the object and the variable you want to use and click 
OK.

4. Repeat steps #2 and #3 for each process variable you want 
to use.

5. Click the Select PV button to display the Select Input PV 
property view.

6. Select the object and the variable you want to use and click 
OK.

8.2.44 Defining a Balance
1. Add a balance to your simulation.
2. Click the Connections tab.

3. In the Inlet Streams list, click the <<stream>> field to 
display a drop-down list. From the drop-down list, select a 
pre-defined stream or click the space at the top of the list 
and type the stream name. 

4. Repeat step 3 if you have multiple feed streams.

5. In the Outlet Streams list, click the <<stream>> field to 
display a drop-down list. From the drop-down list, select a 
pre-defined stream or click the space at the top of the list 
and type the stream name. 

6. Repeat step 5 if you have multiple outlet streams.

7. Click the Parameters tab.

8. In the Balance Type group, select the balance type you want 
to use.

When all of the attached streams are properly defined, the 
status bar at the bottom of the property view turns green and 
displays the message Ok. If the balance cannot solve, the status 
bar is yellow and displays the requirements needed to solve.
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8.2.45 Defining a Digital Point
1. Add a digital point to your simulation.
2. In the Output Target Object group, click the Select OP 

button to display the Select OP Object property view. 

3. Select the object you want to use.

4. Click OK.

8.2.46 Defining a Transfer 
Function Block

1. Add a transfer function block to your simulation.
2. In the Transformed PV Target group, click the Select PV 

button to display the Select Output PV property view.

3. Select the object and the variable you want to use.

4. Click OK.

5. Click the Parameters tab, then select the Configuration 
page.

6. Specify a value for the input variable in the Constant PV 
field.

8.2.47 Defining an MPC 
Controller

1. Add an MPC controller to your simulation.
2. In the Process Variable Source group, click the Select PV 

button to display the Select Input PV property view.

3. Select the object and the variable you want to use.

4. Click OK.

5. In the Output Target Object group, click the Select OP 
button to display the Select OP Object property view. 

6. Select the object and the variable you want to use and click 
OK.

7. Click the Control Valve button to display the Control Valve 
property view.
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8. Depending on what type of stream the output object is, 
specify the minimum and maximum variables and then close 
the property view.

9. Click the Parameters tab, then select the Configuration 
page.

10. In the PV Min and Max group, specify minimum and 
maximum values for the process variables.
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9-2 Introduction
9.1 Introduction
In HYSYS, you can transcribe process information concerning 
your simulation case using printing features. You can create 
printed reports ranging from basic data to comprehensive 
summaries. There are two primary printing options in HYSYS:

• Object Specific
• Reports

Object Specific printing relates to the current object of focus in 
the simulation case. For instance, if the Separator property view 
is active, you can print a Snapshot of that property view as seen 
on your monitor or print out a Datasheet specific to the unit 
operation. A Datasheet displays object related information that 
can include input specifications and calculated results. Each 
object within HYSYS has at least one Datasheet available, with 
many objects also having condensed versions of the full 
Datasheet.

Printing reports deal with more extensive information sets. 
When creating a report, you collect the Datasheets of multiple 
objects into one document. HYSYS enables you to select any 
Datasheet for any object currently in your simulation case. For 
each report created, you can customize the page setup.

Both primary printing features are accessed through the menu 
bar, however, Object Specific printing is also available through 
the Object Inspect menu. By right-clicking the Title Bar of an 
object, you can preview and print its associated Datasheet.

The Report property view can remain open while you manipulate 
your flowsheet. If changes occur that affect the values shown in 
a Datasheet, you can easily update the information.
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9.2 Printing in HYSYS
In HYSYS, you can print information in one of three ways:

9.2.1 Menu Bar Options
The HYSYS printing options found in the File in the menu are as 
follows: 

Method Description

Menu Bar Select one of the options under the File menu.

Object 
Inspect 
menu

Right-click the Title Bar of a property view and select the 
Print Datasheet command from the menu. This is the same 
as selecting the Print command from the File menu.

Report 
Manager 

In the Simulation environment, from the Tools menu, select 
Reports. This opens the Report Manager property view.

Option Description

Print Lists the available Datasheet(s) for the currently active 
object. You can select a Datasheet and either preview or print 
it. 

Print 
Window 
Snapshot

Prints a bitmap of the currently active HYSYS property view. 
Use this command when you want to print a property view 
that does not have a Datasheet associated with it (for 
example, a table such as a Column Profiles table).

Printer 
Setup 

With this command, you can select either the Graphic 
Printer or the Report Printer. This enables you to select the 
printer, paper orientation, paper size and source. 

 Figure 9.1

Refer to Section 9.2.1 - 
Menu Bar Options for 
details.

Refer to Section 9.3 - 
Reports for details on the 
Report Manager.

Refer to Section 9.2.2 - 
Printing Datasheets for 
more detail.

Refer to Section 9.3.6 - 
Printing & Previewing 
Reports for details.
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9.2.2 Printing Datasheets
When you select the Print command, the Select Datablocks to 
Print property view appears and HYSYS prepares to print the 
Datasheets for the property view that currently has focus. For 
example, this could be a Workbook tab, a Stream, a Unit 
Operation or a Utility. If you are currently in an area where 
printing is not available (for example, the Reaction Package 
property view), the Select Datablocks to Print property view 
appears with no Datasheets available.

The Select Datablocks to Print appears as follows.

Click the Set Preferences button to save the Datasheet 
selections set in the HYSYS preferences. This allows you to use 
the same settings for each type of object. For example, if you 
print the same Datasheets for every stream in your case, use 
the Set Preferences button to save the settings for the first 
stream and the Use Preferences button to load the settings into 
each of the remaining streams.

All default and customized Workbook pages have Datasheets 
available.

 Figure 9.2

Select the Datasheets 
by selecting the 
appropriate checkbox. 

Displays a Preview of 
the selected 
Datasheets.

Prints the selected 
Datasheets.

Set the Datasheet preferences and 
recall the preferred selection. 

Selects the output 
format. If selected, 
HYSYS prints the 
Datasheet to an ASCII 
file.

Click the Select All button to include 
all the Datasheets. The Invert 
Selection button reverses the 
selection.
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The default Datasheet selections are set in the Session 
Preferences. 

The active location in the flowsheet determines which 
Datasheets are available. In this case, the active location is a 
Workbook, so the only available options pertain to the 
Workbook. The All Pages Datasheet displays all the information 
in the Workbook. Only the variables present on the Workbook 
tabs appear in the Datasheets.

Click the Preview button to open the Report Preview property 
view as shown below.

There are particular Datasheets for certain operations. For 
example, a column tray section has a Tray Section 
Component Summary and a Datasheet; a Strip Chart has a 
Strip Chart Variables and Historical Data Datasheet.

 Figure 9.3

Refer to Section 12.4 - 
Reports Tab for more 
details.

Change the 
Datasheet 
format.

Prints the currently displayed Datasheet.

You can 
zoom-in to 
get a close-
up view of 
your 
document or 
zoom-out to 
see more of 
the page at a 
reduced size.
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9.2.3 Printing the PFD 
To print the PFD, right-click on an empty area of the PFD to 
display the Object Inspect menu shown in the figure on the left.

There are three print related functions available: 

All items (Streams, Operations, Text, and PFD Tables) included 
in the PFD property view can be printed. You can also use the 
Print Snapshot command under the File menu to print the PFD 
when it has focus.

9.2.4 Printing Plots
To print a plot, right-click on the plot area to display the Object 
Inspect menu as shown on the left. Select one of the following 
two printing options from the menu:

Alternatively, you can select Print from the File menu when 
the PFD has focus.

Option Description

Print PFD Prints the PFD as it appears on the screen. Only the 
sections visible within the PFD property view are printed. 
Any tables that you add are also printed. When you select 
this command, the PFD is printed without accessing any 
further menus.

Print Setup Accesses the Windows Print Setup. You can set the printer, 
the paper orientation, the paper size and paper source.

Print to PFD 
to File

Prints the entire PFD to a file. 

Object Description

Print Plot Prints the plot as it appears on the screen.

For information on setting the appearance of plots, refer to 
Section 10.4 - Graph Control.

Print Setup Accesses the Windows Print Setup. You can set the printer, 
the paper orientation, the paper size and paper source.

For more information 
refer to Section 9.4 - 
Printing the PFD as a 
File.

Plot Object Inspect menu
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9.2.5 Printer Setup
The Print Setup property view is accessed by selecting Printer 
Setup from the File menu. The sub-menu provides two 
additional commands:  

If the Print Setup property view is accessed by right-clicking (in 
other words, through the PFD Object Inspect menu), HYSYS 
defaults to the appropriate printer according to the active 
location in the flowsheet. 

 Figure 9.4

Printer Description

Graphic 
Printer

The Graphic Printer is used to print the PFD, Plots, Strip 
Charts and Snapshots.

Report Printer The Report Printer is used to print Datasheets, Reports 
and Text.

The layout of the Print Setup property view varies depending 
on the selected printer. You can also modify the default 
properties for the selected printer by clicking the Properties 
button.
9-7



9-8 Reports
9.3 Reports
Within a simulation case, you can print stream and operation 
Datasheets using the print function, however, this only enables 
you to print Datasheets for a single object at a time. By using 
the Report Manager, you can combine multiple Datasheets for 
streams and operations in a single report and print the entire 
document. You can also format the display of the report to meet 
your requirements.

 Figure 9.5

The Report Manager can only be accessed in the Simulation 
environment.
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The Report Manager is accessed by selecting Reports from the 
Tools menu, or by using the hot key combination CTRL R.

9.3.1 Creating a Report
Click the Create button in the Report Manager to open the 
Report Builder property view for creating a new report.

The Printing group provides the same functions as what you find 
in the Report Manager.

 Figure 9.6

Shows the Reports 
installed in the 
simulation case. 
Report1 is a default 
name, Second 
Report is a user 
specified name.

Deletes the selected 
Report.

Opens the Report 
Builder property view 
so you can edit the 
selected Report.

Displays a Preview 
of the Report.

Updates and 
prints the selected 
Report.

Opens the Report 
Builder property view 
for creating new 
reports.

Selects the 
output format. If 
selected, HYSYS 
prints the 
Datasheet to an 
ASCII file.

All reports created for 
the simulation are 
listed in the Available 
Reports group.

 Figure 9.7

By default, it is 
named Report1. 
You can type a 
new name in this 
field.

Displays the 
current 
number of 
pages in the 
report.

Allows you to rearrange the list in the Report 
Datasheets group. The selected Datasheet is 
moved up or down within the list.

Removes a 
selected 
Datasheet 
from the 
report.

Allows you to add 
available 
Datasheets to the 
report.

Allows you to edit the 
selection made for the 
selected Datasheet.
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Inserting a Datasheet
Click the Insert Datasheet button in the Report Builder property 
view to open the Select Datablocks for Datasheet property view 
as shown below. 

The property view is divided into the Source for Datablocks and 
Available Datablocks groups. The Source for Datablocks Group 
contains a list of available flowsheets and the following radio 
buttons:

• Pick a Specific Object by Name
• Pick All Objects of a Given Type 

The information contained within the group changes depending 
on the radio button selected.

The Available Datablocks group lists the datablocks that can be 
added to the report.

Pick a Specific Object by Name

When the Pick a Specific Object by Name radio button is 
selected, the Objects list and Filter group appear as shown in 
Figure 9.8. This allows you to insert individual Datasheets for 

 Figure 9.8

To return to the Report Builder property view without adding 
a Datasheet, click the Cancel button.
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any object that is present in the simulation case.

To add a Datasheet to your report, do the following:

1. From the list of available flowsheets, click the flowsheet 
containing the objects you want to add to the Datasheet.

2. From the list of available objects, select an object.

3. In the Available Datablocks tree browser, all datablocks 
available for the selected flowsheet object appear. Select the 
datablocks you want to add to the report by clicking in their 
corresponding checkboxes. 

4. Click the Add button to add the datablocks with checkmarks 
to the report.

5. Repeat steps 1 to 4 for each Datasheet that you want to add 
to the report.

6. Click the Done button when all Datasheets are added.

Pick All Objects of a Given Type 

When the Pick All Objects of a Given Type radio button is 
selected, the list of available object types appears as shown in 
the figure below. This enables you to insert Datasheets for all 

Use the Filter to narrow the search list of available objects.

Expand some of branches in the tree browser by clicking the 
Plus icon  to reveal more datablocks.
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object types in the simulation case.

To add a group of Datasheets, do the following:

1. From the list of available flowsheets, select the flowsheet 
containing the objects you want to add the Datasheet.

2. In the list of available object types, select an object type (for 
example, material stream or compressor). To expand the 
tree browser and view the branch-items, click the Plus icon 

. 

3. In the Available Datablocks tree browser, all datablocks 
available for the selected flowsheet object appear. Select the 
datablocks you want to add to the report by clicking the 
corresponding checkbox. 

4. Click the Add button to add the datablocks with checkmarks 
to the report.

5. Repeat steps 1 to 6 for each Datasheet being added to the 
report.

6. When all Datasheets are added, click the Done button.

Editing a Datasheet
1. From the list of available report Datasheets in the Report 

 Figure 9.9

For the selected object type, add Datasheets to the report for 
objects that reside within subflowsheets. Select the Include 
Sub-Flowsheets checkbox.
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Builder property view, select the Datasheet you want to edit.
2. Click the Edit Datasheet button to open the Select 

Datablocks for Datasheet property view. 

3. Use this property view to edit the Datasheet.

Removing a Datasheet
1. From the list of available report Datasheet in the Report 

Builder property view, click the Datasheet you want to 
delete.

2. Click the Remove Datasheet button. You are not prompted 
to confirm the deletion of the Datasheet.

9.3.2 Editing a Report
1. From the list of available reports in the Report Manager 

property view, click the report you want to edit.
2. Click the Edit button to open the Report Builder property 

view. 

9.3.3 Deleting a Report
1. From the list of available reports in the Report Manager 

property view, click the report you want to delete.
2. Click the Delete button. You are not prompted to confirm 

the deletion of the Datasheet.

9.3.4 Report Format & Layout
When the Text to File checkbox in the Report Builder and 
Report Manager property views is clear, the Format/Layout 
button appears. Click this button to open the Report Format and 
Layout property view. This property view displays the options 

Refer to the section 
Inserting a Datasheet 
for more information 
about the Select 
Datablocks for Datasheet 
property view.

Refer to Section 9.3.1 - 
Creating a Report for 
more information about 
the Report Builder 
property view.
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available for customizing the format and layout of your report.

 Figure 9.10

Specification values for the page size and orientation.

Specify the distance 
between each border 
and the edge of the 
report page. Default 
units correspond to the 
page width and height 
units.
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The following options in the Format group allow you to 
determine how the data will appear in the report:

Click the Set Preferences button to save your format selections 
in HYSYS preferences. This enables you to use the same settings 
for each report you create. Click the Use Preferences button to 
load the settings into any future reports.

9.3.5 Text Report Format
When the Text to File checkbox in the Report Builder and 
Report Manager property views is selected, the Delimited 
checkbox is available and the Format button appears.

• Select the Delimited checkbox if you want your text file 
to be text delimited.

• Click the Format button to open the Text Format property 
view. This property view displays the options for 
formatting your text file.

Field Description

Shading When selected, the headers, footers and titles are 
shaded.

Line Number When selected, line numbers appear on the left side of 
each page.

Thick Borders When selected, the report borders are thicker than the 
other lines in the report.

Indicate User 
Specified

When selected, any user specified values in the 
Datasheet are indicated with an asterisk “*”.

Start Datasheet 
on New Page

When selected, each Datasheet starts on a new page.

Empty Text Specify what displays in the report when there is no 
value available. The default is ---.

Unit Set Select the unit set you want your report to use. This 
gives you the option of printing reports with different 
unit sets than your case. For example, your case may 
be in SI, but you require your report to be in Field 
units.

The default report format is set in the Session Preferences.Refer to Section 12.4 - 
Reports Tab for more 
details.
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The items in the Options When Delimited group allow you to 
control how data appears in the report:

From the Unit Set drop-down list, select the unit set you want 
your report to use. This gives you the option of printing reports 
with different unit sets than in your case. For example, your 
case may be in SI, but you can print the report in Field units.

Click the Set Preferences button to save the format selections 
you defined in HYSYS preferences. This allows you to use the 
same settings for each report you create. Click the Use 
Preferences button to load the settings into subsequent reports.

 Figure 9.11

Field Description

Text is Delimited When selected, the text file will be delimited.

Title Description 
Visible

When selected, a title is added to the text file. The title 
includes the name of the object and the tabs in the 
report.

Header Field 
Visible

When selected, a header is added to the text file. The 
header includes the company information and the date 
the file was created.

Footer Field 
Visible

When selected, a footer is added to the text file. The 
footer includes the HYSYS version and build number.

Fields Padded for 
Alignment

When selected, spaces are added between each field to 
align the fields in the report.

Disable Column 
Wrapping

When selected, column wrapping is disabled. This 
means that text running past the edge of the page 
does not wrap onto the next line.

Empty Text Specify what you want to display in the report when 
there is no value available. The default is ---.

Delimiter Specify what you want to use as the delimiter in your 
text file. The HYSYS default is ‘,’.
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9.3.6 Printing & Previewing 
Reports

A report can be printed or previewed from either the Report 
Manager property view or the Report Builder property view. 
Click the Print button in either of these property views and the 
entire report is updated and printed.

When you preview a report, a print button is available on the 
preview screen so you can print directly from the preview.

9.4 Printing the PFD as a 
File

You can use HYSYS to create an ASCII Drawing Interchange File 
(DXF) representing the HYSYS PFD. The *.dxf file can then be 
read into AutoCAD. By default, the file created is called pfd.dxf 
and contains the entire PFD regardless of what is visible on the 
screen. A different layer is generated for each of the following 
groups:

• Physical unit operations (pfdOP)
• Logical unit operations (pfdLOGICOP)
• Streams (pfdSTREAM)
• Stream labels (pfdLABEL)
• Table or other text (pfdTABLE)

Each layer is created using standard AUTOCAD blocks.

The default report format is set in the Session Preferences.

To open the *.dxf file in AutoCAD Release 14, select DXF in 
the Files of Type drop-down list on the File Open property 
view.

Refer to Section 12.4 - 
Reports Tab for more 
details.

Refer to Section 9.2.2 - 
Printing Datasheets for 
more information 
regarding the Print 
Preview property view.
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To create a *.dxf file in HYSYS, do the following: 

1. Right-click the PFD and select Print PFD to File from the 
Object Inspect menu. 

2. Select Print to DXF File from the sub-menu. A standard 
windows file selection property view appears. 

3. Select the path and file name for the *.dxf file.

You can also right-click the PFD and select Print PFD to File 
- Setup DXF File. This opens the Setup DXF property view. 
This property view enables you to set which layers are sent 
to the file. Click the Print button, define the file location, 
and click the Save button. 

 Figure 9.12

 Figure 9.13
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An example of a pfd.dxf exported to AutoCAD appears below:

Included in the directory \HYSYS\Support\ is a header file 
named autocad.hdr. If you have trouble transferring the *.dxf 
into AutoCAD, changes may be needed in this header file. The 
default version of the header file may not be compatible with 
certain versions of AutoCAD and therefore, may need to be 
manipulated.

To check the header file, follow the steps below:

1. Start a completely new AutoCAD drawing.
2. Verify that the custom corporate title blocks and border are 

not in the blank drawing used to generate the test header.

3. Save the blank drawing as a *.dxf file using AutoCAD’s 
DXFOUT command.

4. Compare the *.dxf file of the blank drawing to the 
AutoCAD.hdr supplied with HYSYS.

 Figure 9.14
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10.1 Introduction
This chapter explains the commands that are available through 
the Edit menu and provides information on editing PFD objects.

You can access the Edit menu commands in three ways: 

• Select the Edit menu in the menu bar. 
• Use the ALT key in combination with the letter E.
• Use the ALT key by itself to move the active location to 

the File menu in the menu bar. 

The UP and DOWN arrow keys move you through the menu 
associated with a specific item, while the left and right arrows 
move you to the next menu bar item, automatically opening the 
associated menu. If you want to switch focus from the menu bar 
without making a selection, press the ESC key or the ALT key.

10.2 Edit Menu
The functions listed under the Edit menu are available in all 
environments (Basis, Simulation, and subflowsheet 
environments) and can be used across environments and 
outside of HYSYS:

Although the edit functions are available throughout HYSYS, not 
all areas within the environments support them. Only matrix 
type areas can be manipulated. 

For example, you can copy a group of cells from the Workbook 
or from a table and paste them into the spreadsheet. In most 
areas, you can manipulate a group of cells by clicking and 

Command Description

Cut Copy and remove the selected values/objects from the 
current property view.

Copy Copies the selected values/objects to the clipboard.

Copy Special 
/ with Labels

Copies the selected values/objects and their corresponding 
labels to the clipboard.

Paste Place copied or cut selections in the location of your choice 
or in another application.

Edit menu
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dragging them with the mouse. Whenever cells are grouped 
within a matrix (for example, the inlet streams for a mixer as 
shown in the figure below), you can select more than a single 
cell.

10.3 Editing the PFD
The appearance of the PFD can be modified including all objects 
that are installed in the PFD: 

• Streams
• Unit Operations
• Logical Operations
• Labels
• Text Annotations 

In addition to selecting alternate icons for the operations, you 
can manipulate the routing of streams, swap nozzle connections 
for two streams attached to the same operation, move and size 
icons, add text, transform the orientation of objects, and change 
text fonts and colours.

Use the following tools to modify the appearance of the PFD: 

• Menu Bar
• Mouse and Keyboard
• Object Inspect menu

 Figure 10.1

Any PFD in the simulation can be accessed from any location 
in the Simulation environment by clicking the PFD icon or 
using the CTRL P hot key.

PFD icon
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• PFD Inspection Menu

10.3.1 PFD Menu
The PFD menu is only available when the PFD is open and 
active. The commands contained in the PFD menu are described 
in the table below:

The items being modified must be selected before using 
these tools.

Command Description

Select Objects Select multiple operations and streams on the PFD. 
The Select Objects property view contains a filter for 
narrowing object selection. See Menu Bar Option for 
more information.

Show Hidden 
Objects

Hidden objects in the PFD can be viewed using this 
command. When selected, the Show Hidden Objects 
property view appears.

See Revealing Hidden Objects for more information.

Break a 
Connection

Breaks the connection between a stream and an 
operation without deleting either.

See Disconnecting Using the Break Connection 
Tool for more information.

Swap 
Connections

Select two streams that are attached to the same 
operation and exchange their nozzle connections.

See Section 10.3.11 - Swapping Connections for 
more information.

Auto Position All Repositions all objects on the PFD to the best possible 
location as determined by the application.

See Section 10.3.7 - Auto Positioning for more 
information.

Auto Position 
Selected

Auto positions only selected objects.

See Section 10.3.7 - Auto Positioning for more 
information.

Select Mode Select the operating mode for the PFD. This is either 
Move, Size, or Attach.

See the PFD Modes section for more information.

Drag Zoom Click and hold the mouse button to drag a frame 
around a region, then release the mouse button. The 
PFD is redrawn showing only that region.

Add a PFD Adds a new page to the PFD Notebook. The command 
to clone an existing PFD is available.

PFD menu
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10.3.2 Object Inspect Menu
Use the Object Inspect menu to manipulate the icons in the PFD. 
The menu options vary depending on the selected item (Stream, 
Operation, Column or Text Annotation).

The entire PFD Object Inspect menu can be accessed by right-
clicking on an area of the PFD where there are no icons. The 
menu of available commands appears. 

Delete this PFD Deletes the active PFD without a prompt to confirm the 
action. You cannot delete the PFD if it is the only one in 
the case.

Rename this PFD Change the name of the PFD that appears on the tab.

To access the Object Inspect menu of an icon, position the 
cursor over the icon and right-click.

 Figure 10.2

Command Description

General Object Inspect 
menu for Icons.

General Object Inspect 
menu for the PFD.

For subflowsheet operations (including the 
column subflowsheet), the following two 
extra commands appear. 

For stream, the 
following extra 
command appears. 
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10.3.3 PFD Tools
Several tools are provided to help simplify interaction with the 
PFD. These tools are described in the following section.

Pan/Zoom Functions
 The pan and zoom functions allow you to focus on a particular 
area within the PFD or to view all the objects within the 
flowsheet. The following table describes the available functions:

A menu item with an arrow head pointing to the side has 
further commands on a sub-menu.

Function Icon Definition

Zoom Out Zooms the display out by 25%. Click the 
Zoom Out icon, located in the lower left of the 
PFD, or use the keyboard command SHIFT 
PAGE DOWN.

Zoom In Zooms the display in by 25%. Click the Zoom 
In icon, located in the lower left of the PFD, or 
use the keyboard command SHIFT PAGE UP.

Zoom All Displays all visible objects in the current PFD. 
Click the function icon, located in the lower 
left of the PFD, or use the keyboard command 
HOME.

Zoom Out display 
5% 

Use the keyboard command PAGE DOWN.

Zoom In display 
5%

Use the keyboard command PAGE UP.

Zoom In

Mouse Wheel

Scroll the mouse wheel forward to display the 
PFD zoom in.

Zoom Out

Mouse Wheel

Scroll the mouse wheel backward to display 
the PFD zoom out.

Zoom In

HOME Key

Select PFD objects and press the HOME key 
to zoom in on those objects. If no objects are 
selected, the entire PFD is shown.

Toggle between 
last two Zoom 
property views

Use the keyboard key Z.

Pan 15% Left, 
Right, Up, Down

Use the keyboard arrow keys: left, right, up, 
down.

Pan 70% Left, 
Right, Up, Down 

Use the SHIFT key combined with one of the 
arrow keys: left, right, up, down.
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PFD Modes
The PFD operates in the following four modes:

• Move
• Attach
• Auto Attach
• Size

Only one mode can be active at a time, so when you are in 
attach mode, you cannot move or resize icons. There are three 
ways to change the PFD mode:

• Select the Select Mode command from the PFD menu 
to open the Select PFD Mode property view. Use the radio 
buttons in the PFD Mode group to select the mode.

• Right-click the PFD, then select the mode options in the 
Mode sub-menu from the PFD Object Inspect menu.

Pan Mouse 
Wheel

Click the mouse wheel (or middle mouse 
button) and move the mouse to pan the 
property view. To stop, click the mouse button 
a second time.

Centre PFD on 
cursor

Press the PERIOD key on the keyboard, and 
the PFD shifts, making the location of the 
cursor the centre of the property view.

For the PFD to respond to the keyboard command, it must be 
the active property view.

 Figure 10.3

Function Icon Definition
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• Use the icons in the PFD toolbar.

Auto Attach Mode

In Auto Attach mode, any unit operation added to the PFD is 
automatically attached with the required material and energy 
streams. The generated streams are automatically named based 
on the user’s defined naming preference. 

The Auto Attach mode behaviour changes when a new unit 
operation is added, depending on what is selected in the PFD. 

• When nothing is selected and a unit operation is added, 
then the required streams are created and attached.

• The Auto Attach functionality is based on an anchor 
stream(s). Once a stream(s) is selected, it is treated as 
the anchor. The behaviour from this point is dependent 
on the current connectivity of the anchor stream(s).
If the anchor stream is a product from a unit operation, it 
is automatically attached as the feed to the unit 

Name Icon Definition

Move/Attach 
Mode

Controls the Move and Attach modes in the PFD. 
Move is the default setting and is used to relocate 
selected operations and streams. 

When the icon is “pressed” you are in Attach mode 
and can connect streams and operations 
graphically. 

Auto Attach 
Mode

In this mode, new operations placed on the PFD 
automatically have their own required material 
and energy streams connected to them. These 
generated streams are automatically given a 
numerical value for a name. 

Size Mode When in Size mode, selected objects can be sized. 
A selected sizeable object appears with a box 
around it, and this box contains eight smaller 
white boxes around its perimeter. Using the 
mouse, drag the size of the box in any of these 
eight directions. 

Auto attach mode does not attach energy streams already in 
the PFD to an added operation, even if the energy stream is 
selected and the operation requires an energy stream. 

Auto attach mode always generates and attaches new 
energy streams for added operations that require energy 
streams.

Refer to Section 10.3.18 
- Connecting Streams 
& Operations for more 
information about Attach 
mode.

Refer to Auto Attach 
Mode section for more 
information.

Refer to Section 10.3.4 - 
Selecting PFD Objects 
for more details on sizing 
PFD objects.

Refer to Section 12.2.4 
- Naming Page for more 
information on setting 
the naming preference.
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operation being added. The remaining streams for the 
unit operation are automatically created and connected.
If the anchor stream is a feed stream to another unit 
operation, it is automatically attached as a product to the 
unit operation being added.

If the anchor stream is both a feed and a product, you 
are prompted to insert the unit operation upstream or 
downstream of the anchor stream.

• When multiple streams are selected (in some cases), this 
mode attaches multiple feeds and products depending on 
what is selected (in other words, one feed and one 
product or three feeds and a product). 
When one product and one feed are selected and a new 
unit operation is added, both the feed and product 
streams are attached to the unit operation along with the 
remaining required streams. 
If multiple feeds and a product are selected and a new 

Since most unit operations have multiple product streams, 
the selected product stream is attached to the top product 
stream (usually the vapour stream).

 Figure 10.4

In this example a valve is attached to Stream D using Auto Attach Mode. 
The valve is placed upstream of Stream D.

Product stream of Unit B is now stream 1.
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mixer or separator is added, all the selected feeds and 
the product are attached to the unit op along with the 
remaining required streams. 
When multiple feeds and products are selected, multiple 
feeds are attached to the mixer or separator, but a new 
product stream is created because the system does not 
know which selected product stream attaches to where. 
You can select multiple product streams and use Auto 
Attach mode to add a tee.

• Auto attach mode has limitations; with the subflowsheet 
and template, it creates all required streams and 
attaches them to the unit operations. Because there are 
so many different feeds and products, even if there is a 
feed or product selected, all new streams are attached, 
but not necessarily where you wanted them attached.

• You are not limited to selecting streams; you can also 
select a unit operation. 
If you select a unit operation with a single feed and a 
single product and add a new unit op, then a property 
view prompts you to add the unit operation upstream or 
downstream of the selected unit operation. 
For example, the figure below displays a property view 
prompting an object to be attached up or down stream:

If you select a unit operation with multiple feed or 
products and add a new unit operation, you are 
prompted to select a stream from a list of streams that 
are attached to this selected unit operation. You are also 
prompted to specify if the new unit operation is to be 
attached upstream or downstream of the stream selected 
from the attachment list.

 Figure 10.5
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Additional Icons  
Name Icon Function

Break 
Connection 

Break the connection between a stream and an 
operation. When you place the cursor over the 
stream you want to break, the cursor appears with 
a checkmark. Click any portion of the stream 
between the stream icon and the operation to 
break the connection. 

Swap 
Connections 

Switches the nozzle connection points for two 
streams attached to the same operation. 

Drag Zoom When you click this icon, the cursor becomes an 
arrow and magnifying glass combination. Click and 
drag around a region of interest to redraw the PFD 
showing only the selected region. You can also 
Zoom from the PFD Object Inspect menu by 
clicking Mode and then Zoom (see Figure 10.6) 
or by selecting Drag Zoom from the PFD menu in 
the menu bar.

Add Text 
Annotation

Adds text to a PFD. When clicked, a + symbol is 
added to the regular cursor and a rectangular box 
appears at the end of the pointer. Position the 
cursor where you want to place the text, click the 
mouse button, and then type the text into the 
property view that appears. 

Quick Route 
Mode

Move icons quickly about the PFD (in other words, 
object icons can be moved with their attached 
streams overlapping the other object icons). 
Turning off the Quick Route mode, enables HYSYS 
to reposition the stream lines so that there is no 
overlap of the object icons. 

Drag Mode Enables you to shift/scroll through the PFD 
property view and see other areas of the PFD. To 
scroll across the PFD, click and drag the mouse 
cursor on the PFD. Similar functions as the scroll 
buttons, except with in the Drag mode you can 
scroll diagonally.

Object 
Palette

Enables you to access the Object Palette. 

Colour 
Scheme

Displays the PFD Colour Schemes property view. A 
new scheme can be created or an existing one 
selected, edited or deleted.

Refer to Section 10.3.19 
- Disconnecting 
Streams & Operations 
for more details.

For more information, 
refer to Section 10.3.11 
- Swapping 
Connections.

Refer to Section 10.3.22 
- Annotations & Labels, 
for more information.

Refer to Section 10.3.16 
- Stream Routing for 
more information.

Refer to Section 8.1.1 - 
Install Objects Using 
the Object Palette for 
more information.
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10.3.4  Selecting PFD Objects
To manipulate the PFD, you must be able to select PFD objects 
such as streams, operations, and text annotations. You can 
select single or multiple objects, but you cannot be in Attach 
mode when doing so.

Single Object Selection
To select a single object in the PFD, do one of the following:

• Position the cursor over the object and click the mouse 
button. The object has a white rectangular box around its 
icon when selected.

• Use the keyboard by pressing S to cycle through all items 
in the PFD and SHIFT S to cycle backwards through all 
items.

 Figure 10.6

If you are trying to perform a function in the PFD (such as 
Move, Size, or Attach) and it is not working, check the icons 
to see if you are in the correct mode.

When an object is selected, the icon is surrounded by a 
border and the label background is selected.

Press and hold SHIFT while clicking the objects to select 
scattered multiple objects in the PFD.
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Multiple Object Selection
There are three methods available to select multiple objects and 
they are as follows:

• Mouse drag option
• Menu bar option
• Keyboard/mouse option

Mouse Drag Option

If selecting multiple objects within the same area, click and hold 
the mouse button while dragging a box around the entire group 
of objects. When all of the objects are within the box, release 
the mouse button. Each object is outlined to indicate that it is 
selected.

Menu Bar Option
1. From the PFD menu or the PFD Inspection menu, select 

the Select Objects command. The Select Objects property 
view appears.

2. From the list of available objects, select the necessary 
objects. Select multiple objects by holding down the CTRL 
key and clicking each object being selected. 

To select a label, right-click the label or the object that it is 
attached to, and select the Move/Size Label command. 
Alternatively, select the object and press the L key.

 Figure 10.7
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3. Click the OK button after all selections are made. This closes 
the property view and returns you to the PFD. Each object is 
outlined to indicate that it is selected.

Keyboard/Mouse Option
1. Position the cursor (in the PFD) over the first object you 

want to select and click the mouse button. 
2. To select a second object, hold down the SHIFT key and 

click the second object. The two objects are now selected.

3. Repeat step #2 until all the necessary objects are selected.

10.3.5 Deselecting PFD 
Objects

Any of the following methods can be used to deselect an object:

• Click any empty spot in the PFD.
• Press the D key to deselect all the selected items.
• Press the SHIFT key and click on a selected object to 

deselect only that one item.

10.3.6 Moving Objects

You can move objects individually or as a group.

1. Select the object or objects you want to move.
2. Position the cursor over one of the selected objects.

3. Press and hold the mouse button while dragging the cursor 
to the new position on the PFD. Release the mouse button. If 
multiple objects are selected, all selected objects move 
simultaneously.

Use the filter option for a more specific list of objects.

Objects can be moved in either Size or Move mode.
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The keyboard can also be used to move an object within the 
PFD. Select the object(s) to move. Use the arrow keys to move 
up, down, right, or left. The object moves one space at a time. 
To move an item in larger increments, hold the SHIFT key down 
while pressing the arrow keys.

10.3.7 Auto Positioning
Use the Auto Positioning function to automatically reposition 
streams and unit operations. Select the object(s) being 
repositioned and an internal algorithm determines the current 
location of objects on the PFD. This information is then used to 
set the most appropriate location for the selected object(s).

Auto positioning works differently depending on the object 
selected. For unit operations, a new location for the object is 
determined and it is placed in that position. Manually moving 
streams attached to the unit operation after the auto positioning 
has no effect on the position of the unit operation icon.

When a stream is auto positioned, it becomes a floating icon 
until it is manually moved. This means the stream is initially 
positioned by HYSYS after the Auto Positioning function is 
accessed. If a unit operation icon that is attached to the stream 
is then moved, the stream is automatically repositioned, floating 
with the unit operation icon. 

When you manually move a selected stream, the auto 
positioning function becomes inactive. Any subsequent 
movement of an operation that this stream is attached to does 
not affect the position of the stream. Use the Auto Positioning 
function again to have the stream move with the operation.

The internal Auto Snap feature can prevent an icon from 
being moved with the keyboard arrow keys.

See Section 10.3.8 - 
Aligning Icons section for 
more information.
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You can access Auto Positioning in the following ways.

10.3.8 Aligning Icons
This function can be used to horizontally or vertically align any 
combination of streams and objects on the PFD. Each object has 
a predetermined point through which it is aligned. 

1. Select the objects that you want to align. At least two 
objects must be selected.

2. Right-click the icon that is to be the anchoring point (all 
other selected objects are aligned with this icon).

3. Select Align Selected Icons from the Object Inspect menu.

10.3.9 Auto Snap Align
The Auto Snap feature on the PFD automatically aligns objects if 
they are moved within an internally set tolerance. This feature 
helps eliminate the irregular line segments that might occur for 
streams.

The Auto Snap feature is always active and cannot be toggled on 
and off. This poses a problem if you want to move an icon using 
the keyboard arrow keys. If HYSYS detects that the object is 
within the set tolerance, the object initially moves in the 
direction of the arrow key, but snaps back to its original 
position. To overcome this, use the SHIFT key with the 
keyboard arrow key to move the object by larger increments.

Method Description

Menu Bar From the PFD menu, select either Auto Position All or 
Auto Position Selected.

Object Inspect 
menu

Select Auto Position from the Object Inspect menu. 
Only selected items are repositioned.
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10.3.10 Sizing Objects
Operations and streams installed on a PFD are all a standard 
size. Sometimes the size of these objects needs to be changed; 
this can be done in Size mode only.

1. Activate the Size mode by doing one of the following:
• Click the Size Mode icon in the PFD toolbar. 
• Select the Select Mode command from the PFD menu. 

The Select PFD Mode property view appears.

Click the Size radio button.
• Right-click in the PFD and select Mode>Size from the 

Object Inspect menu.
2. Select the object being resized. A white outline with eight 

handles appears around the icon. These identify the 
directions in which you can size the icon.

3. Place the cursor over one of the target handles. The pointer 
changes to the sizing tool (line with an arrowhead at each 
end) indicating the directions that the object can be 
stretched or compressed.

4. Click and drag the mouse in the direction you want to size 
the object. The icon is sized according to the change in the 
size of the box.

 Figure 10.8

 Figure 10.9

Size Mode icon

Sizing 
Tool
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The Pump shown in Figure 10.9 is ready to size, however, 
the name associated with it, P-100, is not resized. It remains 
at its default size even though the size of its associated icon 
changes. To change the size of the label, change the Font 
size of the text. 

Rather than sizing several objects individually, you can size 
multiple objects simultaneously. Enter Size mode and select the 
objects you want to size. Each object has its own outline around 
it. Select any one of these boxes and then resize the object. All 
the selected objects are sized by this factor.

10.3.11 Swapping Connections
This function lets you select two streams attached to the same 
object and swap their nozzle connections. This is useful when 
streams cross each other.

1. Activate the Swap Connections tool by doing one of the 
following:
• Click the Swap Connections icon in the PFD toolbar.
• Right-click a connection point and select Swap 

Attachments from the Object Inspect menu.
• Select Swap Connections from the PFD menu.
• Press the F hot key to activate the Swap Connections 

icon.The ESC key reverses the effect of the F key.
2. The cursor (when it is over an area of the PFD) takes on a 

special flip stream appearance, indicating which streams are 
available for the operation (arrow with a checkmark and a 
number 1).

3. Click the first stream you want to swap and the cursor 
changes (replacing the 1 with a 2).

4. Click the second stream being swapped.

You can size Labels and Annotations only horizontally and to 
a maximum size. This is useful for text containing more than 
one line. You can size such a text box so that all text appears 
on one line.

Refer to Moving & Sizing 
Labels section for more 
information.

Swap Connections icon

Available to Swap 
Connections

Unavailable to 
Swap Connections
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5. After the swapping is complete, the Swap Connections 
icon is released.

10.3.12 Transforming Icons, 
Labels, & Annotations

When you add a unit operation, stream, or annotations to the 
PFD, the icon appears as shown in the Object Palette. You may 
want to alter the orientation of an icon to improve PFD clarity. 
This can be done using rotating and mirroring functions.  

Access the Rotate and Mirror functions from the Object Inspect 
menu.

1. Select the object(s) you want to transform. 
2. Right-click on one of the objects to open the Object Inspect 

menu.

HYSYS indicates an unacceptable choice for Swap 
Connections by replacing the checkmark with an X.

Method Description

Transform-Rotate Rotate the icon of a selected object (clockwise) 
about its centre in one of three ways, 90 degrees, 
180 degrees, and 270 degrees.

Transform-Mirror Mirrors the object about the X or Y axis.

You can use the Rotate and Mirror functions to change the 
orientation of multiple objects at the same time.

Keyboard commands for selected objects:

• X mirror about X axis
• Y mirror about Y axis
• 1 rotate by 90
• 2 rotate by 180
• 3 rotate by 270
• N returns original orientation
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3. Select Transform to open a sub-menu containing the 
Rotate and Mirror functions. Click the required function.

10.3.13 Changing Icons
HYSYS always displays the default icons for the PFD. However, 
there are optional icons that can be used to represent the same 
unit operation.

1. Select the unit operation for which you want to change the 
icon.

2. Right-click on the unit operation to open the Object Inspect 
menu.

3. Click Change Icon (if there are no alternate icons, this 
command is disabled in the menu). This opens the Select 
Icon property view.

4. Click the icon you want to use. The figure below shows the 
options available for the Cooler operation.

5. Click OK to accept the selection and return to the PFD.

 Figure 10.10

 Figure 10.11

Select the Default checkbox to 
make the selected icon the 
default icon for your simulation. 
This icon is then used the next 
time you add this type of 
operation.
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If you have more than one icon selected in the PFD and they 
represent the same type of operation, then you can change all 
selections to an alternate icon at the same time. If the 
operations are of different types, the Change Icon command is 
not available in the Object Inspect menu.

Wire Frame & 3D Icons
When you right-click a three dimensional icon, the Draw Wire 
Frame command is available in the Object Inspect menu. Any 
operation or stream with a three dimensional icon can be 
transformed to an outline representation, or a Wire Frame. A 
wire frame of the Cooler is shown in the figure below.

Alternatively, the Object Inspect menu of a wire frame object 
contains the Draw 3D command, which draws the icon in its 
default 3D image.

To switch all objects into wire frames, do the following:

1. Select all objects. 
2. Right-click one of the objects and select the Draw Wire 

Frame command in the Object Inspect menu.

Thick Stream Line
The Draw Thick Streamline command (in the stream Object 
Inspect menu) creates a more visible stream by making it wider 
than the other streams. This command is useful when tracking 
one particular stream in a complex flowsheet (for example, a 
pipe network).

Return a stream to its default thickness by right-clicking the 
stream and clicking Draw Normal Streamline from the Object 
Inspect menu.

 Figure 10.12

Cooler 3D Icon Cooler Wire Frame Icon
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10.3.14 Publish Stream/
Operation

HYSYS has several ways of distributing simulation case 
information. One of these types of distribution is referred to as 
publishing. When you publish an object in HYSYS, you are 
putting the object’s data on to a RTI Data Server, where it can 
be shared with other cases. The object’s data is information 
about the object’s configuration and the condition of the object. 
The fluid package associated to the object is optional and only 
applies to streams.

Before you publish an object, you must set your RTI server 
connection. After your RTI server is set up, you can publish the 
object’s information.

To publish a stream or a unit operation, do the following:

1. Select the stream or operation on the PFD.
2. Right-click and select Publish Stream or Publish Unit 

Operation from the Object Inspect menu.

3. The Stream Public Information property view appears.

4. Enter your name and the information associated with the 
object. You can select the Include Property Package 
Information checkbox to include the fluid package 
associated with the object. 

 Figure 10.13

Refer to Section 11.19 - 
Case Collaboration for 
more information about 
published objects.

Refer to Section 12.2.9 - 
RTi Server Page for 
information about setting 
up the RTI server in the 
Session Preferences.

Enter your name in this field.

You can add a description about 
the object you are publishing in 
this field.

You can select whether to include 
or exclude fluid package 
information by using the checkbox.
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5. Click the Submit button to publish the object.

10.3.15 PFD Navigation

Auto Scrolling
Unlike most of the features available on the PFD, the auto 
scrolling function cannot be accessed through the main menu or 
by using the keyboard. Only the mouse can be used to access 
this feature.

Auto scrolling enables continuous horizontal or vertical scrolling 
of the active pane, depending on the location of the mouse.

To initiate auto scrolling, do the following:

1. Place the cursor anywhere in the active property view. 
2. Press and hold the mouse button and drag the mouse near 

the PFD pane boundary. When the cursor enters a 15 pixel 
boundary at a pane edge and remains anywhere within the 
boundary for 0.3 seconds, the property view of the PFD 
begins to scroll. The boundary closest to the cursor 
determines the direction of scrolling.

The speed of scrolling can be varied by moving the mouse within 
the boundary near the edge of the property view. Faster 
scrolling occurs as the cursor is moved closer to the outside.

Mouse Wheel Scrolling
As an alternative to using the scroll bars, you can scroll to any 
location on your PFD using the mouse wheel (or middle mouse 
button). Click the mouse wheel while the cursor is in the PFD. 
The cursor changes to the static PFD scroll cursor. Point the 
mouse in the direction you want to scroll. After you have 
reached the location that you want to view, either click the 
mouse wheel a second time or place the cursor directly over the 
static PFD scroll cursor (which remains on your PFD until you 
click the mouse wheel).

Scroll Button

The Static PFD Scroll 
cursor 

The Scrolling Cursor 
points in the direction 
that the focus is moving. 
10-24



Edit Options 10-25
10.3.16 Stream Routing

Quick Route Mode
To maintain clarity in the PFD, streams should not overlap unit 
operation icons. When working with large, complex flowsheets, 
each movement of an object causes HYSYS to reposition 
streams so that no unit operation icons are covered. If the PFD 
is complex, this repositioning can consume valuable 
computational time.

When you use the Quick Route function, HYSYS relocates and 
connects the objects without considering the other objects in the 
flowsheet. For example, if moving a valve, its icon and streams 
are relocated without repositioning the streams, even if one 
passes over another icon.

After exiting Quick Route mode, the streams are repositioned 
automatically so they do not overlap the icons. This means the 
streams are repositioned once instead of after relocating each 
object.

To access the Quick Route function, click the Quick Route icon 
in the PFD toolbar. After manipulating the objects on the PFD, 
click the Quick Route icon again to ensure that no streams 
overlap unit operation icons.

Manual Routing of Streams
There are two types of manual stream routing:

• Moving the location of a horizontal or vertical line 
segment

• Adding bend points to create a new route for some 
portion of the stream 

The Quick Route function can be accessed in any mode.

Quick Route icon
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Full Manual Route mode can only be accessed by right-clicking a 
stream (not the stream arrow icon). From the Object Inspect 
menu, select the Manual Route command. 

Only the portion of the stream that is inspected becomes 
available for manual routing (in other words, right-click either 
the portion upstream or downstream of the stream icon will 
apply the selected route option on the upstream or downstream 
line respectively).

In Full Manual Route mode, a bend point is shown at the end of 
each line segment and the portion of the stream available for 
manual routing changes colour. You can then manipulate any of 
the line segments in the selected stream until the manual route 
is interrupted.

When not in Manual Route mode, you can still click on a stream 
line segment and drag that portion of the line. The bend points 
are not shown in this case.

Moving Line Segments

To move a portion of a stream, do the following:

1. Right-click the stream portion and select Manual Route 
from the Object Inspect menu. Anchor points appear at each 
corner of the stream route.
When you move the pointer over the stream, the pointer 
changes to a double arrowhead cursor.  

To exit the Manual Route function, click an empty area of the 
PFD.

 Figure 10.14

A Horizontal Stream Line 
can be dragged Vertically.

A Vertical Stream Line can 
be dragged Horizontally.
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2. Click the mouse button and drag the stream portion to the 
new location. As you move, a thin black line appears, 
indicating the new stream route.

3. Release the mouse button when you reach the target 
location. The stream is redrawn through the new path.

Adding Bend Points

Add new bend points to create a new route for a stream. The 
initial procedure is the same as moving line segments. Right-
click the stream and select Manual Route from the menu. The 
stream is re-drawn showing the existing bend points.

The idea of bend points is illustrated in the figure below.  

Bend point 2 is the one being manipulated. You can initially 
create a horizontal or vertical line segment and subsequent line 
orientation is determined by that first line, in other words 
horizontal segments follow vertical and vice versa.

This cursor is oriented in the direction in which you can 
move the selected stream portion; Vertical for a horizontal 
section and Horizontal for a vertical section.

The logic behind the routing procedure is that you alternate 
between horizontal and vertical sections of line with each 
successive bend point.

A bend point is an anchor that the stream passes through. 

Press the ESC key to end Manual Routing. Press the DELETE 
key to delete a manual route in progress.

 Figure 10.15

A Bend Point in this region 
produces a Vertical Line.

A Bend Point placed in this region 
specifies a Horizontal Line.
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To add new bend points to a stream:

1. Right-click on a stream and select the Manual Route 
command from the object inspect menu.

2. Select an existing bend point to begin the new route. The 
cursor changes to an arrow with a + symbol at the end when 
placed over a bend point.

Around a bend point there are four regions, two that define 
the next line as Horizontal, and two that define the next line 
as Vertical. As you drag the mouse pointer around the region 
of the bend point, a light coloured line shows the area where 
the new line routing is placed.

3. Click to place a new bend point. 

4. Continue to move the cursor to the location of the next bend 
point and place it by clicking the PFD. 

5. Manual Routing can only be completed by placing the final 
bend point on an existing bend point, otherwise the new 
routing you just laid out does not appear in the PFD. Any 
bend points added are erased.

Removing Bend Points 

In certain instances, bend points can be removed to provide a 
more direct route between operations. When there is an extra 
bend in the route, as shown in the figure below, close the 
section. 

The mouse cursor displays a checkmark at an acceptable 
location for the final Bend Point.

For slight kinks in a stream it could be easier to select the 
Stream icon and use the keyboard arrow keys to nudge it 
into place, rather than inserting and removing bend points.

 Figure 10.16
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Select either the horizontal section between points 1 and 2 and 
move it vertically until points 1 and 3 coincide, or select the 
vertical section (2 to 3) and move it horizontally until points 1 
and 2 coincide. Either route results in the extra bend being 
removed from the stream.

You can also remove several intermediate bend points. Select 
the bend point at the start of the section to be manipulated (in 
the case of the figure below, point 2). Next, select the bend 
point at the end of the section (point 9) and double-click on the 
end point. All intermediate bend points are removed.

Connection Line Straightening
The Connection Line Straightening function removes all bend 
points from a stream to straighten the line between the stream 
icon and the unit operation. To access this function, the 
orientation of the Stream icon must align with the nozzle 
connection (in other words, a horizontal stream icon is in 
alignment with a nozzle connected to the side of a unit 
operation).

To straighten a connection line, do the following:

1. Right-click the stream and select Straighten Stream Line 
from the Object Inspect menu.

2. The stream section being straightened becomes a thin red 
line and the cursor changes to the acceptable/unacceptable 
connection indicator.

 Figure 10.17

The end of the thin red line that is not selected serves as the 
anchor point, and does not move when the line is 
straightened.
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3. Move the cursor to either end of the red line where the 
cursor changes from an X to a checkmark, indicating an 
acceptable choice for line straightening.

4. Click to straighten the line.

Line Segment Alignment
While performing manual routing, the mouse can be used to 
align sections of streams. Horizontal sections are aligned 
horizontally and vertical sections are aligned vertically. The 
streams do not need to be connected to the same unit 
operation, but the stream sections must be in close proximity so 
that the internal tolerance for the function is not exceeded.

As an example of line segment aligning, a unit operation with 
multiple feeds is used. The Mixer, shown in the figure below, has 
three feed streams, two that contain vertical sections. For 
presentation purposes the vertical sections of the streams are to 
be aligned.

To align segments ab and cd, do the following:

1. Right-click the line segment ab and select the Manual 
Route command. The entire line becomes selected and its 
bend points are shown.

2. Click the anchoring segment, in this case segment cd.

The segments are now aligned. Follow the same steps for the 
alignment of horizontal segments.

 Figure 10.18
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10.3.17 Rebuilding the PFD
In addition to manipulating the PFD, you can also rebuild the 
PFD for any simulation case. 

1. Before opening the case you want to rebuild, use the hot key 
combination CTRL SHIFT K Z to display a message asking if 
you want to rebuild the PFD.

2. Click the Yes button. The Open Simulation Case property 
view appears. 

3. Open the case for the PFD you want to rebuild. If there is 
more than one PFD (in the main and subflowsheet 
environments), you are asked if you want to rebuild each 
PFD (in the main and subflowsheet environments).

4. Click Yes if you want to rebuild the specified PFD and No if 
you do not. If there is only one PFD (no subflowsheets), you 
are only asked once if you want to rebuild the main PFD.

10.3.18 Connecting Streams & 
Operations

There are two ways to connect streams to an operation:

• In the operation property view, select the streams’ name 
in the inlet and outlet field/cell. New streams can be 
generated and connected to the operation by entering 
the new stream’s name in the inlet and/or outlet field/
cell.

• On the PFD property view, make the connections in 
Attach mode. 

 Figure 10.19
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Connecting Streams & Operations in 
Attach Mode
The Attach mode can be used to connect an operation to an 
existing stream, generate a new stream connected to an 
existing operation, or create a new stream to connect two 
operations.

When the PFD is in Attach mode, connection nozzles and ports 
automatically appear on each icon as the cursor passes over the 
icon. In addition to the coloured boxes that indicate the different 
connection types, a Fly-by description appears when the cursor 
is placed over a connection nozzle or port.

Creating a New Stream from an Operation

To create a stream from an operation in Attach mode, do the 
following:

1. Enter Attach mode by, right-clicking on the PFD and 
selecting Mode | Attach command from the object inspect 
menu.

2. Place the cursor over the required operation connection point 
or nozzle. When the cursor is in the correct location, a white 
square appears at the tip of the cursor.

 Figure 10.20

Connection nozzle or port colours:
• Dark Red - Energy Stream
• Blue - Material Stream
• Green - Logical Connection

An exception to this is the Balance block 
which can accept both Material and 
Energy streams. All connections for the 
Balance are shown in green.

To temporary enter Attach Mode, hold down the CTRL key. 
Make the connections, then release the CTRL key to exit the 
Attach Mode.

These small 
boxes are 
connection 
nozzles and 
ports.
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3. Click and drag the mouse to an empty space in the PFD. 
Keep dragging the stream until the Stream Connection Tool 
cursor appears at the end of the stream. 

If you release the mouse button while a full black square is 
visible, the stream will not be created.

4. Release the mouse button and a stream icon appears.

HYSYS names the stream using the next stream name as 
defined under the current Session Preferences.

Connecting Operations to Existing Streams

In Attach mode you can connect streams operations or vice 
versa on the PFD. The procedure for both is identical.

To connect an operation to an existing stream, do the following:

1. Place the cursor over the required connection point, then 
click and drag the cursor to the target stream. A line 
indicating the creation of a stream appears as you move the 
mouse.

As you approach the stream, the available connection 
activates. When you are within the defined connection 
region for a nozzle (larger than the region used when HYSYS 
indicates available connection points), the cursor changes to 
the Stream Connection Tool cursor. 

2. To complete the connection, release the mouse button when 
a white square appears at the tip of the cursor.

Both Streams and Operations have nozzle(s) and port(s). 
The connection points that activate depend on the origin of 
the connection (for example, when connecting from a stream 
outlet only nozzles to operations appear).

Stream Connection Tool 
cursor

Refer to Chapter 12 - 
Streams in the HYSYS 
Operations Guide for 
more information about 
streams.

See Section 10.3.16 - 
Stream Routing for 
information on manually 
changing the route of a 
stream.

Stream Connection Tool 
cursor
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Connecting Two Operations

Directly connecting two operations automatically creates a new 
stream using the next available name as defined in the Session 
Preferences. To accomplish this, you must make the connection 
on the PFD in Attach mode.

1. Select the connection point of the operation to which the 
stream will be connected (in the case of Figure 10.21 the 
Valve, VLV-100).

2. Click and drag the new stream toward the operation that the 
stream is connected to (the separator V-100 in Figure 
10.21). The available connection points are indicated. In 
this case, because the stream is taken from the outlet of the 
Valve, only the connection point on the inlet area of the 
Separator appears.

3. When you reach the connection region, the cursor changes 
to a solid white square. Release the mouse button to 
complete the connection and create a new stream.

 Figure 10.21

Valve outlet nozzle 
where a stream 
connects

The long 
connection 
indicates that 
more than one 
feed can be 
attached

21

3
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Connecting Logical Operations

Logical operations can be connected to operations or streams in 
the same way as other objects. The only difference is that after 
the connection is made, the Select Adjusted Variable property 
view appears. This property view varies depending on the type 
of logical operation and whether the connection is made to a 
stream or operation. 

10.3.19 Disconnecting 
Streams & Operations

Connections between streams and operations can be broken by 
doing one of the following:

• Enter the operation’s property view and break the 
connection by deleting the stream’s name from the inlet 
or outlet cell/field.

• Break the connection on the PFD by using the Object 
Inspect menu or the Break Connection tool.

 Figure 10.22

Refer to Chapter 5 - 
Logical Operations in 
the HYSYS Operations 
Guide for more 
information.
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Disconnecting Using the Object 
Inspect Menu
Use this procedure to break a connection using the Object 
Inspect menu.

1. On the PFD, move the cursor to the stream where you want 
to break the connection (anywhere except over the stream 
icon).

2. When the cursor is over the stream line, it changes into the 
Move Segment cursor. Right-click the mouse button.

3. From the menu that appears, select Break Connection.

Depending on the selected stream, the Object Inspect menu 
may not have all of the commands as shown in the figure 
below.

 Figure 10.23

 Figure 10.24

The Swap Attachments command appears in the Object 
Inspect menu only when more than one stream is attached 
to a certain location (in other words, 2 feed streams).

Move 
Segment 
cursor
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Disconnecting Using the Break 
Connection Tool
The Break Connection tool lets you break an existing stream 
connection in the PFD. You can only break one connection at a 
time. If you want to break a second connection, select the Break 
Connection option again. You can either break an inlet or an 
outlet stream connection, depending on which side of the 
stream icon you select.

Use this procedure to break a connection using the Break 
Connection tool:

1. Access the Break Connection tool by doing one of the 
following:
• Select Break a Connection from the PFD menu. 
• Click the Break Connection icon in PFD toolbar.

2. Move the cursor to the stream where you want to break the 
connection. When the cursor is in position, it changes from 
an X to a checkmark. 

3. When the checkmark appears, click the stream. The 
connection is broken.

Breaking the connection does not delete the stream, only its 
connection to the operation.

Break Connection icon
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10.3.20 Cut/Paste Functions
The Cut/Paste Objects sub-menu available in the PFD Object 
Inspect menu provides several commands for adding, removing, 
and recombining flowsheet objects.

Combine Objects into Subflowsheets
The Combine Into Sub-flowsheet command lets you select 
multiple PFD objects in your simulation case (in the main 
flowsheet) and create a sub-flowsheet containing those objects. 

Use this feature to organize complicated flowsheets. For 
example, you can divide your flowsheet into different sections to 
make the information more readable.

1. Select the PFD objects (for example, unit operations, 
streams, and logical operators) to be included in the new 
subflowsheet.

2. Right-click to open the Object Inspect menu.

3. From the Cut/Paste Objects sub-menu, select the 
Combine Into Sub-flowsheet command.

 Figure 10.25
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Moving Subflowsheet Objects Back to the 
Parent Flowsheet
1. Right-click the subflowsheet icon. The Object Inspect menu 

appears.
2. From the Cut/Paste Objects sub-menu, select the Move 

Contents to Owner Flowsheet command.

Importing/Exporting Objects
You can export flowsheet objects from one PFD and import to 
another using the Import Objects and Export Objects commands 
in the PFD Object Inspect menu. The objects that you export or 
import are saved as an HFL file. 

Exporting Objects
1. Select the PFD objects you want to export.

2. Right-click on one of the selected objects.

3. From the Cut/Paste Objects sub-menu, select Export 
Objects. The File Save property view appears.

4. Enter a name and destination for the flowsheet file.

5. Click Save.

When you export objects from a flowsheet, the objects, 
connections, and geometric data are exported. None of the basis 
or flow information (components, flowrates, etc.) are included.

Even though the contents of the subflowsheet were moved 
to the owner flowsheet, the subflowsheet still exists, but can 
be deleted. If you decided to “re-collapse” the subflowsheet 
objects, a new subflowsheet is created.

Exported object files use the extension.hfl.

Refer to Section 4.3 - 
HFL Files for more 
information.
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Importing Objects

Templates can be imported into a flowsheet by using the Import 
Objects command in the PFD Object Inspect menu. All basis 
information already supplied to the flowsheet is automatically 
applied to the imported objects. None of the basis information 
from the case in which the objects were exported is saved in the 
template file.

1. Right-click the PFD to open the Object Inspect menu.
2. From the Cut/Paste Objects sub-menu select Import 

Objects. This opens the Open File property view. 

3. Browse to the location of the flowsheet file (*.hfl) you want 
to open and select it. 

4. Click Open.

Cloning Objects
You can clone flowsheet objects on your PFD using the Clone 
Selected Objects command in the Copy/Paste Objects sub-
menu. All object information is automatically cloned into a new 
set of objects. Only the object name changes.

Cut/Copy/Paste
The Cut, Copy, and Paste commands in the Cut/Paste Objects 
sub-menu have the typical functionality associated with these 
commands. You cut or copy an object(s) in one flowsheet and 
paste the object(s) to another location on the PFD or into any 
subflowsheets of any case. If the destination subflowsheet was 
created using a different fluid package, then some of the copied 
information may not be transferrable and will be omitted.

Hot Keys:

• Cut - CTRL X
• Copy - CTRL C
• Paste - CTRL V
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10.3.21 Stream Label Options
By default, each stream on the PFD has a label that displays its 
name. You can change all stream name labels so that the 
current value of a key variable appears in place of each stream 
name.

Common Variable Choices
There are some hot key combinations that let you toggle 
between stream name labels and some of the more common 
stream variables:

Other Variables
You can also replace the stream name labels with other variable 
values. To change the stream name label to the Std Gas Flow, 
do the following:

1. Right-click in a blank part of the PFD to open the Object 
Inspect menu.

2. Select Choose Label Variable to open the Select Variable 
for PFD Labels property view.

Hot Key Combination Function

Shift T Displays stream temperatures

Shift P Displays stream pressures

Shift F Displays stream molar flowrates

Shift N Displays stream names

 Figure 10.26
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3. Click the Change Variable button to open the Variable 
Navigator.

4. Select Std Gas Flow from the list of available variables.

5. Change the variable description in the Description field, if 
required.

6. Click OK. 

You are returned to the Select Variable for PFD Labels 
property view. The variable you just selected appears in the 
Current Variable field.

7. Click the Variable Values radio button to display the values 
of the current variable on the PFD. Select the Object 
Names radio button to display the names of the streams on 
the PFD.

8. Click the Close icon .

10.3.22 Annotations & Labels
Annotations are any text that appears on the PFD aside from the 
object labels. HYSYS allows you to enter annotations anywhere 
on the PFD. HYSYS automatically labels an object on the PFD 
with the object’s name. The object’s name is taken from the 

 Figure 10.27

Use the Hide Units and Show Units radio buttons to toggle 
the units on and off.
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name that appears on the Name field in the object’s property 
view. 

Adding Annotations
Use this procedure to add text to the PFD.

1. Click the Add Text Annotation icon in the PFD toolbar. 
2. Move the cursor to the location on the PFD where you want 

to place the text and click the mouse button. The Text Props 
property view appears. 

3. In the Text field, type the text that you want to appear on 
the PFD. 

4. Click the OK button.

Editing Annotations
1. In the PFD, right-click the Text Annotation, then click the 

View Properties command. The Text Props property view 
appears.

2. In the Text field, modify the text, then click OK.

Other editing options include the following:

• Hide. Hides the selected Label or Text Annotation.
• Delete. Deletes the selected Label or Text Annotation.
• Transform. Rotate by 90, 180 or 270 degrees.
• Change Font. Changes the font for a Label or Text 

Annotation. This function is not global; it changes only 
the selected object’s font. 

 Figure 10.28

Add Text Annotation icon
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• Change Colour. Opens the colour palette and lets you 
change the colour of the selected Label or Text 
Annotation.

Moving & Sizing Labels
You can move and size object labels on the PFD. Right-click the 
object icon and select the Move/Size Label command from the 
object menu. 

You can also free the Label by selecting the object and then 
pressing L on the keyboard. Move labels the same way you 
move operations, streams, and annotations.

Once you select the Move/Size Label command, the label is 
unlocked from the object to which it belongs. The label re-locks 
itself once it is deselected, however, you can select the label’s 
corresponding object icon and then select the label again 
without re-locking the Label. This facilitates moving and sizing 
both the icon and its label at one time without repeatedly 
selecting the Move/Size Label command.

 Figure 10.29

Labels and annotations can 
only be sized horizontally.

There are only two resize 
handles on the box 
surrounding the label, as 
compared to the eight 
handles that appear for 
objects.
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10.3.23 Hiding PFD Objects
Any object on the PFD can be hidden, and you can hide multiple 
objects at one time. Hiding an object does not prevent the case 
from solving. You can hide operations, streams, and text 
annotations by selecting the Hide command from the Object 
Inspect menu.

To hide labels, you need to select the Format Label command 
and then select Hide Label from the sub-menu.

Revealing Hidden Objects
Use this function to reveal any objects that are hidden on the 
PFD. You can access this function in two places: 

• PFD menu
• Object Inspect menu

When you select the Show Hidden Objects command, the Show 
Hidden Object property view appears. This property view allows 
you to specify the hidden objects to be revealed. Select the 
objects you want to show, then click the OK button.

Hiding a unit operation or stream on your PFD does not alter 
your simulation case.

A Show/Hide option also exists for displaying subflowsheet 
objects on the main flowsheet PFD.

 Figure 10.30

For details, refer to 
Section 7.24.4 - Access 
Column or Subflowsheet 
PFDs.
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10.3.24 Printing the PFD
All objects (Streams, Operations, Text, and PFD Tables) included 
within the PFD property view can be printed. HYSYS prints the 
PFD as it appears on the screen.

10.4 Graph Control
You can customize each individual plot in HYSYS using the Graph 
Control tool. You can also modify many of the plot 
characteristics. These options are grouped into the five tabs in 
the Graph Control property view. 

To access the Graph Control property view, do one of the 
following:

• Right-click any spot on an active plot and select the 
Graph Control command from the Object Inspect menu.

• Click in the plot area to make the plot the active property 
view. Then, either double-click on the plot Title or Legend 
to access the respective tab of the Graph Control 
property view. 

 Figure 10.31

While the plot area has focus, you can click and drag on 
either the Legend or Title to reposition the selected item.

For more information see 
Section 9.2.3 - Printing 
the PFD.
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10.4.1 Data Page Tab
For each data set on the plot, you can do the following:

• View the data set Type
• Modify the data set Name
• Specify the Colour and Symbol that represent the data 

on the plot
• Select a Line Style
• Show/hide the Symbol or Line

• Show/hide the name in the Legend 

The changes made to a plot using the Graph Control tool are 
specific to the active plot.

To make global changes that affect all plots, use the Colours 
and Fonts pages on the Resources tab of the Session 
Preferences property view.

The Symbol drop-down list is not available for Bar Charts.

 Figure 10.32

All changes instantaneously affect the plot. There is no need 
to close the Graph Control property view to see the 
modifications.

List of available 
data set in the 
plot.
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To modify the appearance of a data set, select the name of the 
set in the list of data sets. The information that corresponds to 
the selected data set appears in the objects/options in the Data 
tab. The following table lists and describes the options: 

10.4.2 Axes Tab
From the Axes tab, you can do the following for each axis:

• Make changes to the Label name, font and units.
• Show/Hide the Label name and/or units.
• Define the axis bounds or use the Auto Scale function.
• Format the axis values. 

Object Description

Type field Displays the plot type (line or bar) of the selected data 
set.

Name field Enables you to modify the name of the selected data 
set. If applicable, this is the name that appears in the 
legend for the selected data set.

Colour field Enables you to modify the colour of the selected data 
set in the plot.

Symbol drop-
down list

Enables you to select the point/symbol appearance of 
the selected data set in the plot.

You need to select the Visible checkbox beside the 
drop-donw list to display the symbols in the plot.

Line Style drop-
down list

Enables you to select the line style of the selected data 
set in the plot.

You need to select the Visible checkbox beside the 
drop-down list to display the line in the plot.

Thickness field Enables you to modify the line thickness of the selected 
data set in the plot.

Show in Legend 
checkbox

Enables you to toggle between displaying or hiding the 
selected data set in the legend.

Any changes that are made affect only the data set that is 
selected in the list.

Any changes that are made affect only the axis that is 
selected in the list. 

Refer to Section 10.5 - 
Format Editor for 
information regarding 
value formatting.
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To make modifications to the appearance of an axis, select the 
name in the list of axes. The information that corresponds to the 
selected axis in the objects/options in the Axes tab. The 
following table lists and describes the options:

 Figure 10.33

Object Description

Label group

Label field Enables you to modify the name/label of the selected 
axis.

You need to select the Visible checkbox beside the 
field to display the axis lable in the plot.

Label drop-down 
list

Enables you to select the unit type of the selected axis.

This drop-down list is only available if the Use Default 
Units checkbox is clear.

You need to select the Visible checkbox beside the 
drop-down list to display the unit in the plot.

Use Default Units 
checkbox

Enables you to toggle between applying or ignoring the 
default units for the selected axis.

Font display field Enables you to access the Font Property View and 
modify the font size and style of the selected axis.

Bounds group

Use Auto Scale 
checkbox

Enables you to toggle between activating or 
deactivating HYSYS auto scale calculation for the 
minimum value of the selected axis.

Minimum field Enables you to specify the minimum value for the 
selected axis.

You need to clear the Use Auto Scale checkbox to 
activate this field.

Use Auto Scale 
checkbox

Enables you to toggle between activating or 
deactivating HYSYS auto scale calculation for the 
maximum value of the selected axis.

List of axes in 
the plot.

Font display field
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Font Property View
The Font property view enables you to modify the font type, 
style, and size appearance for the selected text display variable. 
To access the Font property view, double-click the Font display 
field.

• In the Font list, use the scroll bar or type in the name of 
the font type in the field to find the font type, then select 
the type of font for the selected text display.

• In the Font style list, select the style for the selected 
text display.

• In the Size list, select from the list a default font size or 
type in the size value in the field.

• In the Script drop-down list, open the list to select the 
type of script for the selected text display.

Maximum field Enables you to specify the maximum value for the 
selected axis.

You need to clear the Use Auto Scale checkbox to 
activate this field.

Logarithmic Axis 
checkbox

Enables you to toggle between logarithmic or original 
value scale for the selected axis.

Format field Displays the current value decimal format of the 
selected axis.

Click the Ellipsis icon to access the Format Editor 
property view.

 Figure 10.34

Object Description

Ellipsis icon

Font display field
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• The Sample group displays an example of how the 
selected text will appear based on the selections from the 
lists.

• Click the OK button to accept the font modification(s) 
and exit the Font property view

• Click the Cancel button to ignore the font modifcation(s) 
and exit the Font property view.

10.4.3 Title Tab
On the Title tab, you can do the following:

• Change the default title name and font.
• Select the colours for the text, background, and border 

of the title.
• Show/Hide the title, background, and border. 

 Figure 10.35

Object Description

Text group

Text field Enables you to specify a title for the plot.

Visible checkbox Enables you to toggle between displaying or hidding 
the title in the plot.

Colour field Enables you to modify the colour of the title in the plot.

Font display field Enables you to access the Font Property View and 
modify the font size and style of the title in the plot.

Background group

Background field Enables you to modify the colour of the title 
background in the plot.

Font display field
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10.4.4 Legend Tab
The Legend tab allows you to change the appearance and 
location of the legend. You can do the following:

• Change the colour of the border, background, or text.
• Select the orientation: vertical or horizontal.
• Show/Hide the border and background.
• Enable automatic resizing of the legend upon 

repositioning.
• Place the legend in the foreground or background. 

Visible checkbox Enables you to toggle between displaying or hiding the 
selected title background colour.

Border group

Border field Enables you to modify the colour of the border 
surrounding the title in the plot.

Visible checkbox Enables you to toggle between displaying or hiding  the 
border surrounding the title in the plot.

 Figure 10.36

Object Description

Visible checkbox Enables you to toggle between displaying or hiding 
the legend in the plot.

Border group

Border field Enables you to modify the colour of the border 
surrounding the legend in the plot.

Visible checkbox Enables you to toggle between displaying or hiding 
the border surrounding the legend in the plot.

Object Description
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10.4.5 Plot Area Tab
From the Plot Area tab, you can do the following:

• Change the colour of the background, frame, and grid.
• Show/Hide the background, frame, and grid. 

Background group

Background field Enables you to modify the background colour of 
the legend in the plot.

Visible checkbox Enables you to toggle between displaying or hiding 
the background colour of the legend in the plot.

Text group

Text field Enables you to modify the colour of the text in the 
legend.

Font display field Enables you to access the Font Property View 
and modify the font size and style of the text in 
the legend.

Alignment group

Dynamic checkbox Enables you to toggle between activating or 
deactivating the HYSYS auto-resize option when 
the legend is repositioned in the plot area.

Vertical / Horizontal 
radio buttons

Enables you to select the orientation of the legend.

 Figure 10.37

Object Description

Font display field
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Object Description

Background group

Background field Enables you to modify the background colour of 
the plot.

Visible checkbox Enables you to toggle between displaying or hiding 
the background colour of the plot.

Frame group

Frame field Enables you to modify the colour of the frame 
surrounding the plot.

Visible checkbox Enables you to toggle between displaying or hiding 
the frame surrounding the plot.

Grid group

Grid field Enables you to modify the colour of the grid in the 
plot.

Visible checkbox Enables you to toggle between displaying or hiding 
the grid in the plot.

Cross Hairs group

Cross Hairs field Enables you to modify the colour of the cross hairs 
when the cursor is within the plot.

Visible checkbox Enables you to toggle between displaying or hiding 
the cross hairs when the cursor is within the plot.

This checkbox is automatically selected, if either 
the Vertical Component or Horizontal 
Component checkbox is selected.

Vertical Component 
checkbox

Enables you to toggle between displaying or hiding 
the vertical cross hair when the cursor is within 
the plot.

Horizontal 
Component checkbox

Enables you to toggle between displaying or hiding 
the horizontal cross hair when the cursor is within 
the plot.
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10.5 Format Editor
The Real Format Editor can be accessed in the following 
locations:

• Workbook Setup property view
• Graph Control property view

From the property view in the figure above, you can set the 
format of values displayed in HYSYS. The Format Specification 
group uses three radio buttons for the options available:

The Use Default button closes the Real Format Editor property 
view and assigns the HYSYS default format to the associated 
values.

 Figure 10.38

Format Description

Exponential The values are in exponential form with a specified number 
of Significant digits. For example, 8546 appears as 
8.546e+03 if 4 was specified in the Significant cell.

Fixed 
Decimal 
Point

Specify the maximum number of digits that appear before 
the decimal point in the Whole cell (see above figure). If 
the Whole cell limit is exceeded by a value in HYSYS, 
exponential form is used. In the Decimal Digits cell, input 
the number of digits that appear after the decimal point. 

If you select the Display sign if zero checkbox, HYSYS 
displays a + symbol in front of a value that appears as zero 
using the current precision. For example, a composition of 
0.000008 appears as zero when using a Decimal Digits 
value of 4. With the checkbox selected, the cell shows 
+0.0000 to signify that there is a small number present.

Significant 
Figures 

In the Significant cell, specify the number of significant 
figures (between 0 and 9) that you want to display.

The layout of the Real Format Editor property view depends on the radio 
button selected.
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11.1 Introduction
This chapter provides information about the tools available in 
the Tools menu. To access the Tools menu commands, use one 
of the following methods: 

• Click the Tools menu in the menu bar.
• Press ALT T.
• Press just the ALT key to move the active location to the 

File menu in the menu bar.

When you press the ALT key, the menu bar is active and you 
can navigate it using the keyboard. The UP and DOWN arrow 
keys move through the menu associated with a specific item, 
while the left and right arrows move you to the next menu bar 
item, automatically opening the associated menu.

If you want to switch focus from the menu bar without making a 
selection, press the ESC key or the ALT key.

11.2 Workbook
The Workbook command opens the HYSYS Workbook. Refer to 
Section 7.23 - Workbook for more information on using the 
Workbook.

11.3 PFD
The PFD command opens the HYSYS PFD. The information on 
this command is covered in Section 7.24 - PFD.

To add objects into the PFD, refer to Chapter 8 - HYSYS 
Objects.

Tools menu
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11.4 Case Summary
To open the Select Summary property view, do the following:

1. Select the Summaries command from the Tools menu. 
2. From the list of available flowsheets, select the flowsheet 

you want to view.

3. Click the View button to display the Summary property 
view. The Summary property view provides an alternative 
way of adding, editing, and deleting streams and unit 
operation in specific flowsheets.

The Flowsheet Streams group is used for adding, editing, and 
deleting streams in the selected flowsheet. The stream list 
contains all of the streams available in the selected flowsheet.

The Unit Operations group is used for adding, editing, and 
deleting unit operations in the selected flowsheet. The unit 
operation list contains all of the unit operations available in the 
selected flowsheet.

Upon deleting a stream or unit operation, you are prompted to 
confirm the deletion.

 Figure 11.1

Select more than one object at a time by holding down the 
CTRL key and then clicking each object you want to select.
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11.5 Utilities
The Utilities command opens the Available Utilities property 
view. Refer to Section 7.26 - Utilities for more information on 
utilities.

11.6 Reports
The Reports command opens the Report Manager. Refer to 
Section 9.3 - Reports for more information on using the 
Report Manager.

11.7 Databook
The Databook is used for systematically analyzing data and lets 
you monitor key process variables in both Steady State and 
Dynamics modes. Variables for all Databook features are 
selected in a single location and can be activated from the main 
list for each application.

To access the Databook, use one of the following methods:

• Select the Databook command from the Tools menu.
• Press the CTRL D hot key combination.

11.7.1 Databook Variables
All variables used by the Databook are managed through the 
Variables tab. 

There is only one Databook in each HYSYS case, which 
contains variables from all flowsheets.

The Variables tab enables you to attach as many variables to 
the Databook as required.
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Adding a Variable
Use this procedure to add a variable to the Databook.

1. Click the Insert button to display the Variable Navigator 
property view.  

2. From the list of available flowsheets, select the flowsheet in 
which the object is located.

Click the Cancel button at any time to close the Variable 
Navigator without accepting any changes.

3. From the list of available objects, select the object 
containing the variable.

 Figure 11.2

 Figure 11.3

Refer to Section 11.21 - 
Variable Navigator for 
information regarding the 
Variable Navigator.

Select the Unit 
Ops radio 
button to view 
only Unit Ops 
variables.
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4. From the list of available variables, select the variable you 
want to add. Some variables (for example, Comp Mass Flow) 
require that you select a variable specific.

5. Click in the Variable Description field and type a description 
for the variable (optional).

6. Click OK. The variable appears in the list of available data 
entries on the Variable tab.

Editing a Variable
Use this procedure to edit a variable in the Databook.

1. From the list of available data entries, select the variable you 
want to edit. 

2. Click the Edit button. The Variable Navigator property view 
appears. This property view lets you change the flowsheet, 
object, variable and description of the variable.

3. Make the required changes, then click OK, or click the 
Cancel button to close the property view without making 
changes.

Deleting a Variable
Use this procedure to delete a variable from the Databook.

1. From the list of available data entries, select the variable you 
want to delete.

2. Click the Delete button

You will not be prompted to confirm the deletion, so ensure 
you have selected the correct variable.

When a variable is deleted, it is removed from all features in 
the Databook.

Refer to Section 11.21 - 
Variable Navigator for 
information about the 
Variable Navigator.
11-7



11-8 Databook
11.7.2 Process Data Tables
Process data tables are installed individually through the Process 
Data Tables tab. Use this tab to view, add, or delete customized 
process data tables. For each table, add any combination of key 
process variables from the list of available variables. Variables 
can be used in multiple process data tables. 

Adding a Process Data Table
1. Click the Add button. A process data table with default name 

ProcData1 appears in the list of available tables. If 
required, type a new name in the Process Data Table field.

2. Select the Show checkbox for each variable you want 
displayed in this process data table.

 Figure 11.4

Lists all the 
process data 
tables in the 
case.

Views the selected process data table. Supply a descriptive 
name for the 
selected process 
data table.

Adds a new 
process data 
table.

Deletes the 
selected 
process data 
table.

When the Show 
checkbox is 
selected, the 
variable is added to 
the selected process 
data table.

Adds all of the 
variables to the 
process data 
table.

Selects all clear 
checkboxes and clears all 
selected checkboxes.

Removes all of the 
variables from the 
process data table.

Accesses the DDE Notify view, so you 
can set up the process data table to 
trigger a DDE command as a result of 
the timestep event trigger.

Variables for the process data table are selected on the 
Variables tab of the Databook.
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Viewing a Process Data Table
1. From the list of available process data tables, click the 

process data table you want to view.
2. Click the View button. The Process Data Table property view 

appears.

The Process Data Table shows the following for each variable:

• Object that the variable is attached to.
• Variable description.
• Current value.
• Units of the value.

Deleting a Process Data Table
1. From the list of available process data tables, click the 

process data table you want to delete.
2. Click the Delete button.

 Figure 11.5

Click the View Databook button to open the Databook if it is 
closed.

You will not be prompted to confirm the deletion, so ensure 
you have selected the correct variable.

When a Process Data Table is deleted, the variables 
associated with it are not deleted from the Databook.
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11.7.3 Strip Charts
Use the strip chart tool to monitor the response of key process 
variables during dynamics calculations. Strip charts let you 
monitor the behaviour of process variables in a graphical format 
while calculations proceed. Current and historical values for 
each strip chart are also tabulated for further examination.

Strip charts are installed individually using the Strip Charts tab. 
You can have multiple strip charts, with each having an 
unlimited number of variables charted. The same variable can 
be used in more than one Strip Chart, so the use of multiple 
strip charts with a maximum of six variables per strip chart is 
recommended.

Variables for the strip chart are selected on the Variables tab 
of the Databook.

 Figure 11.6

Supplies a descriptive 
name for the selected 
strip chart.

Opens the 
selected strip 
chart.

Displays all 
the strip 
charts in the 
case.

Views the history 
data of the selected 
strip chart.

Displays the 
current values 
of variables in 
the selected 
strip chart.

Adds a new 
strip chart.

Deletes the 
selected strip 
chart.

Opens the 
Logger Set-Up 
Property View.

When selected, the associated 
variable is plotted on the 
selected strip chart.

The interval 
length of the 
sample. The 
current data is 
only stored for 
this amount of 
time.

Opens the Logger 
Set-Up-All Property 
View.
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Logger Set-Up Property View

The Logger Set-Up property view allows you to modify the 
following options of the selected strip chart in the Available Strip 
Charts group:

• The amount of data that the strip chart keeps and 
displays in the graph. 

• The frequency the strip chart records and displays the 
data.

For example, if the Logger Size has a value of 250 and the 
Sample Interval has a value of 5 seconds, the strip chart stores 
and displays 250 values, and each value was recorded every 5 
seconds. So the amount of time range displayed in the strip 
chart is 1250 seconds or 20 minutes and 50 seconds.

Logger Set-Up-All Property View

The Logger Set-Up-All property view allows you to modify the 
following options of all the strip charts in the Available Strip 
Charts group:

• The amount of data that the strip chart keeps and 
displays in the graph. 

• The frequency the strip chart records and displays the 
data.

Adding a Strip Chart
Use this procedure to add a strip chart to the Databook.

1. Click the Add button to display a strip chart with default 
name DataLogger1 in the list of available strip charts. If 

 Figure 11.7
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necessary, type a new name in the Logger Name field.
2. Click the Active checkbox for each variable that you want to 

display in this strip chart.

Deleting a Strip Chart
Use this procedure too delete a strip chart from the Databook.

1. From the list of available strip charts, click on the strip chart 
you want to delete.

2. Click the Delete button.

Viewing a Strip Chart
Use this procedure to view a strip chart.

1. From the list of available strip charts, select the strip chart 
you want to view.

2. Click the Strip Chart button. 

Variables can exist in more than one strip chart.

You will not be prompted to confirm the deletion, so ensure 
you have selected the correct strip chart.

When a strip chart is deleted, the attached variables are not 
deleted from the Databook.

When the Integrator is active, the strip chart begins to 
accumulate data points.
11-12



Simulation Tools 11-13
The Strip Chart property view appears.

You can manipulate the information displayed on the strip chart 
within the Strip Chart property view. There are several functions 
you can perform directly on the strip chart; these are described 
in the following sections.

Selecting Curves

The y-axis displays the range and units of a specific strip chart 
variable depending on the variable selected. Select a curve 
using one of the following methods:

• Click any part of the variable curve in the strip chart.

 Figure 11.8

The Legend displays the names and 
formats of the variables as they appear 
on the strip chart.

By default, like variables are grouped under a similar 
axis range, however, you can create your own y-axis 
in the Graph Controls property view.

Current values 
of the strip 
chart variables.

Interval 
markers are 
used to 
measure 
variables at 
certain 
instances in 
the strip chart.

Time is always 
on the x-axis.

Strip chart 
variables are 
grouped into 
their unit sets. 
Grouped 
variables share 
the same y-axis 
range.
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• Right-click the strip chart and click the Select Curve 
command, then from the sub-menu select the required 
variable.

Manipulating the Y-Axis Range

Use this procedure to manipulate the y-axis range of the strip 
chart. 

1. Position the cursor over an empty space in the strip chart.

2. Click and hold the mouse button until a multi-directional 
cursor appears.

3. Drag the strip chart up if you want to display a lower range 
of values on the y-axis, or, drag the strip chart down if you 
want to display a higher range of values.

By default, strip chart curves are grouped into their unit sets. 
For example, all temperature variables are associated and 
displayed with the same y-axis range and units. By manipulating 
the range of a temperature variable in the strip chart, you 
change the range of all temperature variables associated with 
that axis. 

 Figure 11.9

Cursor Description

When the cursor is in the background of the strip chart, the 
following cursor appears. You can move along the strip 
chart in any direction.

If you simply want to move vertically across the strip chart, 
move the cursor on or near a curve and the following cursor 
appears.
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If you want to associate a different range with a variable in the 
strip chart, you must first create your own axis. Refer to the 
Graph Control section for more information.

Manipulating the X-Axis Range

The range of sampled data displayed in the strip chart can be 
manipulated. Below the x-axis, a set of colours appear to 
indicate what range of sampled data are in the strip chart.

Increase or decrease the range of sampled data and scroll the 
strip chart over a range of recorded strip chart data. Depending 
on the amount of data already recorded in the strip chart 
property view, the Log Controller bar, shown in the figure below, 
appears below the x-axis.

Each colour (from left to right) in the Log Controller bar is 
described in the following table:

Scroll across the strip chart by the x-axis or by selecting the 
light blue section of the Log Controller bar with the cursor. 

The following cursor appears .

Move the cursor along the bar to the interval you want to 
view.

 Figure 11.10

Colour Definition

Gray Bar There is no data in the strip chart.

Dark Blue 
Bar

Strip chart data is recorded.

Red Marker Indicates where the first data displayed in the strip chart is 
located in the overall data set. Expand the range of display 
by “dragging” the red marker to the left (away from the 
yellow marker) and decrease the displayed range by 
dragging the red marker right (towards the yellow marker).
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Creating Interval Markers

Interval markers are used to measure variables at certain 
instances in the strip chart. The strip chart variable value 
appears next to the intersecting point of the interval marker and 
the strip chart variable curve. Up to four interval markers can be 
added to the strip chart.

1. Ensure the most recent data appears on the strip chart. The 
light blue portion of the Log Controller Bar should be located 
to the far right of the x-axis.

2. Place the cursor on the right edge of the strip chart. A left 
arrow  replaces the cursor.

3. Click and drag the interval marker across the strip chart. 
Release the mouse button when the interval marker is in the 
required location.

Zooming in on the Strip Chart

Use this procedure to focus or zoom in on an area of the strip 
chart.

1. Press and hold the SHIFT key and press and hold the right 
mouse button until the cursor changes to a magnifying 
glass.

2. Drag the cursor until a box encompasses an area in the strip 
chart.

Light Blue 
Bar

Indicates where the data displayed on the strip chart is 
located in the overall data set.

Yellow 
Marker

Indicates where the displayed data ends. Expand the 
displayed range by “dragging” the yellow marker to the 
right (away from the red marker) and decrease the 
displayed range of data by dragging the yellow marker left 
(towards the red marker).

Colour Definition

Zoom Strip Chart cursor
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3. Release the mouse button and the SHIFT key. The y-axis 
scaling changes to reflect the zoom selection.

 Figure 11.11
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Object Inspect menu

The following commands appear in the strip chart Object Inspect 
menu.

Graph Control
To open the Strip Chart Configuration property view, click the 
Graph Control command in the strip chart Object Inspect menu. 
Use this property view to modify the characteristics of the strip 
chart.

Option Description

Graph 
Control

Customize the appearance of the strip chart and modify 
curve and axis parameters. 

Legend Opens the Legend property view.

The Legend property view displays all the Curve Names, 
Colours, and Line Styles associated with the variables in the 
strip chart.

• Modify the curve name by clicking in the Curve Name 
field of the appropriate variable and typing in a new 
name.

• Modify the colour by double-clicking in the Colour field 
of the appropriate variable and selecting the new 
colour from the colour palette.

• Modify the line style by clicking in the Line Style field 
of the appropriate variable and selecting a new line 
style from the drop-down list.

Select Curve Select a curve on the strip chart.

Auto Scale 
Curve

The bounds for the y-axis of the selected curve are 
automatically set.

Copy to 
Clipboard

Copies the selected property view/information to the 
clipboard for storage and later use. Also, modifies the 
percentage of the object’s size being stored.

Print Plot Prints the strip chart as it appears on the screen. 

Print Setup Opens the Print Setup property view so you can modify any 
print options associated with printing the strip chart.

For more information, see 
the Graph Control 
section.
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General Tab

Use the General tab to format the appearance of the strip chart.

 Figure 11.12

Select the Visible checkbox to make the 
background, grid, or frame colours visible. 
Select a colour for the item by double-clicking 
the colour field and selecting a colour from the 
colour palette.

Opens the 
Databook property 
view.

Opens the Setup 
Logger property 
view. This property 
view lets you 
specify logger 
sample size and 
sample interval.

Checkboxes are used to modify 
the appearance of the strip 
chart. Select the appropriate 
checkbox to display the option 
on the strip chart.
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Curves Tab

The Curves tab is used to modify the appearance of individual 
curves in the strip chart. You can also modify how strip chart 
variables, variable titles, and units appear on this tab.

 Figure 11.13

Select a specific strip 
chart variable to modify 
plot characteristics.

The Object/Variable and Display Label fields 
display the strip chart curve names. By 
default, the Display Label is copied from the 
Object/Variable field. Change what is 
actually displayed in the strip chart by 
modifying the Display Label field.

Opens the 
Databook 
property 
view.

Modify the curve colour 
and line style in this 
group. Select a colour 
for the item by double-
clicking the Colour field 
and selecting a colour 
from the colour palette. 
Select the line style from 
the drop-down list.

Select the Show Curve checkbox 
to display or hide the selected 
curve. Select the Live Values 
checkbox to display the most recent 
calculated strip chart values.

Deletes the 
selected curve.

Select the units of the curve 
from the drop-down list.

Displays the axis associated with 
the selected strip chart variable. 
Use the drop-down list to select 
any of the axes currently created 
on the Axes tab for the same 
variable type.

Opens the Setup 
Logger property 
view. Specify logger 
sample size and 
sample interval.
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Axes Tab

The Axes tab allows you to create, modify, and delete the y-
axes.

 Figure 11.14

Object Description

Label field Allows you to change the label name of the selected 
vertical axis (y-axis) in the strip chart.

Units field Allows you to change the unit label of the selected 
vertical axis by using the drop-down list.

Approx Num of 
Intervals field

Allows you to set the number of intervals on the 
vertical axis.

Scaling group The Scaling group contains the following objects:
• Current row. Displays the actual high and low 

range values of the axis.
• Default row. Displays the HYSYS default high 

and low range values of the axis.
• Set button. Allows you to copy the ranges from 

the Current row into the Default row.
• Use button. Allows you to copy the default 

ranges from the Default row into the Current row.

Select an axis to 
modify.

The Curves group Lists all the variables that 
are associated with the selected axis.
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Time Axis Tab

The Time Axis tab allows you to modify the display and range of 
the x-axis.

Auto Scale group This group contains the following objects:
• All Points radio button. Allows you to 

automatically adjust the scale to best show all of 
the data points available.

• Current Time Frame radio button. Allows you 
to automatically adjust the scale to best show all 
the data points available within the current time 
frame.

• Automatic Auto Scale checkbox. When you 
select this checkbox, HYSYS automatically 
calculates the most suitable scale setting for all 
the axes in the strip chart. Clear this checkbox to 
allow user-specified scaling. 
The Automatic Auto Scale checkbox is 
automatically cleared when you move the curves, 
adjust the grid, zoom in/out, or scales a single 
curve in the strip chart.

• AutoScale button. Automatically adjust the high 
and low range values for all axes. The AutoScale 
button is automatically disabled when the 
Automatic Auto Scale checkbox is active.

New Axis button Allows you to create a new axis in the strip chart.

Delete Axis 
button

Allows you to delete the selected axis created by the 
user. The HYSYS default axes cannot be deleted.

Axis Display 
group

Select the Show All checkbox to display all the vertical 
axes with individual scale settings in the strip chart. 
Clear to display only one selected axis.

 Figure 11.15

Object Description
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The following table lists and describes the objects on the Time 
Axis tab.

Object Description

Units group This group contains four radio buttons:
• Seconds. Displays the time in seconds on 

the x-axis.
• Minutes. Displays the time in minutes on the 

x-axis.
• Hours. Select to have the time displayed in 

hours on the x-axis.
• Formatted. Select to have the time 

displayed in standard time display (for 
example, hour:minute:second.second).

Enter time using the following format: 
HHH:MM:SS.S

Low Time field Allows you to enter the low range value of the time 
shown on the x-axis on the strip chart.

High Time field Allows you to enter the high range value of the 
time shown on the x-axis on the strip chart.

Delta Time field Allows you to enter the difference between the 
high and low range value of time. If the Low Time 
and High Time fields are specified, the Delta Time 
field shows the time difference.

Customize Time 
Interval checkbox

When you select this checkbox, the Time 
Interval field is enabled. In the Time Interval 
field, you can specify the size of each time interval 
on the x-axis.

Enable group Allows you to show the time axis label on the strip 
chart. When you clear the Time Axis Visible 
checkbox, the time axis label is removed from the 
strip chart.

Open Databook 
button

Opens the Databook property view.

Set-up Logger button Opens the Setup Logger property view which 
allows you to specify the logger sample size and 
the sample interval.
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Printing Tab

The Printing tab is used to control the printed output of the strip 
chart.

Notes Tab

Enter notes or comments about the strip chart in the notes tab 
to let others know what the chart displays.

 Figure 11.16

 Figure 11.17

Allows you to write 
comments 
concerning the strip 
chart.

In the Options 
group, you can 
select what you 
want to print with 
the strip chart.

Toggles the title 
on and off.

To see all notes entered in 
the simulation case, refer 
to Section 7.19 - Notes 
Manager.
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Viewing Historical Data
1. From the list of available strip charts, select the strip chart 

you want to view.
2. Click the Historical button. The Historical Data property 

view appears.

The Historical Data property view records the data history for 
the variables on a strip chart. The number of points recorded 
and the time between points is determined by the logger size 
and sample interval values specified in the Logger Set-Up 
property view. All data in the Historical Data property view are 
displayed in ascending order by default (the Ascending 
checkbox is selected automatically). You can clear the 
Ascending checkbox to display the data in descending order.

Exporting Historical Data
1. Click either the Save To .CSV File or Save To .DMP File 

button. The Save File property view appears.
2. Specify the name and location of your history file.

3. Click Save.

 Figure 11.18

You can resize 
the Historical 
Data property 
view to see more 
information.
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Viewing Current Data
1. From the list of available strip charts, select the strip chart 

you want to view.
2. Click the Current button. The Current Data property view 

appears.

11.7.4 Data Recorder
The Data Recorder tab lets you store snapshots of your process 
by grouping key process variables into different scenarios. You 
can manipulate the process in the current case and then record 
the results for the variables you are monitoring. Each scenario 
created can have an unlimited number of snapshots, called 
States. 

 Figure 11.19

 Figure 11.20

Provide a 
descriptive name 
for the selected 
scenario in this 
cell.

When the Include 
checkbox is 
selected, the 
associated variable 
is added to the 
selected scenario.

Records a state (the current 
values of the variables) for the 
selected scenario.

Displays all 
scenarios in 
the case.

Adds a new 
scenario.

Views the 
recorded states 
of the selected 
scenario in 
tabular or 
graphical 
format.

Deletes the 
selected 
scenario.
11-26



Simulation Tools 11-27
Adding a Scenario
1. Click the Add button. 

A scenario with the default name Scenario 1 appears in the 
list of available scenarios. If required, type a new name in 
the Current Scenario field.

2. From the list of available variables, select the Include 
checkbox for each process variable you want to add to the 
scenario.

Recording States
When you make changes to your process, you can record the 
values of the key variables contained in the scenario.

1. From the list of available scenarios, select the scenario you 
want to use.

2. Click the Record button. 

The New Solved State property view appears. 

The initial default name for the new state is State1. Each 
time you click the Record button, the integer value in the 
state name incrementally increases. If required, modify the 
State name directly in the Name for New State field.

3. Click the OK button. The key process variables of the 
selected Scenario are recorded.

Variables for the data recorder are selected on the Variables 
tab of the Databook.

You can create an unlimited number of scenarios.

Variables can be included in more than one scenario.

If adding a variable to a Scenario after States are recorded, 
values for the new variable do not appear in the previously 
recorded States.

New Solved State 
property view
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Repeat these steps each time you want to record the process 
variables in the scenario. You can record an unlimited number of 
states for a given scenario.

Viewing a Scenario
States within a scenario can be viewed in either tabular or 
graphical format. 

1. From the list of available scenarios, select the scenario you 
want to view.

2. Select either the Table or Graph radio button.

3. Click the View button. The Data Recorder property view 
appears.

If you crate more than one scenario, the scenarios are 
grouped in a Notebook format.

 Figure 11.21

Modify the name of 
the state in the 
State row.

These radio buttons let you to 
toggle between tabular and 
graphical formats.

Opens the Data 
Recorder Setup 
property view.

Returns the existing 
state names to the 
HYSYS default (for 
example, State1 and 
State2).

Deletes the active 
scenario from the 
Databook.
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Customize the scenario plot by accessing the Graph Control 
property view. Right-click anywhere on the plot area and select 
the Graph Control command from the Object Inspect menu.

If more than two variables are active in the Data Recorder 
Setup view, only the first two are plotted.

Deleting a Scenario
1. From the list of available scenarios, select the scenario you 

want to delete. 
2. Click the Delete button.

Deleting a State
1. From the list of available scenarios, select the scenario you 

want to view.
2. Select either the Table radio button or the View button. The 

Data Recorder property view appears.

3. Click in the column of the state you want to delete.

 Figure 11.22

You will not be prompted to confirm the deletion of a 
scenario, so ensure the correct scenario is selected before 
deleting.

When a scenario is deleted, the attached variables are not 
deleted from the Databook.

Refer to Section 10.4 - 
Graph Control for 
information about 
customizing plots.
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4. Press the DELETE key.

Data Recorder Setup
The Data Recorder Setup property view provides a list of all 
scenarios installed in the Databook. From this property view, 
select the variables that appear in the table and on the y-axis of 
the plot for each scenario. There is a limit of two y-axis variables 
per plot.

Select the variables you want to display.

1. From the list of available scenarios, select the scenario you 
want to modify.

2. From the list of variables, select the Active checkbox for the 
variable(s) to be displayed on the plot and in the table.

The following buttons are also available in this property view:

You will not be prompted to confirm the deletion of a state, 
so ensure the correct state is selected before deleting.

 Figure 11.23

Button Description

Add Adds a scenario to the Databook.

Delete Removes the selected scenario from the Databook.

Results Opens the Data Recorder property view to the tab of the 
selected scenario.
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11.7.5 Case Studies
Use the case study tool to monitor the response of key process 
variables to changes in your steady state process.

1. From the list of variables created on the Variables tab, 
designate the independent and dependent variables for each 
case study.

2. For each independent variable, specify a lower and upper 
bound, as well as a step size. 

The independent variables are varied one at a time and with 
each change, the dependent variables are calculated and a new 
state is defined. As you define the bounds and step size of the 
independent variables, the number of states that are calculated 
are shown.

After the case study solves, examine the states in a table or 
view the results in a plot. Although you can select as many 
variables as you want for a case study, a maximum of three 
variables can be shown on a plot. 

One independent variable and two dependent variables produce 
a two-dimensional plot while two independent variables and a 
single dependent variable appear on a three-dimensional graph.

Variables for the case study are selected on the Variables tab 
of the Databook.

Since a maximum of two independent variables can be 
plotted, limit the number of states and minimize solution 
time by selecting only two independent variables per case 
study.
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Adding a Case Study
1. Click the Add button. A scenario with the default name Case 

Study 1 appears in the list of available case studies. If 
necessary, type a new name in the Current Case Study 
field.

2. In the Case Studies Data Selection group, select the Ind 
checkbox for the independent variables that HYSYS varies.

3. Select the Dep checkbox for the calculated dependent 
variables.

Deleting a Case Study
1. From the list of available case studies, select the case study 

you want to delete.
2. Click the Delete button. 

 Figure 11.24

Provides a descriptive name 
for the case study.

Select the 
independent and 
dependent 
variables for the 
selected case 
study by clicking 
the appropriate 
checkboxes.

Opens the Case Studies property view.

Adds a new 
case study.

Deletes the selected 
case study.

Displays all the 
available case 
studies.

Opens the Case 
Studies Setup 
property view.

Select either a 
tabular or 
graphical format 
for the results of 
the selected case 
study.

Use the same variables in different case studies.

You will not be prompted to confirm the deletion of a case 
study, so ensure the correct case study is selected before 
deleting.
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Defining a Case Study
1. From the list of available case studies, select the case study 

you want to define.
2. Select the independent and dependent variables for the 

selected case study by selecting the corresponding 
checkboxes.

3. Click the View button. 

The Case Studies Setup property view appears.

4. Click the Independent Variables Setup tab.

5. For each of the independent variables listed in the table, 
specify values for the following parameters: 

• Low Bound
• High Bound
• Step Size
The number of states for the case study are automatically 
calculated and displayed in the Number of States field.

When a case study is deleted, the attached variables are not 
deleted from the Databook.

 Figure 11.25

You can add and delete case studies from the Case Studies 
Setup property view, but you cannot select the dependent 
and independent variables.
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6. Click the Start button to begin calculations. At any time 
during the calculations, click the Stop button to stop 
calculating.

7. Click the Failed States tab.

If any of the states could not solve, these states and the unit 
operation associated with failure appear on this tab.

8. From the list of available failed states, click the failed state 
to see the value at which the independent variable failed.

9. Click the Display Properties tab. 

A maximum of two independent variables can be plotted. If 
more than two are used in a case study, graphical results are 
not available.

 Figure 11.26

 Figure 11.27
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10. From the list of available dependent variables, select the 
variables for which you want to show results.

11.Click the Results button. The Case Studies property view. 
appears.

Viewing Case Study Results
The states contained within a case study can be viewed in either 
tabular or graphical format.

1. From the list of available case studies, select the case study 
you want to view.

2. Select either the Table or Graph radio button.

3. Click the View button. 

The Case Studies property view appears.   

If two independent variables are selected, only the first 
selected dependent variable appears on the plot. If one 
independent variable is used, the first two selected 
dependent variables are shown on the plot.

 Figure 11.28

To delete a 
state, right-
click an 
associated cell 
and select 
Delete from 
the menu.

Click the state cell 
and modify the 
name.

Opens the 
Case Studies 
Setup property 
view.

Renames the 
existing states to 
the default names; 
State1, State2, 
State3, etc.

Deletes the active 
case study.
11-35



11-36 Databook
Customize the scenario plot by accessing the Graph Control 
property view. Right-click anywhere on the plot area and select 
the Graph Control command from the Object Inspect menu.

Multi-Dimensional Graphing

When conducting case studies that involve two independent 
variables, these results are plotted in a three-dimensional 
graphing environment.

 Figure 11.29

 Figure 11.30

These radio 
buttons let you 
toggle between 
tabular and 
graphical format.

Click the tab to 
move between 
case studies.

Refer to Section 10.4 - 
Graph Control for more 
information about 
customizing plots.
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If the case study is run with two independent variables, it 
automatically plots three-dimensionally. 

Multi-Dimensional Graph Control

To access the graph control, place the cursor over the plot and 
right-click. The Object Inspect menu appears. Select the Graph 
Control command and the Graph Control property view appears.

The Azimuth field defines the angle between a horizontal plane 
and the XY plane of the plot. This means that an azimuth of 0.0 
results in a property view of the XY plane as a single horizontal 
line across the screen. The azimuth can be manipulated by 
clicking in the Azimuth field, entering a value, and then clicking 
the Apply button.

The Angle field defines the angle between the vertical and the 
XZ (YZ) plane of the plot. Increasing the angle causes the graph 
to rotate counter-clockwise. The angle can be manipulated by 
clicking in the Angle field, entering a value, and clicking the 
Apply button.

The limits of the system allow for only three dimensions. Any 
more than two independent variables results in no graph 
being produced.

 Figure 11.31

Some of the options in 
the Graph Control 
property view can also 
be found in the Object 
Inspect menu.
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Alternatively, the angle and azimuth can be manipulated by 
pressing the arrow buttons of the keypad in the View Control 
group. The action of each arrow button is explained in the figure 
below.

The Plane Slice group is used to examine two-dimensional plots 
taken from the XZ, XY, and YZ plane. The appropriate two-
dimensional plot is specified by selecting one of the radio 
buttons. The two-dimensional plot can be examined by clicking 
the View button. 

A sample plot using the plane slice method appears in the figure 
below:

 Figure 11.32

Increase angle

Increase angle and 
decrease azimuthDecrease 

azimuth

Increase 
azimuth.

Decrease angle

Decrease angle and 
decrease azimuth

Increase angle and 
decrease azimuth

Decrease angle and 
increase azimuth

 Figure 11.33
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The planar slice can be moved through the plot by pressing the 
right and left arrow buttons located within the Plane Slice group.

11.8 Face Plates
The face plate provides all pertinent information about a 
controller. To access the Face Plates Manager, select the Face 
Plates command from the Tools menu, or press the CTRL F hot 
key.

The Face Plate Manager lets you quickly search all available 
flowsheets in the case and open the faceplate of the controller 
you want.

Opening a Face Plate
1. From the list of available flowsheets, select the flowsheet 

you want to search.
2. From the list of logical operations, select the controller for 

which you want to view the face plate.

3. Click the Open button to display the face plate for that 
controller.

OR

1. If you know the name of the controller, but not the location, 
click the Find button. The Find Object property view 

 Figure 11.34

Refer to Section 5.13.2 
- Controller Face Plate 
in the HYSYS 
Operations Guide for 
more information.
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appears.
2. Type in the name of the controller, then click OK. The 

controller property view appears, giving you access to all the 
controller parameters and the controllers face plate.
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Face Plate Types
Change the appearance of all face plates in the flowsheet by 
clicking the Type button. Two types of face plates available are 
Fixed Size (the default) and Scalable. Both types appear in the 
figure below.

When the scalable face plate type is selected, you can change 
the face plate font by clicking the Set Font button in the Face 
Plate Manager.

11.9 Dynamics Assistant
The Dynamics Assistant provides a quick method for ensuring 
that a correct set of pressure flow specifications is used. The 
Assistant can be used when initially preparing your case for 
dynamics, or when opening an old HYSYS 1.x dynamics case. 

 Figure 11.35

The Assistant makes recommendations for specifying your 
model in Dynamics mode. You do not have to follow all the 
suggestions. It is recommended that you be aware of the 
effects of each change you make.

With these radio 
buttons, you can 
select the 
controller mode:

• Manual
• Automatic
• Cascade

Fixed Size Face Plate Scalable Face Plate

For more information 
about the Dynamics 
Assistant, see Section 
2.2 - Dynamics 
Assistant in the HYSYS 
Dynamic Modeling 
guide.
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11.10 Control Manager
The Control Manager command opens the Control Manager 
property view. This property view contains a summary of the 
PID Controllers and MPC Controllers contained within the current 
simulation.

11.11 Dynamic Profiling 
Tool

The Dynamic Profiling Tool logs the CPU time spent in the main 
modules of a case during dynamic simulation. Therefore, it 
allows you to compare the speed of the modules within the case.

There are two groups in the Dynamic Profiling Tool property 
view:

• Profiling Controls
• Profiling Results

 Figure 11.36

For more information 
about the Control 
Manager see Section 2.6 
- Control Manager in 
the HYSYS Dynamic 
Modeling guide.
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Profiling Controls
The buttons found in the Profiling Controls group are:

• Start Profiling. The profiling tool begins to record data 
from an active case.

• Stop Profiling. The profiling tools stops recording data 
from a case.

• Clear Results. This clears the results that are currently 
in the Profiling Results group.

Profiling Results
The Profiling Results group displays a table with four categories 
and their corresponding radio buttons. The table displays the 
following information:

• Cost. The CPU cost of an object for a certain integration 
time. The CPS time associated with flashes is attributed 
to the object and not the pressure flow solver module.

• Name. The name you have given to the object in your 
case.

• Type. The type of object in your case (for example, 
valve, separator, and feeder block).

• Converge Problems. The status of the pressure flow 
solver convergence problems associated with a module. 
The checkbox is selected if the module requires four or 
more pressure flow solver iterations during the 
integration period. Four iterations represents a high 
iteration count.
11-43



11-44 Dynamic Profiling Tool
11.11.1 Profiling a Case
To profile a case:

1. From the Tools menu, select Dynamic Profiling Tool. The 
Dynamic Profiling Tool property view appears.

2. Ensure that the StripChart property view and Dynamic 
Profiling Tool property view are both visible.

3. Click the Start Profiling button.

4. Click the Integrator Active icon.

5. When you want to stop logging the profiling data, click the 
Integrator Holding icon.

 Figure 11.37

You should run the profiling tool until there is no significant 
change in the order of the results when it is sorted by cost.

Integrator icons

Green = Active

Red = Holding
11-44



Simulation Tools 11-45
6. Click the Stop Profiling button and the results are displayed 
in the table in the Profiling Results group.

7. You can sort the results by Cost, Name, Type, or 
Convergence Problems by clicking on the corresponding 
radio button.

The information in the Converge Problems column of the 
profiling results is most useful to a developer and not the 
general user. The checkbox is selected if a module requires four 
or more pressure flow solver iterations during the integration 
period. A high convergence count may be associated with a 
particular operating region, or stiff or non-linear equations 
associated with that module. This information is useful to a 
developer in debugging a particular problem with a case that 
could be improved via code changes. If a user has written their 
own extension and they are having problems (for example, case 
is running really slow) the convergence problems information 
may direct them to look at certain pressure flow equations in 
their extension.

 Figure 11.38

If you start the profiling tool again after receiving results, it 
will ask if you want to clear your current results or add to 
them. Click the Yes button if you want to clear the results, or 
click the No button if you want the results to accumulate.
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The Profiling Tool can be useful in a variety of ways, especially 
when you are trying to investigate why a dynamics case is 
running particularly slow. When you compare the profiling 
results from two runs of the same case, you can point to 
problems with a unit operation/module if it is particularly 
expensive in one of the runs.

As well, you can compare the profiling results by object type. 
For example, if one valve is much more expensive than the rest, 
then that valve deserves some investigation. 

11.12 Snapshot Manager
The Snapshot Manager allows you to create a snapshot of the 
simulation during dynamics modeling. A snapshot is a file that 
contains the state of the simulation at a particular time when 
the integrator is still running. Snapshot files allow you to trace 
back to a specific point in the simulation and review the results 
calculated at that time. This is especially useful for Operation 
Training System (OTS) applications, where the instructor can 
routinely save the state of the simulation at various times during 
a training exercise for an extended period of time. Students or 
trainees can then study and compare the result from the 
snapshot files.

The Snapshot Manager consists of three tabs:

• Local Snapshots
• Real Time Monitor
• External Snapshots
11-46



Simulation Tools 11-47
11.12.1 Local Snapshots Tab
The Local Snapshots tab allows you to save, load, and configure 
a snapshot.

The Configuration group is used to specify how you want the 
snapshot to be taken. The following table describes each 
parameter in the Configuration group:

 Figure 11.39

Displays the current integration time. You can choose the units for the time 
displayed from the drop-down list. The Current Time can be reset by changing 
the integration time in the Integrator from the Simulation menu.

Displays the 
Name (group 
name) of the 
snapshots.

Adds a new group 
of snapshots.

Deletes an 
existing group of 
snapshots.

Saves a snapshot 

Opens the File 
Selection for 
Recalling 
Snapshot 
property view, 
which allows you 
to load a saved 
snapshot file.

Object Description

Name Displays the group name of the snapshots in the Snapshot 
List.

FileName Displays the root directory path and the generic name of 
the snapshots. The root path must contain the generic 
name of the snapshots. By default, the generic name is set 
to be the same as the Name (group name) of the 
snapshots.

Click the Ellipsis icon  to change the directory or file 
name. The File Selection for Saving Snapshot property view 
appears.

Refer to Section 7.7 - 
Integrator for more 
information on the 
Integrator.
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Append to Name Consists two radio buttons:
• Real Time. Attaches the current date and real time to 

the FileName of the snapshot (for example, 
snapshot1_2002-12-24_10-20-15.hsp).

• Sim Time. Attaches the current date and simulation 
time to the FileName of the snapshot (for example, 
snapshot1_2002-12-24_10-20-15.hsp).

• Index. Labels the snapshot in chronological order by 
attaching an index number at the end of the FileName 
(for example, snapshot1_1.hsp).

Snapshot Type Consists of two radio buttons:
• Periodic. The Periodic Specs table appears upon 

selecting the Periodic radio button. In the table, you 
can set the snapshot capturing parameters by 
specifying the Start Time, End Time, and Time 
Interval.

• Specified. A table should appear upon selecting the 
Specified radio button. In the Specified Time column, 
you can specify the time (real time) that you want to 
take the snapshot. You can choose the unit of input 
from the drop-down list. HYSYS automatically 
converts your input into standard time display. The 
status of the snapshots are shown in the Processed 
column. The Specified Time values must be equal or 
larger than the Current Time value.

HYSYS displays all time in standard time display: 
hh:mm:ss.

Periodic Specs The table contains three fields:
• Start Time. Allows you to specify the time to take the 

first snapshot. You can choose the unit of input from 
the drop-down list. HYSYS automatically converts your 
input into standard time display.

• End Time. Allows you to specify the time to take the 
last snapshot. You can choose the unit of input from 
the drop-down list. HYSYS automatically converts your 
input into standard time display. The End Time value 
must be larger than the one of Start Time. If the field 
is left blank as <empty>, End Time is equivalent to 
infinity.

• Time Interval. The time interval between capturing 
each snapshot. It is the capturing frequency of the 
snapshots. The minimum value for the Time Interval is 
1 second. If the Time Interval field is left blank as 
<empty>, no snapshots will be taken.

Save PFD with 
Snapshot

Allows you to save the PFD with the simulation results in 
one single file.

Save PFD in Single 
Separate File

Allows you to save the PFD in a separate file without saving 
it each time as the simulation results are being saved. This 
speeds up the saving process of the snapshot.

Restore PFD Upon 
Load if Saved in 
Separated File

Allows you to restore the PFD upon load if the PFD was 
saved in a separate file when the snapshot is saved.

Enable Snapshot Allows you to manually activate the snapshot option 
according to the specified settings.

Object Description
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11.12.2 Real Time Monitor
The Real Time Monitor gives you an overview of the status of 
each group of snapshots.

The following table lists and describes the columns in the Real 
Time Info table.

 Figure 11.40

Object Description

Snapshot 
Name

Displays the group name of the snapshots in the Snapshot 
List, and the Name field on the Local Snapshots tab.

Type Displays the type (Periodic or Specified) of snapshot you 
specified in the Configuration group on the Local Snapshots 
tab.

Time Spent Displays the time spent on saving the last snapshot.

Count Displays the number of snapshots taken under the same 
group.

Enable When you select this checkbox, the snapshots are taken 
under the specified conditions in the Local Snapshots tab.

Active Displays the status of a group of snapshots. A green check 
indicates that all the specifications are valid and the 
Snapshot Manager is ready to take the snapshots. A red 
cross indicates that some of the specifications are not valid 
or the Periodic Specs have expired.

Opens the File 
Selection for 
Recalling 
Snapshot 
property view, 
which allows you 
to load a saved 
snapshot file.
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11.12.3 External Snapshots
HYSYS provides other means to configure and capture a 
snapshot without using the Snapshot Manager.

The External Snapshots tab allows you to set the PFD saving 
preferences when you are taking a snapshot outside of the 
Snapshot Manager. These saving preferences are the same as 
the first three checkboxes in the Configuration group on the 
Local Snapshots tab. You have the options to save the PFD with 
the simulation results in one file or separate file, and you can 
choose to have the PFD restored upon loading if the snapshot is 
saved in a separate file.

You can take a snapshot by using one of the following methods:

• Save As option in the File menu
• Event Scheduler
• OLE (Object Linking and Embedding)

 Figure 11.41

Displays the 
directory of the 
current PFD file.

Use the checkboxes 
to set the PFD saving 
preferences.
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Taking a Snapshot with the Save As 
Option
The Save As option provides you with the most direct way to 
take a snapshot. You can manually take a snapshot at any point 
during the simulation with the integrator running. 

From the Save As Type drop-down list, select HYSYS HSP Cases 
(*.hsp) as shown in the figure below.

In the File name field, type the name you want to save the 
snapshot as. There is no date, time, or index that will be 
appended to the end of the file name. You can view the last 
saved PFD location in the Current PFD File field on the External 
Snapshots tab.

 Figure 11.42 
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Taking a Snapshot in the Event 
Scheduler
The Event Scheduler allows you to setup more complicated 
scenarios for taking a snapshot. 

With the Event Scheduler, you can set the snapshot capturing 
conditions to be triggered by a pre-determined simulation time, 
a logical expression becoming true, or a variable stabilizing to 
within a given tolerance for a set amount of time. You can also 
setup the Event Scheduler to take a snapshot when certain 
operating conditions are reached (for example, amount of valve 
opening or controller output).

You can access the Event Scheduler by pressing CTRL E.

Refer to Section 7.6 - 
Event Scheduler for 
more information on the 
Event Scheduler.

 Figure 11.43

Displays the 
action name from 
the Name field in 
the individual 
Action 
Specification 
group.

Activates the 
action.

Selects the type of 
the action from 
the drop-down 
list.

Opens the File 
Selection for Saving 
Snapshot property 
view. You can name 
and save the 
snapshot.

Displays the name 
of the action.

Saves the 
snapshot 
manually.

Displays the root 
directory path of 
the snapshot.
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Taking a Snapshot with OLE
An OLE is a tool that allows you to programmatically interact 
between two applications. You can program an OLE using Visual 
Basic to have HYSYS take the snapshots according to the 
conditions specified in the user code. This option gives you more 
flexibility on how to take the snapshots in terms of time and 
operation conditions. You can even define additional capturing 
parameters in your code. The PFD saving preferences are still 
constrained by the specifications on the External Snapshots tab.

11.13 Script Manager
You can use the Script Manager to record all your case 
interaction including the following: 

• Installing streams or operations
• Making connections
• Supplying specifications 

The recorded script can be played back later. To access the 
Script Manager property view, select the Script Manager 
command from the Tools menu.

When using the script feature, keep the following in mind:

• Session preferences are not saved in the Script.
• Scripting is always done in HYSYS internal units.

 Figure 11.44

Refer to Section 1.2 - 
Automation & 
Extensibility in the 
HYSYS Customization 
Guide for more 
information on OLE and 
Automation.
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• Scripting is name specific, so stream and operation 
names must be identical to those in the case that you are 
running the script.

• For the playback of a script, the simulation case must be 
exactly as it was when the script was recorded, so all the 
steps in the script can be performed.

11.13.1 Recording a New 
Script

1. Save your simulation, because the case must be in exactly 
the same condition for playback of the recorded script.

2. Select the Script Manager command from the Tools menu. 
The Script Manager appears.

3. From the list of available directories, select the directory 
where you want to save the script file.

4. Click the New button. The New Script property view 
appears.

5. Type a name and description for the script.

6. Click the Record button to start recording. The red Record 
icon appears in the lower right corner of the Desktop.

7. Perform each task that you want to record.

8. When you finish recording, open the Script Manager and 
click the Stop Recording button.

9. Save the case with a different name. If you save the case 
with the same name, this will prevent you from playing back 
the script.

 Figure 11.45

Record icon
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11.13.2 Script Playback
For you to run a script, the simulation case must be in the same 
state as it was prior to the recording.

1. Open the case associated with the script.
2. Select the Script Manager command from the Tools menu. 

The Script Manager appears.

3. From the list of available directories, select the directory 
where your script file is located.

4. From the list of available script files, select the script you 
want to play.

5. Click the Play button. 

The green Playback icon appears in the lower right corner 
of the Desktop.

6. View the steps of the script playback in the Trace Window.

11.14 Macro Language 
Editor

The HYSYS Macro Language Editor is an interactive design 
environment for developing, testing, and executing WinWrap 
Basic scripts. The editor uses a syntax that is similar to Microsoft 
Visual Basic®.

1. From the Tools menu, select Macro Language Editor.
2. The HYSYS Macro Language Editor property view appears. 

The editor is an interactive design environment for 
developing, testing and executing WinWrap Basic 
automation scripts. The editor, which uses a syntax that is 
very similar to Microsoft®’s Visual Basic, allows you to write 
code that interacts with HYSYS.

At any time during the playback, you can stop the script by 
opening the Script Manager property view and clicking the 
Stop Play button. This stops the script, but does not stop the 
HYSYS function that was occurring during playback.

Playback icon

Refer to Section 1.3 - 
Object Status & Trace 
Windows for details 
about the Trace Window.

For more information, 
consult the Online help by 
clicking Editor Help 
command in the Help 
menu of the HYSYS Macro 
Language Editor.

Refer to Section 2.5 - 
Example 1: The Macro 
Language Editor in the 
HYSYS Customization 
Guide for an example.
11-55



11-56 Macro Language Editor
New Features

The Macro Language Editor now has two new features:

• Auto completion feature, which helps you complete the 
user variable codes and helps you debug the program 
with flyby evaluation.

 Figure 11.46

 Figure 11.47

For example, if you want 
to specify 
SimulationCase, you 
just need to type up the 
first few letters of the 
variable, and the auto 
completion feature will 
display all variables with 
similar names in a drop-
down list.
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• List command feature, which shows you a list of valid 
methods or properties depending on the context (type of 
expression) you enter.

11.15 Case Security
Cases can be locked to a password or a password with a security 
lock device such as a security key.

The Case Security command from the Tools menu enables you 
to access the Enter Master Password property view. This 
property view contains options to lock a HYSYS case and enable 
the Runtime Mode.

The Runtime Mode allows you to run a pre-built case with access 
restricted to certain areas in the case only. This option serves as 
a security control that allows clients (especially consultants, 
contractors, and licensors) to deliver a complete HYSYS model 
with their end product while protecting their business interests 
and the intellectual property contained within the product 
model. 

The limitations of a HYSYS runtime version exist at two levels: 
case level and application level. The runtime version of the 
HYSYS application is compatible only with the runtime version of 
the HYSYS cases. Additional licenses are needed to gain full 
authority to edit the basis and model topology of the runtime 
case.

 Figure 11.48

For example, if you type 
ActiveObject and type the 
period, a drop-down list appears 
displaying a list of methods that 
are applicable to the current 
object.
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11.15.1 Locking a HYSYS Case
To lock a case, the following three information must be 
specified:

• master password
• contact name
• company name

1. Select the Case Security command from the Tools menu. 
The Enter Master Password property view appears.

2. In the Case Security tab, type the password you want to 
use for the case in the Password field. 

3. Retype the password in the Confirm field.

4. Click the Accept Password icon. 

 Figure 11.49

The password is case sensitive and must be at least six 
characters in length.

Accept Password icon
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The File Security Setup property view appears.

5. In the Master Password group, enter the name of the contact 
(typically the name of the user entering the initial password) 
in the Contact Name field.

6. Enter the company name (a HYSYS default company name is 
provided, however you can be change it) in the Company 
Name field.

7. Check that the Lock icon is available in the lower right 
corner of the File Security Setup property view.

If the Unlock icon appears, click the Unlock icon to activate 
the Lock icon.

8. Click the Close and Exit icon to save the case security 
setting.

 Figure 11.50

Lock icon

Close and Exit icon
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11.15.2 Loading a Locked 
HYSYS Case

When loading a case that is locked to a password, the following 
property view appears. 

Passwords are case sensitive and must be at least six characters 
in length. You are allowed only three attempts to enter the 
correct password. If the incorrect password is entered or the 
correct password is entered but a locking device is not found, 
the following message appears and the case does not open. 

If the correct user password was entered, but the time 
restriction date has expired, then the following message 
appears:

This message appears only once and uses one attempt of the 
log on procedure.

 Figure 11.51

 Figure 11.52

 Figure 11.53

See Setting a Time 
Restriction section in the 
following section for more 
information about the 
time restriction date.
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11.15.3 File Security Setup
To access the File Security Setup property view, select the Case 
Security command from the Tools menu. One of the following 
will occur:

• If the case was never locked, the Enter Master Password 
property view appears. 

Specify a new password, confirm the password, and click 
the Accept Password icon. 

• If the case is locked, the Enter Master Password property 
view appears. 

Type the correct password and press ENTER.

 Figure 11.54

The password is case sensitive and must be at least six 
characters in length.

 Figure 11.55

Accept Password icon
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The File Security Setup property view appears in the figure 

below.

You are allowed only three attempts to enter the correct 
password. If you exceed the attempt limit, the File Security 
Setup property view does not open and you cannot attempt 
the access again until the case is reloaded.

 Figure 11.56

Object Icon Description

Contact Name 
field

Enables you to specify the name of the person 
who implemented the password.

Company Name 
field

Enables you to specify the company name.

Change 
Password button

Enables you to change the master password.

Clear Password 
button

Enables you to remove the master password.

Password field Enables you to specify the user password. 

The password is case sensitive and must be at 
least six characters in length.

Confirm field Enables you to re-enter and confirm the user 
password.

Good Until field Displays the expiry date of the user password.
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Master Password
The master password is case sensitive, cannot be less than 6 
characters, and cannot be more than 24 characters.

View User 
Password icon

Enables you to see the user password.

Clear User 
Password icon

Enables you to remove the user password.

Open Calendar 
View icon

Enables you to access the Calendar property 
view and select the expiry date for the user 
password.

Accept User 
Password icon

Enables you to save/accept the user password 
entered in the User Password group.

Hardware Locks 
table

Displays the status of the selected Hardware 
locks.

Hardware Locks 
button

Enables you to access the Scan All Locking 
Codes property view and modify the hardware 
lock selection.

Advanced button Enables you to access the Advanced Lock 
Selection property view, and select different 
hardware lock type.

Remove button Enables you to remove the selected hardware 
lock from the table.

Remove All 
button

Enables you to remove all the hardware lock 
in the table.

Case Security is 
Currently Active 
icon

Displays the case security status and enables 
you to change from locked to unlocked case.

Case Security is 
Currently Disable 
icon

Displays the case security status and enables 
you to change from unlocked to locked case.

Close and Exit 
icon

Enables you to close and save the changes 
made in the File Security Setup property view.

Object Icon Description
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Changing the Master Password
1. Open the File Security Setup property view.
2. Click the Change Password button. The Enter Master 

Password property view appears. 

3. Enter the password, then press ENTER. The New Password 
property view appears.

4. Enter a new password in both the Password and Confirm 
fields.

5. Click the Accept Password icon. 

6. Click the Cancel icon to exit the function.

 Figure 11.57

Press the ESC key at any time to cancel changing the 
password.

 Figure 11.58

Accept Password icon

Cancel icon
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Clearing the Master Password
1. Click the Clear Password button. The Enter Master 

Password property view appears.

2. Enter the password, then press ENTER.

User Password
After a master password is entered, a user password can also be 
entered. This is optional, but useful when more than one user is 
working with the case and you do not want to give access to the 
security setup. 

The following restrictions are applied to the user password:

• Cannot be the same as the master password.
• Cannot be less than six characters or more than 24 

characters.

If a case is opened with a user password, then the File Security 
Setup property view is not available.

Adding a User Password
1. Enter the password in the Password field.
2. Retype the password in the Confirm field to confirm the 

password.

3. Click the Accept user password icon. 

 Figure 11.59

Press the ESC key at any time to cancel deleting the 
password.

Accept user password 
icon
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After accepting the user password, the Accept user password 
icon is greyed out and the two icons to the left of it become 
active.

Viewing the User Password
1. Click the View user password icon. The Enter Master 

Password property view appears.

2. Type the correct password.

3. Press ENTER and the user password can be viewed.

4. Click the View User Password icon again to hide the user 
password.

Clearing the User Password
1. Click the Clear user password icon. The Enter Master 

Password property view appears.

2. Type the correct password.

3. Press ENTER.

 Figure 11.60

 Figure 11.61

Press the ESC key at any time to cancel this operation.

View user password 
icon

Clear user password 
icon
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Setting a Time Restriction
To place a time restriction on a user password:

1. Click the Open Calendar View icon. The Calendar property 
view appears.

2. From the month drop-down list, select the month that the 
password expires.

3. From the year drop-down list, select the year that the 
password expires.

4. From the calendar, select the day that the password expires. 
This date is the time restriction date.

5. Click the Accept and close icon.

Refer to the table for the functionality of the remaining icons.

Hardware Locks
Cases can also be locked to hardware devices on your machine 
or a client machine for additional security. The Hardware 
Locks button scans the current machine for a possible lock, 
while the Advanced button lets you enter information that is 
found on a client’s machine.

 Figure 11.62

Name Icon Description

Clear good until date Clears the selected time restriction date.

Cancel Cancels the action.

Open Calendar View 
icon

Accept and close icon
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Scanning for Lock Codes
1. Click the Hardware Locks button. The Scan All Locking 

Codes property view appears.

2. Click the Scan button to scan your system for all the locks 
listed. The Lock code column either displays the lock code for 
the associated hardware device or Not Found if no lock 
code is available.

3. Select the Accept checkbox for each of the lock codes you 
want to lock the case to.

4. Click the Exit View icon to accept the changes. The selected 
lock codes appear in the Hardware Locks table.

You can click the Cancel icon to close the Scan All Locking 
Codes property view without accepting any changes.

Specifying Lock Codes

To enter a specific lock code.

1. Click the Advance button. The Advanced Lock Selection 
property view appears.

 Figure 11.63

 Figure 11.64

Exit View icon

Cancel icon
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2. From the Lock Type drop-down list, select the hardware 
device being locked to the case.

3. In the Lock Code field, specify the lock code that 
corresponds to the selected lock type.

4. Click the Accept icon and the lock code displays in the 
Hardware Locks table.

You can click the Cancel icon to close the property view 
without accepting any changes.

You can use the Echo ID tool to help you determine the lock 
codes for your computer. Refer to Section 11.16 - Echo ID for 
more information.

Removing Hardware Locks

To remove a single hardware lock:

1. Select the hardware lock you want to remove from the 
Hardware Locks table.

2. Click the Remove button. The Enter Master Password 
property view appears.

3. Type the correct password and press ENTER.

 Figure 11.65

Press the ESC key at any time to cancel this operation.

Accept icon

Cancel icon
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To remove all hardware locks:

1. Click the Remove All button. The Enter Master Password 
property view appears.

2. Type the correct password.

3. Press ENTER.

11.15.4 Unlocking a Case
Although a case is locked and all passwords are entered, the 
case can still be unlocked without clearing all the passwords and 
locks.

1. Click the Case Security is Currently Active icon. The 
Enter Master Password property view appears.

2. Type the correct password.

Press the ESC key at any time to cancel this operation.

3. Press ENTER. The Case Security is Currently Active icon 
changes to Case Security is Currently Disable icon which 
indicates that the case is unlocked.

To lock the case again, click the Case Security is Currently 
Disable icon and the file security is automatically activated.

 Figure 11.66

Press the ESC key at any time to cancel this operation.

 Figure 11.67
Case Security is 
Currently Active icon

Case Security is 
Currently Disable icon
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11.15.5 Activate Runtime 
Mode

The Runtime tab allows you to set the restrictions for a runtime 
case. 

Use this procedure to activate the runtime mode in HYSYS:

1. In the menu bar, select Tools | Case Security command.
The Enter Master Password property view appears.

2. Click on the Runtime tab. 

3. Select the Enable Support for Runtime Mode checkbox.

4. Click the Configure button. The Runtime Mode 
Configuration property view appears.

5. In the General tab, select the appropriate checkbox to 
activate the options you want.

6. In the Specifications tab, select the specifications you want 
to enable for other people to modify.

7. In the Access tab, select which objects are accessible by 
other people.

A Runtime case is a version of an application that has a 
limited set of capabilities compared to the standard version 
of that application.

 Figure 11.68
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Runtime Mode Configuration 
Property View
The Runtime Mode Configuration property view allows you to 
create a runtime case with a custom set of restrictions. The 
following tabs are available in the Runtime Mode Configuration 
property view: 

• General
• Specifications
• Access

General Tab

The General tab allows you to set general restrictions in a 
runtime case. 

The General tab contains the following groups:

• Runtime Model Control
• Runtime Case Options
• Runtime Case Information

 Figure 11.69
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Runtime Mode Control Group

The Runtime Mode Control group contains the following 
checkboxes:

Runtime Case Options Group

The Runtime Case Options group contains the following 
checkboxes:

Checkbox Descriptions

Test Runtime 
Mode

You can select this checkbox to test the current case in 
runtime mode under the settings specified in the 
Runtime Case Options and Specifications tab.

Convert to 
Runtime Mode

You can select this checkbox to convert the current case 
to a runtime case under the settings specified in the 
Runtime Case Options group and Specifications tab.

Once the case is converted into runtime mode, you have 
to exit HYSYS to restore the standard operation mode.

Checkbox Descriptions

Can Change All 
Specifications

Allows you to change all the specified properties (blue 
values) of the unit operations in the runtime case.

Enable OLE 
password 
protection

Enables you to apply the OLE password protection 
feature.

When this protection feature is activated, only OLE 
access to the case is allowed if the runtime password is 
supplied. The OLE methods available are:

• OpenLockedOLEWithPassword
• put_VisibleWithPassword
• PlayScriptWithPassword
• PlayScriptRelativeToWithPassword

So, if a case is OLE locked then,
• OpenWithPassword is replaced by 

OpenLockedOLEWithPassword
• PlayScript is replaced by PlayScriptWithPassword
• PlayScriptRelativeToWithPassword
• put_Visible is replaced by 

put_VisibleWithPassword

Can Open All 
Flowsheet 
Objects

Enables you to toggle between access to or restriction 
from all flowsheet objects when in runtime mode. 

This feature overrides any protections specified on the 
Access tab.
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Runtime Case Information Group

The Runtime Case Information displays the Runtime ID, Author, 
and the number of edit changes in a runtime case. The Runtime 
Case Information table appears only when the case is confirmed 
to run in runtime mode.

Each time a runtime case is created, a unique Runtime ID 
(RTID) is assigned to the case. The Author of the runtime case 
has to advise Hyprotech of the RTID so that a license can be 
issued to the users to run the case. 

A runtime case can only be opened in standard mode by the 
original Author. When a runtime case is saved, it will store the 
name of the Author in the case. If the name of the user does not 
match the runtime author license, then the case opens in 
runtime mode and the user can only use the runtime case under 
the restrictions pre-set by the original Author.

There is a limit on how many times a runtime case can be 
modified. HYSYS keeps track of the number of modifications in a 
runtime case, and if the number exceeds a specified amount, 
the runtime case will fail to run.

 Figure 11.70
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Specifications Tab

The Specifications tab allows the original Author of the runtime 
case to select the parameters that can be modified in runtime 
mode. 

Select the method for importing the changeable parameters by 
selecting one of the four radio buttons available in the Add 
Specification From group. 

The parameters you select appear in the table on the 
Specifications tab, and you can view the Object Name, 
Description, Object Type, and Variable Owner for each 
parameter. The parameters you can modify appear in blue text 
when you run the runtime case.

You can modify only the parameters selected on the 
Specifications tab when the case is in runtime mode. All other 
parameters are view-only (black text) for the runtime case.

 Figure 11.71

The Specifications tab will appear blank if the Can Change All 
Specifications checkbox is selected.
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Access Tab

The Access tab enables you to select which objects in the 
simulation case can be viewed by other people. 

To make an object available for modification to other users:

1. In the object tree browser, click the Plus icon  to expand 
the branches and select the object you want to add.

2. Click the Add button.

To remove an object:

1. In the Object Name list, select the object you want to 
remove.

2. Click the Remove button.

 Figure 11.72

The Access tab will appear blank if the Can Open All 
Flowsheet Objects checkbox is selected.
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11.16 Echo ID
The Echo ID tool allows you to scan your computer and display 
all of the available locking codes. To open the Scan All Locking 
Codes property view, click the Echo ID command in the Tools 
menu. 

11.17 Export Case to 
Aspen Icarus

The Aspen Icarus command contains two sub-commands: 

• Export Case to IPE. This command exports the 
currently open case to Aspen Technology’s Icarus Process 
Evaluator (IPE).

• Export Case to Decision Analyzer. This command 
exports the currently open case to Aspen Technology’s 
Icarus Decision Analyzer.

 Figure 11.73

IPE is a project scoping tool that allows process engineers to 
evaluate the economic impact of the process design.

For more information, send 
an e-mail to 
eSales@aspentech.com.
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11.18 Correlation Manager
The Correlation Manager allows you to manage individual 
property correlations or property correlation sets that can be 
applied to all streams in your case.

To access the Correlation Manager, select the Correlation 
Manager command from the Tools menu. 

HYSYS has two kinds of settings for property correlations. A 
property correlation or correlation set that is added to a 
stream from the stream property view has a local setting. A 
property correlation or correlation set that is added to a 
stream from the Correlation Manager property view has a 
global setting.

The property correlation sets can be defined and saved 
external to the case and can be read into any other 
simulation case.

Refer to Chapter 12 - 
Streams in the HYSYS 
Operations Guide for 
more information about 
managing property 
correlations in individual 
streams.

 Figure 11.74

Select different 
methods of 
configuration for 
certain 
properties.

The Display Name 
can be modified 
when the property 
correlation is a 
clone.

Filter the list of available 
properties by using the 
Filter by drop-down list. 
Three filter options are 
available:

• All. Displays all 
available properties.

• Point Properties. 
Displays only point 
properties.

• Plottable 
Properties. Displays 
only plottable 
properties.

Refer to Section 12.2.1 - 
Worksheet Tab in the 
HYSYS Operations Guide for 
more information about the 
Status group.

The HYSYS property 
correlations have been 
grouped into categories 
that target the specific 
reporting needs of the 
various process 
industries.
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The Correlation Manager property view contains three groups 
and a Preference Option status bar. The Configuration group 
contains a list of property correlation types. Currently, Standard 
is available, with the other types being available if you purchase 
the proper extensions. The Stream Correlation Controls (Global) 
group contains the following icons:

The Preference Option status bar indicates whether the 
Activate Property Correlations checkbox on the Options 
page of Simulation tab from the Session Preferences property 
view is selected or clear.

Name Icon Description

Scan System 
Correlations

Scan all system correlation files. Click this icon to 
manually scan the system registry and build a list 
of available property correlations.

Clone 
Selected 
Correlation

Click to clone a selected property correlation. You 
can only clone property correlations with variable 
parameters.

Delete 
Cloned 
Correlation 
From List

Click to delete the selected property correlation 
clone. You can only delete property correlation 
clones.

Activate 
Selected 
Global 
Correlation

Click to add the selected global property 
correlation to all the streams.

Remove 
Selected 
Global 
Correlation

Click to remove the selected global property 
correlation from all the streams.

Remove All 
Global 
Correlation

Click to remove all the global property correlation 
from all the streams.
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The stream property view lets you create your own group of 
property correlations called a correlation set. The Stream 
Correlation Set Controls (Global) group lets you to select a 
correlation set and globally apply it to all streams in the case.

11.18.1 Adding Property 
Correlations to Streams

Use this procedure to add a global property correlation to the 
streams.

1. From the list of Available Correlations, click the Plus icon  
to expand the tree browser, displaying the available property 
correlations for each type. All property information for the 
selected property correlation appears on the table to the 
right.

2. Certain properties require qualifiers before they are fully 
configured. Click the appropriate field and specify any values 
that are required.

3. Click the Activate Selected Global Correlation icon in the 
Stream Correlations Controls (Global) group. The Global 
Active status bar changes from red to green.

Name Icon Description

View Global 
Correlation 
Set List

Opens the Correlation Set Picker. From this property view, select the 
correlation set you want to apply to all case streams. The Correlation 
Set Picker will display “File has not been created” until you have 
saved your first set.

You can only create a correlation set in the stream property view.

Remove 
Global 
Correlation 
Set

Click to remove the global correlation set displayed in the status bar 
from all the streams. The Correlation Manager will only remove the 
correlation properties that are part of the selected global set. Any 
other correlation properties that have been globally (or locally) 
added to the streams are not removed.

Active Set 
status bar

Provides description on the status of the active selected global 
correlation set. 

• Red status bar. Indicates that no global correlation set is 
selected for the streams.

• Green status bar. Indicates that a global correlation set is 
selected for the streams.

• Yellow status bar. Indicates that the global correlation set 
has been modified. This is when correlation properties that are 
not part of the set have been globally added to all streams 
(activated), or when properties of this set have been globally 
removed from all streams (deactivated).

Activate Selected Global 
Correlation icon
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11.18.2 Removing Property 
Correlations from Streams

Use this procedure to remove global property correlations from 
the streams.

1. From the Available Correlations list, select the property 
correlation you want to remove from each stream in your 
case. Click the Plus icon  to expand the tree browser, 
displaying the available property correlations for each type. 
The property information for the selected property 
correlation appears on the table to the right.

2. Click the Remove Selected Global Correlation icon in the 
Stream Correlations Controls (Global) group. The Global 
Active status bar changes from green to red.

3. To remove ALL global property correlations and active global 
correlation sets from the streams, click the Remove All 
Global Correlations icon in the Stream Correlations 
Controls (Global) group.

11.18.3 Cloning Property 
Correlations

Any property correlation that contains changeable parameters 
can be cloned. When a correlation is globally activated, all 
streams in the case use the same calculation specified by that 
correlation. When you change a correlation’s parameter, all the 
streams in the case use the new parameter to calculate that 
correlation’s value.

If you require a correlation to have different parameter values 
for different streams, you need to create a clone for that 
correlation. When you create a clone, you can specify a unique 
parameter value for that correlation and then add the clone to 
the appropriate streams.

Remove Selected Global 
Correlation icon

Remove All Global 
Correlations icon
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Do the following to create a clone of a property correlation:

1. From the Available Correlations list, select the property 
correlation you want to clone. Click the Plus icon  to 
expand the tree browser, displaying the available property 
correlations for each type.

2. Click the Clone Selected Correlation icon in the Stream 
Correlations Controls (Global) group. The new property 
correlation is added to the Available Correlations tree 
browser under the Clone branch.

HYSYS automatically names each cloned property correlation 
using the original property correlation name and “_Clone-
1”. The number at the end increases with each clone of the 
same property correlation.

3. Rename the clone property correlation in the Display Name 
field if required. You can only rename cloned property 
correlations and each clone name must be unique.

11.18.4 Deleting Cloned 
Property Correlations

1. From the Available Correlations list under the Clone branch, 
select the clone property correlation you want to delete. 
Click the Plus icon  to expand the Clone branch displaying 
the available clone property correlations.
You can only delete clone property correlations that are not 
used by any streams.

2. Click the Delete Cloned Correlation From List icon in the 
Stream Correlations Controls (Global) group. The selected 
clone property correlation is removed from the Available 
Correlations tree browser under the Clone branch. If the 
selected clone is being used by any stream within the case, it 
cannot be deleted.

Clone Selected 
Correlation icon

Delete Cloned Correlation 
From List icon
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11.18.5 Adding Correlation 
Sets to Streams

Use this procedure to add a global correlation set to all the 
streams in the case.

1. Before selecting a correlation set, there must be no active 
global correlation set. 

2. Click the View Global Correlation Set List icon. The 
Correlation Set Picker property view appears.   

 Figure 11.75

 Figure 11.76

If you have a new product installed the 
Support\StreamCorrSets.xml file will not exist until you 
actually save a set. 

The status bar is red, 
indicating that there is 
no active global 
correlation set.

Remove Global Correlation Set icon

View Global Correlation Set List icon

View Global Correlation 
Set List icon

The location and name of the file that 
contains the correlation set is shown in the 
File Path field. 

If an error is encountered in the file path or 
file name when HYSYS looks for the 
available correlation sets, you are asked to 
let HYSYS rebuild the file path and file, or 
you can change the file path and file name 
in the Session Preferences property view. 
You can only change the file path and name 
in the Session Preferences property view.

Refer to Section 12.5.2 - Locations Page 
for more information.
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3. Select the correlation set you want from the property view. 
You can click the Plus icon  to see what property 
correlations the correlation set contains.

4. Click the Apply button. The selected correlation set is now 
the active global correlation set. All the streams in the case 
contain the selected correlation set and any new stream 
added to the case will automatically contain the selected 
correlation set.

Whenever a correlation/correlation set is applied to the streams, 
a check is made of the correlation type against the fluid type of 
each stream. If the Correlation Manager encounters a problem, 
it will send a warning to the trace window.

The Active Set status bar turns green and displays the selected 
global correlation set.

11.18.6 Deleting a Correlation 
Set

Refer to Deleting a Correlation Set section from 
Section 12.2.1 - Worksheet Tab in the HYSYS Operations 
Guide for more information.

HYSYS creates the file the first time you want to save a set. 
The program manages the file after this, but should only 
have to create the file once. If you are looking in the Support 
directory the file will not exist there until the user has saved 
a correlation set using one of the stream properties property 
views. 

The Correlation Manager will not display the Correlation Set 
Picker property view if a set is already globally active. Only 
one correlation set can be globally active at a time.

 Figure 11.77

Refer to Section 12.2.1 - 
Worksheet Tab in the 
HYSYS Operations 
Guide for more 
information.
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11.18.7 Gas Properties 
Correlation

The Gas Properties in the Correlation Manager consists of the 
following seven correlations:

• HC Dew Point
• Higher Heating Value
• Lower Heating Value
• Mass Density (Std. Cond)
• Water Content In Mg/m3
• Water Dew Point
• Wobbe Index

These correlations are grouped within the Gas correlation type. 
The Gas type is shown on the Available Correlations window of 
the Correlation Picker and Correlation Manager property views. 
You can access the seven Gas correlations by double-clicking on 
the Gas correlation type to expand the list.

 Figure 11.78

Refer to Adding a 
Property Correlation 
section from Section 
12.2.1 - Worksheet 
Tab in the HYSYS 
Operations Guide for 
more information on the 
Correlation Picker.
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The following four Gas correlation types allow you to specify the 
calculation’s reference temperature:

• Higher Heating Value
• Lower Heating Value
• Mass Density (Std. Cond)
• Wobbe Index

Properties
The Gas correlation uses the methods and data from ISO 
6976:1995(E). If the stream contains components that are not 
supported by this data, then the data for the hydrocarbon with 
the nearest molecular weight Alkane is used. If the molecular 
weight is greater than decane (C10), then the data for decane is 
assumed. ISO data has been provided to support the following 
components:

For more information on 
the Correlation Manager, 
refer to Section 11.18 - 
Correlation Manager.

Components

Methane n-Decane n-C21 Propene M-Cyclohexane

Ethane n-C11 n-C22 Methanol CO

Propane n-C12 n-C23 EGlycol CO2

i-Butane n-C13 n-C24 TEGlycol H2S

n-Butane n-C14 n-C25 Benzene Ammonia

i-Pentane n-C15 n-C26 Toluene H2O

n-Pentane n-C16 n-C27 E-Benzene Hydrogen

n-Hexane n-C17 n-C28 124-M-Benzene Nitrogen

n-Heptane n-C18 n-C29 Cyclopentane Argon

n-Octane n-C19 n-C30 Cyclohexane Oxygen

n-Nonane n-C20 Ethylene M-Cyclopentane
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Higher Heating Value

The higher heating value is the amount of heat obtained during 
combustion when the water produced in the combustion is 
condensed (when the water is in liquid form). 

where:  

HHV = Overall higher heating value

HHVi = Higher heating value of component i

Lower Heating Value

The lower heating value is the amount of heat obtained when 
this water is not condensed (when the water is in vapour form).

where:  

LHV = Overall lower heating value

LHVi = Lower heating value of component i

Hydrocarbon & Water Dew Point

The dew point is the temperature at a given pressure at which 
the first drop of liquid starts to form. Hydrocarbon and water 
dew points indicate the type of liquid formed.

(11.1)

(11.2)

HHV

xi HHVi×

i
∑

Z
---------------------------------=

LHV

xi LHVi×

i
∑

Z
--------------------------------=
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In HYSYS, the dew point is calculated by using a flash to 
calculate the temperature at which the vapour fraction is equal 
to one. When the vapour fraction is equal to one, the vapour is 
said to be saturated or at steam pressure. If the case does not 
contain water, the temperature at which the vapour fraction 
equal to one is reported as the hydrocarbon dew point. If the 
case has water as one of the components, the type of liquid 
phase formed is reported with its corresponding dew point 
temperature. Then the temperature is decreased until a second 
liquid phase forms, the temperature at which this occurs is 
reported as the other dew point.

Mass Density at Standard Conditions

The mass density is reported at 1 atm and 15°C (288.15K). 
From the Ideal Gas law: 

where:  

P = Pressure (kPa)

V = Volume

n = Number of moles

Z = Compressibility factor

R = Gas constant (8.3145 J/mol K) 

T = Temperature (K)

The molar density can be expressed as:

(11.3)

(11.4)

PV nZRT=

1
V
--- P

ZRT
-----------=
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The mass density is therefore: 

where:  

 = Mass density (kg/m3)

xi = Mole fraction of component i

MWi = Molecular weight of component i

Water Content

The water content is the mass of water per unit volume of each 
phase. It is expressed as mg/m3.

Wobbe Index

The Wobbe Index (or Wobbe Number) is a measure of how 
much heat is released when gas is burnt.

The Wobbe Index is calculated by dividing the HHV (higher 
heating value) by the square root of the density relative to air.

The higher heating value is the amount of heat obtained during 
combustion when the water produced in the combustion is 
condensed.

(11.5)

(11.6)

ρ

xi MWi×

i
∑

 
 
 
 

P×

Z R T××
----------------------------------------------=

ρ

Wobbe HHV
ρrelative

----------------------------=
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Density Relative to Air

The density relative to air is calculated by dividing the equation 
for the density of the stream by the equivalent one for the 
density of air at 1 atm and 15°C.

where:  

 = Density relative to air

MWair = Molecular weight of air

11.18.8 RVP Properties
The RVP properties uses the methods and data constructed by 
the company API. The RVP properties consist of the following 
eight correlations:

• Reid VP at 37.8°C
• True VP at 37.8°C
• API 5B1.1
• API 5B1.2
• ASTM D323-73/79
• ASTM D323-82
• ASTM D4953-91
• ASTM D5191-91

The Reid VP at 37.8°C and True VP at 37.8°C correlations are 
grouped within the Standard correlation type, and the other six 
correlations are grouped under the RVP correlation type. 

(11.7)

In order to use the correlations under the RVP correlation 
type, you need to purchase and register the RVPProps.dll 
extension (refer to Section 12.7 - Extensions Tab). The Reid 
VP and True VP correlations come standard with HYSYS.

ρrelative

xi MWi×

i
∑

Z
------------------------------

Zair
MWair
------------------×

xi MWi×

i
∑

Z
------------------------------ 0.99958

28.962
-------------------×= =

ρ
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The RVP and Standard types are shown on the Available 
Correlations window of the Correlation Picker and the 
Correlation Manager property views.

You can access the eight correlations by double-clicking their 
corresponding correlation type to expand the list.  

Properties
The following is a brief description of each of the correlations 
listed under the RVP type.

API 5B1.1 (Naphtha)

This property correlation is useful for gasoline and finished 
petroleum products, but not crude or oxygenated blends. The 
TVP is correlated against the RVP, temperature, and slope of the 
ASTM D86 distillation curve at the 10% point. This property 
solves the corrected version of the API databook equation of the 
correlation for the RVP. A recognized limitation of the API 
Naphtha correlation is that the D86 10% point can have a 
similar gradient for vastly different streams.

 Figure 11.79

Refer to Adding a 
Property Correlation 
section from Section 
12.2.1 - Worksheet 
Tab in the HYSYS 
Operations Guide or 
Section 11.18 - 
Correlation Manager 
for more information.
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API 5B1.2 (Crude)

This property correlation is generally used for condensate and 
crude oil systems (typically wide boiling preprocessed 
hydrocarbons). TVP is correlated against RVP and the 
temperature. This property solves the API databook equation of 
the correlation for RVP. 

The correlation is based on data from 1959, but it is popular 
with engineers for its quick and dirty calculations.

ASTM D323-73/79

This correlation is also known as P323. The pressure is adjusted 
at the RVP reference temperature until the vapour to liquid ratio 
is 4:1 by volume. This correlation is essentially the same as the 
Reid VP at 37.8°C correlation, except it is not on a dry basis and 
the flash method used is the same for the rest of the flowsheet.

ASTM D323-82

This is the standard and accepted procedure for RVP lab 
measurement. Liquid hydrocarbon is saturated with air at 33°F 
and 1 atm pressure. Since the lab procedure does not specify 
that the test chamber is dry, the air used to saturate the 
hydrocarbon is assumed to be saturated with water.

This air-saturated hydrocarbon is then mixed with dry air in a 
4:1 volume ratio and flashed at the RVP reference temperature, 
such that the total volume is constant (since the experimental 
procedure uses a sealed bomb). The gauge pressure of the 
resulting mixture is then reported as the RVP.

ASTM D4953-91

This correlation is for oxygenated gasoline. It is the same as the 
D323-82 test method, except everything is on a completely dry 
basis (in other words, the air is not saturated with water).
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ASTM D5191-91

This was developed for gasoline and gasoline-oxygenate blends 
as an alternative to the D4953-91 test method. In the 
experimental procedure, the hydrocarbon is saturated with dry 
air and then placed in an evacuated bomb with five times its 
volume. The total pressure is then converted to a dry vapour 
pressure equivalent (DVPE) and reported as the RVP.

The method used is to mix near vacuum air at 0.01 psia and 
100°F with hydrocarbon at 1 atm and 33°F in the ratio 4:1. This 
is then flashed at constant volume at the RVP reference 
temperature. The pressure is then converted to a DVPE and 
reported as the RVP.

Conditions for Using RVP
In order to apply some of the RVP correlations to your stream, 
the components in the stream need to comply with the 
correlation.

Nitrogen, oxygen, and water need to be present in the stream if 
you are using the following RVPs:

• ASTM D323-82
• ASTM D4953-91
• ASTM D5191-91

If all three components are not present within your stream and 
you want to use any of the above three RVPs, HYSYS will 
administer a warning in the trace window.

Electrolyte Components

Electrolytes are the only type of components which cannot be 
used with any of the RVP correlations. 

• If an Electrolyte component is present in the stream and 
you try to add a RVP correlation, HYSYS will not allow 
you to use it. 
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• If the RVP correlation is already applied to a stream and 
you add the Electrolyte component afterwards, HYSYS 
will automatically remove the electrolyte component 
from that given stream.

11.19 Case Collaboration
The Case Collaboration feature is used to facilitate the 
distribution of HYSYS simulations over more than one HYSYS 
case. The multiple cases can be run on the same machine or on 
different machines where a network is available.

For cases to be linked, they must share the same data. Data 
from one case is published to the RTI Data Server and is then 
available for sharing with other cases. All machines used in the 
data sharing must point to the same RTI Data Server.

The purpose of Case Collaboration is to allow the sharing of data 
between a source case and one or more sink cases. The data 
that is being shared exists outside of the instance of HYSYS 
where it is being generated, allowing sink cases to acquire 
revisions of the data without the source case being open.

Selecting the Case Collaboration command opens the Simulation 
Variable Manager property view. The Simulation Variable 
Manager contains the following four tabs:

• Available Streams
• Unit Operations
• Messaging
• Published Streams

The first three tabs appear similar and are described in the 
following sections.

The shared data is maintained outside of HYSYS, in effect, in 
another application. If stream A in case 1 publishes its data, 
stream B in case 2 can use that data, even if case 1 is not 
open.

Refer to Section 12.2.9 - 
RTi Server Page for 
information about setting 
up the RTI server 
connection settings in the 
Session Preferences.
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Click the Scan the Database for Published icon to scan for 
available published data. Either stream or operations appear 
depending on the actively selected tab.

The figure below shows an example of two published streams 
being found.

 Figure 11.80

 Figure 11.81

Scan the Database for 
Published icon
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The first three tabs contain the Available list and five icons. The 
Available Published Streams list contains the published data that 
was found. The following table contains a description of the five 
icons.

Published Data Viewer
Clicking the View Published Data Tree icon opens the 
Published Data Viewer property view. All the published objects 
appear on this property view. Published objects are transferred 
in XML format. The XML data is rendered in the tree browser and 
users familiar with XPath can query the published data. This is 
done by typing the query in the XPath Query field and clicking 
the Run button.

Name Icon Description

Scan the 
Database for 
Published ()

Click to scan for published data available in 
the server you specified on the RTI page of 
the Session Preferences property view.

Connect to the 
Message Server

Forces a connection or reconnection of the 
RTI Data Server.

Delete All 
External () Data

Click to delete all the publish data listed in 
the Available Published Streams/Unit 
Operations group.

Delete the 
Current () 
Revision

Select a published data item from the list and 
click to remove the item from the server.

View Published 
Data Tree

Click to open the Published Data Viewer 
property view. All the published data are 
contained in the property view and displayed 
in a tree browser format.

View Published Data Tree 
icon
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The following figure shows what appears in the Published Data 
Viewer property view.

 Figure 11.82
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11.19.1 Available Streams Tab
The Available Streams tab contains three groups: Available 
Published Streams, Stream Information, and Revision 
Information. Use the Available Streams tab to view a published 
stream.

The following table describes each object in the Streams 
Information group.

 Figure 11.83

Object Description

Name This field displays the name of the selected published 
stream.

Number of 
Revisions

When the same stream is published more than once, a 
new revision is created. This field keeps track of the 
number of revisions that exist on a particular server.

Live Link Active If the stream is live-linked to one or more streams in 
the current case, the checkbox is selected.

Stream is 
Remote

If the source of the stream is external to the current 
case, this checkbox is selected.

Rescan Database Click this button to rescan the server database for 
published streams.

Import Fluid 
Package

Click this button to import the source stream’s fluid 
package and component slate to any locally linked 
streams.

Publishing Case Displays the location and name of the case from which 
the published stream was taken.

See Section 11.20 - 
External Data Linker 
for more information on 
live-linking.
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The following table describes each object in the Revision 
Information group.

Server GUID The unique alphanumeric identifier of the RTI Data 
Server that is being used.

Stream GUID The unique alphanumeric identifier of the published 
stream.

Each standard HYSYS material stream has a unique 
alphanumeric identifier. This is what appears in the 
Stream GUID field. 

If you save HYSYS case A under a different name, B, 
the unique identifiers for the material stream in case B 
do not change. In other words, the only time when two 
streams may have the same GUID, is when you use 
the Save As function to create multiple cases from a 
single case. So caution must be used when linking 
cases that have the same origin.

Object Description

Revision # View different revisions of the selected stream using 
this drop-down list.

View Raw Data Click to open the Revision Raw Data property view. The 
Revision Raw Data property view is similar to the 
Publish Data Viewer property view. The difference is 
that the Revision Raw Data property view only displays 
information regarding the active/selected stream.

Use as Default 
Revision

When selected, this option causes a solve in the link 
operation as you select different revisions.

Revision Author Displays the name of the person who published the 
stream for the selected revision. The name is taken 
from the Author Name field from the Publication 
Information property view.

Revision Date Displays the date when the stream was published for 
the selected revision.

Warn if a Higher 
Revision is 
Available

Select this checkbox to be informed if the revision you 
selected is not the latest revision.

The default setting for this checkbox is selected.

Revision Notes Displays the notes associated with the published 
stream for the selected revision. The notes come from 
the Publication Note field from the Stream 
Publication Information property view.

Object Description
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11.19.2 Unit Operations Tab
The Unit Operations tab contains three groups: Available Unit 
Operations, Operation Information, and Revision Information. 
Use the Unit Operations tab to view published operation data. 

The following table describes each object in the Operation 
Information group.

 Figure 11.84

Object Description

Name Displays the name of the selected published operation.

Number of 
Revisions

When the same unit operation is published more than once, 
a new revision is created. This field keeps track of the 
number of revisions that exist on a particular server.

Object Type Displays the operation type of the selected operation.

Publishing 
Case

Displays the location and name of the case the published 
operation was taken from.

Server GUID The unique alphanumeric identifier of the RTI Server that is 
being used.

Operation 
GUID

The unique alphanumeric identifier of the source operation. 

Linked Unit 
Op

The local operation that is statically linked to this operation.
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The following table describes each object in the Revision 
Information group.

The Select Linked Object icon allows the user to statically 
link this operation to an existing local operation.

Click the Create a New Object icon to place the selected 
operation into the current flowsheet. HYSYS automatically 
transfers the published operation specs into the new 
operation created in the flowsheet.

Object Description

Revision # View different revisions of the selected operation using 
this drop-down list.

View Raw Data Click to open the Revision Raw Data property view. The 
Revision Raw Data property view is similar to the 
Publish Data Viewer property view. The difference is 
that the Revision Raw Data property view only displays 
information regarding the active/selected operation.

Use as Default 
Revision

When selected, this option causes a solve in the link 
operation as you select different revisions.

Revision Author Displays the name of the person who published the 
operation for the selected revision. The name is taken 
from the Author Name field from the Publication 
Information property view.

Revision Date Displays the date when the operation was published for 
the selected revision.

Warn if a Higher 
Revision is 
Available

Select this checkbox to be informed if the revision you 
selected is not the latest revision.

By default this checkbox is selected.

Revision Notes Displays the notes associated with the published 
operation for the selected revision. The notes come 
from the Publication Note field from the Publication 
Information property view.

Object Description
11-101



11-102 Case Collaboration
11.19.3 Messaging Tab
The Messaging tab is used for broadcasting simple messages to 
connected HYSYS cases. 

Type a message in the field located at the bottom of the 
property view, then click the Send Message button to broadcast 
the typed message. A unique alphanumeric identifier appears 
with each sent message. This GUID corresponds to the case that 
the message came from. Click the Clear History button to clear 
the message buffer and delete the old messages.

 Figure 11.85

Type your message in this field.
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11.19.4 Published Streams Tab
This tab displays the streams that are published from the active 
case. 

The following table lists and describes the objects on this tab.

The difference between the Published Streams tab and the 
Available Streams tab is that the Available Streams shows all of 
the streams that exist on the server while Published Streams 
shows only the streams on the server that originate from the 
selected case.

11.20 External Data Linker
The External Data Linker operation allows you to connect 
Internal streams (streams that exist within the active 
simulation) to External streams (previously published streams 
that exist on the Data Server).

Install the External Data Linker by doing one of the following:

• Open the Object Palette (press F4). Double-click the 
External Data Linker icon in the Object Palette.

• Select Add Operation from the Flowsheet menu (or 
press F12) to open the UnitOps property view. Select 
External Data Linker from the Available Unit 
Operations list.

Object Description

Case Published 
Stream

Displays the name and publication status of the 
published streams in the case.

Remove Stream Click the Remove Stream button to unpublished the 
stream. This removes it from the RTI server.

Revision Stream Click the Revision Stream button to increment the 
streams revision number on the RTI server.

Propagate State Click the Propagate State button to force all cases that 
are using the published stream (via the External Data 
Linker operation) to refresh their values.

A valid connection to the Data Server must exist before you 
can use the External Data Linker operation.

See Section 11.20 - 
External Data Linker 
for more information.

External Data Linker icon
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The External Data Linker property view contains two tabs: 
Design and Revision History.

To delete the External Data Linker operation, click the Delete 
button. To ignore the External Data Linker during calculations, 
select the Ignored checkbox at the bottom of the property 
view. HYSYS completely disregards the operation until you 
restore it to an active state by clearing the checkbox.

11.20.1 Design Tab
The Design tab contains two pages: 

• Connections 
• Configuration

 Figure 11.86
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Connections Page
You can select the streams you want to attach to the External 
Data Linker operation on the Connections page. 

You can also change the name of the operation by entering a 
different name in the Name field.

Attaching External Streams
1. Click the Design tab, then select the Connections page.
2. In the External Stream column, click the cell containing 

<empty>.

3. Use the down arrow button  to open the drop-down list. 

4. Select the external stream you want to link to from the list.

This list contains the streams that have previously been 
published to the Data Server. You can also type the name of 
the external stream you want in the <empty> cell under 
the External Stream column.

 Figure 11.87

You cannot attach streams to the External Data Linker from 
the PFD property view.
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Attaching Internal Streams
1. Click the Design tab, then select the Connections page.
2. In the Internal Stream column, click the cell that is beside 

the external stream you want to link to.

3. Use the down arrow button  to open the drop-down list. 

4. Select the external stream you want to link from the list. 
This list contains the streams available for linking in the 
current case. The internal streams that can be linked are as 
follows:

• Streams that are not already linked to other external 
streams.

• Streams that are not linked between two operations. If a 
stream comes out of an operation and enters another 
operation, it cannot be linked to an external stream.

5. You can also type the name of the internal stream you want 
in the cell under the Internal Stream column.

You can also create a new internal stream by entering a new 
name for the stream in the cell under the Internal Stream 
column.

The Internal stream takes the conditions of the External stream 
(the transfer specification type can be selected on the 
Configuration page).

The list is the same as the Available Streams list in the 
Simulation Variable Manager property view which is 
accessed from the Case Collaboration menu item under the 
Tools menu.

You must select an external stream before you can select an 
internal stream.

If the Live Link checkbox is selected, the Internal stream 
conditions change as changes are made to the External 
stream published data; if the checkbox is clear, the 
conditions are read in initially at connection only.
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Configuration Page
You can select the transfer specification for each external stream 
on the Configuration page.

To select the transfer specification type for a stream, use the 
drop-down list provided in the Transfer Specification cells.

There are four types of transfer specifications:

• Temperature - Pressure
• Pressure - Vapour Fraction
• Temperature - Vapour Fraction
• Pressure - Enthalpy

11.20.2 Revision History Tab
The revision history for each selected external stream appears 
in the Revision History tab.

 Figure 11.88

 Figure 11.89

Information displayed on 
this tab can also be found 
in the Simulation Variable 
Manager property view. 
See Section 11.19 - 
Case Collaboration for 
more information.
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11.21 Variable Navigator
The Variable Navigator is one of the two navigational aids that 
can be used to bring the multi-flowsheet architecture into a flat 
space. It is also used when browsing for variables, such as 
selecting a process variable for a controller or a strip chart. 

The Variable Navigator uses a similar structure to the Object 
Navigator, but allows for a more detailed search.

11.21.1 Selecting a Variable
When selecting a variable, work through the groups/lists from 
left to right.

1. In the Navigator Scope group, select one of the radio 
buttons to filter the list of available selections. 

2. From the list, select either the flowsheet, case, basis, or 
utility in which the process variable is located.

 Figure 11.90

The list/group located above the Navigator Scope group 
changes depending on the radio button selected.
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3. From the list of available objects, select the object with the 
variable you want to use.

4. From the list of available variables, select the variable you 
want to use.

5. Certain variables (such as component specific variables), 
require further specification. From the list of variable 
specifics, select the qualifier for the variable.

6. Enter a more detailed description of the variable in the 
Variable Description field or leave the default description.

7. Click OK to accept the variable.

To disconnect a selected variable from an operation, click the 
Disconnect button.

You can click the Cancel button at any time to close the Variable 
Navigator property view without accepting any changes.

Navigator Scope
The following table provides information on the different 
navigator scopes you can use. 

Columns are considered as a subflowsheet, and therefore the 
column name must be selected in the Flowsheet list in order 
to select any internal variables in the colume subflowsheet.

You can filter the list of available objects futher by selecting 
the appropriate radio button in the Object Filter group,

Object Definition

Flowsheet Provides a list of all available flowsheets in the simulation, 
so you can select an object from any flowsheet.

Case Access general case information (for example, about the 
Main Solver or Optimizer). You can also use this option 
when a column is the main flowsheet (for example, if you 
are in a column template, then there are a bunch of 
variables that have to be accessed through the Case filter. 
This is because the column template file doesn't have the 
upper environment, so those variables become available 
through the case filter).

Refer to Section 7.17 - 
Object Navigator for 
details on list filtering.
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Basis Provides a list of property packages or components being 
used in the case.

Utilities Provides a list of all available utilities in the simulation. A 
special utility Object Filter replaces the default filter.

Object Definition
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12.1 Introduction
The Session Preferences property view is used to specify default 
information for the simulation case. This information includes 
Automatic Naming Formats, Units, Colours, Fonts, Icons, etc. 
Multiple Session Preferences can be saved for use in other 
simulations. 

Access the Session Preferences property view by selecting the 
Preferences command from the Tools menu in any HYSYS 
environment.

There are a number of tabs associated with the property view. 
Common to all tabs are the two buttons along the bottom of the 
property view: Save Preference Set and Load Preference Set.

 Figure 12.1
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12.1.1 Saving a Preference Set
1. Click the Save Preference Set button. The Save File 

property view appears.
2. Specify the name and location for your preference file.

3. Click Save.

12.1.2 Loading a Preference 
Set

1. Click the Load Preference Set button. The Open File 
property view appears.

2. Browse to the location of your preference file (*.prf).

3. Select the file you want to load and click Open.

12.2 Simulation Tab
The Simulation tab contains the following pages: 

• Options
• Errors
• Desktop
• Naming
• Tool Tips
• Dynamics
• Performance
• Licensing
• RTi Server
• Column
• Status Window
• Trace Window 
• Cut/Copy/Paste
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12.2.1 Options Page
The Options page contains three groups: General Options, Show 
Property Package Warning, and Stream Property Correlations.  

The following table lists and describes the checkboxes in the 
General Options group.

 Figure 12.2

Option Description

Allow Multiple 
Stream 
Connections

Controls whether lists of streams are filtered only to 
those that are not currently connected. If this 
checkbox is clear, when you use the drop-down list of 
streams to select a feed to an operation, only streams 
that are not already connected as a feed to an 
operation appear in the list. If the checkbox is 
selected, all the streams in the flowsheet appear, 
including the ones that you cannot connect as feed 
streams.

View New 
Streams Upon 
Creation

If selected, the property view for the stream 
automatically appears when you add a new stream.

Use Modal 
Property Views

When selected, all property views appear as modal 
(with a Pin). 

When property views are modal, you can individually 
make each property view non-modal by clicking the 
Pin icon in the upper corner of the property view.Pin icon
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The Show Property Package Warning group consists of one 
checkbox that allows you to display the warning message 
related to the property package.

The Stream Property Correlations group has two checkboxes:

• Activate Property Correlations checkbox
When selected, HYSYS will activate all available Black Oil, 
Electrolyte, and Standard Property Correlations. The 
activation process does not guarantee that each stream 
in the case will contain all active correlations. 
Before the HYSYS Correlation Manager appends any 
stream correlations it first checks each streams Fluid 
Package to confirm that the required information will be 
available to that correlations calculation. If that stream 
fluid does not supply the required information the 
correlation cannot be appended. If the checkbox is not 
selected the HYSYS Correlation Manager will not activate 
any new property correlations and will not remove any 
correlations previously added. If this checkbox is 

Record Time 
When Notes are 
Modified

When selected, all notes are time stamped when they 
are modified.

Enable Cross 
Hairs on PFD

When selected, any time the cursor is positioned over 
the PFD property view, a set of vertical and horizontal 
lines appear and intersect where the cursor point is in 
the property view. 

When clear, the set of lines do not appear.

Save XML Fluid 
Package to User 
Defined File

When this checkbox is selected, you can save and 
export an XML file that contains a fluid package to the 
user-defined file so that HYPROPIII can manually read 
the file. 

Use Input 
Experts

Column operations have an optional installation expert 
built in to assist you in the installation. When this 
checkbox is selected, the Input Expert guides you 
through the Column installation.

Confirm Deletes When selected, you are prompted for confirmation 
before deleting an object. If the checkbox is clear, the 
object is deleted when the instruction is given. It is 
recommended that you keep this option selected.

Confirm Mode 
Switches

When this checkbox is selected, you are prompted for 
confirmation when changing to or from Dynamics 
mode.

Enable Single 
Click Actions

When selected, all objects that require a double-click 
only require a single-click.

Enable Cell Edit 
Button

When selected, a cell that is ‘editable’ has a button 
appearing on the left side when the cell has focus. 
Clicking this button, accesses the cell’s edit functions 
(similar to pressing F2). 

Option Description
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unselected and then reselected, the Correlation Manager 
will repeat the process of activating and appending all 
available Black Oil, Electrolyte, and Standard Property 
Correlations. 

• Confirm Before Adding if Active Correlations are 
Present checkbox
When selected, a warning message will appear when 
HYSYS activates a correlation in a case which already 
contains some active correlations. This warning message 
asks you if you want to add a full list of correlations in 
addition to the existing correlations.

Modal vs. Non-Modal Property Views
When a property view is modal, you cannot access any other 
element in the simulation (in other words, you cannot select a 
menu item or property view that is not directly part of that 
modal property view). This functionality is convenient if you do 
not want to clutter the Desktop with unnecessary views.

The modal property view is indicated by the substitution of the 
Minimize/Maximize icons with a Pin icon. Some modal property 
views, such as the Input Composition property view, do not 
have Pins. 

 Figure 12.3

A modal property view with a Pin can be converted to a non-
modal property view by clicking the Pin icon.

Modal property view Non-Modal property view
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Non-modal property views are not restrictive because you can 
leave a non-modal property view open and interact with any 
other property view or menu item. The non-modal property view 
has the Minimize/Maximize icons in the upper right corner of the 
property view. 

12.2.2 Errors Page
The Errors page contains five checkboxes which, when selected, 
send the specified errors to the Trace Window. When these 
checkboxes are clear, you are not prompted to acknowledge 
errors. 

The following is a brief description of each error type.

 Figure 12.4

Error Type Description

Errors in Trace 
Window

The basic error message is displayed within the trace 
window rather than via a pop-up window.

Numerical Errors 
in Trace Window

This option sends numerical errors to the trace window 
rather than via a pop-up error message window. In 
dynamics mode, selecting this option ignores 
numerical errors so the integrator will continue to run 
even if the numerical errors occur.

Prefix Date and 
TIme to Error

The date and time (according to the clock and calendar 
of your CPU) is placed before the error message.

Prefix Integrator 
Time to Error

The integrator time is placed before the error message 
(this only applies when the integrator is running in a 
dynamics case).

Identify Source 
of Numerical 
Errors

This option will try to identify the source of a numerical 
error and display it within the trace window. This can 
slow HYSYS down so it should only be used when you 
are trying to track down errors to clean them up. Once 
you have finished tracking errors, turn this option off.

This option may not be able to identify the source if it 
does not occur within a unit operation (for example, if 
the error was caused by a strip chart).

Refer to Section 1.3 - 
Object Status & Trace 
Windows for more 
information on the Trace 
Window.
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12.2.3 Desktop Page
The Desktop page contains two groups: Initial Build Home View 
and Face Plates.

The Initial Build Home View group contains radio buttons that let 
you specify which of the three main property views (Workbook, 
PFD, or Summary) automatically appears when you first enter 
the Simulation environment. This does not restrict your access 
within that environment, as the Workbook, PFD, and Summary 
property views can all be open at the same time. This setting 
only establishes the property view that appears by default.

 Figure 12.5
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The Face Plates group involves the placement of face plates on 
the Desktop. When you have a large number of face plates open 
in a case and you click the Arrange Desktop command in the 
Window menu, the face plates are organized according to your 
specifications in this group. 

The face plates are either placed along the left side of the 
Desktop in a column format or along the top in a row format. 
You can limit the number of columns or rows (depending on the 
selected radio button) in the Maximum Number of Columns/

 Figure 12.6

Extra property views, 
including face plates, are 
cascaded.

When the Tile Face Plates Along Side radio button 
is selected, the property views are tiled as shown.

A value of 2 was specified as the maximum 
number of columns for tiling; this is why there are 
only two columns visible here.
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Rows field. Any excess face plates that cannot be placed on the 
Desktop due to the columns/rows limit are cascaded with other 
open property views.

12.2.4 Naming Page 
The Naming page dictates how streams and operations are 
named when they are installed. You can specify the naming 
convention for each type of operation. For each flowsheet 
object, specify a naming convention and a starting number. 

For example, in the figure below, Energy Streams are indicated 
as Q-%d, with a starting number of 100. The first energy stream 
installed in the simulation is named Q-100, the second Q-101, 
and so on. The automatic naming function is provided for 
convenience. You can change any default name at any time 
within the flowsheet. 

There are no restrictions in naming streams and operations. 
You can use more than one word, and spaces are allowed.

 Figure 12.7
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12.2.5 Tool Tips Page 

The following table lists and describes the objects in the Show 
ToolTips group.

 Figure 12.8

Object Description

Show ToolTips 
checkbox

Activates the available tool tips. When this checkbox is 
selected you can use the checkboxes in the ToolTips 
group.

Default Unit Set 
radio button

Select this radio button to use the default unit set.

User Defined 
Unit Set radio 
button

Select this radio button to define a custom unit set. 
The User Defined Unit Set table becomes active, and 
you can define the unit set.

Value Calculated 
By checkbox

Displays what operation calculated the value in the tool 
tip. Clear the checkbox if you do not want to see this 
value.

Value in EuroSI 
Units checkbox

Displays the value in European SI units in the tool tip. 
Clear the checkbox if you do not want to see this value.

Value in Field 
Units checkbox

Displays the value in Field units in the tool tip. Clear 
the checkbox if you do not want to see this value.

Value in SI Units 
checkbox

Displays the value in SI units in the tool tip. Clear the 
checkbox if you do not want to see this value.

User Define User 
Set table

Available only when the User Defined Unit Set radio 
button is selected. Allows you to define the unit set.
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The following table lists and describes the objects in the Show 
PFD Fly By group.

12.2.6 Dynamics Page
There are four groups in the Dynamics page: Assistant, 
Controller Options, Pressure Flow Solver, and Other.   

Object Description

Show PFD Fly By 
checkbox

Click this checkbox to see the Fly by text in the PFD. 
The Fly by displays information about an object when 
you move the cursor over it in the PFD. 

Steady State 
radio button

Select this radio button to view the Fly by text in 
Steady State mode.

Dynamic State 
radio button

Select this radio button to view the Fly by text in 
Dynamic Mode.

PFD object tree 
browser

Select a PFD object type from the tree browser. A list of 
Fly by options appears in the table to the right of the 
tree browser.

Show PFD Fly By 
table

Select the checkboxes in the table to select the 
parameters you want to view in the Fly by text. By 
default, Temperature, Pressure, and Molar Flow are 
already selected. Some options are available only in 
Dynamic mode.

Reset to default 
selections button

Click this button to reset the Show PFD Fly By options 
back to the default setting.

 Figure 12.9
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The following table lists and describes the objects on the 
Dynamics page.

12.2.7 Performance Page
The Performance page allows you to manipulate the HYSYS 
computation time and calculation process. 

Object Description

Set dynamic stream 
specifications in the 
background checkbox

Select the checkbox to automatically set all of 
the dynamic stream specifications.

Perform checks when 
switching to dynamics or 
starting the integrator 
checkbox

Select the checkbox if you want to use the 
Dynamics Assistant every time you switch 
from steady state to dynamics, or when 
starting the Integrator.

Trace controller alarm 
messages checkbox

Select the checkbox if you want to see 
controller alarm messages in the Trace 
Window.

Ignore convergence 
failures checkbox

When selected, convergence failures for up to 
five pressure flow steps are ignored. Selecting 
this option is not recommended, but it can be 
useful when you know a converging case 
converges while having problems during one 
of the calculation steps.

Logger Size field Specify the amount of data (steps) you want 
stripcharts to keep.

Sample Interval field Specify how frequent HYSYS records the data 
for the stripcharts. The shorter the amount of 
time, the more frequent HYSYS records the 
data.

Delete Internal sub-
flowsheet streams when 
external streams are 
deleted checkbox

When selected, all internal subflowsheet 
streams are deleted when the corresponding 
external stream is deleted.

 Figure 12.10
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Macro Performance Group

The Macro Performance group contains the Macro Performance 
slider. Move the slider to your required setting to balance the 
Macro speed with your memory requirements. The faster the 
setting, the more memory your computer requires to run the 
macros.

Update Object Status when Solving Checkbox

When the Update Object Status when Solving checkbox is 
selected, the object status services updates each time an object 
is solved. For example, as HYSYS solves the entire flowsheet, 
the object status goes between “not solved” and “solved” as 
HYSYS encounters not solved objects and solved objects in the 
flowsheet. 

When the checkbox is clear, HYSYS only updates the object 
status of all the objects in the flowsheet at the end of the solve 
pass, in other words, when HYSYS has finished solving the 
entire flowsheet. The calculation time decreases and 
performance improves when you clear the checkbox.

SwitchToDirectory in Extensions with no behaviour 
specified Checkbox

When the SwitchToDirectory in Extensions with no 
behaviour specified checkbox is selected, HYSYS performs the 
following process before each call to any extension unit 
operation method (solve, display values, and so forth):

1. HYSYS changes the default directory to match the directory 
location of the extension.

2. After obtaining the results from the extensions, HYSYS 
switches the default directory back to the original setting.

The default setting for the Update Object Status when 
Solving checkbox is selected.
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This process can significantly slow down computation time and 
is not usually required for extensions that most users write.

Clearing the SwitchToDirectory in Extensions with no 
behaviour specified checkbox will improve the HYSYS 
performance and speed up computation time. In older versions 
of HYSYS, the directory was always switched.

12.2.8 Licensing Page
The Licensing page contains the following groups: Licensing 
Options, Job Tracking Options, and ACMOp Licenses Behaviour.

The default setting for the SwitchToDirectory in Extensions 
with no behaviour specified checkbox is selected.

The extensions can set the flag directly by an OLE extension 
interface call, or alternatively the extension can be installed 
in the same directory as the HYSYS executable.

 Figure 12.11

To purchase additional 
licenses or products, 
contact your AspenTech 
agent, or e-mail us at 
info@aspentech.com.
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The default licensing behaviour of the HYSYS Dynamics license 
can be changed in the Licensing Options group.

The options from the drop-down list have the following effects:

• No default behaviour. Selecting this option prompts 
the user to select a behaviour option when changing a 
value that requires it. The figure below shows the prompt 
property view containing the different behaviours.

• Ask every time. Selecting this option prompts the user 
to check the license when changing a value that requires 
it. See the figure above.

• Validate immediately. Selecting this option causes the 
license in question to be validated as soon as any value 
that requires this license is changed. If the license is not 
available, an error message appears and the value is not 
changed. This option is recommended for users with 
standalone keys.

• Check out now and validate later. Selecting this 
option causes the license to be checked out immediately, 
but it is validated at a later stage (for example, the 
HYSYS Dynamics license is validated when the user tries 
to start the integrator). This is useful because the user 
does not see any slow-down due to network problems. It 

 Figure 12.12

 Figure 12.13
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is assumed, however, that the license is there and the 
user can make changes resulting in the case being 
stopped when the validation is complete. This option is 
recommended for users with network based security.

• Check out when in the relevant mode. Selecting this 
option checks the licenses in a run-time usage mode 
(essentially pay-per-use), so the HYSYS Dynamics 
license is only checked out while the case is in dynamics, 
and the Process+ license while the case is in steady 
state. This option is recommended for users with token 
based security.

• Don’t check out. Selecting this option means that 
licenses are not checked out. It is recommended for 
users that do not have the licenses available. Input 
requiring the license is then ignored by HYSYS.

The options in the Job Tracking Options group are Use Job 
tracking for all checked out licenses and Use Defaults.

• If you select the Use Job tracking for all checked out 
licenses checkbox, job numbers will be requested when 
either a new or old case is opened. This option does not 
support multiple jobs within a single HYSYS session.

• If you select the Use Defaults checkbox, you can enter 
defaults values in the adjacent table. If these defaults 
are set, HYSYS will not ask for any job information.

In the ACMOp Licenses Behaviour group, the Keep ACMOp 
Licenses Once Checked Out checkbox allows you to toggle 
between keeping or releasing the licenses of the ACMOp unit 
operation. When you use an ACMOp unit operation in HYSYS, 
the underlying model and framework checks out one or more 
licenses for the ACMOp unit operation. Each time the ACMOp 
unit operation solves, HYSYS checks out these licenses and 
returns them again. This can be slow on some computer 
operating systems. If this checkbox is selected, HYSYS hangs on 
to those licenses once checked out (only ACMOp related 
licenses), thus speeding the process up a little. The licenses are 
returned only when there are no ACMOp instances left 
anywhere.
12-18



Session Preferences 12-19
12.2.9 RTi Server Page
For information publication purposes, a shared network folder 
and shared Web folder named “RTISupport” are required on the 
machine running the RTI server software.

For Web publishing, the host machine should be running 
Microsoft IIS 5.0 and requires the supporting *.asp files to be in 
place in the RTISupport Web folder as well as the Microsoft XML 
parser 3.0.

Configuration of the RTI Server is done in the Session 
Preferences on the RTi Server page.

The RTI Server machine does not have to be the machine 
that is running HYSYS.

 Figure 12.14
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The following table lists and describes the objects in the RTI 
Server page.  

To configure the RTI Server, do the following:

1. Open the Session Preferences property view.
2. Click the Simulation tab, then select the RTI Server page.

3. Enter the Server IP name in the RTI Message Server IP or 
Machine Name cell.

4. Enter the Server name in the XML Server IP or Machine 
Name cell.

5. Enter you login name in the RTI User Login Name cell.

6. Close the Session Preferences property view.

12.2.10 Column Page
The Column page consists of one group: Column Options.

The Column Options group contains the following checkboxes:

• Use Input Experts. Column operations have an optional 
input expert built in to assist you in the installation. 
When this checkbox is selected, you are guided through 
the Column installation.

Field Description

Message Server IP 
or Machine Name

A valid machine name or IP address pointing to the 
server running the RTI Server software.

Message Server 
Port Number

Port number where messaging takes place. This 
should correspond to the port number of the RTI 
Message Server.

XML Server IP or 
Machine Name

A valid IP or machine name that information can be 
published to, this can be the same as the Message 
Server IP, but is not necessary (for example, http://
yourservernamehere).

User Login Name Your user login name.

 Figure 12.15
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• Expand Tray Sections. When selected, it shows a fully 
expanded column in the Column environment PFD. When 
the checkbox is clear, the column appears with the 
minimum required number of trays (those trays which 
have streams [inlet or outlet] attached to them).

• Default New Columns to Split All Feed Streams. 
When selected, all feed streams in any newly created 
column are automatically split. This option does not 
affect existing columns and any feed splitting options 
already selected.

12.2.11 Status Window Page
The Status Window page allows you to manipulate the file that 
saves the status message that appears in the Status Window. 

12.2.12 Trace Window Page
The Trace Window page allows you to manipulate the Trace 
Window options. 

 Figure 12.16

The options in the Status Window page are exactly the same 
as the options offered in the Status List Properties property 
view.

The options in the Trace Window page is exactly the same as 
the options offered in the Trace Properties property view. 

See the Object Status 
Window sub-section from 
Section 1.3.3 - Object 
Inspect Menus for more 
information.

Refer to Trace Window 
section from Section 
1.3.3 - Object Inspect 
Menus for more 
information.
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12.2.13 Cut/Copy/Paste Page
The Cut/Copy/Paste page allows you to add specific extension 
name to a copied unit operation after you have paste the 
operation.

For example, if you specified -optim as the extension to the 
copied name, as shown in the figure below:

 Figure 12.17

 Figure 12.18

 Figure 12.19
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The copied and paste object will have -optim added to the back 
of its name, as shown in the figure below of a copied separator:

12.3 Variables Tab
The Variables tab has two pages: Units and Formats.

12.3.1 Units Page
The Units page allows you to select and manipulate the unit set 
used in the simulation case.

 Figure 12.20

 Figure 12.21

Displays all available unit sets. The default 
unit sets cannot be changed or deleted.

Lets you 
change the 
name of a 
custom unit 
set.

Adds a new 
custom unit set.

Displays the 
variable and 
the unit 
according to 
the selected 
unit set.

Used to delete 
a custom unit 
set from the 
preferences.

Sorts the list 
of variables in 
ascending 
alphabetical 
order.
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HYSYS contains the following default unit sets: 

• Field
• SI
• EuroSI

These three sets cannot be modified in any way or deleted. If 
you want HYSYS to display information in units other than the 
default, you can create your own custom unit sets.

Adding a Unit Set
1. Select the unit set you want to clone from the list of 

available unit sets.

2. Click the Clone button. A new unit set appears with the 
name NewUser. 

3. Change the default name in the Unit Set Name field, if 
required.

The units used in the new unit set are the same as the unit set 
you cloned.

Deleting a Unit Set
1. Select the unit set you want to delete from the list of 

available unit sets.
2. Click the Delete button.

A custom unit set lets you mix SI and Field units within the 
same unit set.

You are not prompted to confirm the deletion of a unit set, so 
ensure that you have selected the correct unit set to delete.

You can not delete the three default unit sets: SI, Field, and 
Euro SI.
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Changing the Units in a Unit Set

1. From the list of available unit sets, select the user-defined 
unit set you want to use for your simulation.

2. In the Displayed Units group, click the unit you want to 
change (for example, Temperature).

3. In the selected unit cell, press the space bar to open a drop-
down list. The drop-down list shows all available convertible 
units for that unit type. 

For Temperature, you see C, K, F, and R and any user 
conversions that were created.

4. From the list, select the unit you want use.

Adding a Unit Conversion
If you require a unit that is not available in the HYSYS database, 
you can create your own unit and supply a conversion factor. 
You can only add a unit to a user defined unit set.

1. From the list of available unit sets, select the customized 
unit set you want to use for your simulation.

2. In the Displayed Units group, select the unit for which you 
want to add a conversion.

3. Click the Add button to display the User Conversion property 
view.

You can not modify the units in any of the three default unit 
sets: SI, Field, and Euro SI.

This selection does not change the HYSYS internal unit set.

 Figure 12.22
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4. In the Name field, type the name of your new unit.

5. In the second field (the multiply/divide field), type the 
conversion factor between your unit and the HYSYS internal 
unit. 

6. From the drop-down list, specify whether you want to 
multiply or divide by the conversion factor.

7. In the final field (the add/subtract field), type the conversion 
factor between your unit and the HYSYS internal unit. 

To add a factor, specify a value in this field. To subtract, 
place a negative sign in front of the number (for example, 
enter -2.0).

8. Click OK. The User Conversion property view closes with this 
unit as the active unit for that unit type.

Viewing a Unit Conversion
The View button lets you view the conversion factor used to 
convert a unit from its internal unit (SI) to the selected user 
defined unit in the unit set.

1. From the list of available unit sets, select the unit set you 
want to use for your simulation.

2. In the Displayed Units group, select the unit for which you 
want to view the conversion.

3. Click the View button. The Conversion property view 
appears.

4. Do one of the following:

• Click the OK button to accept any changes made to a 
user unit conversion and close the property view.

The HYSYS internal unit is always displayed on the User 
Conversion property view.

 Figure 12.23
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• Click the Cancel button to close the property view 
without accepting any changes.

Deleting a Unit Conversion
You can only delete user defined unit conversions. 

1. From the list of available unit sets, select the required unit 
set.

2. In the Displayed Units group, select the user-created unit 
you want to delete.

3. Click the Delete button. You are not prompted to confirm 
the deletion of the unit. The unit returns to the HYSYS 
default unit.

Viewing Users of a Unit Set
Units sets can be attached to spreadsheets and reports, so 
spreadsheets can have different unit sets than your simulation.

1. From the list of available unit sets, select the unit set you 
want to use for your simulation.

2. Click the View Users button. The Unit Set property view 
appears. This button is available only if the unit set is 
attached to an object. 

3. From the list of available users, select the user you want to 
view.

 Figure 12.24

Clicking the OK button closes the property view and returns 
you to the Session Preferences property view.
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4. Click the View selected object button. The property view 
of the selected user appears and the Unit Set property view 
closes.

12.3.2 Formats Page
This page lets you specify how variables appear.

Modifying Variable Formats
1. From the list of variable formats, click the format cell of the 

variable you want to modify.

 Figure 12.25

To select more than one format at a time, hold down the 
CTRL key, and click each variable you want to select.

Resets the format of the active variable back to the HYSYS default setting.

Resets all the 
variable formats 
back to the 
HYSYS default 
setting.

Sorts the list of 
variables in 
ascending 
alphabetical 
order.
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2. Click the Format button. The Real Format Editor property 
view appears.

3. Select the format you want to use for your variable.

4. Click OK to accept the changes and close the property view.

Real Format Editor
The Real Format Editor lets you set the format for displaying 
values in HYSYS.

The following table lists and describes the available formats: 

 Figure 12.26

Radio Button Description

Exponential Displays the values in scientific notation. The number of 
significant digits after the decimal point is set in the 
Significant Figure field. For example:

• Entered or calculated value: 10000.5
• Significant Figure: 5 (includes the first whole digit)
• Final display: 1.0001e+04

Assigns the HYSYS 
default format to 
the associated 
values.
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12.4 Reports Tab
The Reports tab is divided into four pages: Format/Layout, Text 
Format, Datasheets, and Company Info.

Fixed 
Decimal 
Point

Displays the values in decimal notation. The number of 
whole digits and significant digits after the decimal point 
are set in the Whole Digits and Decimal Digits fields. For 
example:

• Entered value: 100.5
• Whole digits: 3
• Decimal digits: 2
• Final display: 100.50

If the entered or calculated value exceed the specified 
whole digits, HYSYS displays the value as Exponential, with 
the sum of the specified whole and decimal digits being the 
number of significant figures.

If the Display sign if zero checkbox is selected, HYSYS 
displays the sign of the number entered or calculated that 
is rounded to zero.

Significant 
Figure

The number of significant digits after the decimal point is 
set in the Significant Figure field. Displays the values in 
either decimal notation or scientific notation. 

Example one:
• Entered or calculated value: 100.5
• Significant Figure: 5
• Final display: 100.50

Example two:
• Entered or calculated value: 10000.5
• Significant Figure: 5
• Final display: 1.0001e+04

Radio Button Description
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12.4.1 Format/Layout Page
The Format/Layout page provides options for formatting and 
specifying the appearance of your printed reports.

 Figure 12.27

Object Description

Shading When selected, headers, footers, and titles are shaded.

Line Number When selected, line numbers appear on the left side of 
the report.

Thick Borders When selected, report border lines are thicker than the 
other lines in the report.

Indicate User 
Specified

When selected, any user specified values in the 
Datasheet are indicated with an asterisk (*).

Start Datasheet 
on New Page

When selected, each Datasheet starts on a new page.

Empty Text Specify what you want to display in the Datasheet 
when there is no value available. The HYSYS default is 
“---”.

Unit Set Select the unit set you want your Datasheet to use. 
This gives you the option of printing Datasheets with 
different unit sets than your case. For example, your 
case may be in SI, but you can set the report to appear 
in Field units.

Page Margins Set the margins of your page. The values are the 
distance in inches from the edge of the page.
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12.4.2 Text Format Page
Use the Text Format page to define the appearance of text in the 
report.

Paper Options Select the size of paper on which you want to print. 
The list contains all the Microsoft defaults.

Orientation Select the orientation of the data on the paper. You 
have two options: Portrait or Landscape.

 Figure 12.28

Object Description

Use Delimiting 
By Default

Select this checkbox if you want the text file to always 
be delimited.

Title Description 
Visible

When selected, a title is added to the text file. The title 
includes the name of the object and the tabs that are 
included in the report.

Header Field 
Visible

When selected, a header is added to the text file. The 
header includes the company information and the date 
the report was created.

Footer Field 
Visible

When selected, a footer is added to the text file. The 
footer includes the HYSYS version and build number.

Fields Padded for 
Alignment

When selected, spaces are added between each field to 
align the fields.

Object Description
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12.4.3 Datasheets Page
The Datasheets page lets you control which information will 
appear in the report for selected streams and operations.

Disable Column 
Wrapping

When selected, column wrapping is disabled. This 
means that text that goes past the edge of the page 
does not wrap onto the next line.

Empty Text Specify what you want to display in the Datasheet 
when there is no value available. The HYSYS default is 
“---”.

Delimiter Specify what you want to use as the delimiter in your 
text file. The HYSYS default is comma delimited (,).

 Figure 12.29

Object Description

Selects all the datablocks 
checkboxes for the 
selected Datasheet type.

Selects all clear datablocks 
checkboxes and clears all selected 
datablocks checkboxes for the 
selected Datasheet type.
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12.4.4 Company Info Page
The Company Info page lets you customize the company 
information that appears on the report. 

To modify the company information, do the following:

1. In the Company Name field, type the company name that 
will appear in the report header.

2. In the Company Location field, type the company location 
that will appear in the report header.

3. To add a company logo, click the Select button. The Open 
File property view appears. Browse to the location of your 
bitmap file (*.bmp).

4. Select the file you want to import and click the Open button.

 Figure 12.30

HYSYS does not automatically resize a bitmap file to fit the 
logo box on this page. 

The maximum logo size that can be accommodated by the 
logo box is 6.55 cm wide by 2.38 cm high.

The logo picture must be in bitmap format.
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12.5 Files Tab
The Files tab has the following pages: 

• Options 
• Locations

12.5.1 Options Page
The Options page lets you modify the preferences used when 
saving a case. 

From the Select style for ‘File Open’ and ‘Save As’ group, select 
either the Standard Windows file picker or the HYPROTECH file 
picker radio button. The HYPROTECH file picker displays custom 
HYSYS open and save property views that show the build in 
which the case was saved, and the case description (if one was 
added).

 Figure 12.31
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In the AutoRecovery Settings and Backups group, use the 
checkboxes to select the options you want to use. The following 
table lists and describes the checkboxes.

12.5.2 Locations Page
On the Locations page, select and specify the default paths for 
various HYSYS resource files. 

Object Description

Save 
AutoRecovery 
Cases Every

When selected, HYSYS saves an auto recovery case in 
the time interval specified in the minutes field. 

You can use the up and down arrow icons  to 
increase and decrease the value of the field by one 
with each click, or you can enter a value directly in the 
field.

Save 
AutoRecovery 
Case While 
Integrating

When selected, HYSYS saves an auto recovery case 
every time the integrator is run. This checkbox is only 
available when the Save AutoRecovery Cases Every 
checkbox is selected.

Cascade Backups 
on Every Save

This checkbox is used in conjunction with the Number 
of Case Backups Automatically Maintained. When 
selected, HYSYS maintains the specified number of 
backups of each simulation, using the extension bk*. 
The newest backup is bk0, the next newest bk1, etc.

 Figure 12.32
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In the Default Files and Paths table, specify the file or path in 
which you want the selected option to reside.

You can scroll down to the Stream Correlation Sets File field and 
change the default name and path. HYSYS has access to any 
custom correlation set files (xml) which you also have access 
too. 

12.6 Resources Tab
The Resources tab is divided into the following pages: 

• Colours
• Fonts
• Icons
• Cursors
• Sounds

12.6.1 Colours Page
All the functions and property views in HYSYS are set with a 
predefined colour scheme. The Colours page lets you customize 
this colour scheme to meet the specific needs of your 
organization or simulation.

HYSYS is set to look in the Cases folder for any case files 
because the Cases field contains the path “Cases”. Leave the 
field blank if you do not want to use a default location for 
that option.

HYSYS default colour settings for text in cells/fields are as follows:

• Black text indicates the value is calculated by HYSYS and cannot be 
changed.

• Blue text indicates the value is entered by the user and is editable.
• Red text indicates the value is calculated by HYSYS and is editable.
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To change the colour of an element, do the following:

1. In the Colour Name list, select the item you want to modify.
2. From the Select System Colour drop-down list, select one of 

the system colours that are available, or select <Custom>.

3. If you selected <Custom>, click the Select Custom Colour 
button. The colour palette appears. Select the required 
colour and click OK.

 Figure 12.33

Double-clicking 
this area opens 
the Colour 
Palette.

Displays the current 
colour for the 
selected object in the 
Colour Name list.

Contains all the screen 
elements in HYSYS for 
which you can change 
the colour.

Resets all colours to 
the default colour 
scheme.

Opens the 
Colour Palette.

Colour system applied to 
the selected object in the 
Colour Name list.
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12.6.2 Fonts Page
All the text displayed in HYSYS has a predefined font scheme, 
however, like the colour scheme, you can change the font 
scheme.

To change the font of a text element, do the following:

1. In the Font Name list, select the item you want to modify.
2. From the Select System Font drop-down list, select one of 

the system fonts that are available, or select <Custom>.

 Figure 12.34

Contains all the text 
items in HYSYS.

Displays the current 
font for the selected 
font element.

Double-clicking this 
area opens the Font 
property view.

Resets all fonts to the 
default font scheme.

Present scaling 
factor of the font.

Opens the Font 
property view.

The system font currently 
applied to the selected 
font. You can select 
another font in the drop-
down list.
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3. If you selected <Custom>, click the Select Custom Font 
button. The Font property view appears. 

4. In the Font list, select the font type for the text element.

5. In the Font Style list, select the style for the text element.

6. In the Size list, select or type in the size for the text 
element.

7. Click OK.

 Figure 12.35
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12.6.3 Icons Page
HYSYS has a default icon scheme. Any icons that can be 
changed appear on this page.

To change an icon, do the following:

1. In the Icon Name list, select the icon you want to modify.
2. From the Select System Icon drop-down list select one of the 

system icons that are available, or select <Custom>. 

3. If you selected <Custom>, click the Select Custom Icon 
button. The Internal Icons property view appears. Select the 
required icon and click OK. 

 Figure 12.36

Lists all the 
icons that can 
be changed in 
HYSYS.

Displays the 
selected icon.

Double-click in 
this area to open 
the Internal 
Icons property 
view.

Resets all icons 
to the HYSYS 
default icon 
scheme.

Used for aligning 
the icon.

Opens the 
Internal Icons 
property view.

Icon system 
applied to the 
selected icon.

 Figure 12.37

Lets you browse to 
other directories 
(besides HYSYS) and 
select icons.

Scroll Bar indicates 
that there are more 
icons in this property 
view.
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12.6.4 Cursors Page
As with the Colours, Fonts, and Icons pages, you can customize 
the cursors in HYSYS.

To change a cursor, do the following:

1. In the Cursor Name list, select the cursor you want to 
modify.

2. From the Select System Cursor drop-down list, select one of 
the system cursors that are available, or select <Custom>.

If you selected <Custom>, click the Select Custom Cursor 
button. 

The Internal Icons property view displays all the icons 
available in HYSYS. You can select any of these icons as the 
icon for an item.

 Figure 12.38

Displays all the cursors 
available in HYSYS.

Displays the selected cursor.

Double-clicking this area opens 
the Internal Cursors property 
view.

Resets all cursors to the HYSYS 
default cursor scheme.

Opens the Internal Cursors 
property view.

Cursor system presently 
applied to the selected cursor.
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The Internal Cursors property view appears. 

3. Select the required cursor and click OK.

12.6.5 Sounds Page
The Sounds page lets you set up HYSYS to play a sound if the 
steady state solution takes longer than a defined period of time.

 Figure 12.39

 Figure 12.40

Click the Test Sound button to play the selected sound file.
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To play a sound, do the following:

1. Select the Enable Solver Done Sound checkbox. 
2. Click the Select Audio File button. The Open File property 

view appears.

3. Browse to the location of your sound file (*.wav). Select the 
file you want to use, then click Open.

4. In the Play Sound if Steady State Solve Takes Longer 
Than field, enter the amount of time you want to the let the 
steady state solver take before a sound is played.

12.7 Extensions Tab
The Extensions tab is used to register external extension in 
HYSYS.

Use the up and down arrow icons  to increase or decrease 
the value in the field by one each click or you can enter a 
value directly in the field.

 Figure 12.41

The Registered 
Extensions 
group displays 
the extension 
type, CLSID, 
ProgID, location 
of the *.dll and 
extension 
status.
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To register an extension, do the following:

1. Click the Register an Extension button. The HYPROTECH 
file picker appears.

2. In the File Path group, browse to the location of the 
extension DLL.

3. From the list of available extension *.dlls, select the 
extension you want to register with HYSYS.

4. Click Ok. The HYPROTECH file picker closes and the 
extension appears in the Registered Extensions group.

To unregister an extension, do the following:

1. Select the extension you want to unregister from the list of 
registered extensions.

2. Click the Unregister Extension button.

12.8 Oil Input Tab
The pages on the Oil Input tab lets you set default settings for 
characterizing oils in your simulation case.

12.8.1 Assay Definition Page
The Assay Definition page enables you to define an assay 
characteristics.

 Figure 12.42

For more details about 
these options, see 
Chapter 4 - HYSYS Oil 
Manager in the HYSYS 
Simulation Basis guide.
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Use the following procedure to set your default assay definition.

1. From the Bulk Properties drop-down list, select one of the 
following options:
• Used option if you are supplying bulk properties data by 

selection.
• Not Used option if you are not supplying the bulk 

properties information.
2. From the Assay Data Type drop-down list, select one of the 

following data types: TBP, ASTM D86, ASTM D1160, ASTM 
D86-D1160, ASTM D2887, Chromatograph, EFV, or None. 

3. From the Light Ends drop-down list select one of the 
following options: Ignore, Input Composition, or Auto 
Calculate.

4. From the Molecular Wt. Curve drop-down list, select one 
of the following options: Not Used, Dependent, or 
Independent.

5. From the Density Curve drop-down list, select one of the 
following options: Not Used, Dependent, or Independent.

6. From the Viscosity Curves drop-down list, select one of the 
following options: Not Used, Dependent, or Independent.
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12.8.2 Assay Options Page
The Assay Options page enables you to select the methods used 
to calculate an assay.

To set your default assay options, do the following:

1. From the Assay Basis drop-down list, select one of the 
following options: Liquid Volume%, Mass%, or Mole%.

2. Use the drop-down lists in the Conversion Methods group to 
select the methods HYSYS will use for D86-TBP 
Interconversion and D2887-TBP Conversion.

3. Use the drop-down lists in the Curve Fitting Methods group 
to select the extrapolation method to be used by each curve 
type. There are three extrapolation methods to select from: 
Lagrange, Least Squares, and Probability.

 Figure 12.43
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12.8.3 Black Oils Page
The Black Oils page allows you to set the default viscosity and 
water content calculation methods for all the Black Oil streams 
in your simulation.

12.9 Tray Sizing Tab
The Tray Sizing tab lets you set the HYSYS defaults for the Tray 
Sizing utility. Any parameters set here are automatically used 
when you attach a Tray Sizing utility to your case. 

 Figure 12.44

Refer to Section 1.2.2 - 
Setting Black Oil 
Stream Default Options 
and Section 1.4.1 - 
Installing the Black Oil 
Feed Streams in the 
Upstream Option 
Guide, for more 
information on setting the 
viscosity method and 
water content option.

For more information 
about this utility, see 
Section 14.19 - Tray 
Sizing in the HYSYS 
Operations Guide.
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12.9.1 Parameters Page

To set your default tray sizing parameters, do the following:

1. In the Area Tolerance field, enter a value for your area 
tolerance.

2. In the NFP Diam Factor field, enter a value for your NFP 
diameter factor.

3. From the Tray Internal Type drop-down list, select one of 
the following tray types: Valve, Sieve, Bubble Cap, or 
Packed.

 Figure 12.45
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12.9.2 Packed Page

To set your default packed parameters, do the following:

1. From the Correlation Type drop-down list, select one of the 
following design correlations for predicting pressure drop 
and liquid hold-up: Robbins or Sherwood-Leva-Eckert. 
The default selection is Robbins.

2. In the Packing Flooding Factor field, specify the packing 
flood factor of your packed tray. 

The default value is 1.000.

3. In the Maximum Flooding field, specify the maximum 
percentage of flooding you can have on your tray. 

The default value is 70.00%.

4. In the Maximum dP per length field, specify the maximum 
pressure difference you can tolerate per measured length.

The default value is 0.4086 kPa/m.

 Figure 12.46

For information about the 
packing types available in 
HYSYS, refer to the 
packinfo.db file located 
in the Support folder. 

You can open the file 
using any text editor 
program.
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12.9.3 Trayed Page
The selections made on the Trayed page are used as the default 
settings for every new tray section that you add to your tray 
sizing utility. The tray parameters group changes depending on 
which radio button you select.

To set your default trayed parameters, do the following:

1. Select the General radio button.
In the General Tray group, enter values for the following tray 
specifications: Tray Spacing, Tray Thickness, Tray Foaming 
Factor, Max Tray Flooding, Weir Height, Max Weir Loading, D/
C Type, D/C Clearance, and Max DC Backup.

2. Select the Sieve radio button.

In the Sieve Tray group, enter values for the following sieve 
tray specifications: Hole Diameter, Hole Pitch, Flooding 
Method and Max Tray DP (height of liquid).

 Figure 12.47

Sieve tray calculations are based on the valve tray manuals 
for tray layout, and Mass-Transfer Operations for pressure 
drop, weeping and entrainment calculations by Treybal 
(McGraw-Hill).
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3. Select the Valve radio button.

In the Valve Tray group, enter values for the following valve 
tray specifications: Orifice Type, Design Manual, Valve 
Material Density, Valve Material Thickness, Hole Area (% of 
actual area) and Max Tray DP (height of liquid).

4. Click the Bubble Cap radio button.

In the Bubble Cap Tray group, enter values for the following 
bubble cap tray specifications: Hole Area (% of actual area), 
Cap Slot Height and Max Tray DP (height of liquid).

5. Click on the Chimney radio button.

In the Chimney Tray group, enter values for Riser Area (% of 
AA), Riser Height, Chimney Tray Spacing, Max Tray DP 
(height of liquid), Chimney Weir Height, and Residence 
Time.

6. Click on the Sump Tray radio button.

In the Sump Tray group, enter values for Sump Tray 
Spacing, Liquid Height, Residence Time, and Max Tray DP 
(height of liquid).

Valve tray calculations are based on the Glitsch, Koch, and 
Nutter valve tray design manuals.

Bubble tray calculations are based on the method described 
in Design of Equilibrium Stage Processes by Bufford D. Smith 
(Wiley & Sons).
12-52



Window & Help Options 13-1
13 Window & Help 
Options
13-1

13.1  Introduction................................................................................. 2

13.2  Window Menu .............................................................................. 2

13.2.1  Save Workspace..................................................................... 3
13.2.2  Load Workspace ..................................................................... 4

13.3  Help Menu.................................................................................... 5

13.3.1  Adding a Bug Report ............................................................... 5
13.3.2  Editing a Bug Report ............................................................... 6
13.3.3  Deleting a Bug Report ............................................................. 6



13-2 Introduction
13.1 Introduction
This chapter provides descriptions for the options available in 
the Window and Help menus.

To access the Window or Help menu options, do one of the 
following: 

• Click the required menu bar item to open the associated 
menu.

• Use the ALT key in combination with the underlined 
letter in the menu title. For example, ALT W opens the 
Window menu.

• Use the ALT key by itself to move the active location to 
the File menu in the menu bar. When the menu bar is 
active, navigate across it using the keyboard. The UP 
and DOWN arrow keys move through the menu 
associated with a specific item, while the LEFT and 
RIGHT arrow keys move to the next menu bar item, 
opening the associated menu.

13.2 Window Menu
This menu contains general Windows application functions. The 
commands are as follows:

If you want to switch focus from the menu bar without 
making a selection, press the ESC key or the ALT key.

Command Description

Arrange Desktop Cascades all property views that are currently open 
and not iconized. Face plates are placed in rows or 
column according to the specifications on the Desktop 
page of the Session Preferences property view. Refer 
to Section 12.2.3 - Desktop Page, for more 
information.

Arrange Icons Arranges icons horizontally at the bottom of the 
Desktop.

Close Closes the active property view.

Close All Closes all property views.

Save Workspace Saves the current property view layout for future use.

Load Workspace Loads another HYSYS case which is currently open. 
This function lets you toggle between cases.
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The last section in this menu lists all open property views on the 
Desktop. The active property view is indicated by a checkmark.

13.2.1 Save Workspace
You can save different Workspace arrangements within a HYSYS 
case. The Workspace is a specific organization of property views 
for the current case. For example, create an arrangement of 
property views that has the PFD, Workbook, Controllers, Strip 
Charts, etc. You can name each arrangement individually, then 
access the arrangement at any time.

This has no effect on the calculation status. It is simply the way 
the various property views are arranged. After changes are 
made to the Desktop arrangement, reload a saved arrangement 
to access the property view layout.

1. From the Window menu, select Save Workspace. The 
Save Workspace property view appears.

2. In the Save Workspace As field, enter the name of the 
workspace.

3. Click Save.

 Figure 13.1
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13.2.2 Load Workspace
The Load Workspace property view displays all cases that are 
currently open and the workspaces available for the loaded 
case.

Loading a Workspace
1. From the Window menu, select Load Workspace. The 

Load Workspace property view appears. 

2. In the list of available cases, select the case in which you are 
currently working.

3. From the list of available workspaces, select the workspace 
you want to use.

4. Click Load.

Switching to Another Open Case
1. From the Window menu, select Load Workspace. The 

Load Workspace property view appears.
2. From the list of available cases, select the case in which you 

want to switch.

3. From the list of available workspaces, select the workspace 
you want to load in the new case.

 Figure 13.2

Select the Save when Switching checkbox to save the case 
when switching between workspaces.
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4. Click Load.

Select the Save when Switching checkbox to save the case 
when switching between cases.

13.3 Help Menu
The following table lists and describes the commands in the Help 
menu:

13.3.1 Adding a Bug Report
1. From the Help menu, select Bug Reports. The Bug Reports 

property view appears.
2. Click the New button to display the Bug Report property 

view.

3. In the Bug Title field, type the name of the bug report.

4. The current date and time appear in the Date field, but you 
can change it if necessary.

5. In the Reported by field, type a contact name so Hyprotech 
Technical Support can ask further questions or provide 
answers to the problem.

6. In the Class group, click either the Bug or Enhancement 
radio button.

7. In the Priority group, click either the High, Medium, or Low 
radio button.

Command Description

HYSYS Help 
Topics

Opens the HYSYS Online Help to the Welcome page.

Help on 
Extending HYSYS

Opens the HYSYS Extensibility Online Help.

Help on the 
Current Form

Opens the HYSYS Online Help to the topic that relates 
to the active property view. If no topic is found for that 
property view, the Welcome page appears.

Bug Reports Accesses HYSYS’ unique bug reporting option. 

About HYSYS Provides information about HYSYS (version, etc.).

Hyprotech on the 
Web

Clicking the Hyprotech on the Web command opens a 
sub-menu with a link to the Hyprotech Web site.
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8. In the Program Area field, enter the area of the program in 
which the bug is found. 

For example, if a bug is found on the Assay tab of the Oil 
Characterization environment, specify Assay tab - Oil 
Characterization environment. Be as specific as possible so 
the problem can be located.

9. In the Step-by-Step Description field, enter the steps 
used to produce the bug. Be as specific as possible so the 
problem can be located and fixed.

10. In the Reproducibility group, click either the Always, 
Sometimes, or Never radio button.

11.Click the Write button to display the Save File property 
view.

12.Specify a name and location for your bug report file.

13.Click Save.

14. E-mail the bug report file to the Support Center at 
support@aspentech.com.

13.3.2 Editing a Bug Report
1. From the Help menu, select Bug Reports. The Bug Reports 

property view appears.
2. From the list of available bug reports, select the bug report 

you want edit.

3. Click the Edit button to display the Bug Report property 
view.

4. Modify any of the parameters making up the bug report.

13.3.3 Deleting a Bug Report
1. From the Help menu, select Bug Reports. The Bug Reports 

property view appears.
2. From the list of available bug reports, select the bug report 

you want delete.

3. Click the Delete button.

You are not prompted to confirm the deletion of a bug report, 
so ensure the correct report is selected before deleting.
13-6
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